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پیشگفتار

هنر می‌تواند به کیفیت زندگی بیفزاید اگر انسانی بتواند زندگی خود را به‌صورت هنرمندانه‌ای خلق کند که در نهایت به 
اثری که از خود خلق کرده آفرین بگوید و از زندگی نهایت لذت را ببرد در واقع آن فرد یک هنرمند است. اگر شما در هنری 

که خلق می‌کنید کمی خلاقیت نیز به خرج بدهید در این صورت هنر شما خاص و منحصربه‌فرد به نظر می‌رسد.
در کارهایی که انجام می‌دهید از خود خلاقیت به خرج بدهید. خیلی‌ها فکر می‌کنند فقط کارهای گرافیکی، نقاشی 
کردن یا امثال این‌ها هنر نامیده می‌شود اما حقیقت آن است که در این دنیا هر حرفه‌ای به نام هنر شناخته می‌شود و اگر 
بتوانید در آن حرفه به‌صورت حرفه‌ای کار کنید و سپس در آن از خود خلاقیت به خرج ‌دهید شما تبدیل به یکی از بهترین‌ها 
در آن حرفه خواهید شد. حتی خلاقیت هم یک هنر است و باید آن را یاد بگیرید. آدم‌ها از همان بچگی خلاق به دنیا نمی‌آیند 
بلکه کم کم بزرگ می‌شوند و با این بزرگ شدن مهارت خلاقیت را هم کسب می‌کنند. فراموش نکنید که خلاقیت ذاتی نیست 

بلکه اکتسابی است و مانند هر هنر دیگری قابل آموزش است.
در این کتاب در بخش‌های مختلف نرم‌افزار، نگاه جامع و کامل‌تری نسبت به ارتباط طراح و نیاز بازار وجود دارد و 
اهمیت موضوع، به تجربه‌ها و نکات کاملًا کاربردی و موردنیاز طراحان و کاربران عزیز اشاره شده است؛ دغدغه و آرزوی مؤلفان، 
سودمندی کتاب و افزایش سطح اطلاعات نرم‌افزاری شما، حداقل برابر با هزینه و زمان صرف‌شده برای مطالعه این کتاب است 

و امیدواریم که خداوند متعال یاری دهد و رضایت خوانندگان محترم فراهم شود.
جا دارد از تمام کسانی که در این مورد ما را یاری کردند تشکر کنیم.

مؤلفان
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  نرم‌افزار InDesign را نصب و راه‌اندازی کند.

  یک سند را باز کند.

  سندی را ایجاد کند.

  پنل‌ها را در حین انجام کار مخفی کند.

  یک فضای کاری سفارشی ایجاد کند.

  خطوط راهنما را بهک‌ار گرفته و آن ها را پس از ایجاد سند تغییر دهد.

  چگونگی تغییر تنظیمات سند را پس از ایجاد بررسی کند.

  ابزارهای Gap را بهک‌ار گیرد.

  حاشیه و ستون‌بندی صفحات را تنظیم کند.

  از الگوها استفاده کند.

 كليات

InDesign را درست مثل هر برنامه دیگری که استفاده میک‌نید، اجرا کنید. روش‌های مختلفی برای اجرای 
InDesign وجود دارد. ساده‌ترین و سریع‌ترین روش موردنظر خود را انتخاب کنید. می‌توانید آن را از نوار 
وظیفه Windows باز کنید یا از میانبر موجود در دسک‌تاپ استفاده کنید و الی آخر. لازم نیست همه راه‌ها 
 Adobe را بدانید، همان روشی را که راحت هستید انجام دهید. مثلًا می‌توانید روی آیکن برنامه کاربردی

InDesign CC در منوی Start، صفحه نمایش Start یا نوار وظیفه کلیک کنید.
یا در صورت استفاده از Windows 10، می‌توانید InDesign را در Cortana تایپ کنید و پس از ظاهر شدن 

برنامه کاربردی InDesign در نتایج جستجو، روی آن دابل کلیک کنید یا Enter را فشار دهید.
هنگامیک‌ه InDesign را اجرا میک‌نید، با یک فضای کاری Start مواجه می‌شوید )شکل 1ـ1(. این فضای 
کاری Start برای کمک به شما در جهت استفاده صحیح از InDesign و یادگیری آن طراحی شده است.

InDesign در Start شکل 1ـ1ـ فضای کاری

زمان آموزش

عملینظری

713
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می​توانید برای مشاهده مطالب آموزشی و چگونگی ایجاد اسناد مختلف، روی برگه Learn کلیک کنید. تا 
مطالب آموزشی را مشاهده کنید تا به شما بیاموزند چگونه انواع اسناد مختلف InDesign را بسازید.

هنگام ایجاد سند جدید، برگه Work فضای کاری Start دو راه برای شروع کار در اختیار شما می‌گذارد. 
 File>New>Document است که میانبری برای فرمان Create New روش اصلی کلیک کردن روی دکمه
است. این امر موجب باز شدن کادر محاوره‌ای New Document می‌شود که پیش تنظیمات متعددی را ارائه 
می‌دهد که می‌توانید از آن‌ها به‌عنوان نقطه شروع استفاده کنید. در صفحه 20 تا 23 نگاه دقيق‌تري به كادر 

محاوره​اي New Document شده است.

1ـ1ـ روش‌های استفاده از الگوها

 Start در پایین فضای کاری Adobe Stock اگر علاقه‌مندید از یک الگو شروع کنید، در فیلد جستجوی
یا از طریق فرمان ... File>Search Adobe Stock، هر آنچه را که به دنبالش هستید، تایپ کنید و روی 

Go کلیک کنید. در نتیجه این کار به صفحه وب Adobe Stock از الگوهای سند InDesign می‌روید.
در استفاده روزانه، اولین کاری که اغلب و پس از شروع InDesign می‌خواهیم انجام دهیم، ادامه کار روی 
پروژه‌های فعلی‌تان است. هنگامیک‌ه فضای کاری Start ظاهر شد، روی Recent کلیک کنید. این کار موجب 
 InDesign می‌شود که اخیراً باز کرده‌اید )چنانچه اولین بار است که از InDesign نمایش فهرستی از اسناد
بازنشانی  را   InDesign پیش‌فرض(  )تنظیمات  ترجیحات  یا چنانچه  استفاده میک‌نید  کامپیوتر خود  روی 
 File>Open میانبری برای فرمان Recent خالی خواهد بود(. فهرست Recent کرده‌اید، احتمالاً فهرست

Recent است.
اگر اسناد InDesign خود را در فضای ذخیره‌سازی آنلاین Creative Cloud Files نگه می‌دارید، می‌توانید 
با کلیک کردن روی CC File آن‌ها را ببینید. Creative Cloud Files فضای ذخیره‌سازی ابری مربوط به 

Adobe ID است که در آن ثبت‌نام کرده‌اید.

 InDesign 2ـ1ـ چگونگی کار با فضای کاری 

هنگامیک‌ه یک سند InDesign را باز میک‌نید، خود را در فضای کاری سند InDesign می‌بینید )شکل 
2ـ1( که برای ارائه گزینه‌هایی طراحی شده است که بیشترین ارتباط را با آن چیزی دارند که در حال کار 
روی آن هستید. به‌علاوه، می‌توانید فضای کاری InDesign را با کنترل‌هایی سفارشی کنید که می‌خواهید 

دم دستتان باشد و فضای نمایش را با پنهان کردن گزینه‌هایی که مدنظرتان نیستند، خلوت کنید.
حال اجازه دهید نگاهی به برخی از نواحی فضای کاری InDesign بیندازیم که اغلب از آن‌ها استفاده خواهید کرد.

3ـ1ـ پنل کنترل 

ارائه می‌دهند که در میان منوها،  را  InDesign صدها ویژگی و گزینه  برنامه‌های کاربردی حرفه‌ای نظیر 
پنل‌ها و کادرهای محاوره‌ای گسترده شده‌اند. چالش عمده پیمایش بین این مکان‌ها در حین کار کردن و 

به‌ویژه در حین یادگیری است.
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شکل 2ـ1ـ فضای کاری InDesign حاوی پنجره‌های سند و پنل‌های برنامه کاربردی است.

پنل کنترل )شکل 3ـ1( با سازگاری خودکار با آنچه که انجام می‌دهید، گام بزرگی به‌سوی حل این مسئله 
برمی‌دارد. هنگامیک‌ه ابزاری را انتخاب میک‌نید، پنل کنترل گزینه‌هایی را برای آن ابزار خاص نشان می‌دهد. 
هنگامیک‌ه چیزی را انتخاب میک‌نید، پنل کنترل برای تمرکز بر گزینه‌هایی که برای شیء منتخب در سند مفید 
هستند، تغییر میک‌ند. مثلًا، اگر یک شیء گرافیکی را انتخاب کنید، پنل کنترل گزینه‌های گرافیکی را نشان 
می‌دهد. اگر متنی را انتخاب کنید، پنل کنترل، کنترل‌های تایپ را ارائه می‌دهد. اگر چند شیء را انتخاب کنید، 

پنل کنترل گزینه‌هایی را برای هم‌تراز کردن آن‌ها اضافه میک‌ند. 

شکل 3ـ1ـ پنل کنترل پر استفاده‌ترین گزینه‌ها را برای شیء فعال جاری نشان می‌دهد.
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گزینه‌های موجود در پنل کنترل فقط در آنجا وجود ندارند. مثلًا، در حالیک‌ه پنل کنترل گزینه‌های مربوط 
باشید  باز کرده  را هم   Character برای یک فریم متنی منتخب نشان می‌دهد، چنانچه پنل  را  تایپ  به 
)شکل 4ـ1(، گزینه‌های مشابه متعددی را هم در آنجا خواهید دید. نکته اینجاست که فقط به این دلیل 
 Character که به مدت 30 ثانیه با متن کار کرده‌اید، نیازی نیست که به خودتان زحمت دهید و پنل

را باز کنید، در صورتیک‌ه گزینه‌های تایپ مدنظر شما هم‌اکنون در پنل کنترل در حال نمایش هستند.

شکل 4ـ1ـ گزینه‌های موجود در پنل کنترل از پنل‌های تخصصی‌تر گرفته می‌شوند، بنابراین می‌توانید با پنل‌های باز کمتری 
کار بیشتری انجام دهید.

ابزارهای متعددی وجود دارند که همه آن‌ها هم‌زمان قابل رؤیت نیستند. برخی از ابزارها گروه‌بندی شده‌اند و 
در هر زمان، فقط یکی از آن‌ها قابل مشاهده است. هنگامی که مثلث کوچکی را در گوشه سمت راست پایین 
یک ابزار می‌بینید، آن مثلث نشان می‌دهد که گروهی با ابزارهای پنهان وجود دارد )شکل 5ـ1(. برای مشاهده 

کل گروه ابزار، ابزار را فشار داده و نگه دارید تا بقیه ابزارها در یک منوی بازشو پدیدار شوند.

Selection ابزار A
Direct Selection ابزار B

Page ابزار C
Gap ابزار D

)Content Placer گروه‌بندی شده با ابزار( Content Collector ابزار E
)Type on a Path گروه‌بندی شده با ابزار( Type ابزار F

Line ابزار G
 )Convert Direction Point و Delete Anchor Pointو،Add Anchor Point گروه‌بندی شده با ابزارهای( Pen ابزار H

)Erase و Smooth گروه‌بندی شده با ابزارهای( Pencil ابزار I
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)polygon Frame و Ellipse Frame گروه‌بندی شده با ابزارهای Rectangle Frame ابزار J
)Polygon و Ellipse گروه‌بندی شده با ابزارهای( Rectangle ابزار K

Scissors ابزار L
)Shear و Scaleو،Rotate گروه‌بندی شده با ابزارهای( Free Transform ابزار M

Gradient Swatch ابزار N
Gradient Feather ابزار O

Note ابزار P
)Measure و Eyedropper گروه‌بندی شده با ابزارهای( Color Theme ابزار Q

Hand ابزار R
Zoom ابزار S

Stroke و Default Fill ابزار T
Stroke و Swap Fill ابزار U

V آیکن‌های Fill و Stroke برای اعمال رنگ‌ها
W آیکن Container و Text برای اعمال رنگ‌ها

Apply Color/Gradient/None آیکن X
View Options آیکن Y

Tools شکل 5ـ1ـ پنل
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 4ـ1ـ نحوه تنظیمات نوار ابزار 

پس از یک نصب درست InDesign، پنل Tools همیشه ستون منفردی در سراسر سمت چپ فضای کاری 
باشد. در صورت چنین  بزرگ  نمایش کوچک‌تر، خیلی  برای صفحات  است  Tools ممکن  پنل  البته،  است. 
اتفاقی، می‌توانید روی فلش‌های دوتایی در بالای پنل Tools کلیک کنید تا آن را به یکی از حالت‌های دیگرش 
ببرید )شکل​​​​​​​​​​​​​​​​​6 ـ1( که ممکن است پنل Tools با صفحه نمایش شما متناسب‌تر باشد و آسان‌تر بتوانید برخی از 

دکمه‌های مفید را در پنل Tools ببینید.

شکل ​​6 ـ 1ـ برای امتحان چیدمان‌های مختلف پنل Tools، روی فلش‌های دوتایی در بالای پنل کلیک کنید.

 5 ـ1ـ چگونگی کار با فضاهای کاری مختلف و ایجاد فضای کاری سفارشی

تاکنون درباره فضایک​اری InDesign به‌عنوان نمایش کلی ابزارها و گزینه‌ها روی صفحه نمایش شما صحبت 
کردیم و بیان کردیم چگونه آن‌ها قابل سفارشی شدن هستند، زیرا می‌توانید پنل‌هایی را که روی صفحه 
نمایش می‌بینید، بسط دهید، جمع کنید و بازآرایی کنید. ولی پنل‌های بسیاری وجود دارند که ممکن است 
اهمیت چندانی برای شما نداشته باشند. به این علت است که شما می‌توانید پیکربندی‌های مختلف پنل را 

ذخیره کنید و آن فضاهای کاری را نام‌گذاری کنید.
می‌توانید فضاهای کاری نزدیک سمت راست نوار برنامه کاربردی را در بالای فضای کاری InDesign درست 
در سمت چپ فیلد جستجو تغییر دهید. روی سوئیچک‌ننده1 فضای کاری )شکل 7ـ1( کلیک کنید تا منویی 
از فضاهای کاری پیش‌تنظیم نصب شده با InDesign را ببینید. اگر فضاهای کاری خاص خود را ایجاد کنید، 

در بالای آن منو ظاهر خواهند شد.

Switchir ـ1
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شکل 7ـ1ـ سوئیچ‌کننده فضای کاری به شما اجازه تغییر دادن فضای کاری فعال را می‌دهد.

فهرست فضاهای کاری نیز در زیرمنوی Window>Workspaces ظاهر می‌شود.
حال به نکاتی درباره استفاده از فضاهای کاری می‌پردازیم:

  اگر آرایشی از پنل‌ها را ایجاد کرده‌اید و می‌خواهید آن را ذخیره کنید، New Workspace را از منوی 

سوئیچک‌ننده فضای کاری انتخاب کنید.
  اگر از یکی از فضاهای کاری نام‌گذاری شده خود استفاده میک‌نید و می‌خواهید آن را به‌روزرسانی کنید، 

دوباره New Workspace را انتخاب کرده و همان نام فضای کاری مدنظرتان برای به‌روزرسانی را به آن 
بدهید؛ InDesign در مورد جایگزینی با فضای کاری موجود از شما سؤال میک‌ند.

  اگر بعضی از پنل‌ها را در یکی از فضاهای کاری معین خود بازآرایی میک‌نید، ]نام فضای کاری[ Reset را 

از منوی سوئیچک‌ننده فضای کاری انتخاب کنید، فضای کاری به حالت پیش‌فرض باز می‌گردد.
به دليل اينکه پنل‌ها در InDesign کاربرد مشخصی دارند، بعضی از پنل‌ها فقط برای وظایف یا گردش‌های 
با   eBook یا یک  تعاملی   PDF ایجاد یک  برای   InDesign از  کاری خاص مفید هستند. مثلًا، می‌توانید 
 Buttons and Forms پویانمایی‌هایی استفاده کنید که نیاز به استفاده از پنل‌های خاصی دارند، از قبیل پنل
یا پنل Animation.وAdobe تعدادی فضای کاری پیش‌تنظیم InDesign را برای گردش‌های کاری متداول 

ایجاد کرده است؛ می‌توانید از بین آن‌ها از سوئیچک‌ننده فضای کاری که قبلًا دیدید، انتخاب کنید.
فضاهای کاری پیش‌فرض InDesign عبارت‌اند از:

  Start: هنگامیک‌ه هیچ سندی در InDesign باز نیست، فضای کاری Start تنها فضای کاری موجود است و 

به‌طور خودکار ظاهر می‌شود. هنگامیک‌ه یک یا چند سند باز هستند، فضای کاری Start در دسترس نخواهد بود.

  Essentials: این فضای کاری پیش‌فرض است. می‌توانید از آن برای طیف گسترده‌ای از پروژه‌های پایه استفاده کنید.

  Advanced: این فضای کاری شامل پنل‌ها در فضای کاری Essentials است، در حالیک‌ه پنل‌های اضافه‌ای 

دارد که در حفظ تصاویر گرافیکی و استانداردهای حروف نگاری از طریق فهرست‌های شیوه InDesign به 
.)Character Styles و Paragraphو،Object Styles شما کمک میک‌نند )پنل‌های

  Book: چیدمان پنلی در این فضای کاری برای ایجاد و مدیریت اسناد طولانی بهینه شده است. در این فضای 

کاری، پنل‌هایی برای ویژگی‌های اسناد طولانی مثل مراجع و مآخذ، متن شرطی، نمایه و نشانه‌ها اضافه شده است.
  Digital Publishing: این فضای کاری بر پنل‌های مورد نیاز برای ایجاد اسناد دیجیتال تعاملی تمرکز 

.Hyperlinks و Buttonsو،Mediaو،Timingو،Animation دارد، از قبیل پنل‌های
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  Interactive for PDF: این فضای کاری بر پنل‌هایی تأیکد دارد که از ایجاد فایل‌های PDF تعاملی 

.Media و Buttons and Formsو،Page Transitions پشتیبانی میک‌نند، از قبیل پنل‌های
  Printing and Proofing: پنل‌ها در این فضای کاری بر یک گردش کار پیشرفته برای چاپ تجاری 

.Preflight و Trap Presetsو،Separations Preview تمرکز دارند، از قبیل پنل‌های
 InDesign این فضای کاری بر پنل‌های حاوی ویژگی‌های متنی و حروف‌نگاری قوی در :Typography  

Character،وCharacter Styles،وParagraph،وParagraph Styles،و پنل‌های  قبیل  از  دارد،  تأیکد 
می‌توانید  زمان  هر  در  شما  هستند.  پیشنهاد  درحد  فقط  پیش‌تنظیم  کاری  فضاهای   .Story و   Glyphs
کاری  فضای  از  است  ممکن  میک‌نید،  کار  کاتالوگ  یک  روی  اگر  مثلًا،  کنید.  استفاده  کاری  فضای  هر  از 
کاری  فضای  به  متن،  دقیق  تنظیم  برای  کنید،  استفاده  صفحات  کلی  چیدمان  انجام  برای   Advanced
 Printing and Proofing سوئیچ کنید، برای آماده کردن کاتالوگ برای چاپ، به فضای کاری Typography
بروید.  Interactive به فضای  کاتالوگ  از  دانلود  قابل   PDF نگارش  آماده کردن یک  برای  بروید و سپس 
هنگامیک‌ه در InDesign تجربه پیدا کردید، ممکن است آرایش پنلی خودتان را ترجیح دهید که متفاوت 
از همه آرایش‌های پیش‌تنظیم باشد. اینجاست که باید فضای کاری سفارشی خاص خودتان را ذخیره کنید.

6ـ1ـ ایجاد فضاهای کاری سفارشی

برای ایجاد یک فضای کاری سفارشی )شکل 8 ـ1(:
1 همه پنل‌هایی را که نمی‌خواهید ببندید.

2 پنل‌هایی را که می‌خواهید در فضای کاری شما ذخیره شوند، باز کرده و آرایش دهید.
3 در سوئیچک‌ننده فضای کاری از منوی Window>Workspace گزینه New Workspace را انتخاب کنید.

4 فضای کاری خود را نام‌گذاری کنید، مطمئن شوید که Panel Locations انتخاب شده است و سپس 
روی OK کلیک کنید.

شکل 8 ـ1ـ پس از ایجاد یک فضای کاری سفارشی، در بالای سوئیچ‌کننده فضای کاری ظاهر می‌شود.

7ـ1ـ بررسی حالت‌های صفحه‌نمایش

یکی از مهم‌ترین موارد درباره پنجره سند InDesign این است که تمام انواع دستیارهای بصری را به شما 
نشان می‌دهد تا به شما کمک شود بدانید دنبال چه چیزی هستید و سند خود را به‌صورتی کارآمد صفحه‌آرایی 
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هستند. صفحات  کنترل‌هایی  و  دارای شاخص‌ها  اشیا  کنید. 
دارای حاشیه1، خطوط راهنما2 و مشبک‌3هایی هستند که در 
صفحه‌بندی و برآورده ساختن نیازها به شما کمک میک‌نند. 
از این دستیارهای بصری قرار نیست در سند  ولی هیچ یک 
که طرح  ببینید  تنهایی  به  می‌خواهید  وقتی  و  باشند  نهایی 
شما به چه صورت است، می‌توانند مانع باشند و حواس شما را 
پرت کنند. به همین دلیل InDesign چندین حالت صفحه 
را فراهم میک‌ند )شکل 9ـ1( تا بتوانید انواع مختلف عناصر را 

در فضای کاری پنهان کنید یا نمایش دهید.
  Normal: حالت صفحه‌نمایش Normal معمولاً حالت کاری روزانه شماست، زیرا شما می‌توانید تمام اشیا و 

خطوط راهنما را ببینید، حتی آن‌هایی که در ناحیه غیرچاپی Pasteboard و خارج از لبه‌های صفحه هستند.
  Preview: حالت Preview روشی عالی برای مشاهده چگونگی طراحی سند به هنگام چاپ یا صدور است، بدون 

اینکه درهم و برهمی ناحیه Pasteboard، خطوط راهنمای مختلف و علامت‌های روی صفحه‌نمایش دیده شوند.

شکل 10ـ1ـ استفاده از سوئیچ‌کننده فضای کاری در نوار برنامه کاربردی برای تغییر دادن فضاهای کاری

Margin ـ1
Guides ـ2
Grids ـ3

InDesign شکل 9ـ1ـ حالت‌های صفحه‌نمایش در
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آن‌ها  ولی  نمیک‌نید،  استفاده   Slug و   Bleed حالت‌های  از  الان  همین  احتمالاً  شما   :Slug و   Bleed   

برای بعضی از پروژه‌های چاپی مفید هستند که در آن پروژه‌ها، سند دارای مقادیر Bleed و Slug در کادر 
محاوره‌ای File>Document Setup است. Bleed ناحیه‌ای اطراف صفحه برای عناصری است که پس از 
چاپ بریده خواهند شد و Slug فضایی اضافی برای چاپ اطلاعات سند است )که آن هم بریده خواهد شد(. 

حالت‌های Bleed و Slug نشان می‌دهند که این نواحی خارج از لبه صفحه هستند.
  Presentation: اگر بخواهید یک سند InDesign را به‌صورت یک اسلایدشو روی صفحه نمایش نشان 

از  را که خارج  پنهان میک‌ند، هر چیزی  به جز طراحی  را  این حالت هر چیزی  این راهش هست.  دهید، 
لبه‌های صفحه است، می‌برد و صفحه را در یک پس‌زمینه سیاه نشان می‌دهد. می‌توانید صفحات را با استفاده 

از کلیدهای جهتی یا کلیدهای Page Up و Page Down حرکت دهید. 

برای تغییر حالت صفحه‌نمایش می‌‌توانید به یکی از این روش‌ها عمل کنید:
  در پنل Tools، روی دکمه Screen Mode کلیک کنید )شکل 11ـ1( و حالتی را انتخاب کنید. توجه 

داشته باشید که اگر پنل Tools در حالت دو ستونی است، دو دکمه Screen Mode وجود دارد: دکمه چپ، 
بازنشانی تک کلیکی به Normal است و دکمه راست به شما اجازه می‌دهد بین همه حالت‌ها سوئیچ کنید به 

استثنای حالت Normal. این تغییر حالت، با فشردن و نگه داشتن دکمه امکان​پذیر می‌شود.

View از منوی Screen Mode شکل 11ـ1ـ انتخاب

  View>Screen Mode را انتخاب کرده و حالتی را از زیرمنو برگزینید.
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8ـ1ـ روش‌های مختلف بزرگ‌نمایی روی صفحات

روش‌های متعددی برای تغییر بزرگ‌نمایی پنجره یک سند InDesign وجود دارد، استفاده از ابزارها تا فرامین 
و میانبرها، بنابراین می‌توانید روش‌هایی را انتخاب کنید که بیشترین تناسب را با شیوه کاری شما دارند.

:Zoom برای تغییر دادن بزرگ‌نمایی سند با ابزار
) را انتخاب کنید. ) Zoom 1 ابزار

2 روی شیئی که می‌خواهید بزرگ‌نمایی کنید، کلیک کنید.
با هر بار کلیک، سطح بزرگ‌نمایی افزایش میی‌ابد. ممکن است برای بزرگ‌نمایی بخشی از صفحه، نیاز به 

چند کلیک باشد.
برای بزرگ‌نمایی ناحیه‌ای خاص )شکل 12ـ1(:

Zoom شکل 12ـ1ـ بزرگ‌نمایی بخشی از صفحه با کشیدن مستطیل دربرگیرنده ناحیه با ابزار

1 ابزار Zoom را انتخاب کنید.
2 مستطیل چشمک‌زن را حول ناحیه‌ای از صفحه که می‌خواهید بزرگ‌نمایی کنید، بکشید.

ناحیه محصورکننده شما حالا کل پنجره سند را پر میک‌ند.
 Fit Page In Window و Actual Size (100%) ،دو مورد از مفیدترین سطوح بزرگ‌نمایی پیش‌تنظیم
است. هر دو سطح بزرگ‌نمایی دارای فرامین منوی راحتی هستند، با این حال می‌توانید از کلیدهای میانبر 

آن‌ها نیز استفاده کنید.
 View>Fit Page In سند،  پنجره  در  فعال  صفحه  کردن  وسط‌چین  و  بزرگ‌نمایی  برگرداندن  برای    

Window را انتخاب کنید یا Ctrl+0 را بفشارید.
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  برای تنظیم سطح بزرگ‌نمایی با 10٠ درصد، View>Actual Size را انتخاب کنید یا Ctrl+1 را بفشارید.

هنگام طراحی گزارش‌ها، کتاب‌ها و مجلات مدنظر برای چاپ، مشاهده صفحات روبه‌رو )با طراحی صفحه 
سمت راست و چپ در کنار هم( با جایگذاری عناصر طراحی و ایجاد ریتم، تراز و‌ هارمونی در طراحی شما 

Spread گفته می‌شوند.  کمک خواهد کرد. صفحاتی که روبه‌روی هم قرار می‌گیرند، اصطلاحاً 

میانبر: برای دستیابی موقت به ابزار Zoom به‌هنگام انتخاب ابزاری دیگر، Ctrl+Spacebar را فشار 
دهید. برای کوچک‌نمایی کلید Alt را هم به این مجموعه اضافه کنید.

برای وسط‌چین کردن Spread فعال در پنجره سند )شکل 13ـView>Fit Spread In Window ،)1 را 
انتخاب کنید یا Ctrl+Alt+0 را فشار دهید.

شکل 13ـ1ـ هنگام کار با Spreadهای چند صفحه‌ای، می‌توانید کل Spread را در پنجره سند مشاهده کنید.

برای بزرگ‌نمایی  را فشار دهید.   Ctrl+5 تا سطح 50 درصدی،  برای کوچک‌نمایی سریع  میانبر: 
را فشار دهید.  Ctrl+2 200 درصدی، 

منوی View حاوی انتخاب کاملی از فرامین بزرگ‌نمایی و میانبرهای صفحه کلید آن‌هاست )شکل 14ـ1(. 
فرامین Zoom In و Zoom Out با تغییرات از پیش‌تنظیم شده بزرگ‌نمایی را انجام می‌دهند.
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شکل 14ـ1ـ سطوح بزرگ‌نمایی پیش‌تنظیم و فرامین Zoom In و Zoom Out را در منوی View مشاهده خواهید کرد.

مکانی دیگر برای تغییر بزرگ‌نمایی سند، منوی Zoom Level در نوار پایین InDesign است )شکل 15ـ1(. 
می‌توانید از هر یک از سطوح بزرگ‌نمایی از قبل تنظیم شده انتخاب کنید یا سطح بزرگ‌نمایی سفارشی را وارد کنید.

هنگام استفاده از فرامین یا میانبرها برای بزرگ‌نمایی، به خاطر بسپارید که اگر چیزی در صفحه انتخاب نشده 
باشد، بزرگ‌نمایی از وسط نمای جاری اعمال می‌شود. اگر اشیا انتخاب شده باشند یا نقطه درج در متن باشد، 

سطح بزرگ‌نمایی از وسط آن عنصر انجام می‌شود.

شکل 15ـ1ـ منوی Zoom Level در نوار برنامه کاربردی
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 9ـ1ـ چگونگی استفاده از خط کش و خطوط راهنما

دیگر،  به‌روش  می‌شود.  استفاده   Ctrl+R کلید  صفحه  میانبر  از  خطک‌ش‌ها  کردن  غیرفعال  و  فعال  برای 
می‌توانید به منوی View بروید و Show Rulers یا Hide Rulers را انتخاب کنید )این گزینه بسته به اینکه 
خطک‌ش‌ها در حال حاضر قابل رؤیت باشند یا نباشند، تغییر میک‌ند(. این امر موجب آشکار یا پنهان شدن 
آن‌ها در سمت چپ و بالای سند می‌شود. هنگامیک‌ه خطک‌ش‌ها قابل رؤیت هستند، ویژگی‌های سند اصلی 
را خواهند گرفت. بنابراین، اگر سند را برحسب اینچ تنظیم کرده باشید، آن‌گاه خطک‌ش هم برحسب اینچ 
خواهد بود. برای تغییر دادن واحد اندازه‌گیری، روی یکی از خطک‌ش‌ها کلیک راست کنید تا منوی بازشویی 
 Inchesو،Inchesو،Picasو،Points :به شما نشان داده شود که این گزینه‌ها را در اختیار شما قرار می‌دهد
Decimal،وMilimeters،وCentimeters،وCiceros،وAgates و Pixels )شکل 16ـ1(.  می‌توانید در هر 
زمان بین این گزینه‌ها جابه‌جا شوید. مقدار صفر همیشه به‌طور پیش‌فرض گوشه سمت چپ بالا در محل 
تقاطع خطک‌ش‌هاست. اگر بخواهید صفر خطک‌ش شما در جای دیگری در سند شروع شود، کافی است روی 
مربع کوچک در محل تقاطع خطک‌ش‌ها کلیک کرده و صفر را به مکانی جدید بکشید. در منوی بازشویی که 
 Rulerو،Ruler Per Page هنگام کلیک راست روی خطک‌ش ظاهر می‌شود نیز می‌توانید تنظیم گزینه‌های

Per Spread یا Ruler On Spine را انتخاب کنید.

شکل 16ـ1ـ گزینه‌های مختلف خط‌کش‌ها

در  عمودی )چپ(  و  )بالا(  افقی  از خطک‌ش‌های  را  راهنما  می‌توانید خطوط  هنگام صفحه‌آرایی یک سند، 
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لبه‌های پنجره سند بکشید )این‌ها تنها مکان‌هایی هستند که خطک‌ش‌ها قابل رؤیت خواهند بود(. کافی است 
روی خطک‌ش کلیک کرده و در حین پایین نگه داشتن دکمه ماوس، مکان‌نما را به مکان مناسب بکشید، 
سپس ماوس خود را رها کنید تا خط راهنما در آن مکان قرار گیرد )شکل 17ـ1(. برای اعمال یک خط 
راهنما بر کل Spread، کلید Ctrl را فشار داده و در حین کشیدن یک خط راهنمای افقی، آن را نگه دارید. 
نگه داشتن کلید Alt در حین کشیدن یک خط راهنما از خطک‌ش افقی، موجب تغییر آن به خط راهنمای 
عمودی می‌شود و برعکس. اگر می‌خواهید قبل از رها کردن ماوس، دست از خط راهنما بکشید، کافی است 

کلید Esc را فشار دهید.
برای انتخاب همه خطوط راهنما در یک صفحه یا Spread،وCtrl+Alt+G را فشار دهید. اگر می‌خواهید 
تقاطع  نگه دارید و در محل  را فشرده و   Ctrl افقی و عمودی رسم کنید، کلید  هم‌زمان خطوط راهنمای 
خطک‌ش‌ها در سمت چپ بالای پنجره سند، کلیک کرده و ماوس را بکشید )چنانچه خطک‌ش‌ها قابل رؤیت 
نیستند، Ctrl+R را فشار دهید(. اگر در حال کشیدن یک خط راهنمای عمودی هستید ولی می‌خواهید 
سریعاً آن را به یک خط راهنمای افقی تبدیل کنید )یا برعکس(، کلید Alt را هنگام کشیدن فشرده و نگه 
دارید. چنانچه می‌خواهید همه خطوط راهنما را حذف کنید، روی یکی از خطک‌ش‌ها کلیک راست کرده و 
Delete All Guides on Spread را انتخاب کنید. هم‌چنین می‌توانید از ویژگی Smart Guides تعبیه‌شده 
در Indesign استفاده کنید که خطوط راهنمای قابل رؤیتی را به شما ارائه می‌دهد که برای تراز کردن اشیا 
 View>Grid & از آن‌ها استفاده کرده‌اید. برای فعال یا غیرفعال کردن این خطوط راهنما، کافی است به

بروید.  Guides>Smart Guides

شکل 17ـ 1ـ استفاده از خطوط راهنما
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شکل 18ـ1ـ تغییرات در خطوط راهنما
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واحد كار دوم

مدیریت صفحات اسناد
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  از منوی Layout برای مدیریت صفحات استفاده کند.

  پنل Page را بهک‌ار گیرد.

كليات

است.  نشر  دنیای  برای  موجود  ابزارهای  قوی‌ترین  با  اسناد  از  صفحاتی  ساخت   ،InDesign قضیه  اصل 
تا یک کتاب بزرگ است. صفحات و اسپریدها به  ابزاری برای ساخت یک سند تک صفحه‌ای   InDesign
شما اجازه می‌دهند سند خود را به‌طور حرفه‌ای و کارآمد تنظیم کنید. در این واحد کار، نگاهی به تنظیم 
اولین سند شما خواهیم داشت و طیفی از تنظیمات موجود را بررسی خواهیم کرد که باید قبل از شروع یک 
پروژه بدانید. هم‌چنین بررسی میک‌نیم که چگونه صفحات اصلی بسیار مهم را تنظیم کنیم، چگونه آن‌ها را 
ویرایش کنیم، بازآرایی کنیم، تغییر اندازه بدهیم و حتی به آن‌ها کد رنگی بدهیم تا شناسایی آن‌ها در سند 
آسان شود. هنگامیک‌ه برای اولین بار شروع به ساخت اسناد میک‌نید، با تنظیمات پیش‌فرض بسیاری شروع 
استفاده  بارها  را تنظیم کنید که  اسنادی  برای شما وجود دارد. می‌توانید  اما گزینه‌های بسیاری  میک‌نید، 
شوند یا اسناد بسیار منحصربه‌فردی را تنظیم کنید. البته باید بدانید که InDesign فقط برای چاپ نیست؛ 
هنگامیک‌ه درباره اسناد برای وب صحبت میک‌نیم، InDesign ابزاری بسیار قوی و عالی است. مجبور نیستید 
فقط از اندازه‌های چاپی پیش‌فرض استفاده کنید؛ می‌توانید از اندازه‌های مختلف وب یا حتی اندازه‌های خاص 

دستگاه‌ها، مثلًا اندازه‌ای که مناسب یک iPhone است، استفاده کنید.

زمان آموزش

عملینظری

520
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1ـ2ـ ایجاد یک سند خالی جدید

به File>New>Document بروید تا کادر محاوره‌ای مربوطه باز شود. بسته به پیکربندی ترجیحات1 شما، 
یکی از این دو کادر محاوره‌ای را خواهید دید )شکل 1ـ2(: کادر محاوره‌ای New Document قدیمی )شکل 
 (Recent) است و اسناد اخیر Start که شبیه فضای کاری New Document سمت چپ( یا کادر محاوره‌ای
را نشان می‌دهد )سمت راست(. می‌توانید با انتخاب یکی از اندازه‌های از قبل تعیین شده موجود در این کادر 
محاوره‌ای سند خود را ایجاد کنید )اگر از فضای کاری Start استفاده میک‌نید( یا اندازه‌ای اختصاصی را ایجاد 
کنید. اگر کادر انتخاب Preview را در پایین هر یک از کادرهای محاوره‌ای New Document در حالت 
تأیید قرار دهید، سند جدید را در زیر کادر محاوره‌ای خواهید دید. اگر نمی‌خواهید از ابعاد استاندارد موجود 
استفاده کنید، تنظیمات موردنظر خود را وارد کرده و روی OK کلیک کنید. پس از انجام این کار می‌توانید 

سند را ذخیره کنید.

 2ـ2ـ تنظیم صفحات سند جدید

بیشتر تنظیمات سند جدید گویا و مشخص هستند، ولی بهتر است تعدادی از آن‌ها را توضیح دهیم. هم کادر 
محاوره‌ای New Document قدیمی و هم فضای کاری Start، گزینه‌های مشابهی را ارائه می‌دهند، ولی 
این گزینه‌های مشابه نیز ممکن است کار متفاوتی انجام دهند. بنابراین، این دو روش را در صورت ضرورت 

برچسب‌گذاری میک‌نیم: (L)= قدیمی؛ (N)= جدید.

شکل 1ـ2ـ ایجاد سند خالی جدید و تنظیم صفحات سند جدید

Preferences ـ1
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Document Presetـ اگر پیش‌تنظیم سندی را ایجاد کرده‌اید که دوست دارید استفاده کنید، آن را در اینجا 
انتخاب کنید.

Print/Web/Mobile Tabs (N)/Intent (L) در بالاـ قصد دارید خروجی محصول نهایی به چه صورتی 
باشد؟ گزینه پیش‌فرض Print است، ولی گزینه‌های Web و Mobile هم وجود دارند.

Primary Text Frameـ راستش را بخواهید، این برای اسناد پیچیده‌تر با تعداد زیادی متن شناور است. 
فعلًا نیازی نیست آن را تیک بزنید.

Column Gutter (N)/Gutter (L)ـ این دو فاصله‌های بین ستون‌ها هستند )اگر ستون‌هایی داشته باشید(. 
بیشتر  در  ولی  باشد،  متن  نقطه‌ای  اندازه  با  مساوی  که حداقل  تنظیم شود  مقداری  با  باید   gutter عرض 

پروژه‌ها، می‌توانید از چیزی استفاده کنید که برای چشم و‌اضح‌تر به‌نظر برسد.
Bleed and SlugـوBleed ناحیه‌ای اطراف لبه سند شما برای برش پس از چاپ است، استاندارد آن 0.125 
اینچ یا 3mm است )برای چاپ بنرهای بزرگ، این مقدار بیشتر خواهد بود(. این مقدار، اطمینان می‌دهد که 
تصاویر با رنگ‌های لبه کاغذ، درست و کامل برش می‌خورند. Slug )که کمتر استفاده می‌شود( ناحیه‌ای است 

که می‌تواند شامل اطلاعات و یادداشت‌های سند باشد.

)Start 3ـ2ـ ایجاد و ذخیره‌سازی پیش تنظیمات سند سفارشی )با استفاده از فضای کاری

اگر از تنظیمات خاصی بیشتر استفاده میک‌نید، 
بهتر است آن تنظیم را به‌عنوان یک پیش‌تنظیم 
ذخیره کنید، بنابراین هر بار مجبور به انجام این 
پیش‌تنظیم   یک  ایجاد  برای  نیستید.  تنظیمات 
کنید.  شروع   File>New>Document با 
 New Document محاوره‌ای  کادر  در 
در  کنید.  وارد  را  خود  سند  نیازمندی‌های 
 (210mm*297mm) سند  یک  2ـ2،  شکل 
کرده‌ایم:  برنامه‌ریزی  تنظیمات  این  با  را   A4
 Facing6،و Pagesو،Protrait Orientation
 3mm Column6،و Columnsو،Pages
 .3mm Bleed Gutter،و10mm Margins و 
آیکن  روی  خود،  تنظیمات  کردن  وارد  از  پس 
بالای  راست  سمت  گوشه  در  موجود  کوچک 
کادر محاوره‌ای )که دایره روی آن کشیده شده( 
کلیک کنید، درست کنار محلی که نام سند را 
می‌دهد  اجازه  شما  به  امر  این  میک‌نید.  اضافه 

شکل 2ـ2ـ ایجاد و ذخیره‌سازی پیش تنظیمات سند سفارشی 
 Start با استفاده از فضای کاری
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تنظیمات خود را به‌عنوان یک Document Preset ذخیره کنید. حال نامی به Document Preset بدهید تا 
یافتن آن آسان شود و سپس روی Save Preset کلیک کنید. حال این تنظیم سند ویژه در Saved items شما 

بود. خواهد  دسترس  در   New Document محاوره‌ای  کادر  در 

4ـ2ـ ایجاد و ذخیره‌سازی پیش تنظیمات سند سفارشی )با استفاده از کادر محاوره‌ای 
New Document قدیمی(

 New Document خود را برای استفاده از کادر محاوره‌ای Preferences اگر سند جدیدی را ایجاد میک‌نید و
 File>Document تنظیم کرده‌اید، آن‌گاه زمان مناسبی برای ایجاد یک پیش‌تنظیم سند جدید است. به
Presets>Define بروید تا کادر محاوره‌ای Document Presets به شما ارائه شود )سمت چپ شکل 3ـ2(. 
 New باز شدن کادر محاوره‌ای  برای  از پیش تنظیم‌های موجود را خواهید دید.  این قسمت، فهرستی  در 
 OK کلیک کنید )وسط شکل ٣ـ2(. ترجیحات خود را تنظیم کرده و روی New روی ،Document Preset
کلیک کنید تا به کادر محاوره‌ای Document Presets برگردید. خواهید دید که پیش‌تنظیم جدید شما 
فهرست شده است. می‌توانید هر پیش‌تنظیمی را با متمایز کردن آن در فهرست Presets و کلیک کردن 
روی Edit ویرایش کنید. هنگامیک‌ه تغییرات خود را اعمال کردید، روی OK کلیک کنید. حال هنگام ایجاد 
سندی جدید، کافی است به File>New Document بروید، منوی بازشو Document Presets را در بالای 
کادر محاوره‌ای New Document باز کنید و پیش‌تنظیم سفارشی خود را در فهرست ببینید )سمت راست 

شکل 3ـ2(. پیش‌تنظیم مدنظر خود را انتخاب کنید تا تنظیمات مرتبط کادر محاوره‌ای را پر کند.

 New Document شکل 3ـ2ـ ایجاد و ذخیره‌سازی پیش تنظیمات سند سفارشی با استفاده از کادر محاوره‌ای
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​5 ـ2ـ حرکت بین اسناد باز

اگر چندین سند باز در InDesign دارید، حرکت بین آن‌ها به سادگی صورت می‌گیرد. چندین روش برای 
 Window است. هم‌چنین می‌توانید منوی Ctrl+~ انجام این کار وجود دارد، ولی سریع‌ترین روش، فشردن
را باز کنید که فهرستی از اسنادی را که هم‌اکنون در InDesign باز شده‌اند، در پایین منو نمایش می‌دهد. 
سند موردنظر خود را برای مشاهده انتخاب کنید. سندی که هم‌اکنون مشاهده میک‌نید، دارای یک چک‌مارک 
در کنار نامش خواهد شد. روش سوم، کلیک کردن روی برگه کنار بالای فضای کاری است که حاوی نام سند 

موردنظر برای مشاهده است.

شکل 4ـ2ـ حرکت بین اسناد باز
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6ـ2ـ اضافه کردن صفحات سند اصلی

چندین روش برای افزودن صفحات اضافی به سند شما وجود دارد. ساده‌ترین روش کلیک کردن روی آیکن 
Create New Page در پایین پنل Pages است. اگر حین انجام این کار، کلید Ctrl را پایین نگه دارید، صفحه 
اصلی خالی جدیدی اضافه می‌شود. اگر در حین کلیک کردن روی آیکن Create New Page، کلید Alt را 
نگه دارید، کادر محاوره‌ای Insert Pages ظاهر می‌شود که می‌توانید چندین صفحه اضافه کرده و محلی را در 

سند برای افزودن صفحات انتخاب کنید.
و تصمیم   )At End of Document یا   At Start of Documentو،Before Page xو،After Page x(
بگیرید که کدام صفحات اصلی را بر صفحات جدید اعمال کنید. انتخاب‌های خود را انجام داده، سپس روی 
OK کلیک کنید. هم‌چنین می‌توان با کلیک راست در پنل Pages و انتخاب Insert Pages از منوی زمینه 

به کادر محاوره‌ای Insert Pages دسترسی داشته باشید.

شکل 5 ـ2ـ اضافه کردن صفحات به سند
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 7ـ2ـ بازآرایی و حذف صفحات سند

پنل  در  را  آن  آیکن  است  کافی  از سند،  برای حذف یک صفحه 
پنل  پایین  در  آشغال  سطل  آیکن  روی  و  کرده  متمایز   Pages
کلیک کنید. برای جابه‌جا کردن صفحه به مکانی جدید در سند، 
به پنل Pages رفته و روی آیکن آن صفحه کلیک کنید و آن را به 
مکانی بکشید که می‌خواهید ظاهر شود. خطی ظاهر خواهد شد که 

محل صفحه را در صورت رها شدن ماوس نشان می‌دهد.

شکل 6 ـ2ـ تغییر مکان و حذف صفحات سند
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واحد كار سوم

رسم و مدیریت اشکال و اشیا
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  شکل اشیا را تغییر دهد.

  فریم و اشکال را رسم کند.

  با منوی Object کار کند.

  انتخاب، جابه‌جايي، حذف، تغيير شكل و جايگزيني اشيا را انجام دهد.

  گروه‌بندی و قفل كردن اشيا را انجام دهد.

  گوشه‌هاي فانتزي را ایجاد کند.

  جلوه‌ها را براي اشيا بهک‌ار گیرد.

  جانمايي تصاوير در كادر را انجام دهد.

  چند تصوير را در يك كادر بچیند.

  تصاوير پيوند داده شده را مدیریت کند.

  از Pathfinder در ساخت اشيا و كادر تركيبي استفاده کند.

  تنظيمات خط دور را انجام دهد.

  با پنل Link کار کند.

كليات

تا حالا InDesign وارد زندگی‌مان شده است، وقت آن است که به ‌ویژگی‌های جدیدی بپردازیم، فریم‌ها 
و اشیا، هر دوی آن‌ها، اشکالی هستند که در آن‌ها می‌توانیم محتوا قرار دهیم. هر چیزی در یک فریم قرار 
می‌گیرد. این دو ویژگی هستند که باعث تفاوت در InDesign و Word می‌شوند. به هر حال، فریم‌ها و اشیا 
چیزی هستند که صفحه‌آرایی1 را اینقدر ساده‌تر میک‌نند.  در این واحدکار خواهید دید که با فریم‌ها و اشیا، 
کنترل بیشتری برای ایجاد آن‌ها، رفتار آن‌ها، عملکرد آن‌ها و میزان انعطاف‌پذیری آن‌ها برای ایجاد محتوا 
خواهید داشت. می‌توانید خطوط دور2 را به کار ببرید تا فریم‌ها و اشیای شما برجسته شوند و حتی می‌توانید 
اشکال سفارشی را با ابزارهای Pen و Pencil ایجاد کنید. می‌توانید چندین فریم و شکل را در مشبک‌ها قرار 
دهید، شیوه‌های با گوشه جالب را اعمال کنید و آن‌ها را به زیبایی با هم تراز کنید. هم‌چنین می‌توانید شیوه‌ها 
را برای آن‌ها تنظیم کنید. در این واحدکار، عملکرد وظیفه‌ای پایه، خلاقیت و ویرایش فریم و شی ء را بررسی 

میک‌نیم. تا انتهای واحدکار، در فریم‌ها و اشیا ماهر خواهید شد.

Layout ـ1

Strokes ـ2

زمان آموزش

عملینظری

621
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1ـ3ـ استفاده از فریم‌ها

در InDesign، هر چیزی را در نوعی فریم قرار می‌دهیم و هر فریم می‌تواند به‌طور مستقل ویرایش شود. به 
 Microsoft نسبت به یک برنامه کاربردی نظیر InDesign این دلیل است که ایجاد اسنادی با ظاهر عالی در
Word خیلی ساده‌تر است. سه نوع فریم وجود دارد: فریم‌های متنی، فریم‌های گرافیکی و فریم‌های نامعین. 
برای تمام فریم‌ها و شکل‌ها می‌توان خط دور و رنگ زمینه داد. فریم نامعین، شکلی است که به‌طور دستی 
ایجاد شده است، بدین معنی که با یک ابزار فریم ایجاد شده و با ابزار Pen (P) تغییر شکل داده شده است 
 (A) ایجاد شده است و متن یا گرافیکی ندارد. اندازه تمام این فریم‌ها را می‌توان با ابزار Pen یا فقط با ابزار

Direct Selection یا ابزار Pen ‌تغییر داد.

شکل 1ـ3ـ فریم‌ها

2ـ3ـ ایجاد یک فریم

 (F) Rectangle ابزار  این  باشیدـ  آن  روی   x یک  با  )پیش‌فرض(  مستطیل  آیکن  دنبال  به  ابزار،  نوار  در 
Frame است. برای باز شدن منوی شناور، روی این آیکن کلیک کرده و نگه دارید که حاوی سه انتخاب 
است: Rectangle،وEllipse و Polygon. برای ایجاد یک فریم، شکل فریم موردنیاز خود را انتخاب کنید 
و سپس روی سند خود کلیک کرده و فریم را به سمت بیرون بکشید. به‌هنگام کشیدن، کلید Shift را فشار 
داده و نگه دارید تا تناسب شکل حفظ شود. مثلًا، در حین کشیدن با ابزار Ellipse Frame، نگه داشتن 
کلید Shift موجب ایجاد یک دایره می‌شود و انجام همین کار با ابزار Rectangle Frame موجب ایجاد یک 
مربع می‌شود. به‌طور پیش‌فرض، ابزار Polygon Frame یک شکل پنج ضلعی را ایجاد میک‌ند. ولی اگر پنج 
ضلعی نخواستید چه؟ تمام کاری که باید انجام دهید، انتخاب این ابزار و یک بار کلیک کردن در محلی در 
 Polygon سند است تا یک کادر محاوره‌ای ظاهر شود و گزینه‌های فریم را به شما ارائه دهد. کادر محاوره‌ای
به شما اجازه می‌دهد در مورد تعداد اضلاع مدنظر برای فریم تصمیم بگیرید. وارد کردن اندازه در اینجا خیلی 
مهم نیست، زیرا پس از قرار دادن آن، می‌توانید اندازه آن را به‌صورت دستی تغییر دهید. برای ایجاد یک فریم 
متنی، ابزار Type (T) را از نوار ابزار انتخاب کرده و شکلی را برای متن خود به بیرون بکشید. در صورت نیاز، 
پس از ایجاد آن، می‌توانید اندازه‌اش را تغییر دهید. هنگامیک‌ه یک فریم متنی انتخاب می‌شود، می‌توانید 
به File>PLace هم بروید و تصویری را برای قرار دادن در آن فریم انتخاب کنید. InDesign فریم را به 
یک فریم گرافیکی تبدیل میک‌ند و از کل متن موجود در فریم صرف‌نظر می‌شود و متن با تصویر جایگزین 

می‌گردد. هم‌چنین می‌توانید متن را حول یک فریم بچرخانید.
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شکل 2ـ3ـ ایجاد فریم

3ـ3ـ ایجاد شکل

شکل‌ها شبیه فریم‌ها هستند، ولی می‌توانید کارهای بیشتری با آن‌ها انجام دهید. ابزارهای شکل Rectangle،و
ابزارهای فریم در نوار قرار دارند و یک X در آن‌ها وجود ندارد. برای ایجاد  Ellipse و Polygon در زیر 
شکلی در سند خود، روی ابزار شکل در نوار ابزار کلیک راست کرده و شکلی را از منوی شناور انتخاب کنید، 
سپس شکل را به سمت سند خود بکشید. در حین کشیدن، کلید Shift را نگه دارید تا تناسب‌ها حفظ شود. 
هم‌چنین می‌توانید با انتخاب ابزار شکل خود و یک بار کلیک کردن در سند، شکلی را ایجاد کنید. این امر 
موجب باز شدن یک کادر محاوره‌ای کنترلی می‌شود که در آنجا می‌توانید اندازه دقیق شکل خود را تعیین 
کنید. روی OK کلیک کنید تا شکل به سند شما اضافه شود. هنوز آن را نخواهید دید، زیرا هیچ زمینه یا 
خط دوری ندارد؛ فقط هنگامیک‌ه شکل انتخاب می‌شود، مسیر شکل در نما وجود خواهد داشت. با استفاده از 
نکاتی که قبلًا در مورد خطوط دور و زمینه‌ها گفتیم، می‌توانید مقداری شخصیت به شکل خود بدهید. ابزار 
Shape معمولاً برای ایجاد شکل‌های توپر استفاده می‌شود، ولی این‌ها به سادگی می‌توانند برای پذیرش متن 
یا تصویر تبدیل شوند. شکل به‌عنوان فریم نامعین هم شناخته می‌شود و مثلًا می‌تواند به‌طور دستی با استفاده 
از ابزار Pen (P) ایجاد شود. این‌ها فریم‌هایی هستند که واقعاً دربرگیرنده هیچ متن یا گرافیکی نیستند، ولی 
در صورت نیاز می‌توانید این کار را انجام دهید. ممکن است شکل‌هایی را به‌عنوان دکور در صفحه خود رسم 
کنید؛ آن‌ها را با یک رنگ پس‌زمینه پر کنید یا اگر به قدر کافی دلیر هستید، حتی می‌توانید نوعی لوگو ایجاد 
کنید، گویی که در حال رسم در Adobe Illustrator هستید. هم‌چنین می‌توانید متن موجود در شکل را 

بچرخانید.
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شکل 3ـ3ـ ایجاد شکل

4ـ3ـ به کار بردن خط دور

می‌توانید خطوط دور1 را به کار ببرید که به‌عنوان تنظیمات خط هم شناخته می‌شوند. خطوط دور بر هر 
انتخاب می‌شود،  اقلام  این  از  اعمال هستند. هنگامی که یکی  مسیر، شکل، فریم و محیط‌های متنی قابل 
خصوصیات خط دور در دسترس شما قرار می‌گیرند. پنل Properties مکان خوبی برای شروع کار است. 
اولین کاری که باید انجام دهید، دادن یک رنگ به خط دور است )بدون رنگ، خط دور اعمال نخواهد شد(. 
روی آیکن کوچک خط دور )فریم مربع کنار کلمه Stroke( در پنل Properties کلیک کنید تا انتخابگر 
رنگ باز شود. رنگ موردنظر خود را انتخاب کنید تا خط دور بر فریم، شیء یا متن منتخب شما اعمال شود. 
من رنگ مشکی را در شکل 4ـ3 انتخاب کرده ام. هنگامی که رنگی را انتخاب کردید، ضخامت پیش‌فرض خط 

دور که 1pt است تنظیم خواهد شد و این نقطه شروع شماست.

Strokes ـ1
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شکل 4ـ3ـ تنظیم خط دور

​​5 ـ3ـ تغییر شیوه خط دور

را در پنل  برای خطوط دور وجود دارد که می‌توانید آن‌ها  بر ضخامت و رنگ(  اختیاری )علاوه  تنظیماتی 
Stroke بیابید (Window>Stroke). هم‌چنین می‌توانید کلمه Stroke را در پنل Properties تایپ کنید 
تا پنل بازشویی با تمام کنترل‌های اضافی موجود در پنل Stroke در اختیار شما قرار گیرد، بدین معنی که 
شما ابداً مجبور به باز کردن پنل Stroke نیستید. این تنظیمات خط دور به شما اجازه می‌دهند ضخامت و 
نوع خط؛ نوع گوشه یا شکل پخ؛ چگونگی تلفیق بخش‌های خط دور: شکل‌های شروع و پایان خط دور )اگر 
انتهای باز وجود داشته باشد(؛ رنگ بین شکاف‌ها )اگر نوع خط را با شکاف‌ها انتخاب کرده باشید(؛ و غیره 
را تعیین کنید )گزینه‌های دیگری نیز وجود دارد(. در پنل Properties، حتی می‌توانید جلوه‌های ویژه را با 
انتخاب آیکن fx در زیر تنظیمات خط دور بر خط دور اعمال کنید. ولی طبق قوانین طراحی عادی، فقط به 

این دلیل که می‌توانید کاری انجام دهید، به این معنی نیست که باید آن کار را انجام دهید.
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شکل 5ـ3ـ انجام تنظیمات متنوع در خط دور

6 ـ3ـ اضافه کردن متن در یک فریم

کنید.  ایجاد  متنی  فریم  یک   (T) Type ابزار  با  ماوس  کشیدن  با  می‌توانید  شد،  ذکر  قبلًا  که  همان‌گونه 
هنگامیک‌ه ماوس خود را رها میک‌نید، چشمک‌زن مکان‌نما را در گوشه سمت چپ بالای فریم خواهید دید 
و می‌توانید شروع به تایپ کنید )برای تایپ فارسی ابزار ME Type Tool را انتخاب میک‌نیم(. هم‌چنین 
می‌توانید فریمی را با متن جایبانی )الگو(1 پر کنید تا هنگام اضافه کردن یک کپی از متن خودتان، ظاهر سند 
را ببینید. مکان‌نمای خود را در فریم متنی درج کرده و به Type>Fill with Placeholder Text بروید. 
در حالی که فریم متنی انتخاب شده است، می‌توانید به File>Place رفته و تصویری را برای قرار گرفتن در 
فریم انتخاب کنید تا از همه متن در آن فریم صرف‌نظر شده و با تصویر جایگزین شود. این بدان دلیل است 

که InDesign فریم را به یک فریم گرافیکی تبدیل کرده است.

شکل 6ـ3ـ درج متن در فریم

Placeholder Text ـ1
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7ـ3ـ جایگزین کردن محتوا در فریم

اگر متنی را جایگزین میک‌نید، کافی است متن جدید خود را کپی کرده و آن را مستقیماً روی متن موجود 
انتخاب کرده و به File>Place بروید، سپس  الصاق کنید. اگر قصد جایگزینی تصویری را دارید، فریم را 
تصویر جدیدی را انتخاب کنید. توجه خواهید داشت که کادر انتخاب Replace Selected Item در پایین 
کادر محاوره‌ای Place به‌طور خودکار انتخاب شده است. از گزینه‌های Frame Fitting برای تنظیم محل 
هم   Edit>Paste Into از  می‌توانید  میک‌نید،  کپی  را  تصویری  اگر  کنید.  استفاده  خود  تصویر  قرارگیری 
استفاده کنید، ولی الصاق آن در اسناد InِِDesign توصیه نمی‌شود؛ قرار دادن آن همیشه روش بهتری است.

شکل 7ـ3ـ جایگزینی محتوا در فریم

8 ـ3ـ متناسب کردن تصویر با فریم

Frame Fitting Options به شما اجازه تنظیم فریم‌ها را متناسب با تصاویری که در بردارند بر اساس نیازهای شما 
می‌دهد. برای دستیابی به Frame Fitting Options یا به Object>Fitting>Frame Fitting Options بروید 
یا روی خود فریم تصویر کلیک راست کرده و گزینه‌های منوی مشابه را انتخاب کنید. این امر یک کادر محاوره‌ای 
،Fit Content to Frameو،None( را به همراه دارد که می‌توانید گزینه مناسب خود را از آن انتخاب کنید 

Fit Content Proportionally یا Fill Frame Proportionally(. بالاخره، می‌توانید به‌طور دستی مقدار 
برشی را که ممکن است حول تصویر نیاز داشته باشید، انتخاب کنید.
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شکل 8ـ3ـ گزینه‌های متناسب ساختن فریم

9ـ3ـ اصلاح شکل یک فریم یا شیء

اولین ابزار در جعبه ابزار شما برای تغییر دستی سریع شکل چیزی، ابزار Direct Selection است )[A]؛ 
آیکن فلش توپر در جعبه ابزار(. آن را از جعبه ابزار انتخاب کرده و روی فریم خود کلیک کنید. حال نقطه‌ای 
را در فریم کلیک کنید و آن را مستقل از نقاط دیگر جابه جا کنید. هنگامی که نقطه‌ای انتخاب می‌شود، 
را در هر  نقطه  از یک  بیش  تغییر خواهد کرد. می‌توانید  رنگ  آبی  نقطه‌ای  به  نقطه سفید کوچک  از یک 
زمان با فشردن و نگه داشتن کلید Shift انتخاب کنید، در حالیک‌ه نقاط دیگر خود را انتخاب میک‌نید. از 
 Free کلیدهای جهتی برای حرکت دادن نقاط در فواصل کوچک استفاده کنید. هم‌چنین می‌توانید از کارکرد

Transform در جعبه ابزار، به گزینه‌های تبدیل دیگر دسترسی پیدا کنید، از جمله این موارد:
  Free Transform Tool (E): به شما امکان تغییر دستی یک شکل را می‌دهد.

  Rotate Tool (R): به شما امکان چرخاندن شکل را از نقطه مرجع منتخب شما می‌دهد.

  Scale Tool (S): به شما امکان تغییر اندازه دستی یک شکل را از نقطه مرجع منتخب شما می‌دهد.

  Shear Tool (O): به شما امکان کوتاه کردن یک شکل را از نقطه مرجع منتخب شما می‌دهد.

شکل 9ـ3ـ تغییر شکل یک فریم یا شیء
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Transform شکل 10ـ3ـ استفاده از پنل

برای باز کردن پنل Transform به Window>Object & Layout>Transform بروید. می‌توانید از این 
پنل برای مشاهده و یا دادن ورودی اطلاعات هندسی خاص‌تر برای یک شکل یا فریم منتخب استفاده کنید، 
از جمله مقادیری برای مکان )مختصات X و Y(، اندازه )درصد W و H(، دوران )برحسب زاویه( و کوتاه کردن 
)برحسب زاویه(. هم‌چنین مشبک نقطه مرجع )دایره‌ای در سمت چپ بالا( را خواهید دید. این مشبک به شما 

اجازه می‌دهد مطمئن شوید که تمام تبدیل​ها از یک نقطه ثابت یا نزدیک شیء منشأ می‌گیرند.
آیکن به شکل ضربدر در نقطه مرجع در سند هنگامی نمایش داده می‌شود که یک ابزار تبدیل )از قبیل ابزار 
Scale [S]( برای نشان دادن محل تغییر مقیاس شیء یا تغییر از آنجا فعال شود. هم‌چنین اگر بخواهید 

تغییرات خود را به روشی متناسب انجام دهید، یک لینک تناسب در پنل Transform وجود دارد.

10ـ3ـ تغییر گوشه‌های شکل

یک روش ساده برای تغییر شکل دادن به یک شکل، استفاده از گزینه‌های Convert Point )که به آن نقاط 
با نقاط لنگری آشنا هستید( برای تغییر دادن  لنگری هم می‌گویندـ اگر از Illustrator استفاده کرده‌اید، 
را در آن  نقطه‌ای  را گردتر کنید،  بخواهید گوشه شکل چند ضلعی خود  اگر  گوشه‌های شکل است. مثلاً، 
گوشه انتخاب کرده و به Object>Convert Point>Smooth )یا Symmetrical( بروید. این فقط یک 
نکته سریع است، ولی گاهی اوقات می‌تواند مفید باشد، به‌ویژه هنگامیک‌ه شکلی را می‌خواهید که گردتر از 
شکل‌های استاندارد است و می‌خواهید آن‌ها را سریع تبدیل کنید. اگر با ابزار Pen (P) آشنا هستید، خواهید 

دید که داشتن نقاط Smooth و Corner در چگونگی تغییر دادن شکل با ابزار Pen متفاوت است.
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شکل 11ـ3ـ تغییر دادن گوشه‌های شکل

11ـ3ـ ایجاد مستطیل با گوشه‌های گرد

باشد.  گرد  آن‌ها  گوشه‌های  نیست  بد  اوقات  گاهی  میک‌نید،  رسم  را  مستطیلی  یا  مربع  شکل  که  هنگامی 
تنظیمات مورد استفاده برای ایجاد گوشه‌های گرد در دسترس شما قرار دارد. ما از آن در بخش قبلی برای 
گزینه‌های گوشه استفاده کردیم، ولی در اینجا به شما نشان خواهیم داد چگونه از آن برای جالب‌تر کردن 
گوشه‌های گرد و هم‌چنین در گوشه‌های مستقل استفاده کنید. ابتدا شکل خودتان را رسم کنید و سپس ابزار 
Selection (V) را از نوار ابزار انتخاب کنید. مربع زرد کوچکی را در سمت راست فریم خواهید دید، درست 
نزدیک گوشه سمت راست بالا. یک بار روی مربع زرد رنگ کلیک کنید تا تبدیل به یک لوزی شود و به گوشه 
فریم بپرد. هم‌چنین لوزی‌های زرد رنگی را در سه گوشه دیگر فریم می‌بینید. حال می‌توانید هر یک از این 
لوزی‌های زرد رنگ را به چپ یا راست بکشید تا گردی گوشه‌ها را کم یا زیاد کنید. اگر کلید Alt را فشار داده و 
نگه دارید و روی یکی از لوزی‌های گوشه کلیک کنید، می‌توانید شیوه گوشه را با چرخاندن از طریق گزینه‌های 
دیگر، یکی یکی تغییر دهید. برای تغییر دادن فقط یک گوشه در یک زمان، کلید Shift را در حین کشیدن 
لوزی گوشه فشار داده و نگه دارید. Alt+Shift را فشار داده و نگه دارید و روی یک گوشه کلیک کنید تا فقط 

شیوه آن گوشه تغییر کند.

شکل 12ـ3ـ مستطیلی با گوشه‌های گرد
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 12ـ3ـ اعمال شیوه‌های گوشه

روش دیگر برای تغییر شکل فریم‌ها یا شکل‌ها بهک‌ارگیری شیوه‌های گوشه بر آن‌هاست. با ایجاد )یا انتخاب( 
فریم یا شکل خود شروع کنید و سپس گزینه گوشه را از منوی بازشوی Corner در پنل Properties انتخاب 
انتخاب   Corner Options را در کادر محاوره‌ای  Object>Corner Options و سپس شیوه‌ای  یا  کنید 
کنید. سپس از ابزار Selection (V) برای انتخاب فریم یا شکل خود استفاده کنید و سپس روی مربع زرد 
کوچک که در سمت راست بالای فریم ظاهر می‌شود، کلیک کنید. این امر باعث می‌شود مربع به گوشه‌های 
شکل شما بپرد. اگر این مربع را به سمت چپ بکشید، اندازه دکوراسیون گوشه را افزایش خواهد داد. کشیدن 

آن به سمت راست، موجب کاهش اندازه دکوراسیون گوشه می‌شود.

شکل 13ـ3ـ شیوه‌های گوشه

13ـ3ـ تریکب شکل‌ها یا فریم‌ها برای ایجاد شکل‌ها یا فریم‌های جدید

می‌توانید  ولی  کنید،  ایجاد  محتوا  برای  را  استاندارد  فریم‌های  و  شکل‌ها  چگونه  که  کردیم  بیان  تاکنون 
شکل‌ها و فریم‌های سفارشی را با تلفیق کردن آن‌ها با یکدیگر با استفاده از پنل Pathfinder ایجاد کنید 

از: عبارت‌اند   Pathfinder گزینه‌های   .(Window>Object & Layout>Pathfinder)
  Add: اشیای منتخب را در یک شکل تریکب میک‌ند.

  Subtract: اشیای جلویی را از شیء پشتی کم میک‌ند.

  Intersect: نواحی مشترک شکل‌ها را اشتراک می‌گیرد.

  Exclude Overlap: نواحی روی هم افتاده شکل‌ها را کنار می‌گذارد.

  Minus Back: اشیای پشتی را از اشیای جلویی کم میک‌ند.
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برای اعمال گزینه‌های Pathfinder، شکل‌های شما باید در برخی نقاط روی هم افتادگی داشته باشند. سپس، 
همه آنچه که باید انجام دهید، انتخاب شکل‌ها و کلیک کردن روی یک از گزینه‌هاست. در مثال نشان داده 
شده در شکل 14ـ3، یک دایره و یک مستطیل را انتخاب کرده‌ایم و گزینه‌های Pathfinder زیر را بر آن‌ها 
اعمال کرده‌ایم )از بالا به پایین(: Add،وSubtract و Minus Back. این‌ها سه گزینه‌ای هستند که برای 
ساخت شکل در InDesign بیشترین کاربرد را دارند. می‌توانید از این شکل‌ها برای اضافه کردن رنگ؛ اضافه 
کردن تصاویر یا متن برای یک شیوه بسیار هنری؛ یا حتی چرخاندن متن حول آن‌ها استفاده کنید. بهترین 

راه یادگیری این ابزارهای عالی، کار کردن با آن‌ها و مشاهده اتفاقاتی است که رخ می‌دهد.

شکل 14ـ3ـ ترکیب کردن شکل‌ها یا فریم‌ها

Pencil 14ـ3ـ تغییر شکل یک فریم یا شکل با ابزار

این تکنیک، شبیه استفاده از مداد در طراحی است. همه موارد نباید تمیز و متقارن باشد؛ گاهی قدری زبری 
هم لازم است. اگر احساس میک‌نید یکی از شکل‌ها یا فریم‌های شما باید قدری ناقص شود و از شکل بیفتد، 
می‌توانید آن را با رسم لبه فریم با ابزار Pencil تغییر دهید. برای انجام این کار، کافی است شکل یا فریم را با 
ابزار Selection (V) انتخاب کنید، سپس به ابزار Pencil (N) سوئیچ کنید و شروع به رسم در سراسر لبه 
از نقطه ابتدا تا نقطه پایان کنید. مطمئن شوید شروع یا پایان درست در لبه قرار دارند، در غیر این صورت 

چندان جالب نخواهد شد.

شکل 15ـ3ـ استفاده از ابزار Pencil برای تغییر شکل
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Pencil 15ـ3ـ ایجاد یک شکل سفارشی با ابزار

ابزار Pencil به شما اجازه رسم دستی و ایجاد مسیرهای باز و بسته را می‌دهد. این ابزار برای ایجاد نوعی جلوه 
ترسیم دستی عالی است. مزیت دیگر آن این است که می‌توانید آنچه را که رسم کرده‌اید، ویرایش کنید. کافی 
است ابزار Pencil (N) را انتخاب کرده و شروع به رسم شکل شما میک‌ند. هنگام رسم، مجموعه‌ای از نقاط 
آبی را خواهید دید که ظاهر می‌شوند و هنگامیک‌ه ماوس را رها میک‌نید، مسیر خصوصیات تنظیم شده توسط 
خط دور را خواهد گرفت. اگر انتهای شکل باز باشد، در هر انتها نقطه‌ای وجود خواهد داشت و همین‌طور 
 Pencil را فشار داده و نگه دارید، مکان‌نمای ابزار Alt نقاطی در سراسر مسیر. اگر بعد از شروع رسم، کلید
دایرۀ کوچکی را نمایش می‌دهد تا به شما نشان دهد که می‌خواهید مسیر بسته‌ای را ایجاد کنید. هنگامیک‌ه 

از شکل راضی بودید، قبل از رها کردن کلید Alt، ماوس را رها کنید تا دو نقطه باز به هم متصل شوند.

شکل 16ـ3ـ استفاده از ابزار Pencil برای ایجاد شکل‌های سفارشی

Pen 16ـ3ـ ایجاد شکل‌های سفارشی با ابزار

و   Illustratorو،Photoshop در  پرکاربرد  ابزارهای  از  )یکی  بدانید  را   Pen ابزار  با  کار  فن  و  فوت  اگر 
InDesign(، می‌توانید از آن برای ایجاد شکل‌های خاص خود استفاده کنید. این ابزار اغلب توسط افراد با 
تجربه‌تر استفاده می‌شود ولی شما هم می‌توانید نحوه استفاده از آن را یاد بگیرید. بیشتر اوقات، از شکل‌های 
ایجاد موردی سفارشی هستید، ممکن  پایه در سند InDesign خود استفاده میک‌نید. ولی اگر مجبور به 
است بخواهید آن را امتحان کنید. ابزار Pen (P) را انتخاب کرده و برای ایجاد اولین نقطه خود، روی سندتان 
کلیک کنید. می‌توانید شکلی با اضلاع مستقیم )راست( را به سادگی و تنها با کلیک کردن مجدد روی مکانی 
که می‌خواهید نقطه بعدی خود را قرار دهید بسازید و الی آخر. مطمئن شوید که شکل خود را با کلیک کردن 
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مجدد روی اولین نقطه‌ای که قرار داده‌اید، ببندید. اگر تجربه کار با ابزار Pen را دارید، می‌توانید منحنی‌هایی 
در شکل خود ایجاد کنید، ولی این امر نیازمند دستورالعمل‌های دقیقی است.

Pen شکل 17ـ3ـ استفاده از ابزار
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واحد كار چهارم

استفاده از متن
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  پنل كاراكتر و پاراگراف را در ويرایش متون بهک ار گیرد.

  سبک را براي كاراكتر و پاراگراف ها تهیه کند.

  Tab، Glyph و Bullet را بهک ار گیرد.

  متن روي مسير و تنظيمات آن را انجام دهد.

  حالت هاي مختلف چيدمان متن و اشيا را انجام دهد.

  با فريم هاي متني کار کند.

  تنظيمات قالب بندي را انجام دهد.

کلیات 

InDesign  مناسب ترین نرم افزار برای هر کسی است که به دنبال ارائه هر نوع سند یا مطلب چاپی است. 
برای ارائه این نوع اسناد نیاز به استفاده از متن دارید که در این واحد کار به معرفی ابزارها و ویژگی های متنی 

می پردازیم. برای کار کردن با متن، ابتدا باید بتوانید فونت را تعریف کرده و تغییر دهید.

زمان آموزش

عملینظری

410



واحد کار  چهارم: استفاده از متن

4 5

1ـ4ـ تغییر دادن فونت

تغییر دادن فونت خیلی ساده است. برای انتخاب متن موردنظر خود برای تغییر، ابزار Type (T) را انتخاب 
کرده و سپس منوی بازشوی فونت را در پنل Control، پنل Properties یا پنل Character انتخاب کنید. 
متن نمونه را در کنار فونت های دیگر در منو خواهید دید. این امر به شما کمک خواهد کرد فونت موردنظر 
خود را انتخاب کنید. هم چنین در سند خواهید دید که متن متمایز شده شما به صورت پیش نمایش زنده 

تغییر میک ند و نمای بی درنگی از ظاهر طراحی را به شما می دهد.

شکل 1ـ4ـ تغییر دادن فونت

2ـ4ـ فریم متنی

تایپ باید در فریم متنی انجام شود و البته گاهی همه تایپ شما در فریمی که ایجاد کرده اید، جای نمی گیرد. 
آنگاه باید وقت بگذارید و هنگام کار کردن، اندازه فریم متنی را تغییر دهید. اما به یک ترفند می توان این 
مشکل را حل کرد، برای تغییر اندازه خودکار فریم متنی هنگام وارد کردن متن، در برگه Auto-Size کلیک 
کرده و سپس height Only را از منوی بازشوی Auto-Sizing انتخاب کنید. در کادر مربعی زیر، گزینه 
top-middle را انتخاب کنید )فلش کوچک اشارهک ننده به پایین(. این بدان معنی است که متن همواره در 
بالای فریم شروع می شود و به سمت پایین کار می شود. روی OK کلیک کنید. حالا اندازه کادر متنی شما 
هنگام تایپ تغییر میک ند. برای اطمینان از اینکه این اتفاق همیشه می افتد، قبل از ایجاد سند خود )هنگامی 
که هیچ سندی باز نیست( این تنظیم را اعمال کنید تا در هر بار ایجاد یک فریم متنی، این تنظیم پیش فرض 
باشد. تنظیمات دیگر این بخش را هم امتحان کنید، ممکن است پیش فرض مفید دیگری را برای قرار دادن 

متن خود بیابید.
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شکل 2ـ4ـ تنظیمات فریم متنی

3ـ4ـ تغییر تراز متن

هنگام صفحه بندی متن در سند، این مرحله ساده بسیار مهم است. بسیاری از اوقات، طراحان فقط از متن 
چپ چین یا وسط چین استفاده میک نند و از بقیه گزینه ها صرف نظر میک نند. بقیه هم بسیار مهم هستند 
 Control یا پنل Properties پنل ،Paragraph به ویژه در صفحه آرایی متون فارسی. تراز را می توان در پنل
تنظیم کرد. قبل از اضافه کردن متن، یک گزینه تراز را انتخاب کنید تا پیش فرض شود. اگر بخواهید تراز 
متن خود را تغییر دهید، متن را متمایز کرده و روی گزینه جدیدی کلیک کنید. گزینه های ذیل در دسترس 

قرار می گیرند:
Align Left  

Align Center  

Align right  

Justify with last line aligned left  

 Justify with last line aligned center  

Justify with last line aligned right  

Justify all lines  

Align towards spine  

Align away from spine  

در ردیف پایین پاراگراف های بالا، می توانید ببینید که بسته به محل قرارگیری متن، به طور خودکار از عطف 
یا به طرف عطف تراز می شود.
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شکل 3ـ4ـ ترازبندی متن

Glyph 4ـ4ـ مفهوم

Glyphها کاراکترهای ویژه هستند. این کاراکترها شامل بولت ها، کادرهای انتخاب، موارد زینتی و کاراکترهای 
لهجه می شوند. افزودن Glyph به متن، کار بسیار ساده ای است. با استفاده از ابزار Type (T)، مکان نمای 
خود را در محلی قرار دهید که می خواهید Glyph ظاهر شود و سپس Type>Glyph را انتخاب کنید. این 
امر موجب باز شدن پنل Glyphs می شود که Glyph های موجود را برای فونت انتخابی فعلی شما نشان 
می دهد. برای یافتن فهرست گزینه های مرتب سازی از جمله ویژگی های OpenType، نمادها، اعداد و موارد 
زینتی، کسرها، نویسه های دوتایی و غیره، روی منوی بازشوی Show کلیک کنید. به دنبال Glyph موردنظر 
خود برای استفاده بگردید و برای افزودن آن به متن خود روی آن دابل کلیک کنید. در مثال بالا، افزودن نماد 
 Symbolsو،Glyphs اضافه کنید. در پنل “Queen’s Park Rangers” را پس از کلمات )TM( نشان تجاری
را از منوی Show انتخاب کرده، TM را پیدا کنید و روی آن دابل کلیک کنید. این امر موجب اضافه شدن 
نمادها به این فضا می شود. همه Glyph های استفاده شده اخیر در بالای پنل Glyphs نمایش داده می شوند. 

این مسئله هنگامی مفید است که از یک Glyph به دفعات استفاده میک نید.
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شکل 4ـ4ـ اضافه کردن Glyph به متن

Word 5 ـ4ـ درجک ردن متن از یک سند

 InDesign را به منزله محتوا در Word افراد زیادی این مسئله را نمی دانند، ولی شما می توانید کل یک سند
قرار دهید. بسیاری از افراد فقط محتوا را از سند Word به سند InDesign کپی و الصاق میک نند. شما هم 
 File>Place می توانید این کار را انجام دهید، ولی در اینجا شرح می دهیم که چگونه سند واقعی را قرار دهید. به
 Import Options موردنظر خود را برای استفاده پیدا کنید. مطمئن شوید که کادر انتخاب Word رفته و سند
در پایین کادر محاوره ای Place در حالت انتخاب است، در غیر این صورت این روش درست کار نخواهد کرد 
)حداقل نه به روشی که شما روی آن کنترل داشته باشید(. روی بخش Formatting در نیمه پایینی این کادر 

محاوره ای تمرکز خواهیم کرد که به شما دو گزینه را برای کار کردن با متن وارد شده به شما می دهد:
  Remove Styles and Formatting from Text and Tables: این گزینه تمام فرمت بندی را از 

سند Word شما کنار گذاشته و از شیوه های پیش فرض تنظیمی شما در سند InDesign استفاده میک ند.
  Preserve Styles and Formatting from Text and Tables: این گزینه همه فرمت بندی اعمال 

شده بر سند Word را حفظ میک ند. نکته مفید اینجاست: این گزینه امکان وارد کردن شیوه های Word را 
به شما می دهد.
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Microsoft Word Import شکل 5 ـ4ـ کادر محاوره ای

هنگامی که انتخاب خود را انجام دادید، روی OK کلیک کنید تا مکان نمای شما با سند Word بارگذاری 
شود. حال جایی در سند InDesign خود کلیک کنید تا متن را از سند Word قرار دهید.

6 ـ4ـ استفاده از بولت ها و شماره ها )یا حروف( برای متن

 Properties برای تأیکد بر یک لیست با افزودن بولت ها یا شماره ها )یا حروف(، متن را متمایز کرده و پنل
را باز کنید )Window>Properties(. در نزدیک پایین پنل، آیکن هایی برای بولت ها و شماره گذاری وجود 
دارد. انتخاب هر کدام موجب فرمت بندی لیست شما می شود و آنچه را که انتخاب کرده اید، دقیقاً بر متن شما 
اعمال می شود. در آنجا می توانید شیوه کاراکتری خود، مکان بولت یا شماره را انتخاب کنید. می توانید از نماد 
متفاوتی برای بولت های خود استفاده کنید یا می توانید به جای اعداد، حروف یا اعداد رومی را انتخاب کنید.



5 0

شکل 6 ـ4ـ بولت ها و شماره گذاری

7ـ4ـ تایپ کردن روی یک مسیر

اگر تلاش کنید که تایپی را به یک منحنی اضافه کنیدـ از قبیل نمونه ای که با ابزار P( Pen( در شکل 7ـ5 
نشان داده شده است ـ منحنی خود را رسم کنید یا شکلی را با استفاده از یکی از ابزارهای شکلی انتخاب 

کنید و سپس Type Tool را به Type on a Path Tool تغییر دهید.

 برای داشتن Type on a Path Tool، روی ابزار Type در نوار ابزار کلیک کرده و نگه دارید تا منوی 
را   Shift+T یا  کنید  انتخاب  زمینه  منوی  از  را   Type on a Path Tool و سپس  باز شود  شناوری 

فشار  دهید.

نکته

هنگامی که مکان نما را روی مسیری نگه داشته  اید که می خواهید روی آن تایپ کنید، تغییر خواهد کرد و 
یک علامت + کوچک را نشان می دهد. هنگامیک ه به علاوه را دیدید، برای قرار دادن مکان نما، یک بار کلیک 
کنید. حال می توانید متن خود را تایپ کنید تا مسیر را دنبال کند. به خاطر داشته باشید که هر چه مسیر 
زمخت تر باشد، متن روی مسیر بدتر به نظر خواهد رسید. محتاط بودن و دانستن دلیل افزودن تایپ به مسیر 

برای شکل و ظاهر طراحی بسیار مهم است.
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شکل 7ـ4ـ تایپ روی مسیر

 8  ـ4ـ تنظیم سبک های ترجیحی کاراکتر و پاراگراف

در واحد کارهای قبل چگونگی تنظیم پیش فرض ها برای فونت، خط دور و تنظیمات دیگر را بیان کردیم، ولی 
شما می توانید سبک های ترجیحی کاراکتر و پاراگراف خود را تنظیم کنید. ساده ترین روش انجام این کار، 
وارد کردن سبک ها از یک سند موجود است. ابتدا مطمئن شوید هیچ سندی باز نیست. این  مورد همیشه 
 Pragraph یا Type>Character Styles مهم ترین گام برای تنظیمات ترجیحات سبک است. سپس به
Styles بروید )این نکته برای هر دو کار میک ند(. از منوی پنل، Load All Text Styles را انتخاب کنید. 
به سند موجودی بروید که حاوی سبک های موردنظر شماست و روی Open کلیک کنید. سبک ها به سادگی 
از آن سند وارد می شوند و این سبک ها هم اینک به عنوان سبک های ترجیحی پاراگراف و کاراکتر شما تنظیم 

شده اند. این روشی عالی برای تنظیم سریع سبک هاست.



5 2

شکل 8  ـ4ـ سبک های کاراکتر و پاراگراف

 9ـ4ـ تنظیم مقدار در پنل کاراکتر

فیلد  را در  نکنید مکان نما  تغییر دهید، سعی  Character سریعاً  را در پنل  نیاز است مقداری  هنگامیک ه 
کوچکی قرار دهید، مقدار فعلی را حذف کنید و سپس مقدار جدید خود را تایپ کنید. در عوض، می توانید 
که  کاری  تنها  حالا،  شود.  متمایز  فیلد  تا  کنید  کلیک  تغییر  برای  خود  موردنظر  ویژگی  آیکن  روی  فقط 
ولی  نرسد،  نظر  به  مهم  چندان  است  ممکن  مسئله  این  است.  مقدار جدید  کردن  تایپ  دهید،  انجام  باید 

چنانچه به کرات مقادیری را در پنل Character تنظیم میک نید، 
تفاوت معناداری خواهد داشت. آیا می خواهید سریع تر از این هم 
عمل کنید؟ بسیاری از مواقع مجبورید این مقادیر را بارها و بارها 
مقدار،  شدن  متمایز  هنگام  به  کار،  این  تشریح  برای  کنید.  تایپ 
یا  افزایش  برای  کلید  صفحه  در  پایین  و  بالا  جهتی  کلیدهای  از 
موردنظر  مقدار  به  هنگامیک ه  کنید.  استفاده  مقدار  سریع  کاهش 

فشار دهید. را   Enter خود رسیدید، 

Character شکل 9ـ٤ـ پنل
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10ـ4ـ یافتن پنل های سبک ها

به Window>Styles بروید و این پنل های موجود سبک ها را ببینید:
Cell Styles  

Character Styles  

Object Styles  

Paragraph Styles  

Table Styles  

شکل 10ـ4ـ منوی Styles و پنل های مرتبط

پنل موردنظر خود را برای باز شدن انتخاب کنید تا در فضای کاری شما نمایان شود. این فرایند را برای باز 
کردن پنل دیگری تکرار کنید. هر پنلی که در کنار نامش در منو علامت چک مارک باشد، هم اکنون باز است. 
هنگامی که پنلی را باز کردید، می توانید آن را شناور رها کنید یا می توانید آن را به پنل های دیگر وصل کنید. 
اگر از سبک هایی در سند خود استفاده میک نید، پشته بندی همه پنل های سبک ها با یکدیگر ایده خوبی است.

 11ـ4ـ ایجاد یک سبک کاراکتری

پنل Character Styles برای ایجاد، نام گذاری و بهک ارگیری سبک های کاراکتری برای متن در یک پاراگراف 
استفاده می شود. این سبک ها با سندی که برای آن ایجاد شده اند، ذخیره می شوند و هر بار که آن سند خاص 
از  می توانید  ایجاد یک سبک،  برای  داده خواهد شد.  نمایش   Character Styles پنل  در  باز میک نید،  را 
مشخصات تایپی که هم اکنون در صفحه فرمت بندی کرده اید، استفاده کنید یا سبک جدیدی را از طریق منوی 
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پنل Character Styles از ابتدا بسازید. برای انجام روش دوم، مطمئن شوید مکان نمای شما در متنی قرار 
 Character دارد که برای آن سبک ایجاد میک نید، روی آیکن منوی پنل در گوشه سمت راست بالای پنل
 New Character را انتخاب کنید. در کادر محاوره ای New Character Styles کلیک کنید و Styles

Styles، به بخش Style Settings بروید و ویژگی های منتخب خود را مرور کنید. 

New Character Style شکل 11ـ4ـ کادر محاوره ای

اگر می خواهید چیزی را تغییر دهید، روی گزینه های موجود در منو در سمت چپ پنل کلیک کنید تا به 
تنظیمات مختلف ویژگی های متنی دسترسی پیدا کنید. پس از رضایت از تنظیمات، روی OK کلیک کنید تا 
سبک جدید شما در پنل Character Styles نمایان شود. این فرایند را برای هر یک از سبک های دیگر که 
می خواهید ایجاد کنید، تکرار کنید، سپس سند را ذخیره کنید. هم چنین می توانید متن دارای سبک را کپی 
کرده و آن را در سند جدیدی الصاق کنید تا آن سبک ها روی متن شما سوار شوند یا می توانید سبک ها را در 
سند دیگری وارد کنید. بهتر است پروژه ای را که شروع میک نید، سند جدیدی را ایجاد کنید و عناصر متنی 
مختلف خود را در فریم های متنی مجزا بچینید )سرصفحه ها، متن اصلی، عناوین و غیره(. سپس سبک گذاری 
را به طور دستی بر هر عنصر متنی اعمال کنید )فونت، اندازه، وزن، رنگ و غیره(. پس از رضایت از تنظیمات 

خود، سبک های کاراکتری را برای هر نوع متن ایجاد کنید.

 12ـ4ـ اعمال یک سبک کاراکتری

انجام این کار واقعاً آسان است. متنی را که می خواهید سبک کاراکتری را روی آن اعمال کنید، متمایز کنید، 
 Apply بروید و روی نام سبک کلیک کنید یا روی آن کلیک راست کنید و Character Styles سپس به پنل

”[name of style]“ را انتخاب کنید. این امر موجب اعمال خودکار سبک بر متن منتخب می شود.
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شکل 12ـ4ـ اعمال سبک بر متن

 13ـ4ـ ایجاد یک سبک پاراگرافی

سبک های پاراگرافی به شما اجازه اعمال و به روزرسانی کلی فرمت بندی متن را برای کل پاراگراف ها می دهد 
و نه فقط کاراکترهای منتخب. آن ها تمام عناصر فرمت بندی متن شما را شامل می شوند، بنابراین، علاوه بر 
پاراگرافی  پاراگرافی شامل ویژگی های  اندازه، رنگ و ضخامت، سبک های  از قبیل فونت،  ویژگی های متنی 
نیز می شوند، از جمله تورفتگی ها، tabها، تراز و گذاشتن خط پیوند1. به هر حال، می توانید بعضی از عناصر 
سبک های کاراکتری را لغو کنید. برای ایجاد یک سبک پاراگراف پایه از ابتدا، مطمئن شوید هیچ متنی در 
حال حاضر انتخاب نشده است و روی آیکن Create New Style در پایین پنل Paragraph Styles کلیک 
کنید )شبیه برگه ای کاغذی با گوشه تاخورده است(. روی سبک ایجاد شده جدیدـ Paragraph Styles 1ـ 

دابل کلیک کنید تا InDesign کادر محاوره ای Paragraph Styles Options را باز کند.

چنانچه هنگام کلیک کردن روی آیکن Create New Style، کلید Alt را فشار داده و نگه دارید، سبکی 
را ایجاد خواهید کرد و کادر محاوره ای Paragraph Styles Options با یک کلیک باز می شود.

توجه

Hyphenation ـ1
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 Basic Character کافی است سبک پایه ای را ایجاد کنید و فعلًا از تنظیمات دیگر صرف نظر کنید. روی 
Formats در سمت چپ کادر محاوره ای کلیک کنید و سبک فونتی را برای پاراگراف پایه خود تنظیم کنید. 
نامی به سبک خود بدهید و روی OK کلیک کنید. حالا یک سبک پاراگراف پایه را ایجاد کرده اید. هم چنین 
می توانید سبک پاراگراف جدیدی را از یک خط متنی ایجاد کنید که هم اکنون فرمت بندی کرده اید. متن 
 Paragraph Styles در پایین پنل Create New Style انتخاب کرده و روی آیکن فرمت بندی شده را 
اعمال میک ند.  بر سبک  را  و آن ها  را می گیرد  تمام ویژگی های منتخب  ـ  کلیک کنید. خیلی ساده است 

می توانید نام سبک را با دابل کلیک کردن روی نام آن تغییر دهید.

شکل 13ـ4ـ سبک های پاراگراف

14ـ4ـ اعمال کردن سبک پاراگراف

مکان نمای خود را در پاراگرافی قرار دهید که می خواهید سبک پاراگراف را بر آن اعمال کنید.

برخلاف هنگام اعمال سبک کاراکتر، نباید تمام متنی را که می خواهید سبک پاراگراف را بر آن اعمال 
کنید، متمایز کنید. فقط باید مکان نمای خود را جایی در پاراگراف قرار دهید یا فریم متنی را انتخاب 

کنید، این کار باعث بازنویسی سبک های کاراکتری موجود نمی شود.

توجه

 Apply بروید و روی نام سبک کلیک کنید یا روی آن کلیک راست کرده و Paragraph Styles به پنل
”[name of style]“ را انتخاب کنید. این امر موجب اعمال خودکار سبک ـ با تمام سبک گذاری ایجاد شده  ـ 

بر کل پاراگرافی می شود که مکان نما در آن قرار دارد.
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شکل 14ـ4ـ اعمال سبک پاراگراف

15ـ4ـ بارگذاری سبک ها از سندی دیگر

همانگونه که قبلًا بیان شد، قصد داریم اسنادی را با سبک های متنی خاص ایجاد کنیم و سپس آن سبک ها 
با  را  خود  سند  طریقی،  هر  به  کنیم.  ذخیره  مربوطه  پنل های سبک های  در  واقعی  به عنوان سبک های  را 
سبک های تنظیمی اش ذخیره میک نیم و می توانیم آن سبک ها را قرض بدهیم و بر سند جدیدی اعمال کنیم. 

به عنوان یک مثال، بعضی از سبک های کاراکتری موجود را در سندی جدید بارگذاری خواهیم کرد.

هم چنین می توانید از مراحل مشابه برای بارگذاری هر نوع سبک دیگری استفاده کنید؛ کافی است از پنل 
مربوط به نوع سبک واردشونده استفاده کنید. 

نکته

 Load Character کلیک کرده و Character Styles روی آیکن منوی پنل در گوشه سمت راست بالای پنل 
Styles را انتخاب کنید. فایلی را بیابید که حاوی سبک های موردنظر شما برای ورود است و روی OK کلیک 
ورودی  سبک های  مورد  در  می توانید  که  می شود  جدید  محاوره ای  کادر  شدن  باز  موجب  امر  این  کنید. 
تصمیم گیری کنید. روی کادر انتخاب کنار هر سبکی که می خواهید وارد کنید، کلیک کنید و سپس روی 
OK کلیک کنید. حالا آن سبک ها را در پنل  Character Styles خود خواهید دید. کافی است این مراحل 

را برای هر سند دیگری تکرار کنید یا هر سبک دیگری را وارد کنید.
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شکل 15ـ4ـ بارگذاری سبک ها

16ـ4ـ حذف کردن سبک

اگر ذهنیت شما درباره سبکی تغییر کندـ شاید دیگر نیازی به آن نداشته باشید یا بخواهید از اول شروع 
کنید  ـ روش های ساده متعددی برای خلاص شدن از آن وجود دارد. ابتدا، می توانید یک بار روی نام سبکی 
کلیک کنید تا متمایز شود و سپس روی آیکن سطل آشغال در گوشه سمت راست پایین پنل سبک ها کلیک 
کنید یا می توانید روی نام سبک در پنل سبک ها کلیک راست کرده و Delete Style را انتخاب کنید یا 
می توانید نام سبک را متمایز کنید، منوی پنل سبک ها را باز کنید و Delete Style را از آن جا انتخاب کنید.

شکل 16ـ4ـ حذف کردن سبک
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واحد كار پنجم

کار با Master و کاربرد آن در صفحه آرایی
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  از Master استفاده کند و تنظیمات آن را انجام دهد.

  شماره صفحات را با استفاده از Master ایجاد کند.

  فهرست مطالب را ایجاد کند و تنظيمات آن را انجام دهد.

  پانويس ها را اضافه کند.

  راهنماي موضوعي را ایجاد کند.

  فهرست مطالب را ایجاد کند.

  فصل ها و كتاب ها را چاپ کند.

زمان آموزش

عملینظری

410
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Master 1ـ5  ـ مفهوم 

صفحات Master عناصر مشترک طراحی را در صفحات سند شما اعمال میک نند. این امر موجب صرفه جویی 
در وقت شما برای افزودن این عناصر به تک تک صفحات و تضمین انسجام می شود و روشی آسان را برای 

سراسری کردن تغییرات در یک سند فراهم میک ند.
یا  طراحی  عناصر  می توانید  آیا  بزنید.  ورق  را  آن  صفحات  دارید،  صفحه ای  چند  نشریه  یا  مجله  یک  اگر 
ویژگی های صفحه بندی آن را مشخص کنید؟ کدام عناصر طراحی در چندین صفحه در صفحه بندی کتاب 

هستند. تکراری  گزارش  یا 
مجله حاوی مثال های متعددی از اقلام Master است که در صفحات Master فعال هستند. سرصفحه ها 
)ناحیه بالای حاشیه بالایی صفحه( و پانویس ها )ناحیه زیر حاشیه پایین(، نواحی ای در صفحه هستند که 
عناصر تکراری را در صفحات مختلف قرار می دهید )شکل 1ـ5(. برخی مثال های عناصر تکراری سرصفحه و 

پانویس، شماره صفحات، لوگوهای شرکت و کنترل های پیمایش هستند.

شکل 1ـ5  ـ نمونه دو صفحه روبه روی هم از صفحه آرایی یک مجله و صفحه اصلی که برای افزودن نوارهای قرمز، سرصفحه و 
پانویس به کار گرفته شده است.

اگر قرار است عنصر موردنظر شما در صفحات متعددی ظاهر شود، آن آیتم را به یک صفحه Master اضافه 
کنید. سپس، هنگامی که آن صفحه Master را بر صفحات سند اعمال میک نید، آن اقلام Master به طور 

خودکار در آن صفحات سند ظاهر می شوند.
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Master 2ـ5  ـ ایجاد و ویرایش صفحات

هنگام ایجاد یک سند جدید، سندی خالی با تعداد صفحات مشخص شده باز می شود. تمام صفحات به طور 
خودکار برمبنای صفحه Master پیش فرض به نام MasterـA هستند. این صفحه Master پیش فرض بر 
همه صفحات خالی اعمال می شود و در تنظیمات سند جدید اصلی از قبیل اندازه صفحه، جهت صفحه )افقی 

یا عمودی بودن(، حاشیه ها، ستون ها و تنظیمات bleed به کار گرفته می شود.
قبل از افزودن اقلام به صفحه Master، صفحه Master با انجام یکی از موارد ذیل نمایش داده می شود:

  در ناحیه صفحات Master پنل Pages، روی نام صفحه Master )در این مورد، MasterـA( دابل کلیک کنید.

  در نوار وضعیت، نام صفحه Master (MasterـA) را از منوی Go To Page انتخاب کنید.

  Layout>Go to Page را انتخاب کنید و نام صفحه Master (MasterـA) را از منوی Page برگزینید 

)شکل 2ـ5(.

Pages پنل Master قابل انتخاب از نوار وضعیت در پایین پنجره سند و در ناحیه صفحه AـMaster شکل 2ـ5 ـ

حالا اسپرید یا صفحه MasterـA در پنجره سند نمایان می شود و می توانید افزودن اقلام Master مشترک 
را شروع کنید.

هنگام استفاده از صفحات روبه رو، یک اسپرید صفحه Master حاوی صفحه Master چپ و راست است، 
بنابراین می توانید اقلام را فقط به یک صفحه هر اسپرید اضافه کنید.
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نشانگر ویژه شماره صفحه اغلب اولین آیتم Master است که به یک صفحه Master اضافه میک نید، به ویژه 
برای اسناد طولانی مثل کتاب، گزارش یا مجله. این نشانگر برای نمایش شماره صفحه فعلی به طور خودکار 

بهنگام رسانی می شود.
برای افزودن نشانگر شماره صفحه )شکل 3ـ5(:

1 با استفاده از ابزار Type، یک فریم متنی در صفحه MasterـA در ناحیه پانویس بکشید و داخل فریم کلیک کنید.
Type>Insert Special Character>Markers>Current Page Number 2 را انتخاب کنید. نشانگر 
ویژه شماره صفحه درج شده به صورت حرف A ظاهر می شود که با پیشوند صفحه Master منطبق است. 
شماره صفحه در MasterـB به صورت حرف B نمایان می شود. چنانچه بخواهید متن بیشتری به فریم متنی 

پانویس اضافه کنید که حاوی نشانگر شماره صفحه است، از قبیل نام مجله، دست به کار شوید.
3 هنگام بازگشت به صفحه سند، آیتم Master جدیدی را در هر صفحه استفادهک ننده از آن Master خواهید دید.

شکل 3ـ5 ـ نشانگرهای شماره صفحه فعلی در سمت چپ MasterـA )بالا( و چگونگی ظهور نشانگر در صفحه 4.

اگر از صفحات روبه رو استفاده میک نید و می خواهید آیتم Master را در هر صفحه ببینید، به خاطر داشته 
باشید که آیتم Master را هم به صفحات چپ و هم به صفحات راست اسپرید Master اضافه کنید.

به همان روش، می توانید هر متن یا گرافیک دیگری را به اسپرید Master اضافه کنید، از قبیل عنوان سند 
یا تاریخ صدور.

صفحات Master فقط برای اشیایی نیستند که در هر صفحه ظاهر می شوند. آن ها برای چیدمان هایی نیز که 
به کرات استفاده مجدد می شوند، مفیدند. به جای هر بار بازسازی چیدمان، یک صفحه Master آماده خواهید 

داشت که به هر صفحه دیگری اضافه خواهند شد.
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Master 3ـ5 ـ افزودن صفحات 

مثلًا، در صفحه بندی یک مجله،  نیستند.  واحد   Master اسپرید  یا   Master به یک صفحه  اسناد محدود 
استفادهک نند. متفاوتی  استاندارد  صفحه بندی های  از  است  ممکن  مختلف  بخش های 

برای ایجاد یک صفحه Master، یکی از موارد ذیل را انجام دهید:
  با صفحه یا اسپرید Master انتخاب شده، روی دکمه Create New Page در پایین پنل Page کلیک کنید.

  New Master را از منوی پنل Pages انتخاب کنید.

  روی ناحیه صفحه Master در پنل Pages کلیک راست کرده و New Master را انتخاب کنید.

اگر فرمان New Master را انتخاب کنید )یا فرمان Master Options هنگام انتخاب Master(، می توانید 
تنظیمات را برای Master تغییر دهید )شکل 4ـ5(:

  Prefix: راه کوتاه شناسایی Master هنگامی که فضای کافی برای نمایش کامل نام Master وجود ندارد.

.Master نام :Name  

تغییرات است.  برای مدیریت  بر دیگری، روشی عالی   Master Based on Master: مبنا گرفتن یک    

مثلًا، اگر در دو بخش یک کاتالوگ، مستطیل های یکسانی در سرصفحه وجود دارد به استثنای رنگ زمینه 
مستطیل، می توانید Master دوم را برمبنای اولی قرار دهید و فقط رنگ مستطیل را تغییر دهید. هنگام 
ویرایش اولین Master، تغییرات بر دومی هم اعمال می شود )به استثنای رنگ زمینه(، بنابراین برای تغییر هر 

دو Master، کافیست فقط یکی را ویرایش کنید.
 Master می تواند بیش از دو صفحه داشته باشد، مثلًا، می توانید یک Master یک :Number of Pages  

را برای صفحه آرایی خود طراحی کنید.
علاوه بر داشتن اشیا و راهنماهای متفاوت، هر Master می تواند اندازه صفحه، تنظیمات حاشیه و تنظیمات 

ستون خودش را داشته باشد.

New Master جدید با فرمان Master شکل 4ـ5  ـ افزودن صفحه
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Master 4ـ5 ـ کپی کردن صفحات

می توانید یک صفحه Master موجود را کپی کنید تا به منزله پایه ای برای صفحه Master جدیدی عمل 
 Master موجود سریع تر از ساخت یک Master مرتبط، کپی کردن یک Master کند. هنگام ایجاد چندین

جدید از یک صفحه خالی است.
برای کپی کردن یک اسپرید یا صفحه Master، یکی از موارد ذیل را انجام دهید:

  در حالیک ه یک Master انتخاب شده است، Duplicate Master Spread را از منوی پنل Pages انتخاب کنید.

  روی یک Master کلیک راست کرده و Duplicate Master را انتخاب کنید.

  Master را به دکمه Create New Page در پایین پنل Pages بکشید.

پس از کپی کردن یک اسپرید، می توانید از فرمان Master Options برای سفارشی کردن نام و ویژگی های 
آن استفاده کنید. سپس می توانید اقلام موجود در کپی را در صورت لزوم اضافه یا حذف کنید.

برای ایجاد یک صفحه Master جدید که طراحی صفحه یک سند را کپی کند، صفحه سند را در 
 Master را از منوی پنل Master Pages>Save As Master انتخاب کرده و سپس Page پنل

انتخاب کنید.

نکته

Master 5ـ5 ـ عملیاتی کردن صفحات

بر  را   Master می توانید صفحات  نیز  و  کنید  اعمال  بر همه صفحات سند  را   Master می توانید صفحات 
کنید. اعمال  میک نید،  اضافه  که  جدید  صفحات 

Master 6ـ5 ـ بهک ارگیری صفحات

هنگام اعمال صفحات Master بر صفحات سند، حرف پیشوند )مثلًا A برای MasterـA( در نمونه تصویری 
صفحه در پنل Pages نمایان می شود. این کار مشاهده اینکه کدام صفحه Master بر یک صفحه سند اعمال 

شده است را آسان میک ند. 
برای اعمال یک صفحه Master بر یک صفحه سند )شکل 5ـ5(:

1 در پنل Pages، صفحات سند را برای اعمال صفحه master انتخاب کنید.
Apply Master to Pages 2 را از منوی پنل Pages انتخاب کنید.

3 در کادر محاوره ای Apply Master، یک Master را برای اعمال صفحه سند از منوی Apply Master انتخاب کنید.
4 روی OK کلیک کنید.
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Pages بر صفحات سند منتخب در پنل Master شکل 5ـ5 ـ اعمال یک صفحه

میانبر: برای انتخاب محدوده پیوسته ای از صفحات در پنل Pages، روی اولین صفحه در محدوده 
کلیک کرده و سپس روی صفحه آخر در محدوده Shift کلیک کنید. برای انتخاب صفحات ناپیوسته، 

روی آیکن صفحات Ctrl کلیک کنید.

همچنین می توانید Master را در پنل Pages با کشیدن نمونه تصویری Master و انداختن آن روی نمونه 
تصویری صفحات در پنل Pages اعمال کنید.

Master 7ـ5 ـ افزودن صفحات بر مبنای صفحات 

هنگام افزودن صفحه ای جدید، آن صفحه از همان Master صفحه ای استفاده میک ند که در زمان افزودن 
صفحه جدید انتخاب کرده اید.

می توانید با انتخاب Insert Pages از منوی پنل Pages، کادر محاوره ای Insert Pages را باز کنید 
یا روی دکمه Create New Page در پنل Alt، Layer کلیک کنید.

نکته

 Layout>Pages>Insert Pages ،برای صفحه جدید شما استفاده شود Master اگر می خواهید انتخاب کنید که کدام
5ـ(. در کادر محاوره ای Insert Pages، می توانید مشخص کنید که صفحات جدید را کجا اضافه  را انتخاب کنید )شکل 6
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 Pages پنل Masters را از ناحیه Master استفاده کنند. هم چنین می توانید یک Master میک نید و آن ها باید از کدام
قبل یا بعد از هر یک از صفحات در ناحیه صفحات سند پنل Pages بکشید.

Master شکل 6ـ5 ـ افزودن یک یا چند صفحه و اعمال صفحه

8ـ5 ـ حذف Master ها

حذف یک Master تقریباً شبیه ایجاد آن است. در پنل Pages، به سادگی می توانید یک اسپرید یا صفحه 
( بکشید. هنگام انتخاب یک Master، می توانید روی  ( Delete Selected Pages را به آیکن Master
آیکن Delete Selected Pages کلیک کنید یا Delete Master را از منوی پنل Pages انتخاب کنید. 

9ـ5 ـ ایجاد فهرست مطالب

فهرست مطالب )TOC( معمولاً بخشی از محتوای ابتدای یک نشریه است. فهرست مطالب معمولاً تیترهای 
متفاوت مورد استفاده در سراسر نشریه را فهرست میک ند )مثلًا، عناوین و زیرعناوین دستورعمل یا عناوین 
دارای  که  کنید  پیدا  را  کتابی  تمرین،  یک  به عنوان  فصل ها(.  این  در  استفاده  مورد  زیرتیترهای  و  فصل ها 
فهرست مطالب است، حتی شاید کتابی که در حال حاضر در حال مطالعه آن هستید. آیا رابطه ای بین متن 

فهرست مطالب و تیترهای مورد استفاده در سراسر کتاب را می توانید ببینید؟
کلید ساخت فهرست مطالب، استفاده از شیوه های پاراگراف برای هر تیتر یا متن دیگری است که می خواهید 
در فهرست مطالب باشد. مثلًا، اگر شیوه هایی به نام Heading1 و Heading2 دارید و آن ها را بر آن سطوح 
مطالب  فهرست  در  شیوه  دو  این  که  بگویید   InDesign به  می توانید  کرده اید،  اعمال  خود  سند  در  تیتر 
با شیوه های  پاراگراف های تگ گذاری شده  از  مراتبی  فهرستی سلسله  نتیجه،  مطالب  فهرست  باشند.  شما 

Heading1 و Heading2 است.
معمولاً،  کرد.  خواهید  استفاده  نتیجه  مطالب  فهرست  قالب بندی  برای  پاراگراف  شیوه های  از  همچنین 
مجموعه ای از شیوه هایی را طراحی میک نید که چگونگی ظهور متن فهرست مطالب را کنترل کنند. این دو 
کاربرد شیوه ها در فهرست مطالب ممکن است کمی گیجک ننده باشد، پس اجازه دهید آن را روشن کنیم؛ 
شما یک مجموعه از شیوه های پاراگرافی را انتخاب میک نید که ویژگی Table of Contents می گوید کدام 
پاراگراف ها را لحاظ کند و مجموعه دیگری از شیوه های پاراگرف را برای قالب بندی متن تولید شده برای 

انتخاب میک نید )شکل 7ـ5(. فهرست مطالب 
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شکل 7ـ5 ـ فهرست مطالبی که به طور خودکار از شیوه های سند تولید شده است.

قبل از تعریف فهرست مطالب:
  همیشه شیوه های پاراگراف را بر متن در پروژه طراحی خود اعمال کنید، به ویژه عناوین و تیترها، زیرا ایجاد 

فهرست مطالب متکی به این قالب بندی است.
  یک صفحه بندی مدل برای طراحی فهرست مطالب ایجاد کنید.

  شیوه های پاراگراف را برای عنوان فهرست مطالب برای سطوح مختلف ایجاد کنید.

  تعیین کنید که کدام متن از سند شما باید در فهرست مطالب باشد و بررسی کنید که کدام شیوه های 

پاراگراف بر آن متن اعمال می شوند، نام شیوه ها را یادداشت کنید و همین طور سطح اهمیتی که آن ها دارند. 
بگیرید )پیش غذاها،  نظر  را در  انواع مختلف دستورعمل ها  برای یک کتاب دستورعملی، ممکن است  مثلًا 
نام  بالا )سطح 1( در فهرست مطالب و در زیر هر یک می توانید  به عنوان سطح  یا دسرهاـ  غذاهای اصلی 

دستورعمل های مختلف را فهرست کنید )سطح 2((.
  مشخص کنید کدام شیوه های پاراگراف برای قالب بندی متن سند شما استفاده می شوند که باید در فهرست 

مطالب ظاهر شوند. این ها شیوه هایی هستند که در شیوه فهرست مطالب شما خواهند بود.

10ـ5 ـ تعریف شیوه فهرست مطالب

هنگامی که شیوه هایی را برای قالب بندی متن فهرست مطالب ایجاد کردید و تعیین کردید که کدام متن باید 
به آن اضافه شود، شما آماده تعریف شیوه فهرست مطالب هستید. شیوه فهرست مطالب متن مندرج، سلسله 

مرتبه و قالب بندی نهایی فهرست مطالب را تعیین میک ند.
برای تعریف شیوه فهرست مطالب:

Layout>Table of Contents Styles 1 را انتخاب کنید.
2 روی New کلیک کنید. کادر محاوره ای New Table of Contents Style باز می شود.

3 برای بسط دادن این کادر محاوره ای، روی More Options کلیک کنید )شکل 8ـ5(.



واحد کار پنجم:کار با Master و کاربرد آن در صفحه‌آرایی

6 9

4 یک نام توصیفی برای شیوه فهرست مطالب در فیلد TOC Style وارد کنید.
5 عنوانی را در فیلد Title تایپ کنید که در بالای فهرست مطالب ظاهر می شود )مثلًا »فهرست«( و یک 
شامل  هم اکنون  شما  فهرست  اگر  کنید.  انتخاب  متن  قالب بندی  برای   Style منوی  از  را  پاراگراف  شیوه 
شیوه ای نیست که برای عنوان TOC کار کند، New Paragraph Style را از فهرست برای تعریف شیوه 

جدید پاراگراف انتخاب کنید.
 Include Paragraph Styles حالا آماده افزودن تعدادی شیوه مورد استفاده در پروژه خود هستید. این کار در فهرست

در قسمت Styles in Table of Contents انجام می شود.
 Add شیوه ای را انتخاب کنید که می خواهید در فهرست مطالب باشد و روی ،Other Styles 6 در قسمت
 Include کلیک کنید. این گام را برای هر شیوه ای تکرار کنید که می خواهید اضافه کنید. شیوه ها در قسمت

Paragraph Styles نمایان می شوند.
پس از اضافه شدن همه شیوه ها، می توانید قالب بندی و سطوح را برای هر یک از شیوه های پاراگراف مشمول 

تنظیم کنید.
7 شیوه ای را در فهرست Include Paragraph Styles انتخاب کرده و سلسله مرتبه ای را از منوی Level برگزینید.

 New Table of Contents Style شکل 8ـ5 ـ کادر محاوره ای

سطح، ترتیب متن در فهرست مطالب را تعیین میک ند. Level 1 بالاترین سطح و شیوه های Level 2 پس 
از متن Level 1 می آیند.

8 از منوی Entry Style، شیوه پاراگرافی را انتخاب کنید که متن موجود در فهرست مطالب را قالب بندی میک ند.
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 Between Entry شماره صفحات مورد استفاده هر مدخل را سفارشی کنید. از فیلد ،Page Number 9 از منوی
and Number و منوهای Styles برای سفارشی سازی بیشتر مکان و ظاهر شماره صفحات استفاده کنید.

10 مراحل 7 تا 9 را برای هر شیوه موجود در فهرست Include Paragraph Styles تکرار کنید.
11 برای ایجاد خودکار نشانه های پیمایشی که در پنل Adobe Acrobat Reader’s Bookmarks ظاهر 

می شوند، Create PDF Bookmarks را انتخاب کنید.
12 روی OK کلیک کرده و سپس مجدداً روی OK کلیک کنید.

11ـ5 ـ پر کردن متن فهرست مطالب

پس از تعریف شیوه فهرست مطالب، حالا آماده افزودن متن فهرست مطالب به صفحه مطالب در پروژه خود هستید.
برای افزودن فهرست مطالب به سند خود: 

Layout>Table of Contents 1 را انتخاب کنید.
2 شیوه فهرست مطالب خود را از منوی TOC Style انتخاب کنید.

3 روی OK کلیک کنید.
4 برای ایجاد یک فریم متنی پر شده با متن فهرست مطالب، روی آیکن متن بارگذاری شده کلیک کنید 
یا بکشید )شکل 9ـ5( یا روی یک فریم جایبان1 خالی که قبلًا برای درج فهرست مطالب کنار گذاشته شده 

است، کلیک کنید.

شکل 9ـ5 ـ افزودن خودکار متن فهرست مطالب تولید شده به سند

Placeholder ـ1
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12ـ5 ـ به روزرسانی فهرست مطالب

هنگامی که تغییراتی در اسناد InDesign خود می دهید، به خاطر داشته باشید که فهرست مطالبی که قبلًا 
تولید کرده اید، به طور خودکار به روزرسانی نمی شود. تیترهایی که در  فهرست مطالب گنجانده شده اند، ممکن 
است به عنوان بخشی از درخواست های تغییر کارفرما تغییر کرده باشند یا ممکن است پس از اضافه کردن 

مطالب اضافی یا حذف برخی از مطالب، شماره صفحه آن ها تغییر کرده باشد.
برای به روزرسانی فهرست مطالب:

1 با استفاده از ابزار Type، کلیک کنید تا نقطه درج متن جایی در متن فهرست مطالب قرار گیرد.
Layout>Update Table of Contents 2 را انتخاب کنید.

 ـ5 ـ نحوه ایجاد کتاب 13

بسیار  ویژگی   InDesign کنید.  از کجا شروع  را  کتاب  ایجاد  که  باشید  نداشته  تصوری  است هیچ  ممکن 
 File .مفیدی برای ایجاد اسناد طولانی کتاب به شما ارائه می دهد؛ این موارد را فایل های کتاب می نامند
Book مجموعه ای از اسناد )معمولاً فصل ها( است که با هم جمع شده اند. ایجاد یک فایل به جای ایجاد کتاب 

به عنوان یک سند بزرگ InDesign، مزایایی دارد: 
  اول اینکه، می توانید سبک ها را در فصل های File Book به اشتراک بگذارید و توالی شماره صفحه از یک 

فصل به فصل دیگر ادامه خواهد یافت. 
  همچنین وقتی از File Book استفاده میک نید می توانید با سرعت و سهولت بیشتری در کتاب خود تغییراتی 

با  باز کردن یک فایل واحد  ایجاد کنید. به جای 
تعداد زیادی صفحه، می توانید فقط بخش یا فصلی 
باز کنید که این  را که می خواهید ویرایش کنید 
امر پیمایش در کتاب شما را بسیار آسان میک ند.

  File>New>Book به ،File Book برای ایجاد یک
در InDesign بروید. از شما خواسته می شود به 
کتاب نامی دهید و آن را ذخیره کنید. وقتی فایل 
،Book کتاب را ایجاد کردید، از منوی اصلی پنل 

اینجا،  از  کنید.  انتخاب  را   Add Document
می توانید فایل های InDesign را به کتاب اضافه 
هستند  فصل  فایل های  معمول  به طور  که  کنید 

غیره(. و   2 فصل   ،1 فصل  مثال  )به عنوان 

 InDesign برای اطمینان از اینکه متن فهرست مطالب جدیدترین ویرایش است، قبل از تبدیل فایل
به PDF یا پکیج گرفتن از آن برای چاپ، فهرست مطالب را به روزرسانی کنید.

نکته

File Book شکل10ـ5  ـ اضافه کردن سند به
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که  است  مهم  کتاب،  فایل  تنظیم  از  پس 
به درستی  را  خود  کتاب  صفحات  شماره گذاری 
باشد،  این می تواند کمی محرمانه  تنظیم کنید. 
بنابراین بیایید به یک مثال نگاه کنیم. در اینجا، 
می خواهم کتاب خود را تنظیم کنم تا صفحه 1 
از صفحه اول فصل آغازین شروع شود. بنابراین 
من صفحه فصل ابتدایی را انتخاب میک نم )که 
گزینه های  و  است(   13 صفحه  حاضر  حال  در 
از  را   Numbering & Section Options

میک نم. انتخاب  پنل  اصلی  منوی 
در پنجره New Section، شماره صفحه شروع 
را بررسی کرده و آن را با 1 تنظیم کنید. از منوی

Style، قبل از کلیک روی OK،و’...4 ,3 ,2 ,1‘ 
را انتخاب کنید.

 ـ5 ـ انتخاب سبک شماره صفحات شکل 12

Numbering a Section Options شکل11ـ5 ـ انتخاب گزینه
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من می خواهم 12 صفحه اول کتابم با حروف ابجد شماره گذاری شود. برای این کار، من اولین صفحه سند را 
انتخاب میک نم و دوباره Numbering & Section Options را انتخاب میک نم. مانند قبل، شماره صفحه 
شروع را بررسی کرده و آن را با 1 تنظیم میک نم. اما این بار از منوی Style،وArabic Abjad  را انتخاب 

کرده و روی OK کلیک میک نم.

شکل 13ـ5 ـ انتخاب Arabic Abjad برای شماره گذاری صفحات ابتدایی کتاب با حروف

کنید.  اضافه  خود  کتاب  آخر  به صفحات  را  متفاوت  شماره  با  قسمت  یک  بخواهید  است  ممکن  همچنین 
 File Book ،هنگامیک ه شماره های صفحه را به روز میک نید یا صفحات کتاب خود را اضافه یا حذف میک نید

شماره صفحه را در تمام اسناد )فصل ها( به روز میک ند. 

 14ـ5 ـ آماده سازی کتاب برای چاپ

پس از تکمیل جلد و صفحات داخل کتاب، آماده صادر کردن آن برای چاپ هستید. قالب استاندارد فایل آماده 
چاپ برای بیشتر چاپگرها PDF است. در InDesign به File>Export بروید و Adobe PDF (Print) را 
از منوی Format انتخاب کنید. برای اطمینان از اینکه آثار هنری شما با یکفیت بسیار بالایی صادر می شود، 

از گزینه های Preset،وPress Quality را انتخاب کنید. 
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15ـ5 ـ نحوه کار با بخش ها در فصول

شماره گذاری و بخش های صفحه شاید مفیدترین جنبه از ویژگی کتاب در InDesign است که شماره صفحه 
را برای شما ردیابی میک ند و هنگام اضافه کردن صفحات یا حذف آن ها از شماره یا هنگام اضافه کردن سند 
جدیدی بین دو سند دیگر، شماره صفحه را به روز میک ند. البته، این تنها در صورتی جواب می دهد که شماره 
صفحات خودکار را در صفحات سند خود قرار داده باشید. فرض کنید شما قبلًا یک سند 16 صفحه ای در پنل 
کتاب خود داشته اید. وقتی سند دیگری اضافه میک نید، InDesign به طور خودکار شماره صفحه اول سند 
 ،Numbering and Section Options جدید خود را با 17 تنظیم میک ند )به شرطی که در کادر محاوره ای
صفحه اول را به عنوان شروع بخش مشخص نکرده باشید(. اگر بعداً سند اول را باز کنید و دو صفحه به آن 
اضافه کنید، InDesign سند دوم را به طور خودکار تغییر می دهد، دفعه بعدی که آن را باز میک نید، می بینید 
 Numbering and Section Options که از صفحه 19 شروع می شود. از طرف دیگر، اگر از کادر محاوره ای
برای ایجاد شروع بخش استفاده کنید )می توانید با دابل کلیک کردن روی شماره صفحه در صفحه کتاب، 
به سرعت به این ویژگی بروید(، پنل کتاب به آن احترام می گذارد. اسناد بعدی در پنل کتاب شماره گذاری 
صفحه را از جایی که شماره صفحه سند قبلی متوقف شده است ادامه می دهند. اگر از شماره صفحات خودکار 
از  احتمالاً  کرده اید،  کتاب خود مشخص  در  سند  هر  برای  را  دستی  شماره صفحات  یا  نمیک نید  استفاده 
 Book Page شماره گذاری مجدد صفحات کتاب خود خسته خواهید شد. خوشبختانه، می توانید با انتخاب
 Automatically Update Page and و برداشتن علامت Book از منوی پنل Numbering Options

Section Numbers این ویژگی را غیرفعال کنید )به شکل 14ـ5 مراجعه کنید(.
 

Book Page Numbering Options شکل 14ـ5 ـ

جلد و صفحات داخلی خود را به عنوان فایل PDF جداگانه صادر کنید. جلد باید به صورت یک تصویر 
کامل )شامل پشت جلد، روی جلد و عطف( صادر شود، در حالیک ه صفحات داخلی باید به صورت 

صفحات جداگانه صادر شوند )نه اسپرید(.

نکته
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16ـ5 ـ صفحات زوج و فرد

اول فصل 3  را به صفحه  InDesign چه شماره صفحه ای  پایان می رسد،  به  وقتی فصل 2 در صفحه 45 
اختصاص می دهد؟ اگر در کار کتاب هستید، احتمالاً می خواهید فصل 3 از صفحه 47 شروع شود، زیرا این 
یک صفحه دست راست است. ناشران کاتالوگ و مجله می خواهند فصل سوم در صفحه 46 آغاز شود، حتی 
اگر یک صفحه سمت چپ باشد. می توانید با انتخاب Book Page Numbering Options از منوی پنل 
 Continue from :انجام دهد، تعیین کنید. شما سه گزینه دارید InDesign آنچه را که می خواهید ،Book
Previous Document،وContinue on Next Odd Page و Continue on Next Even Page. وقتی 
بین  تا فضای خالی  اضافه میک ند  InDesign یک صفحه  فعال میک نید،  را   Insert blank page گزینه 
 Continue on Next فصل ها را پر کند. به عنوان مثال، اگر فصل 2 در صفحه 45 به پایان برسد و شما
Odd Page را فعال کنید، InDesign یک صفحه خالی را در انتهای فصل 2 اضافه میک ند. این صفحه واقعاً 
 Master خالی است. اگر می خواهید صفحات پشت سر هم بیایند و صفحه خالی نداشته باشید، باید صفحه

خود را اعمال کنید. 

17ـ5 شماره گذاری فصل

دهید  اجازه   InDesign به  می توانید  کنید،  شماره گذاری  خود  کتاب  در  را  سندی  هر  می خواهید  اگر 
شماره گذاری را برای شما با استفاده از شماره های فصل انجام دهد. برای تنظیم شماره گذاری فصل، اولین 
صفحه را در سند انتخاب کنید، سپس Numbering & Section Options را از منوی Layout یا از منوی 
پنل Pages انتخاب کنید. در بخش Document Chapter Numbering در کادر محاوره ای )شکل 15ـ5 
را ببینید(، یک سبک شماره گذاری )مانند regular numerals،وroman numerals یا letters( را انتخاب 
کنید. سپس انتخاب کنید که آیا می خواهید برای این کتاب شماره فصل مشخص کنید یا شماره را از شماره 
فصل سند قبلی در صفحه کتاب قرار می دهید. توجه داشته باشید که حتی اگر یک سند واحد بتواند چندین 

بخش داشته باشد، می تواند فقط یک شماره فصل داشته باشد.

Chapter Numbering شکل 15ـ5 ـ
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پس از تنظیم کادر محاوره ای Numbering & Section Options، می توانید با اضافه کردن متغیر متنی شماره 
فصل، شماره فصل را در یک متن »تایپ« کنید. توجه داشته باشید که وقتی شماره فصل شما تغییر میک ند )به 
 Update All Numbers عنوان مثال، اگر ترتیب اسناد را در صفحه کتاب تنظیم مجدد کنید(، تا زمانی که گزینه
یا Update Chapter & Paragraph Numbers from the Update Numbering را در زیرمنوی منوی پنل 
کتاب انتخاب نکنید، شماره های فصل در اسناد شما به روز نمی شوند. اگر این کار را انجام می دهید و شماره موجود 
روی صفحه مقابل باز هم به روز نمی شود، به یاد داشته باشید که متغیرهای متنی فقط هنگامی تغییر میک نند که 

صفحه نمایش را مجبور به ترسیم دوباره کنید. 

18ـ5 ـ چاپ و صدور کتاب

باید از این فرصت استفاده کرده و مواردی را که مخصوص چاپ، ساخت پکیج یا صدور کتاب است، ذکر کنیم. 
 Book در پنل Modified یا Availableو،Open ابتدا، برای چاپ سند، هر فصل از یک کتاب باید به صورت
فهرست شود. این بدان دلیل است که InDesign به صورت نامرئی هر سندی را در زمان چاپ یا زمان صدور 

باز میک ند )سند را روی صفحه باز نمی بینید، اما باز می شود(. 
دوم، اگر فقط می خواهید اسناد خاصی در یک کتاب چاپ یا صادر شود، آن ها را در صفحه Book انتخاب 
کنید. به یاد داشته باشید که می توانید با نگه داشتن کلید Shift، اسناد مجاور را در لیست و اسناد ناپیوسته 
را با Ctrl انتخاب کنید. اگر هیچ سندی انتخاب نشده باشد، همه آن ها چاپ می شوند )برای لغو انتخاب همه 

اسناد، روی قسمت خالی پایین پنل کلیک کنید(. 
یا   Print Book یا  کنید  کلیک   Book پنل  در   Print Book دکمه  روی  هستید،  چاپ  آماده  وقتی 
محاوره ای  کادر  در  که  تنظیماتی  کنید.  انتخاب  پنل  منوی  از  را   (Print Selected Documents)

می شود.         اعمال  کتاب  در  سندی  هر  برای  میک نید،  انتخاب   Print
با انتخاب Export Book to PDF یا Export Selected Documents to PDF از منوی پنل، می توانید 
 Create Acrobat کادر PDF صادر کنید. اگر هنگام صدور Acrobat PDF کتاب خود را به عنوان فایل
Layers در حالت تأیید باشد، InDesign تمام لایه هایی را که نام یکسان دارند، در یک لایه PDF واحد 
ادغام میک ند. با وجود این، اگر ابتدا Merge Identically Name Layers on Export را از منوی پنل 

کتاب غیرفعال کنید، PDF شامل لایه های جداگانه برای هر سند خواهد بود. 
به همین ترتیب، برای ساخت پکیج از تمام اسناد موجود در کتاب، به علاوه فونت های موردنیاز و تصاویر 
متصل، می توانید از منوی پنل، Package Book for Print را انتخاب کنید. هنگامی که پکیج یک کتاب 
ساخته شد، تمام تصاویر متصل در یک پوشه Links کپی می شوند. اگرچه در اسناد شما تصاویری قرار داده 
شده باشند که متفاوت هستند ولی نام آن ها یکسان است، InDesign به اندازه کافی هوشمند است که به طور 

خودکار نام آن ها را تغییر  دهد.

 19ـ5 ـ انتخاب و ایجاد رنگ های جدید

پنل Color را باز کنید )به Window>Color>Color بروید یا F6 را فشار دهید( و روی نمونه رنگ در 
گوشه سمت چپ بالای پنل کلیک کنید تا کادر محاوره ای Color Picker باز شود. صبر کنید، قبل از اینکه 
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 Color بروید، نکته ظریفی وجود دارد، روی نوار طیف رنگ در پایین پنل Color Picker به کادر محاوره ای
شیفت کلیک کنید تا از بین RGB،وCMYK و Lab دست به انتخاب بزنید. هنگامیک ه حالت رنگ موردنظر 
خود را برگزیدید، کادر محاوره ای Color Picker را باز کنید تا بتوانید از فضای رنگ ارائه شده دست به 

انتخاب بزنید .

برای CMYK، باز هم RGB Color Space View را در بالای این کادر محاوره ای خواهید دید، ولی 
خواهید دید که یکی از دکمه ها Add CMYK Swatch است.

توجه

حالا از یکی از دو روش ذیل برای ایجاد رنگ جدید استفاده کنید:
  روی علامت به علاوه در فیلد رنگ کلیک کرده و آن را به مکان جدیدی بکشید. مقادیر رنگ تعریف شده 

در فیلدهای RGB،وCMYK،وLab و Hex نشان داده خواهد شد.
  مثلث های اسلایدر را در هر یک از سمت های طیف رنگ به بالا و پایین بکشید تا ته رنگِ رنگ منتخب را تغییر دهید.

  به طور دستی مقادیر را در هر یک از فیلدهای مقدار رنگ )RGB،وCMYK یا Lab( وارد کنید.

شکل 16ـ5 ـ انتخاب و ایجاد رنگ های جدید

 Add CMYK Swatchو،Add RGB Swatch برای ذخیره کردن رنگ جدید به عنوان یک نمونه رنگ، روی
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یا Add Lab Swatch در کادر محاوره ای Color Picker کلیک کنید. دکمه ای که در دسترس است وابسته 
به این مسأله است که فیلدهای مقدار رنگ در حال حاضر در کادر محاوره ای Color Picker انتخاب شده اند 
 InDesign را خواهید دید. سپس Add RGB Swatch ،کلیک کنید RGB مثلًا، اگر روی یکی از فیلدهای

رنگ جدید را به پنل Swatches شما با مقادیر رنگ به عنوان نام آن اضافه میک ند. روی OK کلیک کنید.

Swatches 20ـ5 ـ یافتن پنل

پنل Swatches جایی است که رنگ های سند ما فعال هستند. کافی است آن را بیابید: بیشتر پنل ها در 
قسمت منوی Window قرار دارند و این هم استثنا نیست. برای باز شدن پنل Swatches کافی است به 
تا آن را به هر یک  باز شدن، می توانید آن را شناور کنید  از  Window>Color>Swatches بروید. پس 
از پنل های باز دیگر متصل کنید. پنل Swatches به شما اجازه خواهد داد رنگ ها را به خط دور و زمینه 
کانتینرها )فریم ها و شکل ها( و متن نسبت دهید. هم چنین می توانید ته رنگ را برای هر رنگ تنظیم کنید.

Swatches شکل 17ـ5 ـ پنل

21ـ5 ـ اعمال سریع رنگ  زمینه یا خط دور

در پنل Swatches یا در هر پنلی که می توانید رنگی را انتخاب کنید، دو آیکن نمونه رنگ وجود دارد که 
آیکن  است.  توپری  مربع  و  بالاست  نمونه رنگ سمت چپ   ،Fill آیکن  نشان می دهند.  را   Stroke و   Fill
Stroke نمونه رنگ سمت راست پایین است و شبیه یک قاب خالی است. آیکنی که در جلو قرار دارد، نشان 
می دهد رنگ آن کجا بر متن یا شیء منتخب اعمال خواهد شد )یعنی، آیا بر زمینه اعمال خواهد شد یا خط 
دور(. روی آیکن back to bring کلیک کنید تا به جلو بیاید. می توانید با کلیک کردن روی آیکن برعکس 
)فلش خمیده دوسر( رنگ های Fill و Stroke را با هم عوض کنید. برای هر یک، کادر سفیدی با یک خط 
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قرمز ضربدری به این معنی است که زمینه یا خط دوری وجود ندارد. دو روش سریع برای اعمال زمینه یا 
خط دور بر یک شیء وجود دارد. اول اینکه، شیء یا متنی را که می خواهید رنگ بر آن اعمال شود، انتخاب 
کنید، روی آیکن Fill و Stroke کلیک کنید و سپس روی نمونه رنگ موردنظر خود برای اعمال کلیک کنید. 
InDesign سابقه رنگ توپر اخیراً استفاده شده، زمینه فعلی یا آخرین گرادیان مورد استفاده را نگه می دارد، 
بنابراین می توانید از میانبری برای اعمال سریع آخرین رنگ مورد استفاده بر شیء بعدی استفاده کنید. کافی 
است کلید ویرگول را فشار دهید تا رنگ زمینه یا خط دوری که اخیراً استفاده شده اند بر آنچه که هم اکنون 

در سند شما انتخاب شده است، اعمال شوند

مطمئن شوید که آیکن نمونه رنگ Fill قبل از استفاده از این میانبر انتخاب شده است، البته چنانچه 
زمینه را اعمال میک نید یا چنانچه خط دور را اعمال میک نید، آیکن Stroke انتخاب شده باشد.

توجه

شکل 18ـ5 ـ اعمال رنگ خط دور و زمینه

 ـ5 ـ اعمال پروفایل ها بر تصاویر 22

می توانید پروفایل های مناسب را هنگام ورود تصاویر بر آن ها اعمال کنید. هنگام قرار دادن تصویر گرافیکی 
 Show Import Optionsو،)Ctrl+D یا فشردن File>Placeا( Place در کادر محاوره ای InDesign در
را انتخاب کنید. در کادر محاوره ای Image Import Options به پیشخوان Color رفته و پروفایل مناسب 

را از منوی Profile انتخاب کنید.
می توانید با انتخاب یک تصویر قرار گرفته و انتخاب Object>Image Color Settings پروفایلی را بر آن 
اعمال کنید یا آن را تغییر دهید. با انجام این کار، کادر محاوره ای Image Color Settings باز می شود و در 
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آن می توانید پروفایل جدید را از طریق منوی Profile اعمال کنید )هم چنین می توانید برای باز کردن کادر 
محاوره ای Image Color Settings،وGraphics>Image Color Settings را از منوی زمینه انتخاب کنید(.
هنگام باز کردن یک سند، InDesign تمام تصاویر وارد شده در آن سند را بررسی میک ند تا ببیند آیا در آن 

پروفایل مدیریت رنگ تعبیه یا به کار گرفته شده است.
برمبنای تنظیمات تعریف شده در کادر محاوره ای Color Settingsو(Edit>Color Settings) را انتخاب 
کنید(، ممکن است پروفایل های پیش فرض را بر آن ها اعمال کنید، چنانچه پروفایلی برای آن ها تنظیم نشده 
باشد یا از شما سؤال می شود که چه کاری می خواهید انجام دهید. اگر هیچ پروفایل رنگ تعبیه شده ای در 
 Color Settings در کادر محاوره ای Ask When Opening سند وجود نداشته باشد و اگر کادر انتخاب
در حالت تأیید باشد، هنگام باز کردن سند، کادر محاوره ای Missing Profile نمایان می شود. هنگام باز 
کردن سند، ممکن است دو کادر محاوره ای این چنینی دریافت کنید، یکی برای پروفایل RGB و یکی برای 
پروفایل CMYK، بسته به اینکه چه چیزی در تصاویر سند تعبیه شده است.انتخاب های شما به این صورت 

خواهد بود:
  Leave as Is (Use Current Working Space). این گزینه از پروفایل پیش فرض سند برای تصویر 

استفاده میک ند، ولی آن پروفایل را در تصویر تعبیه نمیک ند.
  Assign Current Working Space. این گزینه پروفایل پیش فرض سند را بر تصویر اعمال میک ند، 

آن پروفایل را در تصویر تعبیه میک ند، بنابراین حتی اگر پروفایل پیش فرض سند بعداً تغییر کند، پروفایل 
تصویر تغییر نمیک ند.

  Assign Profile. این گزینه به شما اجازه انتخاب پروفایل مناسب را برای تعبیه شدن در این تصویر 

از منوی بازشو در سمت راست می دهد. از این گزینه هنگامی استفاده می شود که دلیل خاصی برای عدم 
استفاده از پروفایل پیش فرض سند داشته باشید.

از هر کدام از روش ها که برای اعمال پروفایل ها استفاده کنید، فقط پروفایل های مناسب برای نوع تصویر در 
این ها دستگاه های خروجی  CMYK )معمولاً،  بازشو نمایان می شود. مثلًا، فقط پروفایل های  این منوهای 
هستند( برای یک فایل CMYK TIFF نمایان می شود، حتی اگر تصویر با استفاده از اسکنر RGB اسکن 
که  دارد  وجود  دلیل  این  به  محدودیت  این  باشد.  شده  تبدیل   CMYK به   Photoshop با  بعداً  و  شده 
InDesign فرض میک ند تصویر برای خروجی آن چاپگر خاص طراحی شده است و بنابراین، آن را با آن 
مقصد کالیبره میک ند. برای فایل های RGB،وInDesign به شما اجازه می دهد پروفایل های مانیتورمحور و 

پروفایل های اسکنرمحور را بهک ار گیرد.
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  مفهوم مدل های رنگ RGB و CMYK را بیان کند.

  مفهوم پروفایل رنگ را بیان کند.

  نحوه تنظیم شدت رنگ را بداند.

  پنل های Color و Swatch را بهک ار گیرد.

  یک شیب رنگ ایجاد کند.

  جوهرهای تریکبی را ایجاد کند.

  ویژگی خط دور را تغییر دهد.

 كليات

برآورده ساختن  برای  به عنوان قدرت فوق العاده ای  رنگ و جلوه ها همان چیزی است که طراحان گرافیک 
درخواست های مشتریان می شناسند. توانایی استفاده از رنگ و جلوه ها در واقع شما را از حرکت بین برنامه های 
Swatches و  از پنل های  با استفاده  آثار هنری و محتوای خیرهک ننده نجات می دهد.  ایجاد  برای  مختلف 
Color می توانید تمام رنگ های موجود در پروژه های خود را کنترل کنید. البته، این رنگ می تواند بر فریم ها، 
زمینه ها، متن ها، خطوط دور، گرادیان ها،  هایلایت ها یا موارد دیگر اعمال شود. شما می توانید چندین نمونه را 
به صورت دستی یا با استخراج رنگ از تصاویر قرار داده شده ایجاد کرده و در کتابخانه های CC خود ذخیره کنید.

زمان آموزش

عملینظری

49
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RGB و CMYK 1ـ6 ـ مفهوم مدل های رنگ 

مقایسه روش های مختلف تولید رنگ برای مواد وب و چاپی مفید است. دو نوع تریکب رنگ را در نظر بگیرید. 
رنگ افزودنی فرایند ایجاد رنگ با مخلوط کردن روشنی دو یا چند رنگ است. قرمز، سبز و آبی، رنگ های 
اصلی هستند که در سیستم رنگ افزودنی برای نمایش رنگ ها در صفحه رایانه استفاده می شوند. هر چه 
شدت روشنی بیشتری اضافه ک نید، رنگ حاصل روشن تر می شود. این امر نشان می دهد که چگونه رنگ ها 
در طراحی وب نمایش داده می شوند. رنگ افتراقی فرایند ایجاد رنگ با مخلوط جوهر دو یا چند رنگ است. 
جوهرها و یا رنگدانه های فیروزه ای، بنفش، زرد و سیاه روی کاغذ لایه بندی می شوند. هرچه جوهر بیشتری 

اعمال کنید، رنگ حاصل تیره تر می شود. این توصیف نحوه چاپ رنگ است.
معمولاً اسناد چاپی را با استفاده از حالت رنگ CMYK، نه RGB ایجاد میک نید. اما اگر عکس ها را در 
Pho toshop با استفاده از حالت رنگ RGB ویرایش کرده باشید، تصاویر حاوی آرایه وسیع تری از مقادیر 
رنگ نسبت به CMYK خواهند بود. همواره برای تأیید مطالب با لیتوگرافی خود تماس بگیرید. اگر لیتوگرافی 
از RGB پشتیبانی میک ند، ممکن است توصیه هایی را برای تنظیم تصاویر قرار داده شده به RGB ارائه کند، 
زیرا تصاویر نقش بیتی با جزئیات رنگ بیشتری چاپ می شوند. هنگام پر کردن یک فضای توپر با رنگ سیاه 
)مانند یک مستطیل پر از سیاه(، از سیاه تیره استفاده کنید که تریکبی از رنگ های CMYK است که روی 
یکدیگر قرار دارند. این مقادیر به طور معمول با C=60،وM=40،وY=40 و K=100 تنظیم می شوند، هرچند 

این مقادیر را می توان برای ایجاد یک رنگ گرم تر )قرمزتر( یا سردتر )آبی تر( تغییر داد. 
اگر فقط از K=100 استفاده کنید، ناحیه سیاه بزرگ به هنگام چاپ، به ویژه در مقایسه با رنگ های دیگر 
تولید شده در چندین فرایند مقادیر رنگ، کمی خاکستری دیده می شود. برای مواردی که در مطبوعات افست 
منتشر می شوند، از لیتوگرافی خود بخواهید که چه مقادیری را برای محصولات مشکی تیره توصیه میک ند. 

برای چاپ دیجیتال مبتنی بر تونر، مشکی تیره لازم نیست.

2ـ6 ـ مفهوم پروفایل رنگ

سازوکاری که سیستم مدیریت رنگ )CMS( برای انجام کالیبراسیون از آن استفاده میک ند، پروفایلی است 
که شامل اطلاعات مربوط به مدل های رنگی و طیف های پشتیبانی شده توسط یک خالق خاص )مانند برنامه 
تصویرگری یا اسکنر(، صفحه نمایش و چاپگر است. InDesign ده ها پروفایل از پیش تعریف شده را شامل 
می شود. CMS از یک فضای رنگی مستقل از دستگاه برای تطبیق این پروفایل ها با یکدیگر استفاده میک ند. 
فضای رنگی یک روش ریاضی برای توصیف روابط بین رنگ ها است. با استفاده از یک مدل رنگی مستقل از 
دستگاه )استاندارد CIE XYZ که توسط کمیسیون بین المللی روشنایی تعریف شده است(، CMS می تواند 
طیف وسیعی از مدل های دیگر وابسته به دستگاه مانند RGB و سایر مدل ها را مقایسه کند. معنی این امر 
این است که CMS می تواند رنگ های موجود در تصاویر وارد شده و رنگ های تعریف شده شما را بررسی 
کند، آن ها را با قابلیت های مانیتور و چاپگر مقایسه کند و رنگ ها را برای نزدیک ترین نمایشگر و چاپ ممکن 

تنظیم کند.
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3ـ6 ـ جوهرهای تریکبی

از نظر فنی‪  مبحث رنگ به طور کلی و موضوع رنگ در گرافیک رایانه ای و تصاویر دیجیتال به طور خاص، 
مبحثی پیچیده و مفصل است. پرداختن به تمام جوانب تکنیکی آن در اینجا عملی نیست. به ناچار در این 

‬بخش، تنها به آن مواردی اشاره خواهیم کرد که برای هنرجویان از نظرِ کاربردی مفید است.
رنگ موضعی جوهر ویژه از قبل تریکب شده است که به جای جوهرهای پردازشی CMYK یا علاوه بر آن 
استفاده می شود. هر رنگ موضعی به پلیت چاپ مخصوص خود در یک ماشین چاپ نیاز دارد، بنابراین وقتی 
رنگ های کمی مشخص شده و دقت رنگ بسیار مهم است از رنگ موضعی استفاده می شود. جوهرهای رنگی 
موضعی می توانند رنگ های خارج از طیف رنگ های پردازشی را با دقت تولید کنند. با این حال، شکل دقیق 
رنگ موضعی چاپی با تریکبی از مرکب که توسط چاپگر تجاری و کاغذی که روی آن چاپ شده، تعیین 

می شود و نه با توجه به مقادیر رنگی که شما تعیین کرده اید و یا با مدیریت رنگ.
رنگ پردازشی با استفاده از تریکبی از چهار جوهر پردازشی استاندارد چاپ می شود: فیروزه ای، بنفش، زرد 
و سیاه )CMYK(. از رنگ های پردازشی در مواقعی استفاده کنید که کار به تعداد زیادی رنگ نیاز دارد و 

استفاده از جوهرهای موضعی جداگانه، گران یا غیرعملی خواهد بود، مانند چاپ عکس های رنگی.
مقادیر  از  استفاده  با  را  پردازشی  رنگ های  بالا،  یکفیت  با  شده  چاپ  سند  یک  در  نتیجه  بهترین  برای    

CMYK چاپ شده در نمودارهای مرجع رنگ پردازشی، مانند موارد موجود در چاپگر تجاری، مشخص کنید. 
  مقادیر نهایی رنگ پردازشی، مقادیر آن در CMYK است، بنابراین اگر با استفاده از RGB رنگ پردازشی 

را تعیین کنید، هنگام چاپ، آن مقادیر رنگ به CMYK تبدیل می شوند. این تبدیل ها براساس تنظیمات 
مدیریت رنگ و پروفایل سند شما متفاوت هستند.

  رنگ پردازشی را بر اساس شکل ظاهری آن روی مانیتور مشخص نکنید، مگر اینکه مطمئن باشید سیستم 

مدیریت رنگ را به درستی تنظیم کرده اید و محدودیت های آن را برای پیش نمایش رنگ درک نکرده اید. 
  از بهک ارگیری رنگ های پردازشی در اسنادی که برای مشاهده روی صفحه در نظر گرفته شده خودداری 

کنید زیرا طیف رنگ CMYK نسبت به صفحه نمایش معمول کوچک تر است.
بعضی اوقات استفاده از مرکب های پردازشی و موضعی در یک کار عملی است. به عنوان مثال، ممکن است 
از یک جوهر موضعی برای چاپ دقیق رنگ آرم شرکت در همان صفحات گزارش سالانه استفاده کنید که 
در آن عکس ها با استفاده از رنگ پردازشی تولید می شوند. شما همچنین می توانید از یک پلیت چاپ رنگی 
برای استفاده از روغن جلا در نواحی کار رنگ پردازشی استفاده کنید. در هر دو مورد، در کار چاپ شما از 

پنج جوهر استفاده می شود )چهار جوهر پردازشی و یک جوهر موضعی یا روغن جلا(. 
کلی،  به طور  میک ند.  ایجاد  چاپ  برای  اضافی  موضعی  چاپی  پلیت  میک نید  ایجاد  که  موضعی  رنگ  هر 
چاپگرهای تجاری یا کاری دو رنگ )با استفاده از سیاه و یک رنگ( و یا چهار رنگ CMYK تولید میک نند، 
البته، با امکان افزودن یک یا چند رنگ موضعی. استفاده از رنگ های موضعی معمولاً هزینه چاپ را افزایش 

می دهد. بهتر است قبل از استفاده از رنگ های موضعی در یک سند، با چاپچی خود مشورت کنید. 



واحد کار  ششم: مدیریت رنگ و زمینه

8 5

4ـ6 ـ شدت رنگ

ایجاد شدت رنگ )درصدی از رنگ اصلی( بسیار ساده است. رنگ مدنظر خودتان را در پنل Swatch انتخاب 
کرده و سپس روی فلش سمت راست فیلد Tint در بالای پنل کلیک کنید تا اسلایدری باز شود. اسلایدر را 
از 100 درصد به تعداد کمتری حرکت دهید تا شدتی از رنگ منتخب ایجاد شود. برای جلوگیری از افت این 
شدت )به این دلیل که ممکن است برای استفاده از رنگ اصلی مجدداً اسلایدر را به 100 درصد بکشید(، باید 
آن را به عنوان نمونه خاص خود ذخیره کنید. هنگامیک ه اسلایدر Tint در درصد موردنیاز شما قرار گرفت، 
نمونه  به عنوان  را  Swatches کلیک کرده و شدت رنگ جدید  پایین پنل  New Swatch در  روی آیکن 
رنگی کاملًا جدید و مجزا ذخیره کنید. مشکل اینجا این است که این نمونه از شدت رنگ به نمونه رنگ اصلی 
متصل است، بنابراین اگر رنگ نمونه اصلی را تغییر دهید، شدت رنگ براساس آن رنگ جدید تنظیم خواهد 
شد و اگر رنگ اصلی را حذف کنید، شدت رنگ نیز حذف خواهد شد. برای جلوگیری از چنین اتفاقی، روی 
نمونه شدت رنگ کلیک راست کرده و New Color Swatch را انتخاب کنید. مطمئن شوید که همه موارد 
در کادر محاوره ای New Color Swatch خوب هستند و بعد روی OK کلیک کنید. این امر موجب ایجاد 
نمونه رنگ مستقل جدیدی با مقادیر رنگ از شدت رنگ می شود، به این معنی که اگر نمونه اصلی را تغییر 

دهید یا حذف کنید، این نمونه شدت رنگ مستقل تحت تأثیر قرار نخواهد گرفت.

شکل 1ـ6 ـ شدت رنگ

5ـ6 ـ شیب رنگ

به  رفتن  با  قرار دهید. می توانید  یکدیگر  کنار  را  آن ها  و  کنید  باز  را   Gradient و   Swatches پنل های 
Window>Color>Gradient به پنل Gradient بروید یا روی ابزار Gradient Swatch در نوار ابزار 
به صورت  کنید. شیب خطی  انتخاب  را   Radial یا   Linearو،Type بازشوی  منوی  از  کنید.  کلیک  دابل 
خطی از یک سمت به سمت دیگر شیء جابه جا می شود. شیب شعاعی از مرکز شیء شروع شده و از تیره 
به روشن تبدیل می شود یا برعکس شیب پیش فرض، سیاه به سفید است )ممکن است آخرین شیب ایجاد 
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شده خود را نیز ببینید(. ولی می توانید هر رنگ دلخواه خود را هم انتخاب کنید. برای انجام آسان این کار، 
روی نمونه شیب در پنل Gradient کلیک کنید تا توقف های رنگی در زیر نوار شیب در پایین پنل فعال 
Swatches کلیک کرده و آن را به یکی از توقف های  شود. سپس روی اولین رنگ انتخابی خود از پنل 
رنگی در پنل Gradient بکشید. هنگامیک ه آماده انداختن رنگ شدید، علامت + کوچکی را خواهید دید 
که به  شما اجازه می  دهد که از جایگزینی رنگ مطلع شوید. اگر آن را ندیدید، بدان معنی است که رنگ 

جدید را به محل های موجود اضافه کرده اید. همین کار را برای رنگ دوم انجام دهید.

هنگامیک ه از شیب ها خاطر جمع تر شدید می توانید بیش از دو رنگ را به نوار شیب اضافه کنید.
توجه

 حالا می توانید توقف های رنگ را در سراسر نوار شیب به صورت اسلایدی جابه جا کنید تا تأثیر تغییر 
شیب را ببینید. هم چنین می توانید برای جابه جا کردن رنگ ها روی آیکن Reverse کلیک کنید.

شکل 2ـ6 ـ شیب رنگ
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6ـ6 ـ اعمال شیب جدید بر شیء

کنید.  اعمال  هر شیئی  بر  را  آن  به سادگی  می توانید  حالا  کردید،  ایجاد  را  قبل شیب جدیدی  قسمت  در 
از  اعمال کنید(  را  به محلی که می خواهید شیب  )بسته  را   Stroke یا   Fill و  انتخاب کرده  را  شیء خود 
نوار ابزار انتخاب کنید و روی نمونه شیب رنگ در پنل Gradient کلیک کنید. آیا می خواهید از این شیب 
استفاده کنید؟ با کلیک راست روی نمونه در پنل Gradient و انتخاب Add to Swatches یا با  مجدداً 
کشیدن نمونه از پنل Gradient به پنل Swatches، آن را به پنل Swatch اضافه کنید. هنگامیک ه در پنل 
Swatches قرار گرفت، می توانید با کلیک روی آن و انتخاب آن، نامی به آن بدهید و سپس مجدد روی آن 

کلیک کنید تا فیلد نام آن فعال شود.

استفاده از میانبر صفحه کلید برای اعمال یک شیب
نکته

ما فقط شیب را بر یک شیء اعمال کردیم. حالا اجازه دهید همان شیب را با انتخاب شیئی جدید، بر آن شیء 
اعمال کنیم. Fill یا Stroke را از نوار ابزار انتخاب کرده و کلید نقطه ).( را فشار دهید. این امر موجب اعمال 

شیء تنظیم شده جاری در پنل Gradient بر شیء منتخب می شود.

شکل 3ـ6 ـ اعمال شیب جدید بر شیء
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  جداول و تنظيمات آن را بسازد.

  نوشته هاي درون يك جدول را ویرایش کند.

  رنگ زمينه و خط دور را به خانه هاي جدول اضافه کند.

  سبك را در جدول بهک ار گیرد.

كليات

روش‌های متعددی برای دستیابی به گزینه‌های جدولی مختلف وجود دارد که در این واحدکار مورد بحث قرار 
می‌دهیم، بنابراین بر روش‌ها، منوها و پنل‌هایی تمرکز خواهیم کرد که بیشتر مورد استفاده قرار می‌گیرند. 
یکی از مزایای متعدد ایجاد جداول در InDesign این است که می‌توانید به روش‌های متعددی، سبک‌ها را 
بر محتوای خود اعمال کنید. کار با جداول در InDesign بسیار جالب است و به شما اجازه می‌دهد داده‌ها 
را از Excel هم وارد کنید. اصولاً، هر داده جدولی که در یک سند InDesign نیاز دارید، می‌توانند وارد و 

سبک‌گذاری شوند.

زمان آموزش

عملینظری

410
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1ـ7ـ ایجاد جدول

همه ما یک جدول خوب را دوست داریم. در واقع، منوی کاملی در InDesign فقط برای جداول وجود دارد. 
 Table>Insert Table برای قرار دادن سریع یک جدول پایه با سبک بندی پیش فرض در سند خود، به
بروید. یک کادر محاوره ای به شما نشان داده می شود که می توانید تعداد ستون ها و ردیف های موردنظر خود 
را انتخاب کنید و اینکه آیا می خواهید ردیف های سرستون یا پانویس داشته باشید یا خیر. هم چنین فرصت 
بارگذاری شود.  با جدول  تا مکان نمای شما  OK کلیک کنید  دارید. روی  را  اعمال هرگونه سبک جدولی 
حالا جایی در سند خود کلیک کنید و جدول را قرار دهید. به محض قرار گرفتن، می توانید با کلیک کردن 
و کشیدن هر یک از نقاط در فریم آن به سمت داخل یا بیرون، اندازه آن را تغییر دهید. فونت پیش فرض 

هنگامی استفاده خواهد شد که شروع به تایپ کردن در جدول میک نید.

Create Table شکل 1ـ7ـ کادر محاوره ای

جدولی درون جدولی دیگر
شما حتی می توانید جدولی را در خانه ای در یک جدول ایجاد کنید. کافی است درون خانه ای کلیک 

کرده و سپس به Table>Insert Table بروید، ابعاد خود را انتخاب کرده و روی OK کلیک کنید.

نکته

2ـ7ـ اضافه کردن جدول در یک فریم متنی

و  ستون ها  تعداد  بروید.   Table>Insert Table به  سپس  و  کنید  رسم  خود  صفحه  در  متنی  فریم  یک 
پانویس داشته  یا  آیا می خواهید ردیف های سرستون  سطرهای موردنظر خود را وارد کنید، مشخص کنید 
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باشید یا خیر و روی OK کلیک کنید. جدول به طور خودکار خودش را به فریم متنی اضافه میک ند. در مثال 
 1pt شکل 2ـ7، رنگ خط دور سرخابی را به فریم متنی می دهیم تا برجسته شود و جدول دارای خط دور

مشکی پیش فرض است که می توان آن را پس از قرار گرفتن در فریم متنی تغییر داد.

شکل 2ـ7ـ کادر محاوره ای Insert Table و افزودن جدول 

3ـ7ـ تبدیل متن به جدول

ممکن است هم اکنون مقداری متن به شکلی داشته باشید که ما به آن »متن جدا شده با Tab« یا »متن جدا 
شده با ویرگول« می گوییم و اغلب در فایلی با نوع CSV ذخیره شده است. این مورد زمانی اتفاق می افتد که 
ستون هایی از داده ها دارید که با کاراکترهای Tab یا ویرگول از هم جدا شده باشند و ردیف های داده ای که 
با نشانه پاراگراف جدا شده اند. این متن را در یک فریم متنی الصاق کرده و سپس کل متن را متمایز کنید. 
به Table>Convert Text to Table بروید و از منوی Column Seperator برای مشخص کردن  اینکه 
داده های ستونی شما با Tab، ویرگول یا نشانه های پاراگراف جدا شده اند، استفاده کنید. سپس، مشخص کنید 
که آیا داده های ردیفی شما در یک جدول پایه آشفته سازمان دهی شود )مگر اینکه بخواهید از سبک جدولی 
خاص استفاده کنید که می توانید از این کادر محاوره ای قبل از کلیک کردن OK استفاده کنید(. در مثال 

شکل 3ـ7، داده های ستونی من با ویرگول و داده های ردیفی من با نشانه های پاراگراف از هم جدا شده اند.
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شکل 3ـ7ـ تبدیل متن به جدول

4ـ7ـ اعمال کردن رنگ زمینه به یک خانه

اجازه دهید تعدادی از خانه ها را رنگی کنیم. به عنوان مثال، از روش بسیار پایه ای برای ایجاد یک خانه رنگی 
واحد استفاده خواهیم کرد. خانه مدنظر برای افزودن رنگ را متمایز کنید و به هر پنلی بروید که نمونه رنگی 
آنجا پیدا می شود )من علاقه دارم از پنل Swatches استفاده کنم، ولی شما می توانید رنگی را به خانه از 
Control Panel، پنل Properties یا نوار ابزار اعمال کنید(. مطمئن شوید که Fill را تنظیم میک نید )آیکن 
مربع کوچک(، نه Type )آیکن T کوچک(، رنگ خود را انتخاب کنید و خانه واحدی را رنگی کنید. این یک 
روش سریع و واقعاً پایه ای برای اعمال رنگ بر خانه است. سپس، نحوه افزودن یک زمینه رنگی به چندین 

خانه را بررسی کنید.

Swatches شکل 4ـ7ـ اعمال رنگ زمینه به یک خانه از طریق پنل
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5ـ7ـ ویرایش خط دور و زمینه خانه های جدول

یک  طریق  از  را  جدول  خانه  زمینه های  و  دور  خطوط  می توان  چگونه  که  کنیم  بررسی  دهید  اجازه 
و  کنید  انتخاب  تغییر،  برای  را  نظر خود  مورد  خانه های  کرد.  ویرایش  به سرعت  واحد  محاوره ای  کادر 
Table>Cell Options>Strokes and Fills بروید. در کادر محاوره ای که باز می شود، می توانید  به 
تغییراتی در جدول خود بدهید. در این کادر محاوره ای می توانید ضخامت خط دور، رنگ خط دور، رنگ 

تنظیم کنید. را  موارد دیگری  و  نوع خط  زمینه، 

Cell Options شکل 5ـ7ـ کادر محاوره ای

6 ـ7ـ ایجاد سبک جدول پایه

اگر قصد دارید چندین جدول را با فرمت بندی یکسان در سند خود قرار دهید و نمی خواهید در هر بار و 
برای هر جدول وقتی را صرف فرمت بندی کنید، کافی است یک سبک جدول را ایجاد کنید. در این روش 
می توانید هنگام ایجاد جدول جدید، سبکی را انتخاب کنید تا فرمت بندی صحیح به طور خودکار اعمال شود. 
برای ایجاد یک سبک جدول جدید، به Window>Styles>Table Styles بروید تا پنل Table Styles باز 
 New را انتخاب کنید. در کادر محاوره ای New Table Style شود. سپس، روی منوی پنل کلیک کرده و
Table Style، می توانید گزینه های فرمت بندی موردنیاز را اضافه کنید. روی برگه های سمت چپ پنل کلیک 
کنید تا به انواع گزینه ها دسترسی پیدا کنید: General )سبک های خانه ای که ممکن است هم اکنون داشته 
 Column Strokes شامل الگوهای خط دور ردیف(؛( Row Strokes ؛)حاشیه ها( Table Setup ؛)باشید
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)شامل الگوهای خط دور ستون(؛ و Fills )شامل نیازمندی های رنگ(. هنگامیک ه فرمت بندی دلخواه خود را 
تنظیم کردید، نامی به سبک داده و روی OK کلیک کنید. حالا سبک در پنل Table Styles در دسترس 
خواهد بود. می توانید با انتخاب جدول و کلیک کردن روی نام سبک در پنل Table Styles، آن سبک را بر 
 Table جدول موجود اعمال کنید. یا اگر جدول جدیدی را ایجاد میک نید، می توانید سبک را از منوی بازشوی

Styles در کادر محاوره ای Create Table انتخاب کنید.

شکل 6ـ7ـ دادن سبک به جدول
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هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  نحوه ایجاد یک فایل Interactive را بداند.

  Hyperlink را بهک‌ارگیرد.

  Animation را بهک‌ارگیرد.

  Transition را بهک‌ارگیرد.

  دکمه و فرم را بسازد.

  از فایل‌های Interactive خروجی بگیرد.

کلیات

اگر در اینترنت چرخی زده باشید، قطعاً مفهوم‌ هایپرلینک‌ها را می‌دانید. هر بار که روی یک تگ a )مربوط به 
یک دکمه یا متن( کلیک کرده‌اید، به مکان جدید فرستاده شده‌اید و یک مقصد‌ هایپرلینک را تجربه کرده‌اید.‌ 
هایپرلینک‌ها دارای دو بخش هستند: منبع و مقصد. در InDesign، منبع شما می‌تواند متن، فریم متنی، 
تصویر، شیء، عناصر تعاملی و فریم‌های شیء باشند. مقصد برای‌ هایپرلینک‌ها می‌تواند یک URL، اجرای یک 
برنامه ایمیل پیش‌فرض، صفحه‌ای در یک سند، لنگری موجود در یک سند و لینک‌هایی به اسناد داخلی باشد.

همانگونه که می‌بینید، برای‌ هایپرلینک‌های InDesign کارهای بیشتری باید غیر از باز کردن صفحات وب 
انجام دهید. در این واحدکار، بررسی میک‌نیم چگونه‌ هایپرلینک‌ها از منابع مختلف ایجاد می‌شوند و چگونه 

آن‌ها را برای مقاصد مختلف تنظیم کنیم.

زمان آموزش

عملینظری

410
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همانگونه که در ادامه بحث خواهیم کرد، هنگام صدور اسناد PDF تعاملی، باید از ایجاد‌ هایپرلینک‌ها 
 Acrobat از ابزارهای ،PDF خودداری کنیم. برای ایجاد تمام‌ هایپرلینک‌ها در فایل‌های InDesign در

استفاده می‌شود.

نکته

1ـ8 ـ شناخت برخی از اصول‌ هایپرلینک‌ها

 هایپرلینک‌های InDesign می‌توانند به URLها، فایل‌های خارجی، کلاینت‌های ایمیل، صفحات در یک 
سند، لنگرهای متنی و مقاصد مشترک لینک شوند. مقصد مشترک دو یا چند منبع را به اشتراک می‌گذارد. 
هنگامیک‌ه مقاصد به اشتراک گذاشته می‌شوند، در سلسله مرتبه‌ای در پنل Hyperlinks ظاهر و در یک 
پوشه تودرتو می‌شوند. در صورت عدم اشتراک‌گذاری، هر مقصدی به‌طور مجزا در این پنل فهرست می‌شود.

 Hyperlinks 1ـ1ـ8 ـ آشنایی با پنل 
همه‌ هایپرلینک‌ها در سند InDesign شما در پنل Hyperlinks ظاهر می‌شوند، همانگونه که در شکل 1ـ8 
نشان داده شده است. برای باز کردن این پنل، Window>Interactive>Hyperlinks را انتخاب کنید. این 

پنل شامل تعدادی گزینه برای کار کردن با‌ هایپرلینک‌هاست.
  URL: دو آیکن کنار یکدیگر را در سمت راست Name می‌بینید. اولی، آیکن Page است. هر‌ هایپرلینک 

در این پنل با یک آیکن نشان‌دهنده نوع‌ هایپرلینک قرار دارد. در کنار این آیکن، عددی است که متناظر با 
شماره صفحه‌ای است که‌ هایپرلینک وجود دارد. اگر روی این شماره کلیک کنید، InDesign به آن صفحه 

می‌پرد و منبع را انتخاب میک‌ند.
  هر‌ هایپرلینک دارای کد رنگی نیز هست. یک دایره سبز رنگ نشان می‌دهد که URL معتبر است. یک 

دایره قرمز نشان می‌دهد که URL نامعتبر است. کلیک کردن روی آیکن‌های معتبر شما را به مقاصد می‌برد.

شکل 1ـ8 ـ برای باز کردن پنل Hyperlinks،وWindow>Interactive>Hyperlinks را انتخاب کنید.
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  Refresh URL Status: کلیک کردن روی این دکمه موجب نوسازی این فهرست می‌شود.

  Create new hyperlink: چیزی که باید در سند برای این آیکن انتخاب کنید تا فعال شود. هنگامیک‌ه 

متن یا یک شیء انتخاب شد، برای ایجاد‌ هایپرلینک جدید، روی این آیکن کلیک کنید.
در  برای حذف  خود  موردنظر  هایپرلینک  روی‌  هایپرلینک،  یک‌  کردن  برای حذف  زباله:  آیکن سطل    

فهرست Name کلیک کرده و روی آیکن Trash کلیک کنید.
پنل Hyperlinks تعداد جامعی فرمان منو دارد، همان‌گونه که در شکل 2ـ8 نشان داده شده است. برای 
باز کردن این منو، روی گوشه سمت راست بالا در پنل Hyperlinks کلیک کنید. این منو باز می‌شود و 

گزینه‌های ذیل در اختیار شما قرار می‌گیرند:
  New Hyperlink: برای ایجاد‌ هایپرلینک جدید، روی این آیتم منو کلیک کنید. رفتار آن، شبیه کلیکک ردن 

روی آیکن Create new hyperlink در پایین پنل Hyperlinks است.
  New Hyperlink from URL: اگر یک URL را در متنی در سند انتخاب کنید، کلیک کردن روی 

این آیتم منو موجب ایجاد‌ هایپرلینک جدیدی به URL می‌شود.
  Convert URLs to Hyperlinks: از این آیتم با احتیاط استفاده کنید. InDesign بین URLهای 

ایجاد   URL یک   InDesign دارید،   realize.It مثل  متنی  اگر  نمی‌شود.  قائل  تمایزی  غیرمعتبر  و  معتبر 
 URL ، InDesign خواهد کرد. هر متنی که فاصله بین انتهای جمله با نقطه و کلمه بعدی وجود نداشته باشد، در

در نظر گرفته می‌شود.

شکل 2ـ8 ـ برای دستیابی به گزینه‌های‌ هایپرلینک، منوی پنل Hyperlinks را باز کنید.

  Delete Hyperlink: نتیجه استفاده از این فرمان با استفاده از آیکن Trash در پنل Hyperlinks یکی است.

  New Hyperlink Destination: روی این آیتم منو کلیک کنید. یک کادر محاوره‌ای باز می‌شود که 

می‌توانید مقصدی را برای صفحه، لنگر متن یا URL انتخاب کنید.
  Edit Hyperlink:‌ هایپرلینکی در پنل Hyperlinks انتخاب کنید و روی این آیتم منو کلیک کنید تا 
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کادر محاوره‌ای Edit Hyperlink باز شود. در کادر محاوره‌ای Edit Hyperlink، می‌توانید یک URL را 
ویرایش کنید یا مقصد را تغییر دهید، سبک‌های کاراکتر را انتخاب کنید و گزینه‌های PDF را ویرایش کنید.  
 Hyperlink روی این آیتم منو کلیک کنید تا کادر محاوره‌ای :Hyperlinks Destination Options  

Destination Options باز شود. در بین تغییرات دیگر، می‌توانید نام‌ هایپرلینک را تغییر دهید )توجه داشته 
باشید که می‌توانید نام‌ هایپرلینک را با کلیک کردن روی نام، لحظه‌ای درنگ، کلیک کردن مجدد و سپس 
تایپ کردن متن جدید برای نام در پنل Hyperlinks تغییر دهید(. نام‌ هایپرلینک‌ها هیچ تأثیری بر مقصدها 
ندارد. ممکن است هنگام کار کردن و افزودن نام‌های توصیفی‌تر برای آنچه که‌ هایپرلینک انجام می‌دهد، نام‌ 

هایپرلینک‌ها را تغییر دهید.
  Delete Unused Destinations: هنگامیک‌ه کارتان به پایان رسید و آماده انتشار شدید، استفاده از این 

فرمان عادت خوبی است. InDesign تمام مقاصد استفاده نشده در سند را حذف میک‌ند.
Hyper� این گزینه شبیه کلیک کردن روی عدد سمت راست نام‌ هایپرلینک‌ها در پنل :Go to Source  

links است. هنگامیک‌ه این فرمان را انتخاب میک‌نید، InDesign به صفحه‌ای می‌پرد که منبع پیدا می‌شود 
و منبع را انتخاب میک‌ند.

  Go to Destination: کلیک کردن روی این فرمان موجب احضار اقدام‌ هایپرلینک می‌شود. اگر‌ هایپرلینک 

یک URL باشد، URL در مرورگر وب پیش‌فرض شما باز می‌شود. اگر مقصد صفحه باشد، InDesign به 
صفحه مقصد می‌پرد و الی آخر.

  Rename Hyperlink: این گزینه کمی اضافی است، زیرا شما دو روش برای تغییر نام‌ هایپرلینک‌ها 

دارید. هنگامیک‌ه روی آیتم منو کلیک میک‌نید، کادر محاروه‌ای ساده‌ای باز می‌شود که می‌توانید نام جدید 
را در آن تایپ کنید. 

  Reset Hyperlink: فرض کنید که‌ هایپرلینکی دارید که منبع آن مقداری متن است. منبع جدید را 

انتخاب کرده و سپس‌ هایپرلینک را در پنل Hyperlinks برگزیده و Reset Hyperlink را انتخاب کنید. 
منبع جدید از مقصد‌ هایپرلینکی استفاده میک‌ند که از منبع اصلی تولید شده است.

  Update Hyperlink: از این آیتم منو هنگامی استفاده کنید که به اسناد خارجی لینک می‌دهید )چیزی 

مثل یک فایل PDF(. اگر نام یا مکان فایل را تغییر داده‌اید،‌ هایپرلینک را در پنل Hyperlinks انتخاب کرده 
و روی Update Hyperlink کلیک کنید.

اگر  البته،  کنید.  جابه‌جا   Hyperlinks پنل  در  را  هایپرلینک‌ها  نمی‌توانید‌  پیش‌فرض،  به‌طور   :Sort   

Sort>Manually را در منو انتخاب کنید، می‌توانید با کشیدن ماوس، آیتم‌ها را در این لیست بالا و پایین 
نام‌  برحسب  را  لیست  می‌توانید  که  By Type هستند  و   By Name مرتب‌سازی  دیگر  گزینه‌های  کنید. 

هایپرلینک‌ها یا برحسب نوع مقصد مرتب‌سازی کنید.
می‌شود،  لیست کوچک‌تر  در  نوع  میک‌نید،  انتخاب  را  فرمان  این  که  هنگامی   :Small Panel Rows   

بنابراین می‌توانید لیست بلندتری را در پنل ببینید.
  Auto Update URL Status: به‌طور پیش‌فرض، این آیتم انتخاب نشده است. اگر به‌صورت آنلاین کار 

میک‌نید، ممکن است این آیتم را از حالت انتخاب خارج کرده باشید و سپس به‌هنگام آنلاین شدن آن را فعال 
کنید. InDesign وضعیت URL را به‌طور خودکار هنگام فعال شدن به‌روزرسانی میک‌ند و بازخورد بی‌درنگی 

را در مورد URLهای معتبر و غیرمعتبر می‌دهد.
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 2ـ1ـ8 ـ استفاده از سبک‌های‌ هایپرلینک 
هنگام ایجاد اولین‌ هایپرلینک خود در یک سند InDesign، ممکن است بلافاصله از آن مطلع نشوید، ولی 

InDesign یک Character Style را برای شما ایجاد میک‌ند.
پنل Character Styles را باز کنید (Window>Style>Character Styles). پنل Character Style باز 
 Character Style در پنل Hyperlink می‌شود. اگر بخواهید ویژگی‌ها را برای سبک تغییر دهید، روی سبک
 Character Style نام Hyperlink ،را انتخاب کنید )که در این مورد Edit Hyperlink کلیک راست کرده و
است(. کادر محاوره‌ای Character Style Options باز می‌شود، همان‌گونه که در شکل 3ـ8 نشان داده شده 
است که می‌توانید از طریق این کادر محاوره‌ای، فونت، اندازه فونت، Leading، رنگ متن و غیره را تغییر دهید.

شکل 3ـ8 ـ هنگام ایجاد اولین‌ هایپرلینک خود، InDesign به‌طور خودکار یک Character Style ایجاد می‌کند.

 3ـ1ـ8 ـ ویرایش‌ هایپرلینک‌ها
کنید،‌  ویرایش   PDF ظاهر  یا  کاراکتر  سبک   ،URL مقصد،  دادن  تغییر  برای  را  هایپرلینک  بخواهید‌  اگر 
 Hyperlinks پنل  منوی  در  را   Edit Hyperlink و  کرده  انتخاب   Hyperlinks پنل  در  را  هایپرلینک 
برگزینید. کادر محاوره‌ای Edit Hyperlink باز می‌شود، همان‌گونه که در شکل 4ـ8 نشان داده شده است.

برای  انتخابی  باشید، کادر  به دنبال آن   Edit Hyperlink یک چیزی که ممکن است در کادر محاوره‌ای 
Shared Hyperlink Destination است. اگر این کادر در حالت تأیید نباشد و شما فهرستی طولانی از‌ 
هایپرلینک‌هایی داشته باشید که همگی از مقصد یکسانی استفاده میک‌نند، ممکن است بخواهید آن‌ها را 
 Hyperlinks ویرایش کنید و این کادر انتخاب را در حالت تأیید قرار دهید.‌ هایپرلینک‌ها در پوشه‌ای در پنل
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تودرتو می‌شوند و چنانچه سند شما حاوی‌ هایپرلینک‌های بسیار متفاوتی باشد، مدیریت آن‌ها آسان‌تر می‌شود.

شکل 4ـ8 ـ روی Edit Hyperlink در منوی پنل Hyperlinks کلیک کنید.

 4ـ1ـ8 ـ ویرایش‌های مقصدهای‌ هایپرلینک
محاوره‌ای  کادر  تا  کنید  کلیک   Hyperlinks پنل  منوی  در   Hyperlink Destination Options روی 
Hyperlink Destination Options باز شود. هنگامیک‌ه مقصدهای جدیدی را اضافه میک‌نید، آن‌ها به‌طور 

پویا به منو اضافه می‌شوند.

شکل 5ـ8 ـ روی Hyperlink Destination Options در منوی پنل Hyperlinks کلیک کنید.

در این کادر محاوره‌ای، می‌توانید نوع مقصد را تغییر دهید، نام‌ هایپرلینک را تغییر دهید و URL را تغییر 
دهید، البته چنانچه مقصد URL باشد.
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2ـ8 ـ لینک شدن به URLها

همانگونه که می‌بینید، InDesign مجموعه بسیار گسترده‌ای از ویژگی‌ها و فرامینی را به شما ارائه می‌دهد 
که با‌ هایپرلینک‌ها کار میک‌نند. حالا که با کادر‌های محاوره‌ای و پنل Hyperlinks آشنا شده‌اید، وقت آن 

است که‌ هایپرلینک‌هایی در سند ایجاد کنید.

 1ـ2ـ8 ـ ایجاد‌ هایپرلینک
برای ایجاد‌ هایپرلینکی که یک URL را باز میک‌ند، این موارد را انجام دهید:

1 مقداری متن، یک شیء یا تصویری را انتخاب کنید یا با ماوس بکشید تا یک Rectangle Frame باز شود. 
در مثال من، مقداری متن را انتخاب کرده‌ام، همانگونه که در شکل 6ـ8 نشان داده شده است. اگر چند فریم 

.(Ctrl+G) متنی دارید و می‌خواهید از آن‌ها استفاده کنید، آن‌ها را انتخاب و گروه‌بندی کنید

Hyperlinks شکل 6ـ8 ـ انتخاب متن یا تعدادی فریم متنی گروه‌بندی شده و باز کردن پنل

 Create new hyperlink را باز کنید. روی آیکن Hyperlinks 2 اقلام گروه‌بندی شده را انتخاب کرده و پنل
کلیک کنید. ‌URLای را برای‌ هایپرلینک در کادر متنی URL اضافه کرده و Enter را فشار دهید.

3  پنل Hyperlinks را امتحان کنید. به هنگام تایپ اشتباه URL،وInDesign با تغییر دادن آیکن دایره‌ای 
به رنگ قرمز، گزارش URL را به شما برمی‌گرداند. مطمئن شوید که دایره سبز رنگ باشد.

4 نام‌ هایپرلینک را تغییر دهید. به‌طور پیش‌فرض، نام‌ هایپرلینک از آدرس URL مشتق می‌شود. اگر یک 
URL طولانی دارید، ممکن است بهتر باشد نام آن را به نامی توصیفی‌تر تغییر دهید. یک بار روی نام در 
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پنل Hyperlinks کلیک کنید، لحظه‌ای درنگ کرده و مجدداً کلیک کنید. هنگامیک‌ه متن انتخاب شد، نام 
جدیدی تایپ کنید. به ‌روش دیگر، می‌توانید Rename Hyperlink را در پنل Hyperlinks انتخاب کنید.

5 مقصد لینک را بررسی کنید. روی دایره سبز رنگ در پنل Hyperlinks کلیک کنید. اگر URL شما را 
به جایی برد که انتظار دارید، URL درست کار میک‌ند. اگر نتیجه غیرمنتظره‌ای دریافت کردید، URL را در 

پنل Hyperlinks بازبینی کنید.

3ـ8 ـ لینک شدن به کلاینت‌های ایمیل

ایجاد می‌شود.  ایمیل پیش‌فرض شما  پیام جدیدی در کلاینت  ایمیل،  به یک کلاینت  لینک شدن  هنگام 
Hyper�  می‌توانید آدرس ایمیل مقصد، موضوع و حتی محتویات ایمیل را کنترل کنید. هر چیزی در پنل 

links شروع می‌شود که‌ هایپرلینک جدیدی را به یک آدرس ایمیل ایجاد میک‌ند.
ممکن است سندی داشته باشید که بخواهید از خوانندگان درباره محتوا بازخورد بگیرید، بخواهید اطلاعات 
اضافی را به اشتراک بگذارید که در لینک یک فایل ظاهر می‌شوند یا روش دیگری برای برقراری ارتباط با 
خوانندگان خود داشته باشید. ایجاد یک‌ هایپرلینک ایمیل، نسبتاً آسان است. هنگامیک‌ه مجبورید یک خط 

طولانی متن را در کادر متنی Hyperlink وارد کنید، کارها کمی پیچیده‌تر می‌شود.

 1ـ3ـ8 ـ ایجاد یک‌ هایپرلینک ایمیل
برای شروع، ابتدا ایجاد‌ هایپرلینک ایمیل نسبتاً ساده را بخوانید. 

ایجاد یک‌ هایپرلینک ایمیل
برای ایجاد اولین‌ هایپرلینک ایمیل خود، این مراحل را دنبال کنید:

1 یک شیء، متن یا آیتم دیگری را در سند انتخاب کرده و روی آیکن Create new hyperlink در پنل 
Hyperlinks کلیک کنید. کادر محاوره‌ای New Hyperlink باز می‌شود.

Email 2 را از منوی Link To انتخاب کنید. یک آدرس ایمیل معتبر را در فیلد Address تایپ کنید. 
موضوع را تایپ کنید )اختیاری(، همان‌گونه که در شکل 7ـ8 نشان داده شده است. روی OK کلیک کنید.

شکل 7ـ8 ـ Email را از منوی Link To انتخاب کنید.
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3 به URL در پنل Hyperlinks توجه کنید. مقداری کد در آدرس ایمیل می‌بینید )شکل 8ـ8 را ببینید(.

شکل 8ـ8 ـ پنل Hyperlinks بعد از افزودن لینک

4 برای امتحان کردن آدرس، روی تصویر ایمیل در پنل Hyperlinks کلیک کنید. باید پنجره پیام جدیدی 
را ببینید که در کلاینت ایمیل پیش‌فرض شما باز می‌شود. اگر همه چیز درست کار کند، وظیفه لینک ایمیل 

را کامل کرده‌اید.
این لینک ایمیل وظیفه ساده‌ای است. برای بررسی گزینه‌های بیشتر با لینک‌های ایمیل، می‌توانید توضیحی را در 
فیلد پیام اضافه کنید، لینکی را به فایلی خارجی ایجاد کنید و آن را به نام URL در پنل Hyperlinks اضافه کنید.

 2ـ3ـ8 ـ ایجاد یک‌ هایپرلینک ایمیل با پیام
یک خط برای تایپ کردن یک لینک URL در InDesign خیلی کوچک است و هیچ راهکاری برای افزودن 
اطلاعات URL نیست. حتی کادرهای محاوره‌ای که به شما اجازه ویرایش URL را می‌دهند فقط دارای یک 
خط واحد برای یک کادر متنی هستند. اگر یک URL طولانی داشته باشید و نیاز به ویرایش اطلاعات داشته 
 URL ایجاد کنید و آن را در خط متنی InDesign pasteboard باشید، ایده بدی نیست که متنی را در

کپی و الصاق کنید.
در شکل 9ـ8، متنی را در InDesign pasteboard می‌بینید. این متن حاوی‌ هایپرلینکی است که یک سند 
PDF می‌تواند از طریق آن دانلود شود. تعدادی بازگشت به ابتدای خط برای کمک به سهولت خواندن و 
مفهوم‌تر کردن آن اضافه کرده‌ایم. پس از نوشتن کد، باید بازگشت‌ها به ابتدای خط را حذف کنید و سپس 

نتیجه را در یک خط متن واحد داشته باشید.

شکل 9ـ8 ـ اطلاعاتی را برای محتوای ایمیل در InDesign Pasteboard تایپ کنید.
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هنوز کار انجام نشده است. باید تمام فاصله‌ها را حذف کنید و باید آن‌ها را با 20 درصد جایگزین کنید. ممکن است 
آدرس‌های وب را دیده باشید که شبیه این به نظر می‌رسند، زیرا فاصله‌ها در خطوط آدرس URL مجاز نیستند.

 URL مجاز نیستند. 20 درصد یک مقدار رمزگذاری شده برای فاصله در یک رشته URL فاصله‌ها در خطوط
است.

توجه

Keith Gilbert یک مؤلف، سخنران همایش و مشاور حرفه‌ای در InDesign و Adobe DPS است. 
نشر دیجیتال  درباره  ارزشمندی  اطلاعات  میزبان   (www.gilbertconsulting.com) او  وب‌سایت 
 Digital( است که او نوشته است. دو مجموعه از اسکریپت‌های او InDesign و اسکریپت‌های عالی
Publishing pack 1 و Digital Publishing pack 2( ابزارهایی عالی برای کار کردن با DPS و 

نشریات دیجیتال هستند و اکیداً توصیه می‌کنم نگاهی به آن‌ها بیندازید.

توجه

به‌جای انجام دستی این کار، می‌توانید از اسکریپتی برای انجام این فرمت‌بندی استفاده کنید. این اسکریپت از 
Keith Gilbert در آدرس www.gilbertconsulting.com وجود دارد. من اسکریپت Keith را بارگذاری 

کرده و آن را در متن در pasteboard اجرا کرده‌ام. نتیجه در شکل 10ـ8 نشان داده شده است.

شکل 10ـ8 ـ بعد از اجرای اسکریپت Replace Spaces With Entity از Keith Gilbert، تمام فاصله‌ها با کد مناسب 
جایگزین می‌شوند.

پس از اجرای این اسکریپت، متن را کپی کرده و آن را در فیلد متنی URL الصاق کنید.

4ـ8 ـ لینک شدن به صفحات

ممکن است بخواهید مراجع متقابلی را در یک فایل برای خوانندگان ایجاد کنید تا خواندن محتوای مربوط به 
موضوعی معین را شاخه‌بندی کنید یا صفحه محتویاتی را ایجاد کنید که به فصل‌ها لینک هستند.

لینک شدن به صفحات با استفاده از پنل Hyperlinks ساده است:
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1 برای لینک شدن به صفحه‌ای در یک سند، پنل Hyperlinks را باز کرده و منبعی را انتخاب کنید. این منبع 
می‌تواند متن یا گرافیک باشد. روی دکمه Create new hyperlink در پنل Hyperlinks کلیک کنید. کادر 

محاوره‌ای New Hyperlink Destination باز می‌شود، همان‌گونه که در شکل 11ـ8 نشان داده شده است.

شکل 11ـ8 ـ انتخاب Page و گزینش شماره صفحه

Page 2 را در منوی Link To انتخاب کرده و شماره صفحه را در منوی Page برگزینید. تمام صفحات سند 
شما در این منو فهرست می‌شوند. برای ایجاد‌ هایپرلینک، روی OK کلیک کنید.

نوع دیگری از پیمایش صفحه، به لنگرها لینک می‌شود.

 1ـ4ـ8 ـ لینک شدن به لنگرها
برای لینک شدن به لنگرها، این موارد را انجام دهید:

Page 1 را در منوی Link To انتخاب کرده و شماره صفحه را در منوی Page برگزینید. تمام صفحات سند 
شما در این منو فهرست می‌شوند. برای ایجاد‌ هایپرلینک، روی OK کلیک کنید.

انتخاب کنید. کادر محاوره‌ای  باز کرده و New Hyperlink Distenation را  2 منوی Hyperlinks را 
New Hyperlink Destionation باز می‌شود.

Text Anchor  3 را از منوی Type انتخاب کرده و نامی را برای متن لنگر تایپ کنید )شکل 12ـ8 را 
لنگرهای  برای  است.  آخر  الی  و   Anchor3و،Anchor2 آن  از  پس  و   Anchor1 پیش‌فرض  نام  ببینید(. 
اضافی، به سند اضافه کنید. بهتر است نامی توصیفی به لنگر بدهید، به‌ویژه هنگامیک‌ه لنگرهای متعددی در 

سند خود دارید.
تاکنون مقصد را ایجاد کرده‌ایم، ولی هنوز منبع را مشخص نکرده‌ایم.

4 فریمی را ایجاد کنید، شیئی را انتخاب کرده یا متنی را برای منبع برگزینید. 
5 در پنل Hyperlinks، روی دکمه Create new hyperlink کلیک کنید.

6 هنگامیک‌ه کادر محاوره‌ای Create new hyperlink باز می‌شود، Anchor را در منوی Link To انتخاب 
کرده و نام لنگر را در منوی Text Anchor برگزینید.
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شکل 12ـ8 ـ ایجاد یک لنگر به‌عنوان مقصد، روی مکان‌نما کلیک کنید یا متنی را انتخاب کنید یا Text Anchor را در کادر 
محاوره‌ای New Hyperlink Destination برگزینید.

هنگامی که هایپرلینکی به لنگر متن ایجاد کردید، آن هایپرلینک در پنل Hyperlinks با نماد لنگری نمایش 
داده می‌شود. می‌توانید با کلیک کردن روی نماد لنگر در پنل Hyperlinks، هایپرلینک را به سادگی امتحان 

کنید. اگر این لینک را به درستی تنظیم کرده باشید، InDesign به صفحه‌ای می‌پرد که مقصد را میی‌ابد.

 5ـ8 ـ کار کردن با انیمیشن

Adobe InDesign ابزار انیمیشن نیست. شما می‌توانید فرصت‌های بسیار بیشتری را برای ایجاد انیمیشن‌ها 
با Adobe Animate CC و Adobe After Effects بیابید. به هر حال، شما مجموعه جذابی از ویژگی‌ها را 

در Adobe InDesign خواهید داشت که به شما امکان ایجاد انواع انیمیشن‌ها را می‌دهد.
انیمیشن‌ها از InDesign می‌توانند به EPUBهای چیدمان ثابت، PDFهای تعاملی )با یک راه‌حل ـ ولی 
فقط در رایانه های رومیزی( و Adobe Publish Online صادر شوند. انیمیشن‌ها در EPUBهای جریان‌پذیر 

مجدد و اسناد DPS/AEMM پشتیبانی نمی‌شوند.
در این بخش، ایجاد انیمیشن‌ها را بررسی میک‌نیم و آن‌ها را برای پخش در اسنادی که از انیمیشن پشتیبانی 
از  استفاده  سرعت،  و  زمان  مدت  تنظیم  انیمیشن،  پیش‌تنظیمات  از  استفاده  میک‌نیم.  تنظیم  میک‌نند، 
مسیرهای متحرک و استفاده از انیمیشن‌ها را با اشیای چند حالته بررسی میک‌نیم. هم‌چنین تعدادی ایده 

پروژه را ارائه می‌دهیم و شما را در گام‌های لازم برای ایجاد طراحی‌های مشابه هدایت میک‌نیم.

Animation 1ـ5ـ8 ـ شناخت پنل 
در واقع، شما هنگام ایجاد انیمیشن‌های InDesign دو پنل برای استفاده دارید: پنل Animation و پنل 

Timing. در این بخش، درباره استفاده از پنل Animation صحبت میک‌نیم.
هنگامیک‌ه روی متحرک‌سازی متن و اشیا در InDesign کار میک‌نید، باید هر دو پنل را باز کنید. آن‌ها 
برای کمک به شما در تولید انیمیشن‌هایی بهک‌ار می‌روند که به اسناد خود اضافه میک‌نید. هم‌چنین از پنل 
Layers به دفعات استفاده میک‌نید، بنابراین بهتر است محیط کاری خود را طوری تنظیم کنید که بتوانید 

به راحتی بین این سه پنل حرکت کنید.
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 2ـ5ـ8 ـ استفاده از پیش‌تنظیمات انیمیشین
سند جدیدی در InDesign و یک شیء )مستطیل، بیضی یا چند ضلعی( ایجاد کنید. شیء را انتخاب کرده و 
پنل Animation را باز کنید، همان‌گونه که در شکل 13  8 نشان داده شده است. پنل Animation حاوی 
هستند:  این‌ها  شامل  که  میک‌نند  کنترل  را  انیمیشن  پایه  تنظیم  پنج  که  است  پیش‌تنظیم   48
پنل،  این  در   .Opacity و   Scaleو،Rotationو،Easing (speed and duration)و،Motion Paths

از: عبارت‌اند  شما  انتخاب  دارید.  انیمیشن‌ها  برای  صفات  تنظیم  برای  متعددی  انتخاب‌های 

شکل 13ـ8 ـ شیئی را در پنجره سند انتخاب کرده و پنل Animation را باز کنید.

A. منوی پنل Animation: روی آیکن موجود در گوشه سمت راست بالای پنل کلیک کنید تا منویی باز 
شود. در بالا، Save را پیدا کنید. پس از انتخاب گزینه‌های مختلف در این پنل، می‌توانید تنظیمات خود را 

به‌عنوان یک پیش‌تنظیم ذخیره کنید.
B. پیش‌نمایش: بخش بالای انیمیشن، یک پیش‌نمایش بارز را برای انیمیشنی به شما نشان می‌دهد که از 

منوی Preset انتخاب کرده‌اید.
C.وName: نام گرفته شده از پنل Layers. شما باید اشیا و فریم‌های متنی را هنگام ایجاد انیمیشن‌ها در پنل 

Layers نام‌گذاری کنید. یا، چنانچه نام شیء را در اینجا تغییر می‌دهید، این نام در پنل Layers تغییر میک‌ند.
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D.وPreset: منوی Preset فهرستی طولانی از انیمیشن‌های مختلف را در اختیار شما قرار می‌دهد. هنگام انتخاب 
انیمیشنی از منوی Preset، پنجره پیش‌نمایش در بالای پنل Animation، نمای بارزی از انیمیشن را نمایش می‌دهد.
E.وEvents: به فلش رو به پایین کنار متن توجه کنید. برای باز شدن منو، روی فلش کلیک کنید تا بتوانید 
تریگر رویداد را انتخاب کنید. به‌طور پیش‌فرض، تریگر رویداد با On Page Load تنظیم شده است، بدین 

معنی که هنگام دیده شدن صفحه، انیمیشن پخش خواهد شد.
در سمت راست این منو، آیکنی وجود دارد. برای ایجاد دکمه تریگرکننده رویداد، روی این آیکن کلیک کنید.
F.وDuration: در این کادر متنی، می‌توانید مقدار حداقل قابل قبول 0/125 را تنظیم کنید که به انیمیشن 

سرعت می‌بخشد یا آن را با 60 ثانیه تنظیم کنید که آن را کند میک‌ند.
G.وPlay: انتخاب‌هایی برای تعداد دفعاتی داشته باشید که می‌خواهید انیمیشن با وارد کردن مقدار بین 1 

و 99 پخش شود.
H.وLoop: برای تکرار انیمیشن جهت پخش چندین باره، این کادر را در حالت تأیید قرار دهید.

 Ease In and و Ease Outو،Ease Inو،Noneو،From Preset گزینه‌هایی برای ،Speed در منوی :Speedو.I
Out دارید. Easing به انیمیشن سرعت می‌بخشد. هنگام انتخاب Ease In، انیمیشن ابتدا کند است و سپس سرعت 
می‌گیرد. Ease Out برعکس است. Ease In and Out کند شروع می‌شود، شتاب می‌گیرد و سپس پایان کندی دارد.

J.وAnimate: منوی Animate شامل سه گزینه است:
 From Appearance ،اگر توپی را متحرک میک‌نید که کوچک می‌شود :From Current Appearance  

با اندازه توپ هنگام قرار گرفتن آن در InDesign شروع می‌شود. با پیشرفت انیمیشن، توپ کوچک می‌شود.
  To Current Appearance: انیمیشن از یک ظاهر به ظاهر جاری اجرا می‌شود. مثلًا، اگر با توپ کوچکی 

شروع کنید و توپ در صفحه بزرگ شود، تغییر مقیاس توپ از شیئی کوچک‌تر به ظاهر بزرگ‌تر کنونی است.
  To Current Location: اگر توپ جهش داشته باشد، انیمیشن در مکان جاری به پایان می‌رسد، مکانی 

که توپ در طراحی در آن‌جا بوده است.
K.وRotate: یک شیء را تا º 7.200 می‌چرخاند.

L.وScale: تغییر اندازه یک شیء )بزرگ و کوچک کردن آن(. بزرگ‌ترین اندازه موجود 7.200  درصد است.
M.وOpacity: فقط دو انتخاب برای Opacity دارید. Fade In و Fade Out. محدوده آن از 0 درصد تا 

100 درصد است )یا 100 درصد تا ٠ درصد(.
N.وVisibility: می‌توانید مشخص کنید که انیمیشن تا زمان پخش پنهان باشد و می‌توانید انیمیشن را پس 

از اتمام متحرک‌سازی با فعال کردن کادرهای انتخاب مرتبط پنهان کنید.
O. پیش‌نمایش: برای پیش‌نمایش انیمیشن در پنل EPUB Interactivity، روی این آیکن در گوشه سمت 
چپ پایین کلیک کنید. برای پیش‌نمایش انیمیشن در پنل SWF Preview،وAlt را فشار داده و کلیک کنید.

است.  مفید  بسیار  دارد،  قرار  پیش‌نمایش  آیکن  راست  سمت  در  که  آیکن  این   :Animation Proxyو.P
هنگامیک‌ه روی این آیکن کلیک میک‌نید، یک کادر خاکستری مربعی به‌عنوان نماینده‌ای برای نشان دادن 

نقاط ابتدا و انتهای انیمیشن به شما نشان داده می‌شود.
Q. پنل Timing: روی آیکن بعدی در سمت راست Animation Proxy کلیک کنید تا پنل Timing باز شود.

R. تبدیل به Motion Path: در سمت راست پایین این پنل، Convert to Motion Path را میی‌ابید. هر 
خطی که در یک سند رسم کنید، چه مستقیم چه منحنی بزیه، می‌تواند به‌عنوان یک مسیر حرکت استفاده 
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شود. هنگامیک‌ه یک شیء و مسیری را انتخاب میک‌نید و سپس روی این آیکن کلیک میک‌نید، ضخامت خط 
مسیر ناپدید شده و شیء در امتداد مسیر متحرک می‌شود.

S.وRemove Animation: شیء منتسب به انیمیشن را انتخاب کرده و روی آیکن سطل زباله کلیک کنید. 
این عمل موجب حذف انیمیشن می‌شود )شیء شما باز هم در پنجره سند باقی می‌ماند(.

T. نقطه مبدأ: روی یکی از نهُ نقطه برای محور یا نقطه مبدأ کلیک کنید. مثلًا، اگر بخواهید یک شیء را از 
مرکز بچرخانید، روی مربع وسط کلیک کنید.

دومین آیتم در منوی Animation Panel،وManage Presets است. این گزینه را انتخاب کنید تا پنجره‌ای 
باز شود که تمام پیش‌تنظیمات در آن فهرست شده‌اند. می‌توانید پیش‌تنظیمات سفارشی را حذف کنید، 
آن‌ها را کپی کنید، یک فایل پیش‌تنظیم را بارگذاری کنید و پیش‌تنظیمات را در فایل جدیدی ذخیره کنید. 

پیش‌تنظیمات پیش‌فرض InDesign را نمی‌توان حذف کرد.
موارد باقیمانده در منوی پنل Animation مشابه موارد بحث شده در این فهرست هستند، البته به استثنای 
Preview Selection SWF. می‌توانید یک شیء را انتخاب کنید و فقط انیمیشن آن شیء را در پنجره 

پیش‌نمایش SWF پیش‌نمایش دهید.

 3ـ5ـ8 ـ ایجاد انیمیشن‌ها
حال که با همه سوئیچ‌ها و تاگل‌ها1 در پنل Animation آشنا شدید، اجازه دهید چند انیمیشن ساده جالب 

را ایجاد کنیم.
1 سند جدیدی را در InDesign ایجاد کنید. از یکی از اندازه‌های صفحه EPUB استفاده کنید. در این 

مثال، Intent را با Mobile،وPage Size را با iPad و Orientation را با Landscape تنظیم میک‌نیم.
File>Place 2 را انتخاب کرده و شیئی را در صفحه قرار دهید. اگر نیاز به تصویر پس‌زمینه دارید، پس‌زمینه 
را قرار داده و سپس شیء را قرار دهید. این شیء می‌تواند یک تصویر یا توضیح باشد. این انیمیشن را از یک 

پیش‌تنظیم می‌سازیم تا از سمت چپ شناور گردد، سپس به سمت راست وسط صفحه برود.

شکل 14ـ8 ـ در حالی‌که شیئی انتخاب شده است، ویژگی‌هایی را برای انیمیشن در پنل Animation تنظیم کنید. 

Toggles ـ1
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3 شیء را انتخاب کرده و پنل Animation را باز کنید.
 Fly in from را باز کنید و Preset تنظیم کنید. منوی Animation 4 ویژگی‌های انیمیشن را در پنل
 To Current Locationو،Animate Properties را تایپ کنید. در Duration را انتخاب و 2 را برای Left
را از منو انتخاب کنید، Opacity را با Fade In تنظیم کنید و کادر انتخاب Hide Until Animated را در 

حالت تأیید قرار دهید. تنظیمات باید همانند شکل 14ـ8 باشد.
5 انیمیشن را پیش‌نمایش دهید. روی آیکن Preview Spead:EPUB در پنل Animation )در گوشه سمت 
چپ پایین پنل( کلیک کنید. در برخی موارد، ممکن است نیاز باشد روی دکمه Play )فلش اشارهک‌ننده به سمت 

راست( در گوشه سمت چپ پنل EPUB Interactivity Preview کلیک کنید تا انیمیشن پخش شود.
هنگامی که فایل را به یک EPUB با صفحه‌آرایی ثابت صادر میک‌نید، انیمیشن به هنگام بارگذاری صفحه 
 Opacity است. آنچه که می‌بینید، انیمیشن کوتاهی از Timing پخش می‌شود. این تنظیم پیش‌فرض در پنل

٠ درصد است و شیء از سمت راست حرکت کرده و در Opacity ١٠٠ درصد محو می‌شود.

6ـ8 ـ ایجاد فایل‌های PDF تعاملی

نوع  دارای  رایانه ای  و  تبلت  همراه،  تلفن  هر  کرد.  مشاهده  تمام دستگاه‌ها  در  می‌توان  را   PDF1 فایل‌های 
 Adobe Reader رایگان  نرم‌افزاری  برنامه‌  لپ‌تاپ‌ها،  و  رومیزی  رایانه های  در  است.   PDF نمایش‌دهنده 
نمایش‌دهنده غالب PDF است. در تلفن‌های همراه و تبلت‌ها، طیف گسترده‌ای از نمایش‌دهنده‌ها چه رایگان 

و چه پولی وجود دارد.
بدون توجه به نمایش‌دهنده PDF مورد استفاده شما، فایل‌های PDF معمولاً اسناد را دقیقاً همان‌گونه که 
ایجاد شده‌اند، شامل تصاویر، فرمت‌بندی متن و تعبیه فونت نمایش می‌دهند. ایراد استفاده از PDFها این 
است که چندین ویژگی تعاملی در تلفن‌های همراه و تبلت‌ها پشتیبانی نمی‌شود. در رایانه های رومیزی و 

لپ‌تاپ‌ها، طیف‌گسترده‌تری از پشتیبانی برای ویژگی‌های تعاملی وجود دارد.
انجام  و  تعامل‌پذیری  افزودن   ،Adobe InDesign از  تعاملی   PDF فایل‌های  درباره صدور  این بخش،  در 

میک‌نیم. صحبت   Adobe Acrobat به  تعامل‌پذیری  مستقیم  افزودن  مختلف  وظایف 

Acrobat 1ـ6ـ8  ـ آماده‌سازی فضای کاری 
اگر اولین بار است که وارد محیط Acrobat می‌شوید، ممکن است متعجب شوید که آیا این برنامه واقعاً 
از رابط کاربری بسیار   Creative Cloud توسعه یافته است. تمامی برنامه‌های Adobe Systems توسط
مشابهی استفاده میک‌نند. البته، تیم Adobe Acrobat راه خودش را رفته است و Acrobat با استانداردهای 

طراحی رابط کاربری همانند همه برنامه‌های دیگر Creative Cloud سازگار نیست.

 ایجاد یک رابط سفارشی
در Adobe Acrobat، باید یک فضای کاری سفارشی ایجاد کنید که به شما امکان انتخاب سریع ابزارهای 
مختلف را می‌دهد که با PDFهای تعاملی استفاده خواهید کرد. برای شروع، Adobe Acrobat را باز کنید. 
Portable Document Format ـ1
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نیاز به این نیست که سندی در پیشخوان Document باز باشد.

شکل 15ـ8 ـ روی Tools در سمت چپ بالای پنجره Acrobat کلیک کنید تا پنجره Tools باز شود.

به دسته Edit PDF بروید و روی Add کلیک کنید. روی Open کلیک کنید تا ابزارهای ویرایش در نوار ابزار 
در بالای پنجره Acrobat نمایان شوند، همان‌گونه که در شکل 16ـ8 نشان داده شده است.

شکل 16ـ8 ـ برای ویرایش متن در سند، روی Edit کلیک کنید.

ابزارهایی که باز میک‌نید، در پیشخوان سمت راست نمایان می‌شود و هنگام باز کردن فایل‌های PDF دیگر 
در دسترس هستند.
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 2ـ6ـ8 ـ تنظیم ترجیحات
را  Preferences آن‌ها   تنظیمات ترجیحی دارد که می‌توانید در کادر محاوره‌ای  زیادی  تعداد   Acrobat
انتخاب کنید یا Ctrl+K را فشار دهید. انتخاب کنید. برای باز کردن ترجیحات، Edit>Preferences را 

 Gereral هنگام شروع کار تغییر دهید. روی General یک قلم ‌ترجیحی وجود دارد که باید در پیشخوان
در پیشخوان سمت چپ کلیک کنید و بالاترین آیتم، Use Single Key Accelerators، را برای دستیابی 
به ابزارها بیابید. این امر به شما اجازه می‌دهد از میانبرهای صفحه کلید برای دستیابی به ابزارها هنگام کار با 

Adobe Acrobat استفاده کنید.
ایجاد رابط سفارشی و تنظیم یک قلم ترجیحی به شما اجازه می‌دهد با مجموعه حداقلی از ابزارها و ترجیحات 
برای کار روی اسناد PDF تعاملی شروع کنید. هنگامیک‌ه به ویرایش فایل‌های PDF ادامه دادید، ممکن است 
بخواهید ابزارهای بیشتری را اضافه کنید یا ترجیحات اضافی را تغییر دهید. این‌ها گزینه‌هایی برای استفاده 
 ،Adobe Acrobat شخصی هستند. به منوها برگردید و بسته به نوع کار مدنظر خود برای انجام دادن در

دست به انتخاب بزنید.

InDesign از PDF 7ـ8 ـ خروجی

هنگام انتخاب File>Export در InDesign، دو گزینه متفاوت برای نوعی ‌PDF دارید که می‌خواهید صادر 
کنید. در بالای منوی Save as Type در کادر محاوره‌ای Export،وAdobe PDF (Interactive) را در کنار 
Adobe PDF (Print) خواهید دید. برای اسناد تعاملی، بدیهی است که باید از گزینه Interactive استفاده 

کنید. اگر می‌خواهید یک سند PDF را برای چاپ صادر کنید، از گزینه Print استفاده کنید.

Export to Interactive PDF 1ـ7ـ8 ـ استفاده از کادر محاوره‌ای 
هنگام انتخاب File>Export با فشردن Ctrl+E و انتخاب Adobe PDF (Interactive) و سپس کلیکک ردن 
روی Save، کادر محاوره‌ای Export to Intractive PDF باز می‌شود، همان‌گونه که در شکل 17ـ8 نشان 

داده شده است.
در این کادر محاوره‌ای، گزینه‌های متعددی دارید، از جمله:

A.وPage Range: اگر می‌خواهید محدوده‌ای از صفحات را صادر کنید، روی دکمه رادیویی Range کلیک کرده 
و شماره صفحات را تایپ کنید. چیزی شبیه 5ـ3 برای صدور صفحات 3 تا 5.

و  دارید  مقابل  صفحات  اگر  کنید.  استفاده   Pages از  تکی،  صفحه‌آرایی‌های  برای   :Pages/Spreadsو.B
 Spreads به‌صورت یک صفحه عریض واحد دیده شوند، روی  نهایی   PDF می‌خواهید صفحات مقابل در 

کلیک کنید.
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Export to Interactive PDF شکل 17ـ8 ـ کادر محاوره‌ای

C.وView: از این منو، می‌توانید گزینه‌های مختلف بزرگ‌نمایی را انتخاب کنید. اگر می‌خواهید کل صفحه 
اندازه  به  توجه  بدون  را  کاربران کل صفحه  تمام  کنید.  انتخاب  را   Fit Page گیرد،  قرار  در صفحه‌نمایش 

صفحه‌نمایش، در پیشخوان سند می‌بینند.
D.وLayout: اگر Default را از این منو انتخاب کنید، نمایش PDF به گزینه‌های ترجیحی در هر رایانه 
تک  اسناد  به‌عنوان  PDFها  مشاهده  برای  را  ترجیحی  تنظیمات  می‌توانند  کاربران  بود.  خواهد  پایبند 
صفحه‌ای یا پیوسته تنظیم کنند )هنگامیک‌ه در صفحات حرکت میک‌نید، بالای صفحه بعدی را در پایین 
صفحه قبلی می‌بینید که به خارج از نما پیمایش دارد(. اگر همیشه می‌خواهید اسناد PDF شما به‌صورت 
صفحات تکی نمایش داده شوند، به‌طوری که هنگامی که کاربران در صفحات حرکت میک‌نند، به صفحه 
بعدی )یا هر نمای صفحه‌آرایی دیگری( می‌روند، این گزینه را از منو انتخاب کنید. هنگامیک‌ه گزینه‌ای غیر 
از Default انتخاب می‌شود، نمای Layout ترجیحات تک تک رایانه ها را بازنویسی میک‌ند و تمام کاربران 

را مجبور میک‌نید PDFهای شما را در نمای صفحه‌آرایی یکسانی ببینند.
کاربری  رابط  عناصر  تمام  که  است  نمایی   Full Screen Modeو:Open in Full Screen Modeو.E
باز  ایراد  پنهان می‌شوند.  از دید  نوارهای پیمایش و غیره  ابزارها، منوها،  نوار  از قبیل   ،PDF نمایش‌دهنده 
کردن PDFها در Full Screen Mode این است که کاربران کادر محاوره‌ای هشداری را می‌بینند که باید در 
هر بار باز شدن PDF آن را نادیده بگیرند. متأسفانه، بسته به تعداد اقدامات امنیتی که Adobe برای جلوگیری 
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از تغییر PDFها در رایانه شما انجام می‌دهد، این یک شیطنت ضروری است، بدون اینکه شما آن را بدانید.
F.وFlip Pages. آیا با فعال بودن Full Screen Mode، می‌توانید چرخش خودکار صفحات را داشته باشید. 

با تایپ کردن مقدار در این کادر متنی، فاصله را تعیین کنید.
G.وPage Transitions: ترانزیشن‌ها هنگامی روی می‌دهند که در صفحات حرکت میک‌نید. می‌توانید طوری 
ترانزیشن صفحات موجود در PDF را داشته باشید که آبرومند باشد یا از تعدادی از آثار ترانزیشن در منو 

انتخاب کنید.
 InDesign برای در برگرفتن همه فایل‌های رسانه و فیلدهای فرمی که در صفحات :Forms and Mediaو.H

شما قرار گرفته، روی دکمه رادیویی Include All کلیک کنید.
نمونه‌های  نکنید.  فعال  را  آن  هرگز  است.  غیرفعال  همیشه  گزینه  این   :Embed Page Thumbnailsو.I
تصویری در یک سند تصویری، تصاویر نمونه هر صفحه را هنگام مشاهده صفحه‌آرایی در صفحه Pages در 
پیشخوان Navigation نشان می‌دهد. از Acrobat 6 به بعد، نمونه‌های تصویری هنگام باز شدن یک سند 
PDF به‌طور شناور تولید می‌شوند. اگر نمونه‌های تصویری صفحات را تعبیه کنید، سربار بیشتری را اضافه 

کرده و اندازه فایل نهایی بزرگ‌تر می‌شود.
       Acrobat نمایش‌دهنده  یک  در  را  شده  صادر   PDF سند  بخواهید  اگر   :View After Exportingو.J
Adobe Acrobat یا Adobe Reader( باز کنید )به‌طور خودکار پس از تکمیل صدور(، این کادر را در حالت 

تأیید قرار دهید.
لایه‌ها  از  که  هستند  مواردی  تنها  PDFها  تعاملی،  اسناد  انواع  تمام  از   :Create Acrobat Layersو.K
پشتیبانی میک‌نند. اگر یک سند چند زبانه دارید، به‌عنوان یک مثال، می‌توانید از تمام گرافیک‌ها و تصاویر در 
یک لایه استفاده کنید و متن را در لایه‌های مجزا ایجاد کنید. سپس، می‌توانید از دکمه‌ها استفاده کنید تا به 

خواننده سند شما اجازه می‌دهند نماهای لایه را تغییر دهد.
L.وTagged PDF: روی Create Tagged PDF کلیک کنید تا کاربران خواننده‌های صفحه‌نمایش بتوانند 
سند شما را کامل بخوانند. روی Use Structure for the Tab Order کلیک کنید که ترتیب Tab مواردی 

مثل فیلدهای فرم را به ارث می‌برد.
M.وSecurity: برای باز شدن کادر محاوره‌ای Security، روی دکمه Security کلیک کنید. می‌توانید با 

اضافه کردن محافظت گذرواژه‌ای برای باز شدن PDF، ویرایش آن را محدود کنید.

InDesign 8ـ8 ـ آماده‌سازی صفحه‌آرایی‌ها در

هنگام کار کردن با فایل‌های PDF تعاملی، روال‌های خاصی وجود دارند که نیازمند ساخت نتایج تعاملی است 
که می‌توانید به‌دست آورید. در این بخش، هر دو را ارائه می‌دهیم. ‌روش‌های  عالی برای استفاده با PDFهای 
تعاملی خواهید یافت و نباید هنگام ایجاد صفحه‌آرایی ثابت و اسناد Adobe Publish Online نگران باشید.

یک جلوه جالب که می‌توانید با فایل‌های PDF تعاملی ایجاد کنید، طراحی سندی با اشیا یا تصاویری است که 
حاشیه صفحه را قطع میک‌نند. این امر تنها با اسناد PDF انجام می‌شود و تنها برنامه‌ای که می‌تواند این نتیجه 
را حاصل کند، Adobe InDesign است. در شکل 18ـ8، یک صفحه PDF را می‌بینید که در Acrobat نمایش 
داده شده است. به آناناس در سمت چپ صفحه توجه کنید. این تصویر، حاشیه صفحه را قطع کرده است. این 

شبیه یک جلوه خارج از محدوده است که می‌توانید با Adobe Photoshop Elements ایجاد کنید.

(
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شکل 18ـ8 ـ فقط اسناد PDF تعاملی می‌توانند عناصری داشته باشند که از حاشیه‌های صفحه بیرون می‌زنند.

ممکن است دوچرخه‌ای داشته باشید که از صفحه‌نمایش بیرون برود، فوتبالیستی که به توپ ضربه می‌زند، 
موج‌سواری که سوار بر موج است یا عنصر طراحی دیگری که بخواهید بعُد کوچکی به سند نهایی اضافه کنید. 

این کارها بسیار ساده است که می‌توانید با انجام مراحل ذیل، آن‌ها را انجام دهید:
1 یک شیء روی یک صفحه Master قرار دهید. باید شیئی داشته باشید که در صفحه Master قرار داشته 
و از حاشیه بیرون بزند. پنل Pages را باز کرده و روی Master Page دابل کلیک کنید که برای عناصر 

طراحی دیگر در صفحه استفاده می‌شود.
2 مطمئن باشید که نقطه وسط شیء در مرز صفحه است. باید نقطه وسطی در مرز صفحه داشته باشید. اگر 
بخواهید عنصر کوچکی را خارج از مرز صفحه قرار دهید، فریمی بدون خط دور و زمینه داخل ناحیه صفحه 

ایجاد کنید و آن را با شیء کوچک گروه‌بندی کنید.
3 شیء را به یک دکمه تبدیل کنید. شیء را انتخاب کرده و پنل Buttons and Forms را باز کنید. دکمه 
جدیدی برای شیء ایجاد کنید. نگران انتساب یک عمل نباشید، فقط باید مطمئن شوید که شیء یک دکمه است.
 Adobe و  دهید(  فشار  را   Ctrl+E )یا  کنید  انتخاب  را   File>Export کنید.  صادر  تعاملی   PDF به   4
PDF Interactive را برگزینید. اگر View After Exporting را در حالت تأیید قرار داده باشید، PDF در 

نمایش‌دهنده پیش‌فرض PDF باز می‌شود. از اینجا، برای تکمیل کار نیاز به Adobe Acrobat دارید.
5 دکمه را قفل کنید. اگر کاربر کلیک کند و مرتب ماوس را تکان دهد، ممکن است دکمه حرکت کند و 
کاملًا در ناحیه صفحه قرار گیرد. برای جلوگیری از چنین رخدادی، در Adobe Acrobat، در حالیک‌ه ابزار 
Object را انتخاب کرده‌اید، روی دکمه کلیک راست کنید تا منوی بازشویی باز شود )برای دستیابی به ابزار 
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Select Object،وR را روی صفحه کلید فشار دهید(. Properties را از منو انتخاب کنید. به‌طور پیش‌فرض، 
کادر محاوره‌ای General Properties باز می‌شود. در گوشه سمت چپ پایین، کادر Locked را در حالت 

تأیید قرار دهید، همان‌گونه که در شکل 19ـ8 نشان داده شده است.
می‌توانید  باز شود،  تمام صفحه  حالت  در  نمی‌خواهید سند  اگر  )اختیاری(.  کنید  تنظیم  را  کاربر  رابط   6
تعدادی از گزینه‌های رابط را پنهان کنید. File>Properties را انتخاب کنید یا Ctrl+D را فشار دهید. کادر 
محاوره‌ای Document Properties باز می‌شود. روی برگه Initail View کلیک کرده و گزینه‌هایی را در 
ناحیه User Interface Options انتخاب کنید که می‌خواهید پنهان باشند. نمی‌توانید هر سه گزینه رابط 
را پنهان کنید. معمولاً، اقلامی که می‌خواهید بررسی کنید، Hide Menu Bar و Hide Toolbars هستند. 
گرچه اگر طرحی با اشیایی ایجاد کنید که از حاشیه‌های صفحه بیرون می‌زنند، ممکن است بخواهید فایل‌ها 

را در حالت تمام‌صفحه نمایش دهید.

شکل 19ـ8 ـ قفل کردن دکمه برای جلوگیری از حرکت‌های تصادفی

Acrobat 9ـ8 ـ ایجاد‌ هایپرلینک‌ها در

همان‌گونه که قبلًا بیان شد، شما نباید‌ هایپرلینک‌ها را در Adobe InDesign ایجاد کنید و باید آن‌ها را 
به عهده Acrobat بگذارید. دو انتخاب برای ایجاد دکمه‌های پیمایشی دارید: می‌توانید از یک دکمه یا یک 

لینک استفاده کنید.
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 1ـ9ـ8 ـ استفاده از دکمه‌ها برای پیمایش صفحه
دکمه‌ها نسبت به لینک‌ها این مزیت را دارند که می‌توانند در چندین صفحه تکرار شوند. بنابراین، اگر بخواهید 
دکمه‌ای را ایجاد کنید که کاربر را به صفحه بعدی بفرستد، دکمه‌ای را با عمل دکمه ایجاد کرده و سپس آن 

را در چندین صفحه تکرار کنید.
برای ایجاد یک دکمه تعاملی برای پیمایش صفحه، این موارد را انجام دهید:

1 یک سند چند صفحه‌ای را در Acrobat باز کنید.
2 دکمه‌ای را در صفحه اول ایجاد کنید. روی ابزار دکمه کلیک کرده و دکمه‌ای را در محلی رسم کنید که 

می‌خواهید دکمه ظاهر شود.
3 زمینه دکمه را اضافه کنید )اختیاری(. اگر نماد یا آیکنی در صفحه دارید، نباید دکمه‌ای با یک ظاهر 
ایجاد کنید. اگر هیچ نشانه‌ای ندارید که پیمایش از طریق کلیک دکمه صورت می‌گیرد، باید دکمه‌ای را به 
شیوه رایج ایجاد کنید طوری که برای کاربر آشکار باشد که این عنصر، یک دکمه است. می‌توانید رنگ زمینه 
محتویات دکمه را پر کنید یا می‌توانید یک تصویر گرافیکی به دکمه اضافه کنید. لحظه‌ای که دکمه را ایجاد 
 Go روی دکمه باز می‌شود. نامی را برای دکمه تایپ کنید، مثلًا Button Field Name میک‌نید، پنجره

Next، و سپس روی All Properties کلیک کنید.
 Fill Color کلیک کرده و روی آیکن Appearance روی برگه ،Button Properties 4 در کادر محاوره‌ای
 ،Layout کلیک کنید. در منوی Options را از منوی بازشو انتخاب کنید. روی برگه No Color .کلیک کنید
می‌توانید مشخص کنید که یک Label و یک Icon داشته باشید. Label Only یا Icon Only را هم دارید. 

در این مثال، از Icon Only استفاده خواهیم کرد.
5 پس از انتخاب Icon Only و Acrobat کمی اشکال دارد که در آن نمی‌توانید آیکنی را انتخاب کنید، 
دکمه  سپس  و  کرده  انتخاب   Behavior منوی  از  را   Push دهید.  تغییر  را   Behavior ابتدا  اینکه  مگر 
Choose Icon را فعال کنید. روی Choose Icon کلیک کنید تا کادر محاوره‌ای Select Icon باز شود. 
برای باز شدن پنجره Open و پیمایش به هارد درایو برای یافتن آیکن مدنظر خود روی Browse کلیک کنید. 

در پنجره Open کلیک کرده و روی Open کلیک کنید )شکل 20ـ8 را ببینید(.

شکل 20ـ8 ـ شیئی را که می‌خواهید برای ظاهر دکمه استفاده کنید، یافته و روی Open کلیک کنید.
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گزینه‌های متعددی در پنجره Advanced برای اشاره به آیکنی در فیلد button دارید.
6 روی Advanced در برگه Button Properties Options کلیک کنید تا اندازه و مقیاس تنظیم شود.

7 عملی را تنظیم کنید. در حالیک‌ه هم‌چنان در کادر محاوره‌ای Button Properties هستید، روی برگه 
Actions کلیک کنید. Execute a Menu Item را در منوی Select Action انتخاب کرده و روی Add کلیک 
کنید. کادر محاوره‌ای Menu item باز می‌شود. آیتم View>Page Navigation>Next Page را یافته و آن را 
انتخاب کنید. روی OK کلیک کنید و با کلیک کردن دکمه Close، کادر محاوره‌ای Button Properties را ببندید.

8 دکمه دومی ایجاد کنید. روال مشابه مراحل 3 و 4 را برای ایجاد دکمه دوم طی کنید. برای این دکمه، 
صفحه View>Page Navigation>Previous Page را در منوی Menu Item انتخاب کنید.

10ـ8 ـ تنظیم فضای کاری برای فرم‌ها

هنگام ایجاد یک فرم پر شدنی، با صفحه‌ای شروع خواهید کرد که هم‌اکنون طراحی کرده‌اید. در مرحله گرفتن 
یک فرم طراحی شده و تبدیل آن به فرمی که می‌تواند در PDF پر شود، از ابزارهای خاصی استفاده می‌شود. 
فضای کاری Interactive For PDF تعدادی ابزار دارد که شما نیاز دارید و در دسترس شما هستند. اگر 

فضای کاری را کمی سفارشی کنید، کارآمدتر خواهد بود.
 Pasteboard 1 ابتدا، پنل‌هایی را که برای فرم‌ها نیاز ندارید، جدا کنید. هر یک از پنل‌ها را به سمت چپ
بکشید. این پنل‌ها برای انواع دیگر PDFهای تعاملی مفید هستند ولی برای فرم‌ها نیازی به آن‌ها نداریم. 
نمی‌شوند.  استفاده  فرم‌ها  برای  زیرا  بکشید،   Pasteboard به  نیز  را   Gradient و   Colorو،Link پنل‌های 
عملکرد وظیفه‌ای فرم را به سندی اضافه خواهید کرد که هم‌اکنون طراحی و ساخته شده است. مهم نیست 

که اگر هنگام کشیدن پنل‌ها، تعدادی از آن‌ها به هم چسبیده باشند.
2 هر یک از پنل‌هایی را که کشیده‌اید، از حالت اتصال خارج کنید.

 InDesign بکشید. این کتابخانه Buttons and Forms را به زیر پنل Sample Buttons and Forms 3 پنل
شامل فیلدهای فرم از قبل ساخته شده و دکمه‌هایی برای کادرهای انتخاب، دکمه‌های رادیویی و دکمه‌هایی 

است که می‌توانند برای واگذاری یا چاپ فرم استفاده شوند.
4 برای باز کردن پنل Properties،وWindow>Properties را انتخاب کنید. سپس آن را به پایین پنل داک 
بکشید به‌طوری که بتوانید هنگام نیاز آن را باز و بسته کنید، در عین حال که فضای صفحه‌نمایش را حفظ کنید.

 Window>Workspace>New .5 این فضای کاری را ذخیره کنید تا بعداً بتوانید مجدد از آن استفاده کنید
Workspace را انتخاب کنید. از نامی مثل PDF Forms-Basic یا هر نام با معنی دیگری استفاده کنید 
ابزارهای اضافی ذخیره  با  )برای فرم‌های پیچیده‌تر و طولانی‌تر، ممکن است بخواهید فضای خالی مجزا را 
Articles(. روی  و   Object Styles Paragraph Styles،وCharacter Styles، پنل‌های  از جمله  کنید، 

OK کلیک کنید.
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شکل 21ـ8 ـ مرتب‌سازی پنل‌ها

 1ـ10ـ8 ـ افزودن فیلدهای فرم
مقداری از کارهای تنظیمی فیلدهای فرم هم‌اکنون انجام شده است. با افزودن فیلدهای دیگر و سپس اصلاح 

بعضی از آن‌ها، فرم را کامل خواهیم کرد.

 2ـ10ـ8 ـ افزودن فیلدهای متنی
در یک فرم PDF، فیلد متنی مخزنی است که در آن، افراد پرکننده فرم می‌توانند متن در آن وارد کنند. همه 
فریم‌ها به‌جز دو فریم هم‌اکنون به فیلدهای متنی تبدیل شده‌اند. شما دو فریم جدید اضافه خواهید کرد و 

آن‌ها را به فیلدهای متنی تبدیل میک‌نید.
( در پنل داک، پنل Layers را باز کنید. توجه داشته باشید که این فایل  1 با کلیک کردن روی آیکن )
با لایه جداگانه‌ای تنظیم شده است، Form Elements، برای اشیایی که بخشی از فرم هستند. لایه دیگر، 

Layer1، را قفل کنید، به‌طوری که بتوانید با اشیای فرم بدون جابه‌جایی احتمالی آن‌ها کار کنید.
( برای بزرگ‌نمایی روی ناحیه‌ای در نیمه بالایی صفحه که حاوی اشیای فرم است،  ( Zoom 2 از ابزار

استفاده کنید. این محلی است که تمام کار شما در این بخش انجام می‌شود.
( اشاره‌گر را به روی فیلد متنی و زیر First Name ببرید. توجه داشته  ( Selection 3 با استفاده از ابزار
باشید که خط نقطه‌چین قرمز، حول شیء و یک آیکن کوچک در سمت راست پایین نمایش داده می‌شود. 
 PDF است؛ آیکن فریم متنی نوع عنصر فرم PDF این خط نقطه‌چین نشان می‌دهد که شیء یک عنصر فرم

یک فیلد متنی است. برای انتخاب شیء، روی فیلد متنی کلیک کنید.
( در پنل داک برای نمایش Buttons and Forms کلیک کنید.  ( Buttons And Forms 4 روی آیکن
به تنظیمات مربوط به فیلد متنی توجه کنید. Text Field در منوی Type انتخاب شده است و نام این 
عنصر، First Name است. فیلد Description هنگامی به کاربر فرم نمایش داده می‌شود که اشاره‌گر را روی 
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 Description فیلدی ببرید، بنابراین می‌توانید توضیحی اضافه به کاربران بدهید تا فرم را تکمیل کنند. فیلد
با First Name تنظیم شده است. Printable به‌طور پیش‌فرض انتخاب شده است تا امکان چاپ این فرم 

فراهم شود. تنظیم فونت و اندازه را به‌صورت پیش‌فرض رها کنید.

شکل 22ـ8 ـ انواع متفاوت فیلدهای فرم آیکن‌های متفاوتی در گوشه سمت راست پایین دارند. این یک آیکن فیلد متنی است.

5 فریم فیلد فرم First Name را انتخاب کنید، کلید Alt را فشار داده و با کشیدن ماوس، یک کپی از آن 
در زیر Last Name قرار دهید. اندازه فیلد را تغییر دهید تا بزرگ‌تر شود، آن را با فیلدهای زیری تراز کنید 
)با کشیدن دستگیره سمت راست و وسط به سمت راست(. هنگام تراز شدن اشاره‌گر Smart Guides ظاهر 

خواهد شد.
6 در پنل Buttons And Forms، توجه داشته باشید که نام این فیلد First Name 1 است. این یک رفتار 
InDesign است که هنگام ایجاد فرم‌ها باید از آن آگاه باشید: هیچ دو فیلدی نباید نام یکسان داشته باشند. 
InDesign با افزودن شماره‌های ترتیبی به نام فیلدهای تکراری، این قانون را تقویت میک‌ند. برای اینکه این 
فیلد را فیلدی منحصربه‌فرد با اطلاعات صحیح کنیم، فیلدهای Name و Description را به Last Name تغییر 

می‌دهیم.
( را در پنل Tools انتخاب کنید و فریمی در قسمت فریم  ( Rectangle 7 برای ایجاد فرم از ابتدا، ابزار
 Email در بالا و لبه بالا را با پایین فریم متنی City رسم کنید. لبه سمت راست را با فریم Email Address
Address تراز کنید. از Smart Guides برای هم اندازه کردن ارتفاع این فریم با فریم City استفاده کنید. 
می‌توانید هر نوع فریمی )متنی، گرافیکی یا نسبت داده نشده( را به فیلد فرم PDF تبدیل کنید. یک فیلد 

متنی نباید از یک فریم متنی ساخته شود.
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شکل 23ـ8  ـ توجه کنید که چگونه Smart Guides به شما کمک می‌کند اشیا را تراز کرده و اندازه آن‌ها را تنظیم کنید.

8 حالا زمینه و خط دوری مشابه فیلدهای متنی دیگر نسبت می‌دهیم. یک سبک شیء برای کادرهای فیلد 
متنی هم‌اکنون ایجاد کنید. برای باز کردن پنل Object Styles،وWindow>Styles>Object Styles را 
( را انتخاب کرده و روی کادری که رسم کرده‌اید، کلیک کنید )چنانچه  ( Selection انتخاب کنم. ابزار
 Object کلیک کرده و سپس پنل Text Field Box نام  به  انتخاب نشده است(. روی سبک شیء  هنوز 
Styles را ببندید. حالا زمینه و خط دور مشابهی بر فریم جدید اعمال می‌شود. سپس، ارتفاع و عرض فیلد 
 Smart ،بکنید. برای نمایش مجدد City متنی را با کشیدن کامل دستگیره‌های مستطیل هم اندازه با فیلد
Guides را ببینید. اندازه کاملًا تغییر کرده است، زیرا سبک شیء به خط دور فریم اضافه شده است. تأیید 
 Properties یا Control است. این کار را با بررسی اندازه‌ها در پنل City کنید که اندازه این فیلد مشابه فیلد

انجام دهید.
 Email نام و شرح  و  انتخاب کنید   Type از منوی  را   Text Fieldو،Buttons And Forms 9 در پنل 
Address را به آن بدهید. Font Size را با Auto تنظیم کنید. Auto انتخاب خوبی برای فیلدهایی نظیر 
آدرس‌های ایمیل است که خیلی طولانی هستند؛ این تنظیم در صورت لزوم برای پر کردن فریم، اندازه فونت 

را کاهش می‌دهد. این عملکرد وظیفه‌ای از بریده شدن متن هنگام چاپ صفحه جلوگیری میک‌ند.
File>Save 10 را انتخاب کنید.
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کلیات

 InDesign اکنون به آخرهای کتاب رسیده‌ایم. ما همه مهارت‌های عالی را یاد گرفته‌ایم تا تبدیل به کارشناس
شویم. برای اینکه دیگران کار ما را ببینند، باید از آن خروجی بگیریم. همان‌طور که در سراسر کتاب گفتیم، 
InDesign ابزاری برای ایجاد اسناد است. ما این شانس را داریم که در یادگیری InDesign در این کسب‌وکار 
بهترین باشیم. البته گفتیم که InDesign فقط برای چاپ نیست. ما هنوز هم می‌توانیم اسناد عالی را به همراه 
تعامل‌پذیری برای وب آماده کنیم. اجازه دهید با چاپ شروع کنیم. در این واحدکار شما را در مورد چگونگی 
ذخیره‌سازی اسناد و نحوه استفاده از فرمت‌ها هدایت میک‌نیم. نحوه ایجاد PDFهای حرفه‌ای، نحوه چاپ 
صفحات انتخابی از یک سند، نحوه ذخیره‌سازی قالب‌ها برای استفاده‌های آتی، اشتراک‌گذاری فایل‌ها با دیگران 
با ساخت پکیج، مواردی هستند که در این واحدکار بررسی می‌شوند. هم‌چنین ذخیره‌سازی، صادر کردن و وارد 
کردن بخش‌های مهمی از کار شما هستند. اما مهم‌تر از همه کنترل نحوه ذخیره‌سازی و ذخیره کار است. به 

شما توصیه میک‌نیم در مورد PDF بیشتر بدانید، زیرا ابزاری ضروری و فوق‌العاده قدرتمندی است.

هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  نحوه ذخیره‌سازی اسناد را بداند.

  نحوه صدور اسناد را بداند.

  روش‌های وارد کردن اسناد را بداند.

  روش‌های وارد کردن تصاویر گرافیکی را بداند.

  مفهوم اصول چاپ را درک کند.

  مفاهیم اولیه صفحه‌آرایی را بداند.

  انواع کاغذ برای چاپ را بشناسد.

  استانداردهای طراحی بروشور، کاتالوگ، کتاب و مجله را بشناسد.

  با مفاهیم مربوط به وب آشنا باشد.

زمان آموزش

عملینظری

23



واحد كار نهم: وارد و صادر کردن محتوای سند

127

INDD 1ـ9ـ ذخیره‌سازی سند به‌عنوان

فایل INDD چیست؟ INDD نوعی فایل پیش‌فرض برای نگارش‌های اخیر InDesign است. برای ذخیره‌سازی 
 Save بروید تا کادر محاوره‌ای File>Save/Save As/Save a Copy به ،INDD سند خود به عنوان یک فایل
نمایان شود. در این کادر محاوره‌ای، نام و مکان ذخیره‌سازی فایل را مشخص میک‌نید، البته، گزینه‌های فرمت 
فایل متعددی وجود دارد که از طریق منوی بازشوی پایین این کادر محاوره‌ای در دسترس قرار می‌گیرند: 
 .InDesign CS4 or Later (IDML)و،InDesign CC 2021Template، InDesign CC 2021 document
اولین گزینه را انتخاب کنید تا سند شما به‌عنوان یک فایل INDD عادی ذخیره شود. این بدان معنی است 
که این فایل را فقط می‌توانید با نگارش فعلی InDesign باز کنید. برای ذخیره‌سازی فایلی که در نگارشی 

قدیمی‌تر از InDesign باز می‌شود، بخش بعدی را مطالعه کنید.

2ـ9ـ ذخیره‌سازی سند به طوری که در نگارش قدیمی‌تر InDsign باز شود

یکی از ویژگی‌های غیرعادی InDesign این است که یک فایل INDD ذخیره شده در نگارش فعلی این نرم‌افزار 
 InDesign نمی‌تواند در نگارش‌های قدیمی‌تر باز شود. به‌منظور ذخیره‌سازی سند ایجاد شده در نگارش فعلی
به طوری که بتواند توسط نگارش قدیمی‌تر این نرم‌افزار باز شود، این سند باید به‌صورت یک فایل IDML ذخیره 
 Adobe InDesign Markup مخفف IDML :شود. اگر دلیلی فنی برای این مسئله می‌خواهید، این است
Language است. IDML یک نمایش XML از سند InDesign یا مؤلفه‌های آن است. این فرمت، فرمت 
مبادله برای Adobe InDesign است. دانستن این اطلاعات فنی باعث نمی‌شود که شما عاقل‌تر شوید، ولی 
با آن‌ها کار میک‌نید، از یک نگارش InDesign استفاده  به شما کمک میک‌ند که بدانید همه کسانی که 
و   رفته   File>Save As به  است  کافی  کنید.  ذخیره  را   IDML فایل  یک  باید  همیشه  شما  و  نمیک‌نند 
InDesign CS4 or Later (IDML) را از منوی بازشوی Format (Save as Types) در نزدیکی انتهای 
 InDesign این کادر محاوره‌ای انتخاب کنید. البته برعکس این قضیه درست نیست. آخرین نگارش نرم‌افزار
می‌تواند فایل‌های INDD ایجاد شده و ذخیره شده در نگارش‌های قدیمی‌تر Creative Cloud را باز کند.

INDD شکل 1ـ9ـ ذخیره‌سازی به فرمت
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IDML شکل 2ـ9ـ ذخیره‌سازی به فرمت

3ـ9ـ چاپ تک تک صفحات یا اسپریدها

آیا تاکنون روی یک سند چند صفحه‌ای کار کرده‌اید که خواسته باشید به‌جای کل سند، یک یا دو صفحه 
را چاپ کنید؟ در کادر محاوره‌ای Print، می‌توانید مشخص کنید کدام صفحات را می‌خواهید چاپ کنید؛ 
با وجود این، چنانچه ندانید چگونه محدوده صفحات را برای اسناد چندصفحه‌ای انتخاب کنید، مسئله کمی 
 Pages ترفندآمیز می‌شود. ولی نگران نباشید، ترفند جالبی برای ساده‌تر کردن این فرایند با استفاده از پنل
وجود دارد. کافی است پنل Pages را باز کنید )Window>Pages( و روی اولین صفحه مدنظر خود برای 
چاپ  کلیک کنید تا انتخاب شود. روی صفحات دیگری که می‌خواهید چاپ کنید، Ctrl+کلیک کنید )البته، 
اگر قصد چاپ کل سند را ندارید(. هنگامیک‌ه صفحات خود را انتخاب کردید، روی یکی از صفحات منتخب 
 Print محاوره‌ای  کادر  نمایان شدن  موجب  امر  این  کنید.  انتخاب  را   Print Pages و  کرده  راست  کلیک 
می‌شود و شما صفحات انتخابی خود را خواهید دید که به‌طور خودکار در فیلد range فهرست شده است. از 

آنجا می‌توانید هر تغییر دیگری را در کار چاپی خود بدهید، از قبیل کپی‌ها، اندازه چاپ و غیره.

شکل 3ـ9ـ چاپ صفحات انتخابی
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4ـ9ـ ذخیره یک سند به‌عنوان یک PDF چاپی استاندارد

دنیای PDFها و قبل از چاپ، بسیار گسترده است و خارج از گستره این کتاب است. در اینجا، قصد داریم به 
شما نشان دهیم چگونه فایل را به‌عنوان یک PDF با تنظیمات پیش‌فرض ذخیره کنید. اگر می‌خواهید دنیای 
PDFها را بیشتر دنبال کنید، پیشنهاد میک‌نیم یک چاپخانه محلی خوب و یک کتاب جامع درباره چاپ 
بیابید. اجازه دهید فایل‌مان را به PDF صادر کنیم. دو روش برای انجام این کار وجود دارد، ولی ما از روش 
 Adobe PDF و Export :وجود دارد File پیش‌فرض استفاده میک‌نیم. دو گزینه برای این کار در منوی
Presets. ما به Export می‌پردازیم و به شما نشان می‌دهیم چگونه فایل PDF داشته باشید. هنگامیک‌ه 
Export را انتخاب میک‌نید، یک کادر محاوره‌ای Save As نمایان می‌شود که می‌توانید نامی به فایل بدهید و 
 PDF Printو،Format (Save as Type) محل صدور را انتخاب کنید )یعنی، فایل کجا ذخیره می‌شود(. در منوی
 Export Adobe کلیک کنید. این امر موجب باز شدن کادر محاوره‌ای Save را انتخاب کرده و سپس روی
PDF می‌شود. این ممکن است شما را بترساند، ولی نترسید! ابتدا، همیشه منوی Adobe PDF Preset را 
باز کرده و High Quality Print را انتخاب کنید. من می‌خواهم PDF با یکفیتی داشته باشم و این روزها 
 PDF/X1ـa:2001 بروید و Standard ارسال فایل‌های بزرگ‌تر کار چندان مشکلی نیست. سپس، به منوی

را انتخاب کنید، زیرا بهترین شروع  برای تضمین این مسئله است که PDF تمام عناصر موردنیاز را دارد.

تنها مورد دیگری که باید انجام دهید، قرار دادن یک چک‌مارک کنار View PDF after Exporting است. 
روی Export کلیک کنید تا سند شما به PDF صادر شده و در مکان موردنظرتان ذخیره شود و پیش‌نمایش 

آن در Acrobat بازگردد.

PDF شکل 4ـ9ـ ذخیره کردن سند به‌صورت

PDF 5ـ9ـ صدور تک تک صفحات

با عرضه InDesign CC 2018 و نگارش‌های بعدی، توانایی صدور یک سند InDesign به PDFهای جداگانه 
برای هر صفحه یا اسپرید مهیا شد. دیگر نیازی نیست که PDF ذخیره شده را در Adobe Acrobat باز کنید و 

)برای 1aـPDF/X، تمام فونت‌ها باید تعبیه شوند و تصاویر باید CMYK یا رنگ‌های موضعی باشند(. 
توجه
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آن را به‌صورت دستی به چند فایل تقسیم‌بندی کنید. برای ایجاد فایل‌های PDF مجزا، File>Export را انتخاب 
 Adobe PDF باز کرده و فرمت  کرده و در کادر محاوره‌ای Save As، منوی Format (Save as Type) را 
در  میک‌ند.  کار  حالت  دو  هر  در  روش  این  کنید؛  انتخاب  را   Adobe PDF (Interactive) یا   (Print)
کادر محاوره‌ای Export Adobe PDF، یک چک‌مارک کنار Create Separate PDF بگذارید. استفاده 
می‌شود،  اضافه  صادرشونده   PDF فایل  نام  انتهای  به  اطلاعاتی  چه  اینکه  تعریف  برای   Suffix فیلد  از 
کوچک  فلش  روی  شماست.  موردنظر  صفحات  کدام  کنید  مشخص  می‌توانید  بنابراین،  است،  ایده‌آل 
،Incremental Numbers از  می‌خواهید  آیا  کنید  مشخص  و  کرده  کلیک   Suffix فیلد  راست   سمت 

 Suffix استفاده کنید. فیلد نام فایل به‌طور خودکار به سمت راست فیلد Page Size یا Page Number
اضافه می‌شود؛ البته نام فایل از سند اصلی گرفته شده است ولی در صورت لزوم می‌توان آن را ویرایش کرد.

شکل 5ـ9ـ صدور صفحات مجزا

)PNG یا JPG 6ـ9ـ صدور به فرمت‌های تصویری )مثل

گاهی اوقات ممکن است نیاز به صدور سند یا صفحاتی از سند به فرمتی غیر از PDF مثلًا یک فایل تصویری 
داشته باشید. شما چندین گزینه در فرمان Export دارید. به File>Export بروید. سند خود را نام‌گذاری 
کنید و از منوی Format (Save as Type)، می‌توانید JPEG یا PNG را برای ذخیره سند خود به‌عنوان 
یک تصویر انتخاب کنید. اگر JPEG را انتخاب کنید، کادر محاوره‌ای Export JPEG به شما ارائه می‌شود 
که به شما اجازه می‌دهد کدام صفحات را می‌خواهید صادر کنید؛ یکفیت و وضوح فایل؛ فضای رنگ مورد 
استفاده و غیره را مشخص کنید. این روشی واقعاً مفید برای ایجاد نگارش‌های فایل با اندازه کوچک از سند 
شما برای ایمیل به دیگران یا حتی طراحی چیزی در InDesign به‌ویژه برای صدور به یک فرمت تصویری 

است که می‌تواند در رسانه‌های اجتماعی یا وب پست شوند.
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شکل 6ـ9ـ صدور به فرمت‌های تصویری

7ـ9ـ ساخت پکیج از فایل‌ها

ساخت پکیج از فایل InDesign تمام عناصر مختلف )از جمله تصاویر، لوگوهای برداری، کلیه فایل‌های فرمت 
گرافیکی دیگر و فونت‌ها( را گرد هم می‌آورد و همه موارد را در یک پوشه ذخیره میک‌ند. اصولاً شبیه گرفتن 
کپی‌هایی برای ارسال با فایل است، ولی جامعیت لینکی را به وجود می‌آورد که هنگام باز شدن فایل در هر 
 ،Package بروید. در کادر محاوره‌ای   File>Package به  فرایند،  این  برای شروع  جایی، کار خواهد کرد. 
مقداری اطلاعات درباره فایل خود خواهید دید، هم‌چنین برگه‌هایی در سمت چپ این کادر محاوره‌ای برای 
عناصر دیگر سند وجود دارد، از قبیل Font Info، Links Info، Colors and Inks، Print Settings و 
غیره. قبل از ساخت پکیج از فایل خود، مطمئن شوید که چراغ سبز رنگ No Errors را در پایین فضای 
Package کلیک کنید و در کادر محاوره‌ای بعد، از شما خواسته می‌شود  InDesign دارید! روی  کاری 
پوشه پکیج را نام‌گذاری کنید و محل ذخیره‌سازی آن را مشخص کنید. هم‌چنین باید مشخص کنید کدام 
 Use عناصر سند را می‌خواهید داشته باشید. همیشه همه موارد را در حالت تأیید رها کنید، به استثنای
 High را با Select PDF Preset من معمولاً تنظیم Document Hyphenation Exceptions Only
Quality Print توصیه میک‌نم، ولی می‌توانید هر پیش‌تنظیمی را برای آن سند انتخاب کنید. حالا روی 
Package کلیک کنید. روی OK کلیک کنید، ولی به خاطر داشته باشید که فقط فونت‌های دارای مجوز در 
سند تعبیه می‌شوند. حالا به پوشه‌ای بروید که پکیج خود را ذخیره کرده‌اید و بررسی کنید تا مطمئن شوید 
همه اقلام در آنجا وجود دارد. شما یک PDF، فایل INDD و فونت‌ها و تصاویر در پوشه‌های خاص خود را 

دارید. چیزی را جابه‌جا نکنید، چون لینک‌ها گسسته می‌شوند.



132

شکل 7ـ9ـ ساخت پکیج

8ـ9ـ انتشار سند به‌صورت آنلاین

می‌توانید هر سند InDesign را به‌صورت آنلاین منتشر کنید و آن را با شبکه‌های اجتماعی، از طریق ایمیل 
یا حتی به‌عنوان یک صفحه وب مستقل به اشتراک بگذارید. هم‌چنین می‌توانید سند را در هر صفحه وب یا 
وبلاگی تعبیه کنید. نگارش HTML سند شما در تمام رایانه های رومیزی، تبلت‌ها و تلفن‌های هوشمند قابل 
مشاهده است و از همه انواع تعامل‌پذیری که ممکن است در سند InDesign داشته باشید، پشتیبانی میک‌ند. 
ابتدا، مطمئن شوید سند شما کامل و عاری از خطاست و سپس روی دکمه Share در نزدیکی گوشه سمت 
راست بالای فریم برنامه کاربردی کلیک کنید )یا به File>Publish Online بروید(. در کادر محاوره‌ای که 
نمایان می‌شود، روی برگه General کلیک کرده و Publish Online  را از منو انتخاب کنید نام و شرح 
مختصری به سند خود بدهید. محدوده صفحات را انتخاب کنید )صفحات خاصی یا کل سند( و تصمیم بگیرید 
آیا نمایش‌دهنده‌ها صفحات تکی را نمایش دهند یا اسپریدها را. سرانجام، می‌توانید گزینه‌ای را در حالت تأیید 
قرار دهید که به بیننده اجازه دانلود سند را به‌عنوان یک PDF می‌دهد و اینکه گزینه‌های به اشتراک‌گذاری 
و تعبیه برای اشتراک‌گذاری در دسترس نمایش‌دهنده خواهد بود. حالا روی برگه Advanced کلیک کرده و 
تصویر موردنظر خود را برای استفاده در پیش‌نمایش یا تصویر جلد انتخاب کنید. تنظیمات یکفیت تصویر را 
 OK موجود. برای شروع انتشار، روی PDF برای همه تصاویر در سند انتخاب کنید و همین‌طور یکفیت دانلود
کلیک کنید. هنگامیک‌ه فایل شما آپلود شد، برای مشاهده آن در مرورگر، روی View Document کلیک 
کنید. هم‌چنین می‌توانید برای کپی کردن یک لینک به فایل، روی Copy کلیک کنید، بنابراین می‌توانید 
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آن را با دیگران به اشتراک بگذارید و می‌توانید سند آنلاین را در کانال‌های رسانه‌های اجتماعی از قبیل 
Facebook یا Twitter یا از طریق ایمیل با کلیک کردن روی دکمه‌های موجود به اشترک‌ بگذارید.

شکل 8ـ9ـ انتشار آنلاین سند

9ـ9ـ وارد کردن فایل‌های اسناد

اگرچه شما می‌توانید از InDesign به عنوان واژه‌پرداز اصلی خود استفاده کنید، اما این کار بسیار ناکارآمد است.
در نشر، حداقل پیش‌نویس اولیه معمولاً در واژه‌پردازی نظیر Microsoft Word نوشته می‌شود. در صورتی 

که پیش‌نویس اولیه را در InDesign تایپ کنید، غلط‌گیری آن بسیار وقت‌گیر می‌شود.
اگرچه پیش‌نویس خود را در Word ایجاد کرده باشید یا نه، متن در یک نشریه InDesign وارد می‌شود 
تا صفحه‌آرایی و حروف‌چینی خوبی بر آن اعمال شود. علاوه بر وارد کردن فایل‌ها در InDesign، می‌توانید 
متن را به صفحه‌آرایی خود بکشید و از طریق استفاده از Windows Clipbord )کپی و الصاق( می‌توانید 

.InDesign فرمت‌های فایل را به میزان محدودی وارد کنید البته نه تحت پشتیبانی مستقیم

برای ممکن ساختن گزینه‌های به‌اشتراک‌گذاری، به کانال‌های رسانه اجتماعی خود وارد شوید.
توجه
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10ـ9ـ تعیین محل فرمت کردن اسناد

قابلیت‌های ورود InDesign ممکن است شما را اغوا کند مقدار زیادی از فرمت‌بندی متن خود را خارج از 
این برنامه انجام دهید، البته، این مسئله همیشه پیشنهاد نمی‌شود.

به دلیل اینکه قابلیت‌های فرمت‌بندی واژه‌پرداز کاملًا با ویژگی‌های حروف‌نگاری InDesign مطابقت ندارد، 
انجام فرمت‌بندی جامع در واژه‌پرداز، اغلب بی‌ارزش است. این حقیقت ویژه فرمت‌بندی مبتنی بر صفحه‌آرایی 
است. مثلًا، چند ستونی و شماره صفحات در سند InDesign نهایی از استاندارد بسیار بالاتری نسبت به 
آنچه که در واژه‌پرداز دیگری ایجاد کرده‌اید، برخوردار است. روی هم رفته، حتی ویژگی‌های فرمت‌بندی در 

واژه‌پردازهای امروزی چندان به آنچه که برای نشر واقعی لازم است، نزدیک نیست.
این واقعیت را در نظر داشته باشید که برنامه‌های صفحه‌آرایی از بیشتر فرمت‌بندی پیشرفته، از قبیل جداول در طی وارد 
کردن فایل صرف‌نظر میک‌نند، ولی این مسئله در InDesign واقعیت ندارد. شما می‌توانید جداول، پانویس‌ها و حتی 
سبک‌های پاراگراف خاص خودتان را در Microsoft Word یا در برنامه‌هایی را که می‌توانند فایل‌هایی که از 
style های متعددی در آن ها استفاده شده است به فرمت Word یا RTF صادر کنند، تولید کنید. با وجود این،  وقت 
زیادی روی چنین فرمت‌بندی پیچیده‌ای صرف نمیک‌نید، زیرا می‌خواهید از ابزارهای پیشرفته‌تر InDesign استفاده کنید.
در عوض، از InDesign برای صفحه‌آرایی خود و فرمت‌بندی متنی پیچیده )فونت‌ها، فاصله دو خط کرسی1 

و خط تیره‌گذاری( استفاده کنید و از واژه‌پرداز خود برای انجام این وظایف استفاده کنید:
  تنظیم جدول پایه )فرمت‌بندی عالی را به عهده InDesign بگذارید(

  پاورقی‌ها، ویرایش پایه متن، انتساب‌های سبک پاراگراف )شناسایی تیترها، کپی بدنه و غیره(

  فرمت‌بندی کاراکتری پایه )بولد، ایتالیک و دیگر فرمت‌بندی‌های مفهوم محور(

فرمت‌بندی واژه‌پرداز خود را محدود به نوع فرمت‌بندی کنید که درک خواننده را بهبود دهد یا بیانگر مفهومی 
باشد. در چنین فرمت‌بندی، ممکن است مثلًا از حالت ایتالیک یا بولد برای تأیکد بر کلمه‌ای استفاده کنید یا 
از سبک‌ها برای تنظیم عناوین و نام نویسنده مقاله در اندازه‌ها و فونت‌های مختلف استفاده کنید. اجازه دهید 

ویراستاران شما بر کلمات تمرکز کنند و وظایف ارائه را به صفحه‌آراهای شما واگذار کنند.
به  متنی  فایل‌های  تبدیل  باشید،  داشته  آن  انجام  به  نیاز  است  ممکن  که  فایل  آماده‌سازی  از  نوع  یک 
،Microsoft Word فرمت‌های  از  فقط   InDesign است.   InDesign پشتیبانی  تحت   فرمت‌های 
Rich Text Format (RTF) و فقط متن )ASCII( پشتیبانی میک‌ند. اگر از Corel WordPerfect یا 
Apple iWork Pages )یا هر واژه‌پرداز دیگری( استفاده میک‌نید، باید آن را به یکی از این فرمت‌های دیگر 

تبدیل کنید. در صورت امکان، باید آن را به فرمت RTF یا Microsoft Word ذخیره کنید.

InDesign هم‌چنین فایل‌های InCopy را وارد میک‌ند. InCopy یک برنامه افزودنی از Adobe است که 
برای ویراستاران، ویراستاران کپی و سایر هنرمندان غیر از صفحه‌آراهاست که به آن‌ها اجازه می‌دهد ویرایش 

متنی پایه فایل‌های صفحه‌آرایی را بدون به هم ریختن صفحه‌آرایی انجام دهند.

Leading ـ1

InDesign از هر دو نگارش doc. و docx. فایل‌های Microsoft Word پشتیبانی میک‌ند. هم‌چنین، با 
احتمال بسیاری، Adobe از فرمت‌های فایل بعدی Word نیز که عرضه می‌شوند، پشتیبانی خواهد کرد.

نکته
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بدیهی است که چرا شما در بیشتر موارد از فایل‌های متنی دوری میک‌نید، آن‌ها فرمت‌بندی ندارند.
 ،InDesign دست به انتخاب می‌زنید؟ برای بیشتر کاربران RTF و Word به هر حال، چگونه از بین فرمت‌های
آن‌ها یکسان هستند و از همه فرمت‌بندی موردنظر شما که می‌خواهید به صفحه‌آرایی‌های InDesign خود 

بیاورید، پشتیبانی میک‌نند.
تفاوت واقعی در قابلیت واژه‌پردازی آن‌هاست. فرمت RTF از ویژگی‌های کمتری نسبت به Word پشتیبانی 
میک‌ند؛ آنچه که برای بیشتر افراد مهم است این است که فایل RTF نمی‌تواند اطلاعات رهگیری تغییر را 
داشته باشد، در حالیک‌ه فایل Word می‌تواند. اگر گردش کار ویرایش شما وابسته به رهگیری تغییرات است، 

از فرمت RTF استفاده نکنید.

11ـ9ـ حفظ ویژگی‌های خاص در فایل‌های متنی

واژه‌پردازهای امروزی به شما اجازه می‌دهند کارهای بیشتری از تایپ و ویرایش متن انجام دهید. هم‌چنین 
می‌توانید کاراکترهای خاص، جداول، سرصفحه‌ها و پاصفحه‌ها و عناصر دیگر سند را ایجاد کنید. بعضی از این 

ویژگی‌ها هنگام وارد شدن به یک برنامه نشر کار میک‌نند، ولی بقیه کار نمیک‌نند.
InDesign فرمت‌بندی Word ذیل را وارد میک‌ند:

  تمام حروف بزرگ

  بولد

  فهرست‌های شماره‌دار

  رنگ

  تقسیم‌بندی ستون‌ها

  فاصله‌گذاری فشرده/ بسطی‌افته

  خط زدن کلمات با دو خط

  خطوط زیر دوبل

  حروف اول بزرگ در متن‌ها

  فونت

  پاورقی‌ها و یادداشت‌های پایانی

  تورفتگی‌ها

  متن فهرست مطالب و نمایه

  گرافیک‌های درونی )اگر به فرمت تحت پشتیبانی InDesign باشند(

  ایتالیک

  رئوس کلی

  شکست‌های صفحات

  شیوه‌نامه‌های پاراگراف و کاراکتر

  اندازه نقطه‌ای

)InDesign نه InCopy رهگیری بازبینی‌ها/ خط قرمزها )برای استفاده در  
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  حروف کوچک

  خط زدن حروف و کلمات

  اندیس‌ها و زِبرَوندها

  جداول

  کادرهای متنی

  گزینه‌های خط زیر

  خطوط زیر

فرمت‌های ذیل به‌طور جزئی پشتیبانی می‌شوند یا در طی ورود تبدیل می‌گردند:
  متن برجسته

  متن کندهک‌اری شده

  خط زیر کلمات

فرمت‌های زیر پشتیبانی نمی‌شوند و هر متنی که از آن‌ها استفاده کند، به‌عنوان متن ساده وارد می‌شود:
  حالت‌های متمایز

  حروف سایه‌دار

  جلوه‌های متنی، از قبیل حالت چشمک‌زن

فرمت‌های ذیل پشتیبانی نمی‌شود و هر متنی که از آن‌ها استفاده کند، در طی ورود حذف می‌شود:
  حاشیه‌نویسی‌ها و توضیحات

  متن پنهان )حذف شده در طی ورود(

  شکست‌های بخش‌ها

  اقلام OLE/ اشتراکی

  شکست‌های کلمات در انتهای خطوط

 1ـ11ـ9ـ جداول
واژه‌پردازها ویراستارهای جدول بسیار توانمندی را توسعه داده‌اند که به شما اجازه می‌دهند اطلاعات جدولی 
برابری میک‌نند.  برنامه‌های صفحه گسترده اختصاصی  با  اغلب  را خیلی سریع و آسان فرمت‌بندی کنید و 
InDesign می‌تواند جداول ایجاد شده در Word یا Excel و همین‌طور جداول موجود در اسناد RTF را 

وارد کند.

 2ـ11ـ9ـ سرصفحه‌ها و پانویس‌ها
سرصفحه‌ها و پانویس‌ها مسئله صفحه‌آرایی هستند نه مسئله متن، بنابراین دلیلی ندارد که این عناصر را در 
برنامه واژه‌پردازی خود داشته باشید. به دلیل اینکه شماره صفحات برمبنای صفحه‌آرایی InDesign تغییر 

میک‌ند، نباید سرصفحه‌ها و پانویس‌ها را در سند واژه‌پرداز انجام دهید. 
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 3ـ11ـ9ـ پاورقی‌ها و یادداشت‌های انتهایی
 InDesign  ،اگر از ویژگی پاورقی یا یادداشت انتهایی واژه‌پرداز استفاده کرده باشید و فایل متنی را وارد کنید
به درستی پاورقی‌ها را در پایین ستون و یادداشت‌های انتهایی را در انتهای متن وارد شده قرار می‌دهد. اعداد 

یا کاراکترهای زِبرَوند شده در یادداشت‌ها نیز معمولاً به درستی ترجمه می‌شوند.

 4ـ11ـ9ـ هایپرلینک‌ها
باشید،  را در متن خود داشته  اجازه می‌دهند هایپرلینک‌ها  به شما   Word از قبیل  امروزی،  واژه‌پردازهای 
بنابراین هنگام صدور به فرمت‌های HTML یا PDF، خواننده می‌تواند روی لینک کلیک کند و به صفحه 
وارد  هایپرلینک‌هایی  چنین  با  را  متنی  فایل‌های  هنگامیک‌ه  بپرد.   eBook فایل  با  دیگری   PDF یا  وب 
میک‌نید، InDesign فرمت‌بندی بصری و لینک واقعی آن‌ها را حفظ میک‌ند، هایپرلینک‌ها معمولاً به رنگ 

داده می‌شوند. نشان  زیرخط‌دار  آبی 

 5ـ11ـ9ـ کادرهای متنی و گرافیک‌های داخلی
واژه‌پردازهای امروزی معمولاً از گرافیک‌های داخلی پشتیبانی میک‌‌نند و به شما اجازه می‌دهند گرافیک را در 
سند واژه‌پرداز خود وارد کنید و آن را در متن تعبیه کنید. مثلًا، Word به شما اجازه وارد کردن گرافیک را 
می‌دهد و InDesign نیز می‌تواند گرافیک‌ها را با متن شما وارد کند، مادامی که InDesign از فرمت‌هایشان 
وارد   InDesign در   1 OLE طریق  از  شما  واژه‌پرداز  سند  در  تعبیه‌شده  گرافیک‌های  ولی  کند.  پشتیبانی 

نمی‌شود، البته این فناوری این روزها نادر است و خیلی نگران آن نباشید.
InDesign از کادرهای متنی درون یک فایل Word به‌عنوان فریم‌های متنی مجزا پشتیبانی میک‌ند. اگر 
این کادرهای متنی Word به بخشی خاص از متن گره خورده باشند به‌طوریک‌ه با آن متن جریان پیدا ک‌نند، 

InDesign از آن لینک‌ها پشتیبانی کرده و به شما اجازه می‌دهد آن‌ها را تنظیم کنید.

 6ـ11ـ9ـ افزودن متن
مهم نیست که متن از کجا می‌آیدـ از ذهن شما، از ایمیل، از وب، از یک واژه‌پردازـ می‌توانید آن را به سادگی 
در یک سند InDesign وارد کنید. می‌توانید مستقیماً در InDesign متن را تایپ کنید، آن را الصاق کنید، 

بکشید و بیندازید یا آن را وارد کنید.
 InDesign با متن داخل فریم‌ها کار میک‌ند که می‌توانید در ابتدا ایجاد کنید یا اجازه دهید InDesign

هنگام وارد کردن متن، آن را برای شما ایجاد کند.

Type 7ـ11ـ9ـ استفاده از ابزار 
شما بدون ابزار Type نمی‌توانید کاری با متن انجام دهید. بعد از انتخاب ابزار Type، می‌توانید در بلوک متن 

Object Linking and Embedding ـ1
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 Type موجودی کلیک کنید یا برای ایجاد فریم متنی جدیدی، کلیک کنید و بکشید. حتی می‌توانید با ابزار
در هر فریم گرافیکی خالی یا فریم نسبت داده نشده کلیک کنید تا آن را به یک فریم متنی تبدیل کنید.

 Master کلیک کنید )فریم‌های متنی قرار گرفته در صفحه با صفحه Master نمی‌توانید در فریم‌های متنی
در حال استفاده( و به سادگی شروع به تایپ کنید. برای انتخاب فریم متنی Master و افزودن متن به آن، 

Shift+Click یا Ctrl+Shift+Click کنید.
از این لحظه، برای ورود متن شروع به تایپ کنید یا متن را از برنامه‌های دیگر بیاورید. اگر می‌خواهد متن 
جایبانی1 را اضافه کنید )متن تصادفی که مثلًا ممکن است برای امتحان فرمت‌بندی خود استفاده کنید(، 
Type>Fill with Placeholder Text را انتخاب کنید. InDesign متن لاتین جعلی را به فریم متنی اضافه 

میک‌ند تا وقتی که آن را پر کنید.
 [Basic Paragraph است  تنظیم شده  آن  برای  را که  ویژگی سبکی  تایپ کردن متن جدید، هر  هنگام 
[Style می‌گیرد، یک سبک از پیش‌تعریف شده در InDesign. می‌توانید این سبک از قبل تعریف شده را 

تغییر دهید، زیرا می‌توانید هر سبکی را ایجاد کنید.

 8ـ11ـ9ـ الصاق متن
هنگامیک‌ه متن در کلیپ‌بورد Windows قرار دارد و ابزار Type در InDesign فعال است، می‌توانید متن 
را در محل مکان‌نما )نقطه درج متن( الصاق کنید یا متن متمایز شده را با آن جایگزین کنید. اگر هیچ فریم 
متنی فعال نیست، InDesign یک فریم متنی مستطیلی برای در برگرفتن متن الصاق‌شونده ایجاد میک‌ند.

InDesign از فرامین منوی استاندارد و فرامین صفحه کلید برای بریدن و کپی کردن متن در کلیپ‌بورد و 
برای الصاق متن استفاده میک‌ند. از Ctrl+X برای بریدن، Ctrl+C برای کپی کردن و Ctrl+V برای الصاق 

استفاده می‌شود.
به‌طور پیش‌فرض، متن الصاق‌شونده فرمت‌بندی خود را حفظ میک‌ند )مثلًا بولد بودن و اندازه فونت(. با وجود 
این، InDesign به شما اجازه می‌دهد کنترل کنید آیا متن الصاق‌شده فرمت‌بندی خود را حفظ کند، به این 

صورت:
  هنگام الصاق متن از InDesign، می‌توانید با انتخاب File>Paste without Formatting )یا با فشردن 

Ctrl+Shift+V(، فرمت‌بندی آن را بردارید.
  هنگام الصاق متن از خارج InDesign، گزینه Paste with Formatting مشابهی دارید و یک گزینه هم 

 Clipboard برای لغو خودکار فرمت‌بندی دارید. برای فعال کردن حذف خودکار فرمت‌بندی، به پیشخوان
را   Edit>Preferences>Clipboard Handling( بروید   Preferences محاوره‌ای  کادر  از   Handling

انتخاب کنید یا Ctrl+K را فشار دهید( و دکمه رادیویی Text Only را برای تنظیم Paste انتخاب کنید.
 All برای اطمینان از حفظ فرمت‌بندی در متن کپی‌شونده از برنامه‌های کاربردی دیگر، دکمه رادیویی  

Information را در حالت تأیید قرار دهید.
همچنین هنگام الصاق متن، InDesign به قدر کافی هوشمند است که بداند فاصله‌های اضافی را حذف کند یا 
 Adjust Spacing Automatically آن‌ها را به متن الصاق‌شونده اضافه کند. می‌توانید با عدم انتخاب گزینه
When Cutting and Pasting Words در پیشخوان Type کادر محاوره‌ای Preferences را غیرفعال کنید.

Placeholder ـ1
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 9ـ11ـ9ـ کشیدن و انداختن متن
همچنین می‌توانید متن انتخابی را از فریم یا سند دیگری بکشید و در یک فریم متنی در سند جاری بیندازید. 
اگر در حین کشیدن Alt را فشار داده و نگه دارید، یک کپی از متن انتخابی را میک‌شید و متن اصلی جابه‌جا 

نمی‌شود.
Story Editor می‌دهد. برای فعال کردن  InDesign اجازه کشیدن و انداختن را در  به‌طور پیش‌فرض، 
بروید   Preferences محاوره‌ای  کادر  از   Type پیشخوان  به  خود،  صفحه‌آرایی  در  انداختن  و  کشیدن 
 Enable in Layout را فشار دهید( و گزینه   Ctrl+K یا  انتخاب کنید  را   Edit>Preferences>Type(
 Enable in Story Editor را انتخاب کنید. همچنین می‌توانید کشیدن و انداختن را با انتخاب گزینه View

در Story Editor انجام دهید.
همچنین می‌توانید متن را از منابع خارجی به InDesign بکشید:

  می‌توانید آیکن فایل متنی یا فایل واژه‌پردازی تحت پشتیبانی را مستقیماً از Windows Explorer به 

صفحه InDesign بکشید.
  می‌توانید متن متمایزشده از یک سند ایجادشده با برنامه دیگری )مثلًا، Microsoft Word( را به پنجره 

سند InDesign بکشید.
 InDesign در هر دو حالت، فریم متنی جدیدی ایجاد می‌شود و همه سبک‌ها در فایل‌های منبع نیز به 
آورده می‌شوند. برخلاف وارد کردن فایل از طریق فرمان Place )که در ادامه این واحد کار بیان می‌شود(، 
هیچ کنترلی بر فرمت‌بندی چنین ورودی ندارید؛ در عوض، تمام فرمت‌بندی وارد می‌شود یا هیچک‌دام وارد 

نمی‌شود که این مسئله وابسته به تنظیمات ترجیحات InDesign است.
همانند کپی و الصاق، InDesign به شما اجازه می‌دهد روی حفظ فرمت‌بندی متن کشیده‌شده کنترل داشته باشید:

  هنگام کشیدن متن در InDesign، برای حذف فرمت‌بندی متن کلید Shift را فشرده و نگه دارید. سپس 

متن کشیده‌شده فرمت‌بندی متن موجود را به خودش می‌گیرد.
  هنگام کشیدن متن خارج از InDesign، از گزینه Text Only در پیشخوان Clipboard Handling کادر 

محاوره‌ای Preferences استفاده کنید تا فرمت‌بندی کل متن کشیده‌شده از بین برود.

Place 10ـ11ـ9ـ وارد کردن متن با کادر محاوره‌ای 
روی  بیشتری  کنترل  دهید(  فشار  را   Ctrl+D یا  کنید  انتخاب  را   File>Place(وPlace محاوره‌ای  کادر 

می‌دهد. شما  به  متن  کردن  وارد  چگونگی 
متن واردشونده از طریق کادر محاوره‌ای Place برطبق انتخاب جاری شما قرار می‌گیرد:

  اگر مکان‌نما )اشاره‌گر درج متن( در متن در یک فریم متنی فعال باشد، متن در آن مکان درج می‌شود.

  اگر فریم متنی انتخاب شده باشد، ولی در متن فریم کلیک نشده باشد، متن در فریم وارد شده و جایگزین 

همه متن موجود می‌شود.
  اگر دو یا چند فریم متنی انتخاب شده باشند، یک آیکن متن بارگذاری شده نمایان می‌شود.

  اگر هیچ فریم متنی انتخاب نشده باشد، آیکن متن بارگذاری شده به شما اجازه رسم فریم متنی مستطیلی 

برای دربرگرفتن متن، کلیک کردن در فریم خالی موجود یا کلیک کردن در هر ناحیه خالی در صفحه‌آرایی 
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شما را برای ایجاد یک فریم متنی می‌دهد.
برای قرار دادن متن، این مراحل را دنبال کنید:

File>Place 1 را انتخاب کنید یا Ctrl+D را فشار دهید.
2 فایل‌های متنی موردنظر خود را برای ورود پیدا کنید.

3 گزینه‌های ورود مناسب را برای فایل‌های متنی تعیین کنید.
  اگر بخواهید چگونگی مدیریت فرمت‌بندی فعلی را در فایل مشخص کنید، گزینه Show Import Options از 

کادر محاوره‌ای Place را انتخاب کرده و روی Open کلیک کنید. انجام این کار موجب باز شدن کادر محاوره‌ای 
Import Options مناسب برای فرمت فایل متنی می‌شود. برای وارد کردن متن، روی OK کلیک کنید )کادر 
محاوره‌ای Import Options در ادامه این واحد کار بررسی می‌شود(. اگر گزینه Show Import Options را 

انتخاب نکنید، کلیک کردن Open موجب وارد شدن متن با استفاده از تنظیمات پیش‌فرض می‌شود. 
  اگر یک فریم متنی یا محدوده‌ای از متن را انتخاب کرده باشید و بخواهید آن را با متن قرارگیرنده جایگزین 

کنید، گزینه Replace Selected Item را انتخاب کنید.
  از گزینه Create Static Captions در اینجا صرف‌نظر می‌شود، زیرا فقط بر گرافیک‌ها اعمال می‌شود که 

در ادامه این واحد کار بررسی خواهد شد.
4 اگر قبل از شروع به وارد کردن متن، فریمی را انتخاب نکرده باشید، با کلیک کردن و کشیدن آیکن متن 
بارگذاری شده، محل متن را مشخص کنید تا یک فریم متنی مستطیلی ایجاد شود یا در یک فریم موجود 

کلیک کنید یا در هر فریم خالی کلیک کنید.
روی  کردن  کلیک  و   Ctrl گرفتن  با  یا  محدوده  یک  روی  کردن  کلیک  و   Shift گرفتن  با  می‌توانید  شما 
تک تک فایل‌ها، چندین فایل )متن یا گرافیک( را در کادر محاوره‌ای Place انتخاب کنید. InDesign به شما 
اجازه قرار دادن هر فایل در یک فریم مجزا را می‌دهد. کافی است هر فایل یک بار وارد شود، کلیک کنید یا 
Ctrl+Shift را نگه داشته و کلیک کنید تا InDesign را مجبور کنید همه فایل‌ها را در صفحه در فریم‌های 
مجزا قرار دهد. اگر در یک زمان بیش از یک فایل را قرار دهید، آیکن متن بارگذاری شده، تعداد فایل‌های 

قرارگیرنده و همین‌طور پیش‌نمایشی از هر فایل را نمایش می‌دهد.
انتخاب کنید. برای لغو یک فایل خاص در یک ورود  ابزار متفاوتی را  برای لغو کل ورود متن، کافی است 
چندفایلی، هنگام نمایان شدن پیش‌نمایش کوچک آن فایل، Esc را فشار دهید )بقیه فایل‌ها هم‌چنان برای 

قرار گرفتن در دسترس هستند(.

Microsoft Word و RTF 12ـ9ـ گزینه‌های ورود برای فایل‌های

InDesign گزینه‌های زیادی برای کنترل چگونگی ورود فایل‌های RTF و Word از طریق کادر محاوره‌ای 
Place ارائه می‌دهد. گزینه‌های متعددی وجود دارد که واقعاً می‌توانید ترجیحات ورود خود را به‌عنوان یک 

فایل پیش‌تنظیم برای استفاده تکراری ذخیره کنید.
شکل 9ـ9 کادر محاوره‌ای Import Options را برای Microsoft Word نشان می‌دهد. این کادر محاوره‌ای، 

چهار گروه گزینه دارد )گزینه‌های ورود برای فایل‌های RTM نیز یکسان است(.
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Microsoft Word Import Options شکل 9ـ9ـ کادر محاوره‌ای

در بالای این پیشخوان، منوی بازشوی Preset وجود دارد که به شما اجازه انتخاب از مجموعه‌های ذخیره‌شده‌ای 
از گزینه‌های ورود را می‌دهد. اگر هر یک از گزینه‌های موجود در این کادر محاوره‌ای را تغییر دهید، منوی 
بازشویی نشان داده می‌شود ]Custom[، بنابراین می‌دانید که همه تنظیمات پیش‌تنظیم منتخب برای ورود 
Save Preset، تنظیمات را ذخیره کنید و  با کلیک کردن روی  این فایل خاص تغییر کرده‌اند. می‌توانید 
می‌توانید یک پیش‌تنظیم را به‌عنوان رفتار ورود پیش‌فرض با کلیک کردن Set as Default تنظیم کنید؛ 
انتخاب  اینکه پیش‌فرض جدیدی را  این تنظیمات برای ورود تمام فایل‌های Word استفاده می‌شود، مگر 
کرده باشید یا تغییراتی در این کادر محاوره‌ای داده باشید. این ویژگی به شما اجازه می‌دهد از بهک‌ارگیری 

کادر محاوره‌ای Import Options برای ورودهای روتین خود اجتناب کنید.
 Table of :کنار بگذارید Word به شما اجازه می‌دهد انواع خاصی از متن را از فایل ،Include ،بخش بعدی
Contents Text،وIndex Text،وFootnotes و Endnotes. هر یک از اقلام منتخب وارد می‌شوند.  وارد 
 InDesign کردن متن فهرست مطالب یا نمایه متداول نیست، زیرا شما معمولاً فهرست مطالب و نمایه‌ها را در

ایجاد میک‌نید.
بخش سوم، Options، فقط یک گزینه دارد: Use Typographer’s. در صورت انتخاب، این گزینه علائم 
گیومه صفحه کلید )’ و ”( را به علائم گیومه حروف‌نگاری منحنی شکل تبدیل میک‌ند )’ و’، ”و”(. توجه 
داشته باشید که InDesign دو خط تیره پشت سرهم را به یک em dash تبدیل نمیک‌ند )بعضی برنامه‌ها 

این کار را انجام می‌دهند(.
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بخش چهارم، Formatting، نسبتاً پیچیده است.
 InDesign برای حذف فرمت‌بندی در طی ورود، به‌طوری که متن تازه‌ای داشته باشید و بتوانید سبک‌های
خودتان را بر آن اعمال کنید، گزینه Remove Styles and Formatting را از بخش Formatting انتخاب 

کنید. در صورت انتخاب این گزینه، دو کنترل اضافی در دسترس قرار می‌گیرند:
  Preserve Local Overrides: انتخاب این گزینه فرمت‌بندی محلی از قبیل ایتالیک و بولد بودن را 

در حین صرف‌نظر از ویژگی‌های سبک پاراگراف حفظ میک‌ند. شما معمولاً این گزینه را انتخاب میک‌نید تا 
فرمت‌بندی وابسته به معنا حفظ شود.

  Convert Tables To: می‌توانید از این منوی بازشو برای انتخاب چگونگی عدم فرمت‌بندی جداول در 

طی ورود استفاده کنید. آیتم منوی Unformatted Tables ساختار خانه جدول را حفظ میک‌ند، ولی از 
فرمت‌بندی متن و خانه صرف‌نظر میک‌ند، در حالیک‌ه آیتم منوی Unformatted Tabbed Text جدول را 
به متن Tab دار تبدیل میک‌ند )با جداسازی Tab آنچه که برای خانه‌ها و پاراگراف و هم‌چنین برای ردیف‌ها 
استفاده می‌شود( و همه فرمت‌بندی را از بین می‌برد. اگر  قصد دارید جداول را به‌صورت جدول نگه دارید ولی 

آن‌ها را در InDesign فرمت‌بندی کنید، Unformatted Tables را انتخاب کنید.
برای حفظ فرمت‌بندی متن در طی ورود، به‌طوری که سند InDesign حداقل استفاده از تنظیمات انجام 
شده در Word را شروع کند، گزینه Preserve Styles and Formatting from Text and Tables را 
انتخاب کنید. دو دلیل برای انتخاب این گزینه وجود دارد. متداول‌ترین دلیل این است که شما از شیوه‌نامه‌ها 
در Word با نام‌های مشابه در InDesign استفاده میک‌نید. انجام این کار، مانع از اعمال دستی شیوه‌های 
ویراستاری  هنگام  )ویراستاران  می‌شود  شما  طراحان  توسط  صفحه‌آرایی‌ها  روی  کردن  کار  هنگام  صحیح 
معمولاً در Word کار میک‌نند(. دلیل دیگر این است که فایل Word شما واقعاً یک قالب ابتدایی از فایل 
InDesign نهایی شماست، بنابراین شما باید تمام تلاش خود در Word را حفظ کنید و از آن به‌عنوان پایه 

و اساسی برای پالایش در InDesign استفاده کنید.
گزینه Preserve Styles and Formating from Text and Tables چند کنترل دارد: 

 Word این منوی بازشو به شما اجازه می‌دهد شکست‌های صفحه وارد شده در :Manual Page Breaks  

را حفظ کنید، آن‌ها را به شکست‌های ستون تبدیل کنید یا آن‌ها را حذف کنید. گزینه شکست انتخابی شما 
وابسته به چگونگی سازمان‌دهی صفحه‌آرایی شما در مقایسه با صفحه‌آرایی فایل Word است.

  Import Inline Graphics: این گزینه، در صورت انتخاب، تصاویر قرار گرفته در متن Word را وارد 

میک‌ند.
 InDesign را در Word این گزینه، در صورت انتخاب، تمام شیوه‌نامه‌های :Import Unused Styles  

بارگذاری میک‌ند، به‌جای اینکه فقط آن‌هایی را وارد کند که واقعاً در متن فایل به کار گرفته‌اید. شما به‌طور 
عادی نمی‌خواهید تمام شیوه‌های Word را وارد کنید، زیرا این برنامه صدها شیوه از پیش‌تعریف شده دارد 

که می‌توانند پنل‌های Paragraph Styles و Character Styles برنامه InDesign را مسدود کنند.
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  Track Changes: این گزینه، در صورت انتخاب، تمام تغییرات رهگیری شده توسط Word را ذخیره 

کرده و آن را در دسترس کاربران InCopy و InDesign قرار می‌دهد که روی فایل InDesign کار میک‌نند.
فهرست‌های  تمام  انتخاب،  صورت  در  گزینه،  این   :Convert Bullets & Numbers to Text   

شماره‌گذاری و بولت‌گذاری خودکار در Word را حذف میک‌ند و بولت‌ها و شماره‌ها را به کاراکترهای واقعی 
تبدیل میک‌ند. اگر این گزینه را انتخاب کنید و آیتمی را در یک لیست شماره‌گذاری شده وارد شده درج 

نمی‌شود. شماره‌گذاری  دوباره  خودکار  به‌طور  لیست  این  کنید، 
مشابه  نام  با  شیوه‌هایی   Word فایل  که  دهد  تشخیص   InDesign اگر   :Style Name Conflicts   

شیوه‌های موجود در سند InDesign شما دارد، از تعداد نام شیوه‌های تکراری که میی‌ابد در برچسب سمت 
راست Style Name Conflicts یادداشت برمی‌دارد. بنابراین شما دو روش برای مدیریت این تضادها دارید، 

با منوهای بازشوی مجزا برای شیوه‌های پاراگراف و شیوه‌های کاراکتری.
  اگر گزینه Import Styles Automatically را انتخاب کنید، سه گزینه برای شیوه‌های پاراگراف و کاراکتر 

 Character Style و Paragraph Style Conflicts( دریافت میک‌نید، البته با استفاده از دو منوی بازشوی مجزا
Conflicts(. آیتم منوی Use InDesign Style Definition شیوه‌های جاری InDesign را حفظ میک‌ند 
و آن‌ها را بر تمام متن Word اعمال میک‌ند که از شیوه‌نامه‌ای با نام مشابه استفاده میک‌ند. این رایج‌ترین 
گزینه است، زیرا به ویراستاران شما اجازه می‌دهد نشان دهند چه شیوه‌هایی در InDesign استفاده شده‌اند، 

ولی متکی به تنظیمات حروف‌نگاری دقیق‌تر InDesign هستند.
  اگر آیتم منوی Redefine InDesign Style را انتخاب کنید، فرمت‌بندی شیوه‌نامه Word به‌طور دائمی 

جایگزین شیوه‌نامه‌های InDesign می‌شود. اگر آیتم منوی Auto Rename را انتخاب کنید، نام شیوه‌نامه 
امر  این  Character Styles اضافه می‌شود.  یا   Paragraph Styles Word تغییر میک‌ند و به پنل  فایل 
شیوه‌های موجود InDesign شما را حفظ میک‌ند، در حالیک‌ه شیوه‌نامه‌های وارد شده از فایل Word را نیز 

حفظ میک‌ند.
بگیرید که کدام شیوه‌های  انتخاب کنید، می‌توانید تصمیم  را   Customize Style Import اگر گزینه    

 InDesign شیوه‌های ،Word با نام مشابه را لغو کنند و کدام شیوه‌های Word شیوه‌های ،InDesign خاص
با نام مشابه را لغو کنند و نام کدام شیوه‌های Word در طی ورود تغییر کند تا از هر گونه لغوی جلوگیری 
 Style که در شکل 10ـ9 نشان داده شده است، روی Style Mapping شود. برای باز کردن کادر محاوره‌ای
Mapping کلیک کنید. تصمیمات بیان شده را در این کادر محاوره‌ای می‌گیرید. هم‌چنین می‌توانید روی 
Auto-rename Conflicts در آن کادر محاوره‌ای کلیک کنید تا نام تمام شیوه‌های Word دارای تضاد به 
 Import در منوهای بازشوی Auto Rename نام‌های جدیدی تغییر کند )انتخاب این گزینه شبیه انتخاب

Styles Automatically است(.
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Style Mapping شکل 10ـ9ـ کادر محاوره‌ای

 13ـ9ـ گزینه‌های ورود برای فایل‌های فقط متنی

گزینه‌های فایل‌های فقط متنی )ASCII( خیلی ساده‌تر هستند، همان‌گونه که شکل 11ـ9 نشان می‌دهد:

شکل 11ـ9ـ سمت چپ: کادر محاوره ای Text Import Options برای فایل فقط متنی
Microsoft Excel Import Options سمت راست: کادر محاوره‌ای

  منوی بازشوی Character Set: این منو به شما اجازه می‌دهد نوع رمزگذاری فایل متن را تغییر دهید. این 

 Central ، Chinese، European منو 33 گزینه دارد که عمدتاً برای زبان‌های مختلف و گروه‌های زبانی از قبیل
Baltic، Turkish ، Greek و Japanese هستند. در بیشتر موارد، شما این منو را در حالت پیش‌فرض ANSI یا 
یکی از فرمت‌های UTF رها میک‌نید. تنها در صورتی که می‌دانید فایل با چیز دیگری رمزگذاری شده است، 

گزینه دیگری را انتخاب کنید.
  منوی بازشوی Platform: این منو به شما اجازه می‌دهد تا از بین Macintosh و Windows دست به 

انتخاب بزنید. هر کدام که برای فایل منبع مناسب است، انتخاب کنید. 
  منوی بازشوی Set Dictionary To: این منو به شما اجازه می‌دهد هجی پیش‌فرض و زبان فرهنگ 
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لغات را نسبت دهید. می‌توانید این گزینه را در حالت پیش‌فرض رها کنید، مگر اینکه روی چند زبان یا منطقه 
کار میک‌نید. این گزینه وابسته به زبانی است که هنگام نصب InDesign انتخاب کرده‌اید.

کنترل  را  مدیریت سرخط‌ها  می‌توانید چگونگی  بخش،  این  در   :Extra Carriage Returns بخش    

 Remove at End of Every کنید. در صورتی که فایل منبع یک سرخط در انتهای هر خط دارد، گزینه
Line را انتخاب کنید )این مورد اغلب نتیجه کپی کردن متن از وب یا از یک فایل PDF است(. چنانچه فایل 
 Remove Between منبع از دو سرخط سخت برای نشان دادن پاراگراف‌های جدید استفاده میک‌ند، گزینه
Paragraphs را انتخاب کنید. می‌توانید هیچک‌دام، یکی یا دوتا را که مناسب فایل منبع شما هستند، انتخاب کنید.
  بخش Formatting: در این بخش، می‌توانید گزینه Replace را انتخاب کنید تا چندین فاصله پی در پی 

تبدیل به یک Tab شود )می‌توانید تعداد حداقل فاصله‌ها را در فیلد مربوطه مشخص کنید(.
هم‌چنین می‌توانید گزینه Use Typographer’s Quotes را برای تبدیل علائم گیومه صفحه کلید به علائم 

گیومه حروف‌نگاری انتخاب کنید. این گزینه به‌طور عادی انتخاب شده است.

InCopy 1ـ13ـ9ـ فایل‌های 
هنگام وارد کردن فایل‌های InCopy هیچ گزینه‌ای وجود ندارد. به دلیل اینکه آن‌ها حاوی فرمت‌بندی اعمال 

شده به‌عنوان بخشی از یک چیدمان InDesign هستند، InDesign آن‌ها را به همان صورت وارد میک‌ند.

Microsoft Excel 14ـ9ـ گزینه‌های ورود برای فایل‌های

هنگام وارد کردن صفحات گسترده Microsoft Excel، گزینه‌های متعددی دارید، همان‌گونه که در شکل 
11ـ9 نشان داده شد. در بخش Options، می‌توانید تنظیمات ذیل را کنترل کنید:

  منوی بازشوی Sheet: می‌توانید مشخص کنید کدام برگه را در یک کارپوشه وارد میک‌نید. پیش‌فرض، 

Sheet1 نامیده می‌شود مگر اینکه شما نام آن را در Excel تغییر داده باشید  اولین برگه است که معمولاً 
)اگر می‌خواهید چندین برگه را وارد کنید، باید چندین مرتبه صفحه گسترده یکسانی را وارد کنید و هر بار 

برگه متفاوتی را انتخاب کنید(.
  منوی بازشوی View: می‌توانید نماهای سفارشی را که در Excel برای آن صفحه گسترده تعریف کرده‌اید، 

وارد کنید. اگر سند Excel دو نمای سفارشی دارد، می‌توانید با انتخاب ]Ignore View[ از منوی بازشو، از 
نماهای سفارشی صرف‌نظر کنید. اگر هیچ نمای سفارشی ندارید، این منوی بازشو غیرفعال خواهد بود.

 Excel می‌توانید محدوده خانه‌های استفادهک‌ننده از نمادگذاری استاندارد :Cell Range منوی بازشوی  

یعنی Sx:Ey را مشخص کنید که S اولین ردیف، x اولین ستون، E آخرین ردیف و y آخرین ستون هستند، 
از قبیل A1:G89. می‌توانید محدوده را مستقیماً در منوی بازشو تایپ کنید که به‌عنوان یک فیلد ورود متن 

نیز عمل میک‌ند یا می‌توانید از محدوده وارد شده قبلی از منوی بازشو انتخاب کنید.
  Import Hidden Cells Not Saved in View: با انتخاب این گزینه، تمام خانه‌های پنهان نیز وارد 

می‌شوند. هنگام انجام این کار، مواظب باشید، زیرا معمولاً به دلیلی پنهان شده‌اند )معمولاً، آن‌ها منابع داده 
بی‌اهمیت یا محاسبات میانی را نشان می‌دهند(.
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در بخش Formatting، می‌توانید این تنظیمات را کنترل کنید:
را  که صفحه‌گسترده  میک‌نید  انتخاب  را   Formatted Table منوی  آیتم  Table: شما  بازشوی  منوی    

به‌عنوان جدول وارد میک‌ند و فرمت‌بندی متن و خانه را حفظ میک‌ند؛ آیتم منوی Unformatted Table که 
 Unformatted صفحه گسترده را به‌عنوان جدول وارد میک‌ند، ولی فرمت‌بندی را حفظ نمیک‌ند؛ یا آیتم منوی
Table Text که صفحه گسترده را به‌عنوان متن Tab دار وارد میک‌ند )Tab خانه‌ها و پاراگراف‌ها، ردیف‌ها 

را از هم جدا میک‌نند( و هیچ فرمت‌بندی را حفظ نمیک‌ند.
  منوی بازشوی Table Styles: در اینجا، می‌توانید یک شیوه جدولی InDesign را برای اعمال بر جدول 

.)]No Table Style[ وارد شده انتخاب کنید یا آن را تنها رها کنید )با انتخاب
  منوی بازشوی Cell Alignment: می‌توانید به InDesign بگویید چگونه متن را در خانه‌ها تراز کند. 

انتخاب  با  یا  را حفظ کنید  فعلی صفحه گسترده  ترازبندی   ،Current Spreadsheet انتخاب  با  می‌توانید 
Left، Right یا Center، آن‌ها را لغو کنید.

  Include Inline Graphics: این گزینه، در صورت انتخاب، به شما امکان وارد کردن هر گرافیک قرار 

گرفته در خانه‌های Excel را می‌دهد.
تایپ  را  اعداد  برای  اعشار  ارقام  تعداد  فیلد،  این  در   :Number of Decimal Places to Include   

مقدار   InDesign هستند،   n مقدار  حاوی  که  خانه‌هایی  و  کنید  تایپ  را   4 فیلد  این  در  اگر  مثلًا،  کنید. 
نمایش می‌دهد  را  اعشار  تا 10 رقم   Excel اگرچه صفحه گسترده  وارد میک‌ند، حتی  را   3.1415 عددی 
(3.1415926535). توجه داشته باشید که InDesign هیچ فرمولی را وارد نمیک‌ند و فقط نتایج متنی یا 

وارد میک‌ند. را  آن‌ها  عددی 
  Use Typographer’s Quotes: این گزینه را برای تبدیل علائم گیومه صفحه کلید به علائم گیومه 

حروف نگاری انتخاب کنید. این گزینه به‌طور عادی انتخاب شده است.

Tagged Text 15ـ9ـ گزینه‌های ورود برای فایل‌های

InDesign یک فرمت فایل متنی مخصوص به خود را ارائه می‌دهد: Adobe InDesign Tagged Text.و
Tagged Text واقعاً متن ASCII )فقط متن( است که حاوی کدهای تعبیه شده برای گفتن این مسئله به 
InDesign است که از کدام فرمت‌بندی استفاده کند. شما این کدها را تعبیه میک‌نید که شبیه ماکروهاست، 

هنگامیک‌ه فایل‌ها را در واژه‌پرداز خود ایجاد میک‌نید.
کادر  در  را   Show Import Options انتخاب  کادر  Tagged Text، چنانچه  فایل‌های  وارد کردن  هنگام 

دارید: تعدادی گزینه  قرار دهید،  تأیید  Place در حالت  محاوره‌ای 
حروف‌نگاری  گیومه‌های  به  کلید  صفحه  گیومه‌های  تبدیل  برای   :Use Typographer’s Quotes   

می‌شود. استفاده 
  Remove Text Formatting: در صورت انتخاب، همه فرمت‌بندی متن از جمله شیوه‌ها از متن حذف 

می‌شوند.
 Tagged یا Publication Definiition ،در این منوی بازشو :Remove Style Conflicts Using  

Text Definition را انتخاب کنید. اولی، فرمت‌بندی شیوه سند را بر همه متن وارد شده که از شیوه‌ها با 
نام‌های مشابه استفاده میک‌ند، اعمال میک‌ند و فرمت‌بندی ذخیره شده با فایل Tagged Text را لغو میک‌ند؛ 
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دومی تعاریف شیوه فایل Tagged Text را بر همه متن وارد شده اعمال میک‌ند که از شیوه‌هایی با اسامی 
مشابه استفاده میک‌نند و فرمت‌بندی مشخص شده در سند را لغو میک‌ند.

  Show List of Problem Tags Before Place: این گزینه، در صورت انتخاب، یک کادر محاوره‌ای 

را نمایش می‌دهد که همه شیوه‌نامه‌ها را در فایل وارد شده که نام آن‌ها با اسامی موجود در سند تضاد دارد، 
فهرست میک‌ند.

16ـ9ـ وارد کردن گرافیک

شما می‌توانید به روش‌های مختلف، انواع تصاویر گرافیکی را در اسناد InDesign وارد کنید. InDesign به‌طور 
ویژه تصاویر گرافیکی ایجاد شده به فرمت‌های محبوب را می‌پذیرد و از طریق کلیپ‌بورد )کپی و الصاق( می‌توانید 

فرمت‌های فایل را وارد کنید )البته تا اندازه محدودی( که InDesign مستقیماً از آن‌ها پشتیبانی نمیک‌ند.
 InDesign دارای ویژگی‌های گرافیکی تعبیه شده است، ممکن است اغوا شوید که از InDesign به دلیل اینکه
به‌عنوان برنامه گرافیکی خود استفاده کنید، این کار را نکنید. ابزارهای InDesign برای بعضی کارها عالی 
ولی  ـ  اشکالی که متن دور آن‌ها می‌پیچد، حاشیه‌ها و همین طور شیب‌های رنگ  ایجاد  از جمله  هستند، 
InDesign کلًا در خلق گرافیک حرفه‌ای نیست. در واقع، ویژگی‌های حرفه‌ای گرافیکی نرم‌افزارهایی مانند 

Adobe Illustrator و Phoroshop مکمل InDesign در صفحه‌آرایی هستند.
InDesign به‌ویژه برای تصاویر نقش‌بیتی از قبیل فایل‌های اسکن شده و عکس‌ها، قابلیت‌هایی برای اعمال 
جلوه‌های ویژه یا در غیر این صورت دستکاری محتوای تصویر دارد، بنابراین شما باید قبل از وارد کردن فایل 
در InDesign، کارهای لازم را در ویرایشگر تصویر خود انجام دهید. مثلًا، می‌توانید اندازه تصویر وارد شده 
در InDesign را تغییر دهید، دور آن را ببرید، آن را بچرخانید یا آن را کج کنید، ولی نمی‌توانید آن را از یک 

تصویر کاملًا رنگی به duotone تبدیل کنید یا روشنایی یا تباین آن را تغییر دهید.
نتیجه اینکه، از برنامه گرافیکی خود برای ایجاد و ویرایش عکس‌ها و تصاویر اصلی استفاده کنید. از ویژگی‌های 

گرافیکی InDesign برای تزیین صفحه‌آرایی خود استفاده کنید و نه ایجاد اثر هنری اصل.
 InDesign به شما اجازه باز کردن یک برنامه گرافیکی را برای ویرایش تصاویر قرار گرفته از درون InDesign
Alt را فشار  یا می‌توانید  Edit>Edit Original را برگزینید  انتخاب کنید و  را  می‌دهد. می‌توانید تصاویر 
داده و نگه دارید و سپس روی تصاویر دابلک لیک کنید. InDesign برنامه‌هایی را اجرا میک‌ند که گرافیک‌ها 
را ایجاد کرده‌اند؛ اگر این برنامه‌ها را نداشته باشید، InDesign برنامه‌های سازگار را اجرا میک‌ند، البته اگر 
آن‌ها را داشته باشید. مثلًا، اگر کلید Alt را نگه داشته و روی یک فایل EPS در صفحه‌آرایی خود دابلک لیک 
کنید که در Adobe Illustrator ایجاد شده است، ولی شما در عوض CorelDraw دارید، InDesign،و

CorelDraw را روی سیستم شما اجرا میک‌ند.
InDesign به شما اجازه می‌دهد که مشخص کنید از کدام برنامه می‌خواهید برای ویرایش گرافیک استفاده 
 Edit>Edit آن را برای شما انتخاب میک‌ند. این کار با انتخاب گرافیک و سپس انتخاب InDesign کنید و
with انجام می‌شود. زیرمنویی که نمایان می‌شود، تمام برنامه‌هایی را فهرست میک‌ند که InDesign فکر 
میک‌ند می‌توانند گرافیک را ویرایش کنند، یکی را انتخاب کنید یا Others را برای مرور رایانه برای برنامه‌ای 

متفاوت برگزینید.
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 1ـ16ـ9ـ آماده‌سازی فایل‌های گرافیکی
InDesign از تعدادی فرمت فایل گرافیکی اصلی پشتیبانی میک‌ند. بعضی از فرمت‌ها برای انواع خاصی از 

وظایف مناسب‌تر از بقیه هستند. قوانین پایه برای ایجاد فایل‌های گرافیکی عبارت‌اند از:
،(WMF) Windows Metafileو،EPS، PDF،Adobe Illustrator قبیل  از  فرمتی  به  را  خطی  هنر    

Enhanced Metafile (EMF) یا PICT ذخیره کنید )این فرمت‌های شیء‌گرا فرمت‌های برداری نامیده 
هستند(.  مختلف  اشیای  رسم  چگونگی  مورد  در  دستورعمل‌هایی  از  متشکل  برداری  فایل‌های  می‌شوند. 

بهتر کار میک‌ند.  Illustrator فایل‌های  وPDF و   EPS با   InDesign
PNG، Adobe Photoshop،TIFF، قبیل از  فرمتی  به  را  اسکن‌ها(  و  )عکس‌ها  نقش‌بیتی‌ها    

 PICT یا (SCT) Scitex Continuous Toneو،(BMP) Windows Bitmap، GIFو، PCX ، JPEG 
ذخیره کنید )این فرمت‌های پیکسلی، نقش‌بیتی یا فرمت‌های پویشی نامیده می‌شوند. آن‌ها متشکل از مجموعه‌ای 
از نقاط یا پیکسل‌ها هستند که تصویر را می‌سازند(. InDesign با TIFF و فایل‌های Photoshop بهتر کار 

میک‌ند.
توجه داشته باشید که فایل‌های PICT می‌توانند بسته به تصویر اصلی و برنامه‌ای که در آن ایجاد یا  صادر 
شده‌اند، به فرمت برداری یا نقش‌بیتی باشند. اگر یک تصویر PICT را بزرگ کنید و شروع به بلوک‌ بلوک 
شدن کرد، یک نقش‌بیتی است. به‌طور مشابه، فایل‌های EPS و PDF می‌توانند حاوی تصاویر نقش‌بیتی و 

باشند. برداری 
یک سند  ورود  هنگام  گرافیک هستند؛  که  گویی  کند،  وارد  را   InDesign فایل‌های  می‌تواند   InDesign
چند صفحه‌ای، صفحه موردنظر برای ورود را انتخاب میک‌نید، همان‌گونه که در مورد فایل‌های PDF انجام 
می‌دهید. توجه داشته باشید که فایل‌های InDesign که به‌عنوان گرافیک وارد می‌شوند نمی‌توانند مستقیماً 
در صفحه‌آرایی InDesign که در آن قرار گرفته‌اند، ویرایش شوند؛ باید در عوض فایل اصلی در پنجره‌ای 

مجزا به‌روزرسانی شود.
پیشنهاد میک‌نیم فرمت‌های EPS و TIFF را استاندارد خود کنید، زیرا این فرمت‌ها، فرمت‌های گرافیکی 
می‌توانید  میک‌نید،  کار   Adobe نرم‌افزارهای  با  انحصاراً  شما  دفتر  و  شما  اگر  هستند.  نشر  در  استاندارد 
و    Illustrator )فرمت‌های  اضافه کنید  آمیخته  این  به  را   Photoshop و   Illustratorو،PDF فرمت‌های 
PDF گونه‌هایی از EPS هستند(. اگر از شفافیت در گرافیک خود استفاده کرده‌اید، بهتر است آن‌ها را به 
 )TIFF و EPS ذخیره کنید، زیرا فرمت‌های دیگر )به‌ویژه  PDF یا Illustratorو،Photoshop فرمت‌های
بیشتر داده‌های لایه‌بندی شفافیت را حذف میک‌نند که این امر به تصویرنگار کمک میک‌ند تا این فایل‌های 

شفاف را به‌طور بهینه دوباره تولید کند.

 2ـ16ـ9ـ گرافیک‌های تعبیه‌شده در فایل‌های متنی
واژه‌پردازهای امروزی معمولاً از گرافیک درونی پشتیبانی میک‌نند و به شما اجازه وارد کردن گرافیک موجود 
در سند واژه‌پرداز و تعبیه آن در متن را می‌دهند. مثلًا، Word، به شما اجازه وارد کردن گرافیک را می‌دهد 
و InDesign هم می‌تواند گرافیک‌ها را با متن شما وارد کند. به هر حال، گرافیک‌های تعبیه‌شده در سند 
به ندرت  امروزه  فناوری  این  وارد نمی‌شوند.   InDesign به   Windows OLE در  از طریق  واژه‌پرداز شما 
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استفاده می‌شود، بنابراین در کار کردن با فایل‌های متنی قدیمی ممکن است دچار مشکل شوید.
گرافیک‌های درونی به‌عنوان تصاویر پیش‌نمایشی خود وارد می‌شوند و نه به‌عنوان فایل‌های اصلی. این بدان 
معنی است که در بیشتر موارد، موارد تصویری با وضوح کمتری را در صفحه‌آرایی InDesign خود دارید. 
علی‌رغم این محدودیت‌ها، استفاده از تصاویر درونی در واژه‌پرداز شما زمانی می‌تواند مفید باشد که یک سند 
 InDesign را سرهم میک‌نید: از گرافیک‌های درونی که پیش‌نمایش‌های آن‌ها به‌عنوان جایبان‌ها در InDesign
وارد می‌شوند، استفاده کنید، به‌طوری که صفحه‌آرا بداند شما گرافیک‌ها را تعبیه کرده‌اید. سپس، صفحه‌آرا می‌تواند 

پیش‌نمایش را با گرافیک‌های اصلی با یکفیت بهتر جایگزین کند.
InDesign فرمت‌های فایلی متعددی را وارد میک‌ند. اگر فرمت برنامه گرافیکی شما، یکی از موارد فهرست 
شده در اینجا نیست، می‌توانید آن را به‌عنوان یکی از این فرمت‌ها ذخیره یا صادر کنید. در فهرست ذیل، متن 

در حالت تک فونتی است و پرانتزها انشعاب نام فایل رایج برای این فایل‌ها هستند.
فرمت‌های فایل گرافیکی که InDesign وارد میک‌ند، عبارت‌اند از:

.)dib، .bmp)Windows فرمت نقش‌بیتی طبیعی :BMP  

 DCS که مورد علاقه ناشران حرفه‌ای است. گونه‌ای از آن Encapsulated PostScript فرمت فایل :EPS  

.).dcsو،.eps( است Desktop Color Separation نامیده می‌شود، گونه‌ای با رنگ‌های مجزا که نام کامل آن
.(.gif) که در اسناد وب رایج است Graphics Interchange Format :GIF  

(.ai). EPS شبیه Adobe Illustrator فرمت طبیعی در :Illustrator  

  InDesign: شما می‌توانید اسناد InDesign دیگر را وارد کنید، گویی که گرافیک هستند؛ شما حتی 

.(.indd) می‌توانید مشخص کنید کدام صفحات وارد شوند، گویی که گرافیک‌های مجزا هستند
استفاده  وب  در  اغلب  که   Joint Photographic Expert Group فشرده  نقش‌بیتی  فرمت   :JPEG   

.).jpegو،.jpg( می‌شود 
  PCX: فرمت PC Paintbrush که در برنامه‌های DOS و نگارش‌های اولیه Windows بسیار محبوب 

.).rleو،.pcx( بود؛ فرمت‌های دیگر در حال حاضر جانشین پیدا کرده‌اند
  Portable Document Format :PDF که گونه‌ای از PostScript )یا EPS( است و برای اسناد تحت 

.(.pdf) استفاده می‌شود CD وب، شبکه و
  Photoshop: فرمت طبیعی Adobe Photoshop .(psd.) توجه داشته باشید که InDesign نمی‌تواند 

فایل‌های فرمت photoshop RAW (raw.) را وارد کند.
  PICT: مخفف Picture، فرمت گرافیک عادی mac که کمتر در اسناد حرفه‌ای استفاده می‌شود و حتی 

.(.pct) برای کلیپ‌آرت‌های ارزان هم نادر شده است
  PNG: فرمت Portable Network Graphics که به‌عنوان جایگزین توانمندی برای GIF معرفی شده 

.(.png) است
.(.ct) استفاده می‌شود Scitex فرمت نقش‌بیتی با تنُ پیوسته که در سیستم‌های قبل از چاپ :Scitex CT  

  Tagged Image File Format :TIFE که یک استاندارد نقش‌بیتی برای ناشران و ویرایشگرهای تصویر 

.).tiff یا .tif( حرفه‌ای است
.).wmf، .emf( که کمتر در اسناد حرفه‌ای استفاده می‌شود Windows فرمت طبیعی :Windows Metafile  
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InDesign از فرمت‌های تا حد محبوب پشتیبانی نمیک‌ند، از جمله:
(DXF) AutoCAD Document Exchange Format  

(CGM) Computer Graphics Metafile  

CorelDraw  

Eastman kodak’s Photo CD  

(SVG) Scalable Vector Graphics  

 CorelDraw ،فرمت‌های برداری هستند که عمدتاً در مهندسی و معماری استفاده می‌شوند CGM و DXF
فرمت طبیعی از برنامه تصویرسازی تحت Windows مصرفک‌ننده‌محور پیشتاز است، Photo CD فرمت 
نقش‌بیتی است که برای عکس‌های توزیع‌شونده به‌صورت الکترونیکی استفاده می‌شود و SVG فرمت تحت 

وبی برای گرافیک‌های برداری غنی است.

 3ـ16ـ9ـ مشکلات موجود در فایل‌های برداری
تصاویر برداری پیچیده هستند، زیرا آن‌ها می‌توانند چندین عنصر را تریکب کنند )منحنی‌ها، خطوط، رنگ‌ها، 
فونت‌ها، تصاویر نقش‌بیتی و حتی تصاویر برداری وارد شده دیگر(. این بدان معنی است که شما از روی عدم 
آشنایی، فایلی را ایجاد میک‌نید که ممکن است موجب مشکلاتی شود. این مشکلات هنگامی به وجود می‌آیند 
که سعی در گرفتن خروجی از فایل صفحه‌آرایی InDesign استفادهک‌ننده از آن دارید. بنابراین، هنگام کار با 

فرمت‌های برداری، باید چندین معضل را در ذهن داشته باشید.

 4ـ16ـ9ـ فونت‌های تعبیه‌شده
هنگام استفاده از فونت‌ها در متن موجود در فایل‌های گرافیکی، معمولاً گزینه‌ای برای تبدیل متن به منحنی 
)گرافیک( دارید. این گزینه اطمینان می‌دهد که متن شما روی هر چاپگری چاپ می‌شود )اگر از این تبدیل 
استفاده نمیک‌نید، مطمئن شوید که چاپگر شما یا دفتر خدماتی فونت‌های مورد استفاده در گرافیک را دارند. در 
غیر این صورت، متن با فونت صحیح چاپ نمی‌شود؛ در عوض احتمالاً با Courier یا Helvetica چاپ می‌شود(.

اگر گرافیک شما متن زیادی دارد، متن را به منحنی‌ها تبدیل نکنید، تصویر بسیار پیچیده می‌شود و چاپ آن 
خیلی کُند انجام می‌شود. در این مورد، مطمئن شوید دستگاه خروجی دارای همان فونت‌های گرافیک شما هست.

PDF و Illustrator ،DCS ،EPS :PostScript 5ـ16ـ9ـ فایل‌های 
فایل‌های مبتنی بر PostScript چندین گونه هستندـ EPS،وDCS،وIllustrator و PDFـ و به دلیل اینکه 

این فرمت، فرمت پیچیده‌ای است، معضلات بیشتری نسبت به مسئله فونت دارد.

 PDF و Illustrator، Photoshop وارد می‌شوند که تصاویر InDesign رنگ‌های موضعی هنگامی به
را در InDesign قرار می‌دهید و همین‌طور اسناد InDesign که به‌عنوان گرافیک وارد می‌شوند.

نکته
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 EPS 

گرفتاری معمول فایل‌های EPS هدر پیش‌نمایش است. پیش‌نمایش یک کپی قابل نمایش از فایل EPS است. 
به دلیل اینکه فایل‌های EPS واقعاً از مجموعه‌ای از فرامین تشکیل شده‌اند که نحوه رسم تصویر را به چاپگر 
می‌گویند، آنچه که روی صفحه‌نمایش می‌بینید، گرافیک واقعی نیست. بیشتر برنامه‌ها تصویر پیش‌نمایشی را 
برای فایل‌های EPS ایجاد میک‌نند، ولی بسیاری از برنامه‌ها در خواندن آن‌ها مشکل دارند، به‌ویژه اگر فایل 
EPS در پلت‌فرم متفاوتی تولید شده باشد. در این موارد، آن‌ها یک X یا یک کادر خاکستری را به‌جای تصویر 
نمایش می‌دهند )فایل EPS به درستی روی یک چاپگر PostScript چاپ می‌شود(. به این دلیل است که چرا 
InDesign هنگام وارد کردن فایل‌های EPS، تصویر پیش‌نمایش خاص خودش را ایجاد میک‌ند و احتمال 

قرار گرفتن X یا کادر خاکستری به‌جای پیش‌نمایش EPS را کاهش می‌دهد.
هنگامی که فایل‌های EPS را وارد میک‌نید، InDesign به شما اجازه می‌دهد روی بعضی از تنظیمات کنترل 
باشید،  انتخاب کرده   Place را در کادر محاوره‌ای   Show Import Options البته چنانچه  باشید،  داشته 
می‌توانید مسیرهای برش Photoshop را در فایل اعمال کنید، فرمت پیش‌نمایش را انتخاب کنید، اطلاعات 
یا  پویشی‌سازی1 گفته می‌شود(  فرایند،  این  به  تبدیل کنید )که  به یک نقش‌بیتی  را   PostScript برداری 

لینک‌ها را به تصاویر منبع با وضوح بالای OPT تعبیه کنید.

 DCS 

گونه DCS از EPS مجموعه‌ای از پنج فایل است: یک فایل پیش‌نمایش EPS که چهار فایل مجزا را به هم 
لینک میک‌ند )یکی برای فیروزه‌ای، یکی برای بنفش، یکی برای زرد و یکی برای سیاه(. استفاده از این فرمت، 
جداسازی صحیح رنگ‌ها را هنگام گرفتن خروجی نگاتیو برای استفاده از چاپ تجاری تضمین میک‌ند. دفاتر 
خدماتی که تصحیح رنگ را انجام می‌دهند، اغلب این فایل‌ها را نسبت به فایل‌های EPS استاندارد ترجیح 
می‌دهند. یک گونه از فرمت فایل DCS،وDCS 2.0 است که آن هم از پلیت‌های رنگی موضعی علاوه بر 

پلیت‌های استاندارد برای فیروزه‌ای، سرخابی، زرد و مشکی پشتیبانی میک‌ند.
چنانچه قصد دارید فایل‌های تأیید تریکبی با جداسازی‌های in-RIP را از InDesign ایجاد کنید، نباید از 
DCS استفاده کنید. InDesign از فایل‌های جداسازی DCS صرف‌نظر میک‌ند و فقط از فایل پیش‌نمایش 

برای خروجی استفاده میک‌ند )RIP مخفف پردازنده تصویر پویشی است(.

 Illustrator 

فایل‌های Adobe Illustrator خیلی شبیه فایل‌های EPS هستند به استثنای اینکه آن‌ها هدر پیش‌نمایش 
 Illustrator ندارند و از تنظیمات شفافیت در گرافیک بهتر پشتیبانی میک‌نند. هیچ نگرانی خاصی برای فایل‌های
وجود ندارد، فقط مطمئن شوید که به مسائل فونت و رنگ که قبلًا در این بخش بیان شد، توجه کرده‌اید. 
همان‌گونه که بعداً در این واحدکار بیان می‌شود، InDesign می‌تواند بین لایه‌ها در فایل Illustrator تمایز قائل 

شود که این امر به شما اجازه می‌دهد مشخص کنید کدام لایه‌ها در صفحه‌آرایی شما نمایش داده شوند.

Rasterization ـ1
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 InDesign 

فایل‌های InDesign حاوی تمام انواع عناصر هستند )متن، گرافیک و حتی صدا، هایپرلینک و فیلم( که در 
یک یا چند صفحه ارائه می‌شوند. هنگامیک‌ه یک فایل InDesign را وارد میک‌نید، InDesign با آن به مثابه 
یک گرافیک رفتار میک‌ند و می‌تواند آن را در یک یا چند صفحه از فایل در سند شما به‌عنوان یک گرافیک 
)البته اگر بیش از یک صفحه باشد( قرار دهد. می‌توانید دور آن گرافیک را ببرید، اندازه‌اش را تغییر دهید و 
هر کار دیگری که روی گرافیک‌ها قابل انجام است، انجام دهید، ولی برای تغییر دادن متن یا مؤلفه‌های دیگر 

آن، باید فایل InDesign اصلی را ویرایش کنید.

 PDF 

فایل‌های PDF می‌توانند حاوی تمام انواع عناصر باشند )متن، گرافیک، صدا، هایپرلینک و فیلم(. هنگامیک‌ه 
یک فایل PDF را وارد میک‌نید، InDesign با آن به‌عنوان یک گرافیک رفتار میک‌ند و می‌تواند یک یا چند 
صفحه از فایل PDF )البته اگر بیش از یک صفحه باشد( را به‌عنوان یک گرافیک غیرقابل ویرایش در سند 
شما قرار دهد. می‌توانید دور آن را ببرید، اندازه‌اش را تغییر دهید و هر کار دیگری که روی گرافیک‌ها قابل 

انجام است، انجام دهید، ولی نمی‌توانید با متن یا دیگر مؤلفه‌های فایل PDF وارد شده کار کنید.

 فرمت‌های برداری دیگر
اگر خروجی شما نگاتیوهایی برای چاپ حرفه‌ای است، باید از فرمت‌های برداری غیر PostScript خودداری 

کنید، ولی آن‌ها برای چاپ جوهرافشان و لیزری عالی هستند.

 PICT 

فرمت استاندارد Mac برای ترسیمات، PICT، از نقش‌بیتی‌ها هم پشتیبانی میک‌ند. InDesign فایل‌های 
PICT، بدون هیچ مشکلی وارد میک‌ند، ولی نمی‌تواند برای خروجی گرافیکی، تفکیک رنگ را انجام دهد. 
به دلیل اینکه فونت‌های گرافیک‌های PICT برداری به‌طور خودکار به منحنی تبدیل می‌شوند، نباید نگران 

فونت‌های مورد استفاده در گرافیک‌های خود در چاپگرتان باشید.

Windows Metafile 

فرمت استاندارد Windows Metafile برای ترسیمات، Windows Metafile شبیه PICT است که حاوی 
 Windows از اطلاعات نقش‌بیتی در InDesign ،تصاویر نقش‌بیتی و ترسیمات برداری با هم است. با وجود این

Metafile صرف‌نظر میک‌ند و در طی ورود، آن را کنار می‌گذارد.
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 معضلات فرمت‌های نقش‌بیتی
فرمت‌های نقش‌بیتی )که به آن‌ها پویشی1 هم گفته می‌شود( ساده‌تر از فرمت‌های برداری هستند، زیرا آن‌ها 
از ردیف‌هایی از نقاط )پیکسل‌ها( تشکیل می‌شود، نه دستورعمل‌هایی در مورد نحوه رسم شکل‌های مختلف.

 فرمت‌های نقش‌بیتی سطح حرفه‌ای
اگرچه InDesign از انواع فرمت‌های نقش‌بیتی پشتیبانی میک‌ند، فقط یکی از آن‌ها موجب نگرانی است و 
 Scitex CT هم‌چنین ممکن است از فرمت( TIFF :آن هنگام تولید اسناد حرفه‌ای برای خروجی چاپی است

استفاده کنید، چنانچه از تجهیزات خروجی Scitex برای تولید نگاتیوهای خود استفاده میک‌نید(.
 Adobe Photoshop و Corel Photo-Paint( پیشنهاد میک‌نم فرمت‌های دیگر را با استفاده از ویرایشگر تصویر
دو مورد از بهترین ویرایشگرهای تصویر و وارد کردن و صادر کردن بیشتر فرمت‌ها هستند( یا یک برنامه 

تبدیل به TIFF تبدیل کنید.

 Photoshop 

 Photoshop می‌تواند فرمت فایل این ویرایشگر محبوب تصویر را وارد کند. هنگامیک‌ه فایل‌های InDesign
را در InDesign قرار می‌دهید، می‌توانید روی چگونگی ورود کانال آلفا کنترل داشته باشید و مطمئن شوید 

برای داشتن این کنترل، Show Import Options را در کادر محاوره‌ای Place انتخاب کرده‌اید.
هم‌چنین می‌توانید هر مسیر برش تعبیه‌شده‌ای را اعمال کنید و کلیه پروفایل‌های رنگ تعبیه‌شده را وارد 
کنید یا کنار بگذارید. همان‌گونه که در ادامه فصل بیان خواهد شد، InDesign بین لایه‌ها در یک تصویر 
Photoshop تمایز قائل می‌شود و به شما اجازه می‌دهد تا مشخص کنید کدام لایه‌ها در صفحه‌آرایی شما 

نمایش داده شوند.

 Scitex CT 

فرمت Scitex CT با تنُ پیوسته در دستگاه‌های با وضوح بالای خروجی Scitex استفاده می‌شوند و معمولاً 
 Scitex باید روی سیستم این فرمت استفاده میک‌نید،  از  اسکنرهای Scitex آن‌ها را تولید میک‌نند. اگر 

خروجی بگیرید. در غیر این صورت، نمی‌توانید از مزیت وضوح بالای آن بهره بگیرید.

 TIFF 

را  آن   Adobe Systems بعداً  )که   Aldus که  است   TIFF ناشران،  برای  نقش‌بیتی  فرمت  محبوب‌ترین 
خریداری کرد( و مایکروسافت، آن را توسعه داده‌اند. TIFF تا 24 بیت رنگ )16/7 میلیون رنگ( در هر دو 
مدل RGB و CMYK پشتیبانی میک‌ند و هر برنامه عمده ویرایشگر عکس از TIFF پشتیبانی میک‌ند. 

TIFF هم‌چنین از فایل‌های سیاه و سفید و مقیاس خاکستری پشتیبانی میک‌ند.

Raster ـ1
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بزرگ‌ترین مزیت استفاده از فایل‌های TIFF نسبت به فرمت‌های دیگر این است که از رنگ پشتیبانی میک‌ند 
و InDesign از این مزیت آن بهره می‌برد. مثلًا، در یک ویرایشگر تصویر، می‌توانید مسیرهای برش را در یک 
فایل TIFF تنظیم کنید که به‌عنوان ماسکی برای تصویر استفاده می‌شود. InDesign مسیر را می‌بیند و از 
آن به‌عنوان مرز تصویر استفاده میک‌ند و ناحیه خارج از آن را غیرقابل رؤیت میک‌ند. این مسئله هم به شما 
اجازه می‌دهد تصاویر نقش‌بیتی غیرمستطیلی را در صفحه‌آرایی خود داشته باشید و مسیر برش مرز قابل‌رؤیت 
برای تصویر TIFF شما می‌شود. InDesign هم‌چنین از کانال‌های آلفای تعبیه‌شده و پروفایل‌های رنگ در 

فایل‌های TIFF پشتیبانی میک‌ند. 
فایل‌های TIFF گونه‌های متعددی دارند که InDesign از آن‌ها پشتیبانی میک‌ند، ولی به دلیل اینکه از 

برنامه‌های دیگر دریافت می‌شوند، برای اطمینان از تعامل هموار، این دستورعمل‌ها را دنبال کنید:
 Windows استفاده کنید که برنامه‌های LZW فشرده‌سازی نشده و فشرده‌سازی شده TIFF از فایل‌های  

از آن‌ها پشتیبانی میک‌نند. InDesign حتی از روش فشرده‌سازی Zip هم برای فایل‌های TIFF پشتیبانی 
میک‌ند، اگرچه این روش کمتر مورد استفاده قرار می‌گیرد. باید از بهک‌ارگیری فایل‌های TIFF فشرده‌سازی 
شده LZW در برنامه‌های رایج مطمئن باشید، ولی اگر به مشکل برخوردید، توصیه میک‌نیم از فایل‌های 
 LZW فشرده‌سازی‌نشده استفاده کنید. هم‌چنین همیشه با دفتر خدماتی خود درباره پشتیبانی از TIFF
صحبت کنید قبل از اینکه فایل‌ها را برای خروجی ارسال کنید. بسیاری از تصویرنگارهای قدیمی‌تر فشرده‌سازی 

LZW را مدیریت نمیک‌نند و در گرفتن خروجی تصاویر استفادهک‌ننده از آن ناموفق خواهند بود.
  از ترتیب بایتی برای پلت‌فرمی استفاده کنید که فایل TIFF برای آن اختصاص یافته است. ترتیب بایت 

مورد استفاده در Mac و PC برعکس است. اگرچه InDesign هر دو ترتیب را می‌خواند، برنامه‌های دیگر 
)معمولاً قدیمی‌تر( ممکن است این‌طور نباشند، بنابراین چرا سردرگمی ایجاد کنیم؟ البته، اگر فقط کاربران 

InDesign و Photoshop روی فایل‌های TIFF شما کار کنند، ترتیب بایتی اصلًا مهم نیست.

 فرمت‌های نقش‌بیتی وب‌محور
در سال‌های اخیر، فرمت‌های متعددی برای استفاده در اسناد HTML موجود در وب توسعه یافته‌اند. این 
فرمت‌هاـ GIF،وJPEG و PNGـ اندازه کوچکی دارند )برای دانلود سریع‌تر و نمایش در مرورگر( که این کار 

با محدود کردن جزئیات تصویر و رنگ و غنای آن حاصل شده است.
اگرچه شما می‌توانید از هر فرمت گرافیکی تحت پشتیبانی برای اسناد استفاده کنید که انتظار دارید به فرمت 
سند HTML وب صادر کنید، اگر بدانید سند شما فقط برای وب است، ممکن است از فرمت گرافیک وب از 
 GIF به HTML تمام تصاویر را هنگام صدور به InDesign شروع کار استفاده کنید )توجه داشته باشید که

یا JPEG تبدیل میک‌ند(.

 GIF 

GIF قدیمی‌ترین فرمت وب است. برای کمک به کاهش اندازه فایل، این فرمت فایل محدود به 256 رنگ 
است. این امر موجب کاهش اندازه فایل می‌شود، ولی آن را برای عکاسان و گرافیک‌هایی با تریکبات رنگی 
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نامناسب میک‌ند. با وجود این، رویکرد فشرده‌سازی آن هیچ جزئیاتی از تصویر را از دست نمی‌دهد، بنابراین 
برای طرح‌های اولیه، کارتون‌ها و تصاویر ساده دیگر با جزئیات دقیق خوب هستند.

 JPEG 

فرمت تصویر رنگی فشرده‌سازی‌شده JPEG برای تصاویر خیلی بزرگ و تصاویر تکی که انیمیشن یا فیلم را 
تشکیل می‌دهند، استفاده می‌شود. تصاویر فشرده‌سازی‌شده به این فرمت ممکن است جزئیاتی را از دست 
بدهند و به این دلیل است که ناشران فایل‌های TIFF را ترجیح می‌دهند. JPEG حتی می‌تواند به‌طور مؤثر 
در خروجی اسناد در چاپگر جوهرافشان استفاده شود، زیرا می‌توانید سطح اتلاف را در طی صدور با هیچ 
 JPEG استفاده نمی‌شود. به این دلیل است که تصاویر JPEG تنظیم کنید، ولی در چاپ حرفه‌ای از تصاویر
 CMYK چاپ استاندارد. اگرچه ایجاد فایل‌های CMYK استفاده میک‌نند و نه از مدل RGB از مدل رنگ
JPEG با Photoshop امکان پذیر است، این فایل‌های CMYK JPEG در برنامه‌های کاربردی مرورگرهای 

وب نمایش داده نخواهند شد و مشکل‌زا خواهند بود.
هنگام وارد کردن فایل‌های JPEG،وInDesign به‌طور خودکار مقیاس تصویر را تغییر می‌دهد تا با صفحه 
متناسب شود. این امر به تعامل با تصاویر گرافیکی دوربین دیجیتال که معمولاً خیلی بزرگ هستند و هنگام 
باز هم  ورود عرض بیشتری را نسبت به عرض صفحه اشغال میک‌نند، کمک میک‌ند. اگر چه شما احتمالاً 
باید مقیاس تصویر را تغییر دهید تا با صفحه‌آرایی شما متناسب شود، حداقل می‌توانید قبل از انجام کار، کل 

تصویر را ببینید.
JPEG در وب مفید است که وضوح محدود یک مانیتور رایانه موجب می‌شود جزئیات زیادی از JPEG از 
 JPEG .بین برود و توازن قابل قبولی از یکفیت کاملًا مبهم در برابر اندازه فایل بسیار کوچک‌تر ارائه می‌دهد

به‌طور ویژه برای عکاسان مناسب است، زیرا جزئیات از دست رفته، چندان قابل‌توجه نیست.
اگر از JPEG برای کار چاپی استفاده میک‌نید، توجه داشته باشید که می‌توانید مسیر برش را برای آن در 
برنامه‌هایی مثل Photoshop آماده کنید. مسیر برش به تصویر اجازه می‌دهد یک مرز خلاف عرف داشته 
نظیر   InDesign جلوه‌های  از  می‌توانید  بنابراین  می‌شود(  رندر  شفاف  به‌صورت  آن  پس‌زمینه  )بقیه  باشد 

استفاده کنید. پیچش متن 

 PNG 

فرمت PNG برای ارائه فشرده‌سازی بدون اتلاف GIF است، ولی از رنگ 24 بیتی پشتیبانی میک‌ند. ویژگی 
مهم دیگر فرمت PNG پشتیبانی از شفافیت کامل با یک کانال آلفای تعبیه شده است )به این دلیل است که 
InDesign در کادر محاوره‌ای Image Import Options به شما اجازه می‌دهد شفافیت را با سفید عوض 
کنید یا رنگ پس‌زمینه را نگه دارید، همان‌گونه که در ادامه واحدکار به این مسئله می‌پردازیم(. شفافیت 

هم‌چنین در بیشتر مرورگرهای وب امروزی کار میک‌ند.
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 فرمت‌های نقش‌بیتی دیگر
فرمت‌های تحت پشتیبانی دیگر، فرمت‌هایی هستند که باید از آن‌ها اجتناب کنید، مگر اینکه چاپ را روی 
چاپگرهای جوهرافشان یا لیزری انجام می‌دهید. اگر تصاویری به یکی از این فرمت‌ها دارید، تصاویر را قبل از 

استفاده در InDesign به TIFF تبدیل کنید: 
  BMP: همانند TIFF، فرمت نقش‌بیتی BMP Windows از تصاویر رنگی، مقیاس خاکستری و سیاه و 

سفید پشتیبانی میک‌ند.
  PCX: همانند PCX ، TIFF از تصاویر رنگی، مقیاس خاکستری و سیاه و سفید پشتیبانی میک‌ند.

  PICT:وPICT، فرمت قدیمی Macintosh برای ترسیمات است که از نقش‌بیتی‌ها هم پشتیبانی میک‌ند. 

InDesign فایل‌های PICT را بدون مشکل وارد میک‌ند.

٦  ـ١٦ـ٩ـ شناسایی معضلات رنگ
قبلًا وارد کردن رنگ از فایل‌های گرافیکی به برنامه‌های نشر، پیشنهادی بدیهی بود: رنگ‌ها حتی اگر روی 
صفحه‌نمایش درست باشند، اغلب چاپ درستی نخواهند داشت. این بختک‌ها در گذشته مشکل بزرگی بودند، 
زیرا نرم‌افزار صفحه‌آرایی امروزی مثل InDesign تعاریف رنگ را در گرافیک منبع شما به دقت تشخیص 
برنامه‌های  برای  اطلاعات  آن  دادن  قرار  دسترس  در  تصویر  ویرایش  و  تصویرسازی  برنامه‌های  و  می‌دهد 
صفحه‌آرایی بهتر هستند. بنابراین، کافی است برای اطمینان از ورود هموار رنگ، به توصیه ذیل توجه کنید.
اگر تصاویر رنگی را در یک برنامه تصویرسازی یا ویرایش تصویر ایجاد میک‌نید، مطمئن شوید که آن‌ها را 
 CMYK ایجاد میک‌نید یا از رنگ موضعی معین استفاده میک‌نید. اگر از CMYK با استفاده از مدل رنگ
استفاده میک‌نید، در نتیجه، رنگ از قبل جدا شده است. با InDesign، همه رنگ‌های موضعی که در یک 
Swatches برای سند شما اضافه می‌شوند و به‌عنوان  EPS تعریف می‌شوند، به‌طور خودکار به پنل  فایل 

تنظیم می‌گردند. رنگ‌های موضعی 
 ACD و CorelDraw ، Adobe Illustrator( تبعیت میک‌ند Adobe EPS اگر برنامه شما از مشخصات
Canvas همگی چنین هستند(، InDesign رنگ‌های فایل EPS شما را جدا میک‌ند و مهم نیست که شما 
از رنگ پردازشی استفاده میک‌نید یا رنگ موضعی. Canvas به‌طور خودکار رنگ‌های موضعی Pantone را به 
رنگ‌های پردازشی در مدل‌های RGB و CMYK انتخابی شما تبدیل میک‌ند. برای برنامه‌های دیگر، رنگ‌های 
خود را در مدل CMYK ایجاد کنید تا مطمئن شوید به‌عنوان رنگ‌های جدا شده در InDesign چاپ می‌شوند.

٧ـ١٦ـ٩ـ سیستم‌های رنگ
چندین سیستم یا مدل رنگ وجود دارد که از آن‌ها استفاده می‌شود و InDesign از آن‌ها پشتیبانی میک‌ند، 
 Dainippon Ink & Chemical (DIC)و،Focoltoneو،Pantoneو،RGB ،)پردازشی( CMYK از جمله
Toyo،وTrumatch و وب. یک سیستم رنگ مجموعه‌ای از رنگ‌های مجزا را تعریف میک‌ند که به‌طور ویژه 
 RGB تریکبی از جوهرها یا طیفی از رنگ‌هایی هستند که می‌توان با تریکب تعداد جوهر محدود )از قبیل

برای قرمز، سبز و آبی و CMYK برای فیروزه‌ای، سرخابی، زرد و مشکی( ایجاد کرد.
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Pantone استفاده کنید،  RGB و  CMYK )پردازشی(،  از سه سیستم  برای وارد کردن فایل، بهتر است 
زیرا کاربرد جهانی دارند و معمولاً هنگام ارسال اطلاعات از یک سیستم به سیستمی دیگر قابل‌اتکاتر هستند.

٨  ـ١٦ـ٩ـ رنگ کالیبره شده
با فعال بودن ویژگی سیستم مدیریت رنگ InDesign (CMS)، این برنامه رنگ‌های خروجی را )چه روی 
یک چاپگر رنگی چاپ شوند یا همراه با جداسازی رنگ‌ها برای چاپ سنتی( برمبنای دستگاه منبع و دستگاه 
خروجی مقصد در تلاش برای تضمین این امر که آنچه روی صفحه‌نمایش می‌بینید، تقریباً همان را روی 
صفحه چاپ شده خواهید دید، کالیبره میک‌ند. اگرچه کالیبراسیون رنگ، علمی ترفندآمیز است که به ندرت 
رنگ دقیق منطبق بر تمام دستگاه‌های ورودی و خروجی را به همراه خواهد داشت، به حداقل کردن تفاوت‌ها 

در سیر تصاویر در طی مسیر ایجاد و تولید کمک میک‌ند.
با  که  ببرید  کار  به  را  رنگ  پروفایل‌های  می‌دهند  اجازه  شما  به  تصویر  ویرایش  برنامه‌های  بیشتر  امروزه، 
 ICC 1 مطابقت دارند. اگر از کالیبراسیون رنگ استفاده میک‌نید، اعمال این پروفایل‌های ICC استانداردهای

بر تصویر هنگام ایجاد آن‌ها، بهترین کار ممکن است.
اگر نمی‌توانید یا فراموش کردید، پروفایل ICC را هنگام ایجاد تصویر اعمال کنید، نگران نباشید، می‌توانید 
یک پروفایل )چنانچه تصاویر را در برنامه‌ای ایجاد کرده‌اید که از پروفایل‌های ICC پشتیبانی نمیک‌نند( را 

اضافه کنید یا پروفایل متفاوتی را از InDesign اعمال کنید.

٩ـ١٦ـ٩ـ بررسی روش‌هایی برای وارد کردن گرافیک
شما می‌توانید یک گرافیک را در هر نوعی از فریم یا شکل )از جمله یک خط منحنی شکل ایجاد شده با ابزار 

Pen( به استثنای خط مستقیم با استفاده از فرمان Place، کپی و الصاق یا کشیدن و انداختن وارد کنید.

هارددرایو شما  )روی  فایل هستید  دانستن محل  مسئول  است، شما  گرافیک  کردن  وارد  زمان  هنگامیک‌ه 
.)DVD یا CD ذخیره شده یا روی یک درایو فلش که دوستتان به شما داده یا یک سرور فایل شبکه‌ای یا
اگر یک فایل گرافیکی ذخیره شده در هر نوع رسانه برداشتنی را وارد کنید، لینک بین سند و فایل گرافیک 
هنگام برداشتن رسانه از بین می‌رود. معمولاً، بهتر است فایل‌های گرافیکی را در هارددرایو خود یا در یک 

سرور فایل شبکه‌ای کپی کنید، قبل از اینکه آن‌ها را در سند InDesign وارد کنید.

International Color Committee ـ1

مواظب باشید: چنانچه هنگام استفاده از کادر محاوره‌ای Place برای وارد کردن گرافیک در یک فریم 
متنی منتخب، ابزار Type انتخاب شده باشد، یک گرافیک درونی در محل درج متن ایجاد کنید.

هشدار
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Place ١٠ـ١٦ـ٩ـ استفاده از کادر محاوره‌ای
اگرچه InDesign روش‌های متعددی را برای افزودن فایل گرافیکی به سند ارائه می‌دهد )که همه آن‌ها را در 
این واحدکار بررسی میک‌نیم(، کادر محاوره‌ای Place )با انتخاب File>Place یا فشردن Ctrl+D( روشی 
است که اغلب مورد استفاده قرار می‌گیرد. هنگام استفاده از کادر محاوره‌ای Place،وInDesign گزینه‌های 
ورود را برای فرمت‌های فایل گرافیکی متنوع ارائه می‌دهد که در صورت استفاده از روش‌های دیگر ورود، این 

گزینه‌ها در دسترس شما نخواهد بود.
هنگام وارد کردن تصاویر، مطمئن شوید که Show Import Options در کادر محاوره‌ای Place انتخاب 
ورود  گزینه‌های  به  نگاهی  است  بهتر  بودید،  خشنود  پیش‌فرض  ورود  گزینه‌های  از  اگر  حتی  است.  شده 
بیندازید، بنابراین هنگامی که گزینه غیرپیش‌فرض معنا پیدا میک‌ند، از دستیابی به آن اطلاع خواهید داشت.

نحوه استفاده از کادر محاوره‌ای Place برای وارد کردن گرافیک از این قرار است:
١ File>Place را انتخاب کنید یا Ctrl+D را فشار دهید. اگر می‌خواهید گرافیکی را در فریم موجودی وارد 
کنید، فریم مدنظر را با استفاده از یکی از ابزارهای انتخاب، برگزینید )قبل یا بعد از انتخاب File>Place(. اگر 
می‌خواهید InDesign هنگام وارد کردن گرافیک، فریم جدیدی ایجاد کند، مطمئن شوید که هنگام انتخاب 

Place، هیچ شیئی انتخاب نشده است. در هر صورت، کادر محاوره‌ای Place نمایان می‌شود.
2 از کنترل‌های موجود در کادر محاوره‌ای Place برای یافتن و انتخاب فایل گرافیکی مدنظر برای ورود 
استفاده کنید. در کادر محاوره‌ای Place، می‌توانید با فشردن Shift و کلیک کردن روی یک محدوده یا با 

فشردن Ctrl و کلیک کردن روی تک تک فایل‌ها چند فایل را انتخاب کنید )گرافیک و یا متن(. 
3 تصمیم بگیرید از کدام گزینه‌های ورود قصد استفاده دارید و آن‌ها را انتخاب کنید:

  اگر بخواهید گزینه‌های ورودی را نمایش دهید که به شما اجازه کنترل نحوه ورود فایل گرافیکی منتخب 

 Open را انتخاب کنید و سپس روی Show Import Options :را می‌دهد، یکی از این موارد را انجام دهید
کلیک کنید؛ Shift را فشار داده و نگه دارید و روی نام فایل دابلک لیک کنید؛ یا Shift را نگه داشته روی 
Open کلیک کنید. اگر Show Import Options را انتخاب کنید، بسته به نوع گرافیکی که وارد میک‌نید، 
 Image Options یا   Place InDesign Document، Place PDF، EPS Import Options کادر محاوره‌ای
نمایان می‌شود. گزینه‌های ورود مطلوب را در صورت کاربردی بودن مشخص کنید و سپس روی OK کلیک کنید 

)این گزینه‌ها را در ادامه این واحدکار بررسی خواهیم کرد(.
  برای جایگزین کردن گرافیکی که هم‌اکنون انتخاب شده است، Replace Selected Item را انتخاب کنید 

)حتی اگر فریم گرافیکی را انتخاب نکرده باشید، این گزینه در دسترس است(.
  برای ایجاد یک عنوان ایستا، گزینه Create Static Caption را انتخاب کنید. اگر گزینه‌های فراداده را 

تنظیم نکرده‌اید، انتخاب این گزینه موجب ایجاد عنوانی برای تصویری می‌شود که حاوی نام فایل آن است.
4 می‌توانید گرافیک را در یک فریم موجود قرار دهید یا در فریمی جدید، به این صورت:

  اگر یک فریم خالی انتخاب شده است، InDesign به‌طور خودکار گرافیک را در فریم قرار می‌دهد. گوشه 

سمت چپ بالای گرافیک در گوشه سمت چپ بالای فریم قرار می‌گیرد و فریم به‌عنوان شیء برش‌دهنده 
گرافیک عمل میک‌ند.

 Replace Selected اگر فریمی که هم‌اکنون گرافیکی را نگه می‌دارد، انتخاب شود، در صورت انتخاب گزینه  
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Item در کادر محاوره‌ای InDesign، Place گرافیک موجود را با گرافیک جدید جایگزین میک‌ند. در غیر 
این صورت، InDesign فرض میک‌ند که شما می‌خواهید گرافیک جدید را در فریم جدیدی قرار دهید.

  برای قرار دادن گرافیک در فریم جدید، روی آیکن گرافیک بارگذاری شده )که در شکل 12ـ9 نشان داده 

شده است( در این بخش خالی از صفحه یا در Pasteboard کلیک کنید. نقطه‌ای که کلیک کرده‌اید، گوشه 
سمت چپ بالای فریم گرافیکی حاصله را تولید میک‌ند که اندازه آن مشابه گرافیک وارد شده است و به‌عنوان 

یک شکل برش گرافیکی عمل میک‌ند.

شکل 12ـ9ـ آیکن گرافیک بارگذاری شده، تصویر پیش‌نمایشی از گرافیک وارد شده و تعداد گرافیک‌های آماده قرار گرفتن 
را نمایش می‌دهد.

  برای قرار دادن گرافیک در فریم انتخاب نشده موجود، در فریم با آیکن گرافیک بارگذاری شده کلیک کنید. 

گوشه سمت چپ بالای گرافیک در گوشه سمت چپ بالای فریم قرار می‌گیرد و فریم به‌عنوان یک شکل 
برش‌دهنده عمل میک‌ند.

  InDesign به شما اجازه می‌دهد هنگام قرار دادن گرافیک‌ها، فریمی را رسم کنید. InDesign فریمی 

متناسب با تناسب‌های گرافیک می‌سازد. مگر اینکه Shift را فشار داده و نگه دارید که در آن حالت، این 
فریم ممکن است ابعاد موردنظر شما را داشته باشد. به هر حال، آن‌گاه گرافیک جاری به‌طور متناسب در آن 

مستطیل قرار می‌گیرد. هنگام ورود چندین گرافیک، می‌توانید فریم مجزایی برای هر یک رسم کنید.
برای لغو ورود کامل گرافیک‌ها، کافی است ابزار متفاوتی را انتخاب کنید. برای لغو یک فایل خاص در یک ورود 
چند فایلی، هنگام نمایان شدن پیش‌نمایش کوچک آن فایل، Esc را فشار دهید )فایل‌های دیگر باز هم برای 
قرار گرفتن در دسترس هستند(. برای جابه‌جایی میان فایل‌ها در یک فرمت چند فایلی به‌طوری که بتوانید 
آن‌ها را به ترتیب ترجیحی خود قرار دهید،  یا  را در لیست فایل‌ها برای عقب یا جلو بردن آن‌ها فشار 

دهید؛ هنگام جابه‌جا کردن فایل‌ها، پیش‌نمایش تغییر میک‌ند.
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هنگامیک‌ه چندین گرافیک را هم‌زمان قرار می‌دهید، InDesign به شما اجازه می‌دهد هر فایل را در فریم 
جدایی قرار دهید. کافی است برای هر فایل واردشونده یک بار کلیک کنید یا Shift را نگه دارید و کلیک 
کنید یا Ctrl+Shift را نگه داشته و کلیک کنید تا InDesign را مجبور کنید تمام فایل‌ها را در صفحه در 
فریم‌های مجزا قرار دهد. اگر بیش از یک فایل را در یک زمان قرار دهید، آیکن متن بارگذاری شده، تعداد 

فایل‌های قرار گرفته و پیش‌نمایش کوچکی از هر یک از فایل‌ها را نمایش می‌دهد )شکل 12ـ9(.
اگر Shift یا Ctrl+Shift را هنگام قرار دادن چند تصویر فشرده و نگه دارید، InDesign هر تعداد گرافیکی 
را که جا می‌شود در صفحه در زیر مکان اشاره‌گر ماوس قرار می‌دهد و آن‌ها را در یک مشبک مرتب میک‌ند. 
اگر هنگام قرار دادن گرافیک‌ها و در حین استفاده از گزینه Shift یا Ctrl+Shift، فریمی رسم کنید، آن‌گاه 
تعداد  می‌توانید  رسم شده شما جا می‌گیرند.  فریم  در  که  قرار می‌دهد  در مشبکی  را  تصاویر   InDesign
ردیف‌ها در مشبک را با فشردن یا  افزایش یا کاهش دهید، البته پس از نمایان شدن آیکن گرافیک‌های 

بارگذاری‌شده. ضمناً با فشردن  یا  می‌توانید تعداد ستون‌ها را افزایش یا کاهش دهید.
بعد از قرار دادن یک گرافیک، در فریمی نمایان می‌شود که حاوی آن است و فریم انتخاب می‌شود. اگر ابزار 
 Direct Selection انتخاب شود، هشت دستگیره کادر محصورکننده آن نشان داده می‌شوند؛ اگر ابزار Selection
انتخاب شود، دستگیره‌ها فقط در گوشه‌ها نمایان می‌شوند. در این لحظه، می‌توانید فریم یا گرافیک موجود 

در آن را تغییر دهید یا می‌توانید به کار دیگری بپردازید.

 استفاده از گزینه‌های ورود
اگر تا حالا از یک برنامه گرافیکی استفاده کرده باشید )مثلًا یک برنامه ویرایش تصویر مثل Adobe Photoshop یا 
یک برنامه تصویرسازی مثل Adobe Illustrator یا CorelDraw(، احتمالاً مطلع هستید که هنگام ذخیره 
یک فایل گرافیکی، چندین گزینه دارید که مواردی از قبیل فرمت فایل، اندازه تصویر، عمق رنگ، یکفیت 
پیش‌نمایش و غیره را کنترل میک‌نند. هنگام ذخیره یک فایل گرافیکی، تنظیماتی که مشخص میک‌نید، 
به طریقی تعیین ‌می‌شوند که در آن تصویر استفاده خواهد شد. مثلًا، می‌توانید از Photoshop برای ذخیره 
نگارش TIFF با وضوح بالا از یک گرافیک اسکن‌شده برای استفاده در یک گزارش سالانه تمام رنگی حرفه‌ای 
یا نگارش GIF با وضوح پایین از همان گرافیک برای استفاده در صفحه وب شرکت استفاده کنید یا می‌توانید 
از  اندازه‌های مختلف در بسیاری  از  لوگوی شرکتی استفاده کنید که می‌توانید  ایجاد  برای   Illustrator از 

نشریات چاپی خود استفاده کنید.
انتخاب‌های شما  را مشخص میک‌نید،  ورود سفارشی  تنظیمات  گرافیکی،  فایل  وارد کردن یک  اگر هنگام 
 72dpi وابسته به ماهیت نشریه دارد. مثلًا، اگر مقید به وب هستید، نباید با گرافیکی کار کنید که وضوح آن از

مانیتور رایانه تجاوز کند یا آن را ذخیره کنید.
اگر نشریه شما چاپ خواهد شد، تنظیمات ورود تصویر که برای یک روزنامه چاپ شده روی کاغذ روزنامه در 
یک چاپ SWOP 1 مشخص میک‌نید، متفاوت از تنظیماتی است که برای یک مجله چهار رنگ چاپی روی 

کاغذ Coated با استفاده از چاپ Sheetfed انجام می‌دهید.
انتخاب کنید، گزینه‌های نشان داده شده در  اگر هنگام قرار دادن گرافیک، Show Import Options را 

Specifications for Web Offset Publications ـ1
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کادرهای محاوره‌ای حاصله به فرمت گرافیک انتخابی وابسته است. هنگام تنظیم گزینه‌ها برای فایلی خاص، 
اگر  را تغییر دهید.  تا وقتی که آن‌ها  باقی می‌مانند  فایل  برای آن فرمت  گزینه‌هایی که مشخص میک‌نید 
هنگام قرار دادن گرافیک، Show Import Options را انتخاب نکنید، جدیدترین تنظیمات برای فرمت فایل 

گرافیک انتخابی استفاده می‌شود.

17ـ9ـ گزینه‌های ورود برای گرافیک‌های نقش‌بیتی

،TIFF می‌دهد:  شما  به  ذیل  نقش‌بیتی  تصاویر  انواع  برای  ورود  گزینه  مجموعه  دو   InDesign 
GIF،وJPEG،وScitex CT،وBMP و PCX. سه گزینه برای فایل‌های PNG و مجموعه متفاوتی از سه 
 PICT یا QuickTime دارید. هیچ گزینه ورودی برای فایل‌های فیلم Photoshop گزینه برای فایل‌های

ندارید. شکل 13ـ9 چهار پیشخوان احتمالی را برای تصاویر نقش‌بیتی نشان می‌دهد.

 .Image برای فرمت‌های نقش‌بیتی سمت چپ بالا: پیشخوان Image Import شکل 13ـ9ـ پیشخوان‌های کادر محاوره‌ای
سمت چپ پایین: پیشخوان Color. سمت راست بالا: پیشخوان Layers که برای فایل‌های Photoshop نمایان می‌شود. سمت 

راست پایین: پیشخوان PNG Settings که برای فایل‌های PNG نمایان می‌شود.

Image پیشخوان
اگر یک فایل Photoshop،وTIFF یا EPS را وارد میک‌نید که حاوی یک مسیر برش تعبیه‌شده و یا کانال 
آلفا برای ماسک‌گذاری تصویر یا بخشی از تصویر است )در غیر این صورت، این گزینه‌ها غیرفعال خواهند بود(، 
گزینه Apply Photoshop Clipping Path را برای وارد کردن مسیر برش به همراه تصویر انتخاب کنید 
و یک کانال آلفا را از منوی بازشوی Alpha Channel برای وارد کردن کانال آلفا همراه با تصویر برگزینید.
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Color پیشخوان 
در پیشخوان Color، می‌توانید مدیریت رنگ را برای تصویر فعال و چگونگی نمایش تصویر را کنترل کنید.

گزینه Enable Color Management را برای فعال کردن مدیریت رنگ انتخاب کنید. با استفاده از منوی 
بازشوی Profile، پروفایل منبع رنگی را انتخاب کنید که با طیف رنگ دستگاه )اسکنر، دوربین دیجیتال 
و غیره( یا نرم‌افزار مورد استفاده برای ایجاد فایل مطابقت داشته باشد. InDesign تلاش میک‌ند رنگ‌های 
موجود در فایل را به رنگ‌هایی تبدیل کند که دستگاه خروجی قادر به تولید آن باشد )این پروفایل‌ها توسط 

.)InDesign برنامه‌های دیگر روی سیستم عامل نصب شده‌اند و نه
استفاده از منوی بازشوی Rendering Intent برای تعیین چگونگی تبدیل رنگ در فایل گرافیک انتخابی در 
 Perceptual ،است. اگر گرافیک، عکس اسکن‌شده‌ای است InDesign طیفی از دستگاه‌های خروجی توسط
و   Relative Colorimetricو،Saturation (Graphics) دیگرـ  گزینه‌های  کنید.  انتخاب  را   (Images)
Absolute Colorimetricـ برای تصاویری مناسب هستند که بیشتر نواحی آن‌ها رنگ پرُی دارد، از قبیل 

فایل‌های Illustrator EPS که در Photoshop باز شده‌اند و به فرمت TIFF ذخیره شده‌اند.

PNG Settings پیشخوان 
از این پیشخوان )تنها در صورتی در دسترس است که فایل PNG را قرار می‌دهید( برای استفاده از اطلاعات 
شفافیت در یک فایل PNG استفاده میک‌نید، با این فرض که پس‌زمینه شفافی دارند. شما دو انتخاب برای 
کنترل شفافیت دارید: White Background و File-defined Background Color. اولی موجب نمایش 
بخش شفاف به‌صورت سفید در InDesign می‌شود؛ دومی از همان رنگ پس‌زمینه مشخص شده در خود 

فایل PNG استفاده میک‌ند.
که  است  تنظیمی  گاما  می‌دهد.  ورود  در طی  را  گاما  مقدار  تنظیم  اجازه  شما  به  هم‌چنین  پیشخوان  این 
 PNG فایل  برای  را  گاما  تنظیم  بازتولید،  دقیق‌ترین  تضمین  برای  و  میک‌ند  توصیف  را  دستگاه  روشنایی 
می‌خواهید که با گامای دستگاه شما )چاپگر یا مانیتور( یکسان باشد. این تنظیم برای تصحیح فایل ایجاد شده 
در نوع خاصی از مانیتور لازم است. با وجود این، برای استفاده از این ویژگی، باید تنظیم گاما را برای دستگاه 

خروجی نهایی بدانید. در غیر این صورت، آن را رها کنید.

Layers پیشخوان 
 Illustrator یا فایل ‌برداری( Photoshop از این پیشخوان ـ تنها در صورتی در دسترس است که یک تصویر
یا PDF( را قرار می‌دهیدـ برای انتخاب لایه‌های مدنظر خود برای ورود به InDesign استفاده کنید. سپس 
می‌توانید کنترل کنید که کدام لایه‌های وارد شده در InDesign نمایش داده شوند، اگرچه نمی‌توانید ترتیب 

آن‌ها را تغییر دهید. شما باید به Photoshop برگردید و ترتیب لایه‌ها را آنجا تغییر دهید.

اگرچه می‌توانید فایل تصویر را با لایه‌ها به‌عنوان TIFF ذخیره کنید، InDesign توانایی مدیریت 
لایه‌ها را از یک فایل TIFF وارد شده به InDesign نمی‌دهد.

توجه
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از منوی بازشوی Layer Comp برای انتخاب از میان تریکبات مختلف لایه‌ها در فایل منبع استفاده کنید 
)در صورت وجود(. تریکب لایه لزوماً یک تصویر فوری از پنل Photoshop Layers است که به شما اجازه 
گروه‌بندی تنظیمات مختلف قابلیت رؤیت لایه و ذخیره آن‌ها برای استفاده آتی را می‌دهد. یک گزینه هم در 
منوی بازشوی When Updating Link برای کنترل نحوه مدیریت تغییرات فایل از نظر مدیریت لایه وجود 
 Photoshop تمام لایه‌های InDesign ،را انتخاب کنید Use Photoshop’s Layer Visibility دارد. اگر
 Keep Layer Visibility قابل رؤیت میک‌ند. اگر InDesign را هنگام به‌روزرسانی لینک به گرافیک در
Overrides را انتخاب کنید، InDesign فقط لایه‌های انتخابی در این کادر محاوره‌ای را وارد میک‌ند، البته 

اگر بعداً گرافیک را در Photoshop به‌روزرسانی کرده باشید.
از قرار گرفتن چنین تصاویر لایه‌بندی شده‌ای در InDesign، می‌توانید لایه‌هایی را که نمایش داده  پس 
می‌شوند، تغییر دهید، اگرچه نمی‌توانید ترتیب لایه‌ها را تغییر دهید. توجه داشته باشید که کنترل‌ها برای 

اصلاح لایه‌ها برای ورود آن‌ها خیلی شبیه هستند.
برای تغییر دادن نمایش لایه‌ها، شیئی را با ابزار Selection یا Direct Selection انتخاب کنید و سپس 
Object>Object Layer Options را برگزینید. هم‌چنین می‌توانید کلید Ctrl را نگه داشته و روی گرافیک 
کلیک کنید یا روی آن کلیک راست کنید و Graphics>Object Layer Options را از منوی زمینه انتخاب 
کنید. به هر طریق، کادر محاوره‌ای  Object Layer Options نمایان می‌شود. این کادر شبیه پیشخوان 
Layers در کادر محاوره‌ای Image Import Options است و مثل آن کار میک‌ند. این پیشخوان در شکل 

13ـ9 نشان داده شد.

 وارد کردن گزینه‌ها برای فرمت‌های فایل برداری
اگر فایل‌های برداری را وارد میک‌نید، انتخاب کادر انتخاب Import Options موجب نمایان شدن یکی از 
نگارش قدیمی‌‌تر  اگر  برداری بستگی دارد.  فایل  نوع  به  نوع کادر محاوره‌ای  و  کادرهای محاوره‌ای می‌شود 
فایل‌های EPS یا Illustrator را وارد میک‌نید، کادر محاوره‌ای Place PDF که دو پیشخوان دارد نمایان 
می‌شود )هر دو کادر محاوره‌ای در شکل 14ـ9 نشان داده شده‌اند(. هیچ گزینه ورودی برای گرافیک‌های 

ندارد. وجود   Windows Metafile

شکل 14ـ9ـ کادر محاوره‌ای Place PDF )سمت چپ( و کادر محاوره‌ای EPS Import Options )سمت راست(. کادر 
محاوره‌ای Place PDF دو پیشخوان دارد: General و Layers )پیشخوان Layers برای فایل‌های PDF تقریباً با پیشخوان 

layers برای فایل‌های Photosop که در شکل 13ـ9 نشان داده شد، یکسان است(.
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EPS Import Options کادر محاوره‌ای 
اگر از یک گردش کار پروکسی مبتنی بر OPI استفاده میک‌نیدـ یعنی، اگر یک ارائه‌دهنده سرویس مبتنی 
بر OPI، نگارش‌های با وضوح پایین از فایل‌های گرافیکی را در اختیار شما می‌گذارد که در نهایت در طی 
خروجی با فایل‌های با وضوح بالا جایگزین خواهند شدـ در صورتی که می‌خواهید InDesign و نه ارائه‌دهنده 
 Read Embedded OPS Image سرویس شما، جایگزینی تصویر را در طی خروجی انجام دهد، گزینه
Links را انتخاب کنید. هم‌چنین این گزینه را در صورتی باید انتخاب کنید که فایل‌های گرافیکی را وارد 
میک‌نید که حاوی توضیحات OPI برای فایل‌های گرافیک وارد شده دیگر باشد؛ مثلًا، یک فایل EPS که 
حاوی اطلاعات OPI برای یک گرافیک TIFF تعبیه شده است. در صورتی که از یک گردش کار مبتنی بر 
OPI استفاده نمیک‌نید یا چنانچه می‌خواهید ارائه‌دهنده سرویس شما جایگزینی تصویر را در حین خروجی 

مدیریت کند، این گزینه را انتخاب نکنید.
 OPI مؤلفه‌های InDesign ،انتخاب نشده باشد Read Embedded OPI Image Links هنگامیک‌ه گزینه
را حفظ میک‌ند ولی از آن‌ها استفاده نمیک‌ند. هنگامیک‌ه سند را چاپ )یا صادر( میک‌نید، تصویر نماینده و 

اطلاعات لینک ارسال می‌شوند.
هم‌چنین از این پیشخوان برای وارد کردن مسیرهای برش تعبیه‌شده در تصاویر در فایل  EPS استفاده کنید. 

برای فعال‌سازی این امر، گزینه Apply Photoshop Clipping Path را انتخاب کنید.
سرانجام، از این پیشخوان برای کنترل چگونگی ظهور فایل EPS روی صفحه‌نمایش در InDesign استفاده 
کنید. اگر گزینه Use TIFF or PICT Preview را انتخاب کنید، InDesign از تصویر نماینده با وضوح 
پایین که در فایل EPS برای نمایش روی صفحه‌نمایش تعبیه‌شده استفاده میک‌ند و گرافیک را با استفاده از 
 Rasterize the PostScript با وضوح بالای تعبیه‌شده چاپ میک‌ند. اگر گزینه PostScript دستورعمل‌های
را انتخاب کنید، InDesign فایل PostScript را در طی ورود به تصویر نقش‌بیتی تبدیل میک‌ند. به ندرت 

دلیلی برای پویشی کردن یک فایل EPS ورودی وجود دارد.

Place PDF کادر محاوره‌ای 
هنگامی که از فرمان Place PDF برای وارد کردن فایل PDF استفاده میک‌نید و Show Options را انتخاب 
میک‌نید، کادر محاوره‌ای Place PDF file که در شکل 14ـ9 نشان داده شده است، نمایان می‌شود. در دو 

پیشخوان آن ـ General و Layers ـ چندین کنترل برای مشخص کردن چگونگی ورود فایل را می‌بینید.
در پیشخوان General، دو مجموعه گام‌ها از گزینه‌ها برای ورود PDF دارید. اولین مجموعه کنترل میک‌ند 

که کدام صفحات وارد شوند:
 Previewed Page ،All ،برای تعیین اینکه کدام صفحات را برای ورود مدنظر دارید ،Pages 1 در بخش

یا Range را انتخاب کنید.
2 صفحه پیش‌نمایش داده شده را با کلیک کردن روی دکمه‌های فلشی در قسمت پیش‌نمایش تصویر در 

سمت چپ یا تایپ کردن شماره صفحه خاصی در فیلد زیر تصویر پیش‌نمایش تغییر دهید.
3 اگر می‌خواهید محدوده‌ای را وارد کنید، از ویرگول‌ها برای جداسازی صفحات و از خط تیره برای نشان 

دادن محدوده استفاده کنید. مثلًا، اگر 13, 9-5, 3 را تایپ کنید، صفحات 3، 5 تا 9 و 13 وارد می‌شوند.
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مجموعه دوم گزینه‌ها به شما اجازه می‌دهند چگونگی تنظیم صفحات را در طی ورود مشخص کنید:
 Bounding انتخاب کنید. اگر Crop To یکی از گزینه‌های برش را از منوی بازشوی ،Options 1 در بخش
Box را انتخاب کنید، کادر محصورکننده صفحه )یا در صورتی که در فایل PDF چیزی تعریف نشده باشد، 
مستطیلی که تمام اقلام را دربرمی‌گیرد، شامل علائم صفحه خواهد بود( برای ساختن فریم گرافیکی استفاده 
می‌شود. انتخاب Art موجب قرار گرفتن ناحیه تعریف‌شده توسط خالق فایل )در صورت وجود( به‌عنوان اثر 

هنری قابل قرارگیری می‌شود.
 Trim را قرار می‌دهد. انتخاب Adobe Acrobat ناحیه نمایش داده شده و چاپ شده توسط Crop انتخاب
 Bleed موجب قرار گرفتن گرافیک موجود در یک ناحیه برابر با قطعه آراسته شده نهایی می‌شود. انتخاب
موجب قرار گرفتن ناحیه صفحه به‌علاوه هر ناحیه bleed مشخص شده می‌شود. انتخاب Media موجب قرار 
از جمله علائم  PDF می‌شود،  برای سند  اندازه کاغذ مشخص شده  تعریف شده توسط  ناحیه  گرفتن یک 

صفحه.
 Transparent شفاف باشد، گزینه PDF در صورتی که می‌خواهید نواحی سفید صفحه ،Options 2 در بخش
Background را انتخاب کنید. در صورتی که می‌خواهید پس‌زمینه صفحه سفید یکدست باشد، این گزینه 

را انتخاب نکنید.
چگونگی کار با کنترل‌های موجود در پیشخوان Layers به این صورت است:

  فهرستی از لایه‌های تصویر را می‌بینید. همه لایه‌هایی که با آیکن چشم علامت خورده‌اند، به InDesign وارد 

خواهند شد و شما می‌توانید با کلیک کردن در کادر سمت راست نام لایه برای نمایان ساختن یا پنهان کردن 
آیکن چشم، لایه‌ها را انتخاب کنید یا از حالت انتخاب خارج کنید. سپس می‌توانید نمایش لایه‌های وارد شده 

به InDesign را کنترل کنید، اگرچه نمی‌توانید ترتیب لایه‌ها را تغییر دهید.
  از منوی بازشوی When Updating Link برای کنترل چگونگی مدیریت تغییرات در فایل از نظر مدیریت 

لایه استفاده کنید. اگر Use PDF’s Layer Visibility را انتخاب کنید، InDesign کل لایه‌ها را هنگام 
 Keep اگر  یاAcrobat  قابل رؤیت میک‌ند.   Illustrator InDesign در  از  به‌روزرسانی لینک به گرافیک 
 Photoshop در  را  گرافیک  بعداً  چنانچه   InDesign کنید،  انتخاب  را   Layer Visibility Overrides

به‌روزرسانی کنید، فقط لایه‌هایی را که در این کادر محاوره‌ای انتخاب کرده‌اید، وارد میک‌ند.

 Place InDesign Document کادر محاوره‌ای 
هنگامی که فایل‌های InDesign را برای استفاده به‌عنوان گرافیک وارد میک‌نید، گزینه‌هایی مشابه فایل‌های 
PDF دارید. کادر محاوره‌ای Place InDesign Document مشابه کادر محاوره‌ای Place PDF است که 

در بخش قبل توضیح داده شد، البته به استثنای نام این کادر محاوره‌ای.

 استفاده از روش‌های دیگر برای وارد کردن گرافیک
چنانچه می‌خواهید گزینه‌های ورود سفارشی را برای  فایل گرافیکی واردشونده مشخص کنید، باید از فرمان 
Place استفاده کنید. با وجود این، اگر نیاز به این سطح از کنترل ندارید، می‌توانید از یکی از سه گزینه دیگر 

InDesign برای وارد کردن گرافیک‌ها استفاده کنید:
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  می‌توانید از فرامین Copy و Paste رایانه برای انتقال فایل گرافیکی بین دو سند InDesign یا از یک 

سند ایجاد شده با برنامه‌ای دیگر به سند InDesign استفاده کنید.
  می‌توانید آیکن‌های فایل گرافیکی را از دسک‌تاپ رایانه خود کشیده و به اسناد InDesign بیندازید.

از Illustrator به InDesign بکشید یا کپی    در مورد فایل‌های Illustrator، می‌توانید اشیا را مستقیماً 

و الصاق کنید. بسته به ترجیح کلیپ‌بورد خود، این اشیا ممکن است فقط در PDFها تعبیه شوند که در 
InDesign قابل ویرایش نیستند.

به   ،InDesign به   Illustrator از  برداری  اشیای  کشیدن  یا  کردن  کپی  برای  خود  ترجیح  تنظیم   برای 
 Edit>Preferences>File Handling( بروید Preferences از کادر محاوره‌ای File Handling پیشخوان
 InDesign را فشار دهید(. اگر می خواهید اشیای برداری کاملًا قابل ویرایش را در Ctrl+K را انتخاب کنید یا
 Prefer PDF When بروید و گزینه Clipoard Handling از پیشخوان Clipboard قرار دهید، به بخش
Pasting را از حالت انتخاب خارج کنید. چنانچه ترجیح می‌دهید PDFهای تعبیه‌شده غیرقابل ویرایش را 

در InDesign کپی کنید یا بیندازید، آن را در همان حالت انتخاب‌شده رها کنید.
در صورتی که باید یک گرافیک لوگوی برداری را در یک قالب بیندازید، قرار دادن اشیای برداری قابل‌ویرایش 
کاملًا موجود در InDesign، نیاز به پرش بین برنامه‌های گرافیکی را برای انجام تغییراتی هم‌چون ویرایش 

رنگ‌های لوگو و شکل‌های برداری کاهش می‌دهد.
اگر از این روش‌ها برای افزودن گرافیک به سند InDesign استفاده میک‌نید، بعضی از ویژگی‌های گرافیک 
اصلی ممکن است در این انتقال باقی نمانند. سیستم عامل، فرمت فایل و قابلیت‌های برنامه کاربردی اصلی 
همگی ممکن است در تعیین این مسئله که کدام ویژگی‌ها حفظ شوند، نقش داشته باشند. برای آسودگی 
در  قابل‌ویرایش  کاملًا  برداری  اشیای  جابه‌جایی  برای  قبلی  بیان‌شده  روش  از  یا   Place فرمان  از  خاطر، 

InDesign استفاده کنید.

 کپی و الصاق 
کنید،  الصاق  متفاوتی   InDesign به سند  و سپس  کرده  کپی   InDesign در یک سند  را  اگر یک شیء 
این کپی تمام ویژگی‌های اصلی را حفظ میک‌ند. در مورد گرافیک کپی و الصاق‌شده، تمام تنظیمات ورود، 

اصلاحات فریم و اصلاحات گرافیک حفظ می‌شود، زیرا این لینک به فایل گرافیک اصلی است.
اصلی  فایل گرافیک  بین  لینکی  الصاق میک‌نید،  و  InDesign کپی  را در یک سند  گرافیکی  هنگامیک‌ه 
استفاده  با  را  آن  زیرا  می‌شود،   InDesign سند  از  بخشی  گرافیک  نمی‌شود.  برقرار   InDesign سند  و 
صورتی  در  تنها  الصاق‌شده  گرافیک  قبیل  از  برداری  تصویر  یک  کرده‌اید.  ایجاد   InDesign ابزارهای  از 
کادر  از   Clipboard Handling پیشخوان  در  را   Prefer PDF When Pasting که  است  قابل‌ویرایش 

بیان شد. قبلی  بخش  در  که  همان‌گونه  باشید،  کرده  خارج  انتخاب  حالت  از   Preferences محاوره‌ای 

 کشیدن و انداختن 
با  با هر فرمت فایل تحت پشتیبانی  باز است، می‌توانید فایل گرافیکی را   InDesign هنگامیک‌ه یک سند
کلیک کردن و کشیدن آیکن فایل به پنجره سند InDesign وارد کنید. هنگامیک‌ه یک فایل گرافیکی را 
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کشیده و در یک سند می‌اندازید، لینک بین فایل گرافیک اصلی و سند برقرار می‌شود، درست مثل زمانی که 
از فرمان Place استفاده میک‌نید.

اگر آیکن یک فایل Illustrator را بکشید و در یک پنجره سند InDesign بیندازید، گرافیک شبیه زمانی 
رفتار میک‌ند که از فرمان Place استفاده میک‌نید. یعنی، تک تک عناصر در گرافیک در InDesign قابل 
انتخاب یا اصلاح‌پذیر نیستند. با وجود این، اگر اشیای Illustrator را از پنجره سند Illustrator بکشید و 
در پنجره سند InDesign بیندازید، هر یک از اشیا جدا می‌شوند و به‌عنوان شیء InDesign قابل ویرایش 

خواهند بود، درست مثل اینکه در InDesign ایجاد شده‌اند.
این روش مفیدی برای جابه‌جایی اشیایی است که ممکن است بخواهید بین Illustrator و InDesign اصلاح 
کنید. مثلًا، می‌توانید متنی را روی یک مسیر در یک سند Illustrator ایجاد کنید و سپس شیء را بکشید و 
در یک سند InDesign بیندازید. هر کاراکتر به یک شکل قابل‌ویرایش تبدیل می‌شود که می‌توانید با استفاده 
از ویژگی‌های InDesign به آن خط‌دور یا زمینه بدهید یا آن را کج و معوج کنید. با وجود این، نمی‌توانید متن 
روی مسیر را پس از کشیده شدن و انداختن آن در InDesign ویرایش کنید )باید به Illustrator برگردید، 

متن اصلی را ویرایش کنید، مجدداً آن را بکشید و بیندازید و سپس تمام تغییرات را دوباره انجام دهید(.
استفاده از فرامین Copy و Paste برای افزودن اشیای Illustrator به اسناد InDesign شبیه کشیدن و 
انداختن اشیا بین برنامه‌هاست. اشیای کپی شده دقیقاً شبیه اشیای ایجاد شده در InDesign رفتار میک‌نند، 

هنگامیک‌ه Paste را انتخاب میک‌نید و هیچ لینکی برقرار نمی‌شود.

18ـ9ـ مفهوم اصول چاپ

چاپ، فرایند تکثیر متن و تصویر با استفاده از فرم اصلی یا الگو است. چاپ در لغت به معنای اثر، نقش و 
نشان و فشردن یک سطح بر سطح دیگر است. چاپ در اصطلاح به عمل، فن و صنعت تکثیر و ایجاد نقش‌های 
دوبعدی مانند ارقام، خط‌ها، حروف و تصویرها بر پارچه، کاغذ یا مواد دیگرگفته می‌شود. رایج‌ترین نوع کار 
چاپی، چاپ روی کاغذ است. امروزه با پیشرفت فناوری چاپ، این عمل روی مواد نایلونی، سلولوزی، پارچه‌ای، 

چرمی، مواد شیمیایی، فلزی، شیشه‌ای یا اشکال صاف یا ناهموار، مقعر یا محدب صورت می‌گیرد. 
از  و شیوه‌های چاپی،  است  به محصولات چاپی  تصاویر دیجیتال  تبدیل  از روش‌های  یکی  چاپ دیجیتال، 
تصویر دیجیتالی تا انواع رسانه‌ها را در بر می‌گیرد. از جمله ویژگی‌های چاپ دیجیتال این است که معمولاً، 
هزینه چاپ دیجیتال برای هر صفحه بیشتر از چاپ معمولی است و تصاویر توسط چاپگر لیزری و جوهرافشان 
حرفه‌ای چاپ می‌شوند. این نوع از چاپ، مستلزم رعایت و در نظر گرفتن اصول چاپ دیجیتال به منظور ایجاد 

و تولید تصویر مطلوب و دلخواه است. 
تفاوت بین چاپ دیجیتال و چاپ‌های سنتی مانند لیتوگرافی، لترپرس، گراور، افست و فلکسوگرافی، استفاده 
نکردن از پلیت‌های چاپی است که نتیجه آن ارزان‌تر شدن مراحل آماده‌سازی قبل از چاپ است. اما بیشترین 
تفاوت چاپ دیجیتال با چاپ لترپرس و افست است. برخی از این تفاوت‌ها عبارت‌اند از: کوتاه شدن فرایند 
چاپ به دلیل حذف مراحل قبل از چاپ، ثبات قیمت برای هر نسخه چاپی، کاهش اتلاف کاغذ و مواد به دلیل 
عدم نیاز به تنظیمات رنگ چاپ تصویر و متن متفاوت در هر نوبت چاپ به دلیل عدم استفاده از پلیت، پایین 

بودن هزینه چاپ دیجیتال سیاه و سفید.
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  ١٨ـ٩ـ پوستر  ١ 
پوستر، به یک قطعه کاغذ چاپی طراحی‌شده گفته می‌شود که معمولاً آن را روی دیوار یا سطح عمودی نصب 
میک‌نند. پوستر معمولاً از دو بخش متن و گرافیکی تشکیل شده و حتی امکان دارد که کاملًا گرافیکی یا متنی 
باشد. پوستر‌ها ممکن است برای اهداف مختلفی مانند تبلیغات، انتقال پیام و ایجاد آثار هنری که هزینه‌های 

آن‌ها نسبت به اثر اصلی کمتر است، مورد استفاده قرار بگیرند.

 مؤلفه‌های مهم در طراحی پوستر 
1 توازن: به وجود آوردن ارتباط بصری بین مؤلفه‌های تشکیل‌دهنده پوستر که شامل توازن متقارن و غیر 

متقارن است. 
2 وحدت و انسجام: تمام بخش‌های پوستر باید با هم هماهنگ بوده و انسجام داشته باشند. برای وحدت و 
انسجام پوستر باید به مواردی مانند استفاده از رنگ‌های متناسب و هماهنگ با موضوع و بهک‌ارگیری شیوه‌های 

خلاقانه تریکب عناصر تصویری هماهنگ با موضوع توجه داشت. 
3 حرکت: شکل دادن به اجزای تصویر به گونه‌ای که بیننده را جذب کند. مواردی که نقش مهمی در ایجاد 
حرکت دارند شامل استفاده از خطوط جهت‌دار برای هدایت چشم، اضافه کردن تصویر تداعیک‌ننده حرکت 

و دسته‌بندی عناصر است. 
4 تأکید: به درجات متفاوت اهمیت هر یک از مؤلفه‌های تشکیل‌دهنده پوستر تأیکد میک‌ند. این یکفیت، 
حاصل عواملی مانند استفاده از فضای خالی، استفاده از اشکال و فرم‌های جذاب، تریکب و ایجاد یک عنصر 

تأیکدی، استفاده خلاقانه از فونت‌ها و استفاده از رنگ‌های متضاد برای ایجاد عناصر تصویری است. 

  ١٨ـ٩ـ چاپ افست  ٢ 
در واقع، کلمه افست به معنی غیرمستقیم و متعادل کردن بوده و در نتیجه توسعه چاپ برجسته غیرمستقیم 
به وجود آمده است. چاپ افست، معمول‌ترین نوع چاپ است که در آن، تصویر جوهری شده از یک صفحه 
به روکش پلاستیکی و سپس به سطح چاپی منتقل می‌شود. در این نوع چاپ، نوشته یا عکس را روی سطح 
لاستیکی یک استوانه ) سیلندر( برگردان میک‌نند و سپس، آن را روی سطح کاغذ فشار داده و تصویر را چاپ 
میک‌نند. در چاپ افست، چیزی را که قرار است چاپ شود روی یک صفحه فلزی به نام زینک منتقل کرده و 
صفحه را به‌گونه‌ای با مواد شیمیایی حساس میک‌نند که فقط نوشته‌های روی صفحه به خود رنگ بگیرند. در 
کل، ماشین چاپ افست، شامل سه استوانه است. هنگامی که نوشته روی صفحه زینک به خود رنگ گرفت، 
زینک به دور استوانه اول پیچیده می‌شود. سپس، استوانه دوم با استفاده از فشار وارده روی پوشش پلاستیکی 
می‌چرخد. کاغذ سفیدی که به‌طور متوالی به دور استوانه سوم پیچیده می‌شود، مطالب را از روی پوشش 
پلاستیکی استوانه گرفته و در نهایت، چاپ میک‌ند. قابل ذکر است که سرعت کار ماشین‌های چاپ افست 

بیش از چاپ مسطح )حروفی( است. 
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  ١٨ـ٩ـ انواع خدمات چاپ   ٣ 
چاپخانه‌ها سعی میک‌نند که با استفاده از سیستم‌های نوین چاپ و دستگاه‌های بایکفیت، انواع خدمات چاپ 

را ارائه دهند. این خدمات عبارت‌اند از: 

خدمات چاپ افست 
1 چاپ شیت عمومی برای انواع کارت ویزیت افست

  چاپ کارت ویزیت لمینت شیشه‌ای / براق 

  چاپ کارت ویزیت سلفون براق / مات 

 PVC چاپ کارت ویزیت  

  چاپ کارت ویزیت سه بعدی 

٢ چاپ شیت عمومی برای انواع تراکت، سربرگ، فاکتور و کاتالوگ 
  چاپ کاغذ A6 / گلاسه 

  چاپ کاغذ A4 / گلاسه 

  چاپ کاغذ A5/ گلاسه 

3 چاپ شیت اختصاصی 
  چاپ سربرگ 

  چاپ تراکت و برگه‌های تبلیغاتی 

  چاپ کاتالوگ و بروشور 

  چاپ پوستر 

  خدمات چاپ دیجیتال 

4 چاپ انواع کارت ویزیت گلاسه 
  چاپ انواع کارت ویزیت سلفون براق/ مات 

  چاپ انواع کارت ویزیت لمینت براق/ مات 

  چاپ کاتالوگ، پوستر، تراکت، بروشور و کارت پستال 

  چاپ ریسوگرافی 

  چاپ سیلک روی انواع اجسام 

  طراحی و ساخت انواع آلبوم‌های تبلیغاتی 

  طراحی و ساخت انواع هدایای تبلیغاتی

 19ـ9ـ مفاهیم اولیه صفحه‌آرایی

مجموع آماده‌سازی صفحات جهت چاپ را صفحه‌آرايي می‌گویند که رفته رفته به مرور زمان پیشرفته شده و 
با چاشنی خلاقیت به مسئله‌ای مهم در جذب مخاطب برای مطالعه بیشتر رسانه مبدل شده است. با پیشرفت 
علم و فناوری و حضور رسانه‌های نوین از قبیل سایت‌های خبری، کتاب‌های الکترونیک، تلویزیون، رادیو و… 
کتاب و مجله هنوز مخاطب خود را از دست نداده و همچنان به سرانه مطالعه به مهم‌ترین عامل پیشرفت 
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کشورها یاد می‌شود. برای افزایش این سرانه، یکی از راه‌ها صفحه‌آرايي جذاب و هنرمندانه برای جذب و لذت 
بردن بیشتر مخاطبان است.

در کل صفحه‌آرايي، هنر انتخاب فونت، اندازه کلمات، فواصل خطوط، فاصله از حاشیه‌ها، زیباسازی و طراحی 
گرافیکی صفحات، جاگذاری مناسب عکس‌ها و … است. به‌طور کلی می‌توان گفت که صفحه‌آرايي به مجموعه 
عملیات قبل از آماده‌سازی چاپ نشریه می‌گویند. انتخاب مناسب رنگ‌ها جهت چاپ با یکفیت، دید خلاقانه 

و طراحی قوی از دیگر عوامل یک صفحه‌آرايي مناسب است.
به عبارت دیگر صفحه‌آرايي هنر جذب توجه مخاطب به مطالب نشریه و کمک به افزایش توجه او به علاوه 

ایجاد اشتیاق در دنبال کردن موضوع نشریه است که این مهم با شناخت مخاطب به دست می‌آید.
صفحه‌آرايي به‌صورت تاریخی توسط حروف‌چینان و به‌طور دستی انجام می‌شده، اما این روزها با پیشرفت 
علم و فناوری بیشتر از نرم‌افزارهای رایانه ای برای این منظور استفاده می‌گردد که Adobe InDesign از 
مهم‌ترین نرم‌افزارهای صفحه‌آرايي است که با امکانات فراوان، دست طراح را برای انواع خلاقیت باز می‌گذارد. 
Microsoft Publisher از دیگر نرم‌افزارهایی است که سابقاً طرفدار زیادی داشته، اما اکنون جای خود را به 
نرم‌افزار شرکت Adobe داده است. Microsoft Word هم امکان صفحه‌آرايي را برای کاربران غیر حرفه‌ای 

به سادگی فراهم کرده تا برای کارهای روزمره به مشکلی برخورد نکنند.
 

١ـ١٩ـ٩ـ ترکیب‌بندی در صفحه‌آرايي 
تریکب‌بندی به معنی قرار گرفتن اجزای مختلف در کنار هم و تشکیل یک »کل« است. در یک صفحه‌آرايي 
خوب محل قرارگیری اشیا در توازن و تعادلی با یکدیگر قرار دارند که حس مطلوبی به بیننده القا میک‌نند. با 
جابه‌جایی اجزای مختلف در صفحه‌آرايي خوب می‌توانید به این حس خوب که همان حس زیبایی است دست 
پیدا کنید. در یک طراحی صفحه‌آرايي زیبا، تریکب تصاویر، خطوط، متون، رنگ‌ها، سایه‌ها، شفافیت تصاویر 

و غیره به‌صورت متوازن در کنار یکدیگر جای گرفته‌اند.
یکی از روش‌های مفید جهت ایجاد تریکب‌بندی مناسب، روش تقسیم‌بندی سه‌تایی است. به این صورت که 
در نرم‌افزار با استفاده از خطوط راهنما، کادر را به سه قسمت مساوی عمودی و افقی تقسیم‌بندی میک‌نید. از 

محل برخورد این خطوط می‌توان به عنوان نقاط اصلی استفاده کرده و اجزای مهم را در آن قرار داد.
جدای از این‌ها، یک طراح نیازمند دانش و مبانی هنرهای تجسمی و گرافیک جهت یک صفحه‌آرايي مناسب 
است. این دانش است که به هنرمند طراح می‌آموزد تا تریکب عناصر ملموس مانند، خط، سطح، متن، تصویر، 
اندازه، شکل، رنگ، تیرگی و روشنی، به همراه یکفیت خاص دیداری آن‌ها از قبیل تناسب، تعادل، هماهنگی 

و کنتراست را که باعث مستحکم شدن اثر تجسمی می‌شود به راحتی به کار گیرد.
 

٢ـ١٩ـ9ـ ویژگی صفحه‌آرايی خوب 
  مخاطب را در برابر خود متوقف مي‌كند. 

  توجه بيننده را به خود جلب مي‌كند و وي را به پيگيري و خواندن آن ترغيب مي‌كند. 

  آميزش جذابي از حروف و تصاوير را به نمايش مي‌گذارد. 

  به نحو مطلوب انتظام يافته است.



واحد كار نهم: وارد و صادر کردن محتوای سند

1 7 1

  به خوبي مخاطب خود را مي‌شناسد.

  به خوبي عناصر اصلي طراحي را به خدمت مي‌گيرد.

  پيام را به مخاطبان خاص خود منتقل كند.

  مفهوم روشني دارد.

  كاملًا صريح است و هيچ ابهامي ندارد.

20ـ9ـ انواع کاغذ برای چاپ

قدیم  بسیار  زمان‌های  از  بسته‌بندی  و  نوشتن  منظور  به  که  است  وسیله‌هایی  قدیمی‌ترین  از  یکی  کاغذ 
نوع محصول، وزن محصول، شرایط  به  با توجه  قرار گرفته شده است. در صنعت بسته‌بندی  استفاده  مورد 
کاغذ  انتخاب  به  اقدام  هزینه‌ها  گرفتن  نظر  در  با  می‌توانیم  دیگر  موارد  و  بسته‌بندی  ظاهر  زیست‌محیطی، 
مناسب کنیم. همچنین در چاپ انواع رسانه‌های چاپی مانند کاتالوگ، کارت ویزیت، بروشور، فولدر، تراکت 
و سایر رسانه‌های چاپی با توجه به نوع نیاز و هزینه مورد نظر، اقدام به انتخاب کاغذ مورد نظرمان میک‌نیم.

به منظور چاپ انواع رسانه‌ها و بسته‌بندی‌ها، اگر با انواع مختلف کاغذ و مقوا آشنایی داشته باشیم، می‌توانیم 
در انتخاب محصول مورد نظرمان هوشمندانه‌تر عمل کنیم. در این بخش به بررسی انواع کاغذ و مقوا به منظور 

چاپ دیجیتال و افست انواع رسانه‌های چاپی می‌پردازیم.
در حالت کلی اصول ساخت انواع کاغذ یکسان است و با توجه به نوع مصرف و نوع چاپ، گروهی از ویژگی‌ها تغییر 

میک‌ند. قیمت و یکفیت انواع کاغذ بر مبنای نوع خمیر آن تعیین می‌شود و در انواع مختلف ساخته می‌شود.
با توجه به محدودیت بازار کاغذ در ایران، همه انواع کاغذ در بازار ایران موجود نیست و تنها تعداد محدودی از 
انواع کاغذ در بازار عرضه می‌شود. این کاغذها شامل انواع کاغذ ایرانی و خارجی است که در گرماژهای مختلف 

تولید می‌شود. در ادامه به معرفی گرماژ کاغذ، انواع پوشش‌ها و انواع کاغذ می پردازیم.
 

 ١ـ٢٠ـ٩ـ گرماژ کاغذ 
قبل از پرداختن به معرفی انواع کاغذ لازم است که با واژه گرماژ کاغذ آشنا شویم و معنی و مفهوم آن را بدانیم.
گرماژ کاغذ یکی از مهم‌ترین عوامل در تعیین یکفیت و ضخامت کاغذ محسوب می‌شود. گرماژ کاغذ عبارت 
است از نسبت وزن کاغذ برحسب گرم به مساحت یک مترمربع از سطح کاغذ. برای درک بهتر یک مثال را در 
نظر می‌گیریم: اگر گرماژ یک کاغذ 70 گرم باشد، بدین معنا است که هر یک مترمربع از این کاغذ 70 گرم 
وزن دارد. هرچه مقدار گرماژ بیشتر باشد، یکفیت، ضخامت، استحکام و به تبع آن قیمت افزایش خواهد یافت. 

واحد گرماژ GSM (g/m²) است که مخفف Grams per Square Meter است.
 

 ٢ـ٢٠ـ٩ـ پوشش لمینت و سلفون 
به فرایند کشیدن روکش به روی هر سطحی اصطلاحاً لمینت می‌گویند. در سیستم چاپ دیجیتال لایه نازک 
پلاستیکی را یک طرف یا دو طرف کار چاپی می‌‌چسبانند که کار را در برابر پاره شدن، رطوبت، گرما یا سرما 
اگر  با واحد میکرون سنجیده می‌شوند.  لمینت‌ها، ضخامت متنوعی دارند که  و چرویکدگی مقاوم میک‌ند. 
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لمینت دارای ضخامت کمی باشد آن را سلفون نیز می‌نامند. از دیگر مزیت‌های لمینت کردن کار چاپی در 
چاپ دیجیتال می‌‌توان به جلوه دادن به کار و زیبا کردن بیشتر کار با اضافه کردن لمینت مات یا براق به 
آن اشاره کرد. از لمینت و سلفون در چاپ کارت‌‌های ویزیت، کاتالوگ‌ها، بروشورها و دیگر محصولات چاپی 

استفاده می‌شود.

شکل 15ـ9ـ پوشش لمینت و سلفون

در واقع لمینت کردن، محصول چاپی را در مقابل تا شدن و آسیب دیدن مقاوم میک‌ند. در حالی که سلفون، 
تنها در مقابل تا شدن از آن محافظت میک‌ند.

 ٣ـ٢٠ـ٩ـ انواع کاغذ و مقوا در صنعت چاپ و بسته‌بندی 
 حال به بررسی برخی از انواع مختلف کاغذها و مقواها از جمله کاغذ تحریر، کاغذ و مقوای گلاسه، کاغذ کتان، 
کاغذ کرافت، مقوای کارتی، مقوای ایندربرد به همراه برخی از ویژگی‌ها و کاربردهایشان و این که برای هر نوع 

کاغذ چه نوع پوششی مناسب‌تر است می‌پردازیم.

 کاغذ تحریر 
کاغذ تحریر نوعی از کاغذ است که امکان چاپ روی هر دو طرف آن موجود است و مرکب به سمت دیگر آن 
نفوذ نمیک‌ند. کاغذ تحریر در گرماژ 50، 55، 60، 65، 70، 75، 80، 100 و 120 تولید می‌شود که با توجه 

به نوع نیاز و کاربرد، از آن‌ها استفاده می‌شود.
در تولید کاغذهای تحریر از خمیرهای شیمیایی چوب پهن برگان و سوزنی برگان استفاده می‌شود. کاغذ تحریر 

دارای مقاومت مناسبی است که این امر، برای بایگانی به مدت طولانی بسیار اهمیت دارد.
این کاغذ در صنعت چاپ بیشتر برای چاپ انواع تراکت، چاپ کتاب، چاپ سربرگ و چاپ پاکت مورد استفاده 
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قرار می‌گیرد.
کاغذ تحریر در رنگ‌های مختلف تولید می‌شود که نوع رنگ آن با توجه به خمیر مورد استفاده هنگام تولید 
تعیین می‌گردد. سطح کاغذ تحریر علاوه بر اینکه برای چاپ بسیار مناسب است، برای نوشتن روی سطح آن با 
خودکار نیز بسیار مناسب است. روی سطح این نوع کاغذ نمی‌توان هیچ نوع پوششی )سلفون و ...( ایجاد کرد.

 
 کاغذ یا مقوای گلاسه 

آن  سطح  روی  جوهر  یکنواخت  جذب  دلیل  به  که  است  هموار  بسیار  و  صاف  سطح  دارای  گلاسه  کاغذ 
برای چاپ انواع رسانه مناسب است. کاغذ گلاسه از مرغوب‌ترین انواع کاغذ است که در گرماژهای مختلف 
تولید می‌شود. هر چه گرماژ در کاغذ گلاسه بالاتر باشد، مقاومت و ضخامت آن بیشتر می‌شود و همچنین 

می‌شود. انجام  بیشتری  یکفیت  با  آن  چاپ‌پذیری 
لازم به ذکر است برای این نوع کاغذ می‌توان از پوشش لمینت و سلفون به منظور بالاتر بردن مقاومت کالای 
چاپی استفاده کرد. کاغذ گلاسه به منظور چاپ انواع رسانه‌های چاپی مانند چاپ کارت ویزیت، چاپ کاتالوگ، 

چاپ تراکت، چاپ بروشور، چاپ ساک دستی، چاپ تقویم و سایر موارد استفاده می‌گردد.

 مقوای ایندربرد 
ایندربرد نوعی مقوا است که در گرماژهای مختلف تولید شده و در صنعت بسته‌بندی کاربرد فراوانی دارد و از 

آن به عنوان مقوای بهداشتی نیز نام می‌برند.
رنگ این نوع مقوا سفید است و به علت بافت خوبی که دارد در صنعت بسته‌بندی مواد غذایی کاربرد بسیاری 
دارد. این مقوا به دلیل قیمت و استحکام مناسبی که دارد، در صنعت بسته‌بندی و چاپ جعبه‌های محصولات 
دارویی، آرایشی و بهداشتی کاربرد فراوانی دارند. همچنین پوشش سلفون برای بیشتر شدن مقاومت این نوع 

بسته‌بندی، بسیار مناسب است.
 

 مقوای پشت طوسی 
مقوای پشت طوسی نوعی از مقوا است که یک طرف آن سفید و طرف دیگر آن طوسی است. این نوع مقوا در 
گرماژهای مختلف 210، 230، 250، 280، 300، 350، و 400 تولید می‌شود. از مقوای پشت طوسی در 

چاپ جعبه و بسته‌بندی‌های متفاوت استفاده می‌شود.
مقوای پشت طوسی یا دوبلکس از چسبانده شدن ورقه‌های مقوا به‌صورت دولایه توسط صفحات مخصوص 
مانند  مصارف  برخی  در  حساسیت  و  بودن  بازیافتی  علت  به  طوسی  پشت  مقوای  می‌شود.  تهیه  مرطوب 

نمی‌گیرد. قرار  این صنایع خاص  توجه  مورد  غذایی  مواد  بسته‌بندی  و  دارویی  جعبه‌های 
  

 کاغذ کرافت 
 این نوع کاغذ از سولفات خمیر پالت تهیه شده و دارای مقاومت بالایی است. کاغذهای کرافت انواع متفاوتی 
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دارند؛ از جمله کاغذهای کرافت سفید نشده که بیشتر در صنعت بسته‌بندی استفاده می‌شوند یا کاغذهای کرافت 
سفید شده که برای تهیه کاغذهایی که پیوستگی بافت آن‌ها قوی است بیشتر مورد استفاده قرار می‌گیرد.

شکل 16ـ9ـ کاغذ کرافت
کاغذ کرافت معمولاً با رنگ قهوه‌ای یا با رنگ سفید تولید می‌شود و بادوام است. گرماژ و وزن این کاغذ بسیار 
متنوع است به‌طوریک‌ه از تریکب آن‌ها در تولید ورق و کارتن امکان تولید بیش از یک‌صد نوع تریکب در 
ورق‌های 3 لایه و 5 لایه میسر می‌گردد و به‌صورت کاغذ کرافت، مقوای کرافت و مقوای زبر یا خشن کرافت 
است. این نوع کاغذ مورد استفاده در ساخت جعبه، پاکت و همچنین چاپ ساک دستی است. لازم به ذکر 

است هیچ نوع پوششی برای سطح کاغذ کرافت مناسب نیست.

 کاغذ کتان 
کاغذ کتان نوع خاصی از کاغذ بافت‌دار است که به دلیل دارا بودن بافت در درون کاغذ، روی سطح ویژگی 
خاصی ایجاد میک‌ند. این بافت‌ها بسته به نوع کاغذ کتان و کشور تولیدک‌ننده آن، متغیر است. کاغذ کتان در 
چاپ کارت ویزیت، چاپ پاکت و چاپ سربرگ استفاده می‌شود. در این نوع کاغذ شیار‌های عمودی یا افقی 
یا هر دو دیده می‌شود که این شیار‌ها و بافت‌های ریز، زیبایی ویژه‌ای به کار‌های چاپی و به‌ویژه کارت‌های 
ویزیت می‌دهد. به دلیل وجود همین بافت‌های برجسته، برای سطح کاغذ کتان از هیچ نوع پوششی استفاده 

نمی‌شود تا زیبایی آن به شکل بهتری جلوه‌گر باشد.

شکل 17ـ9ـ کارت ویزیت با کاغذ کتان بافت‌دار
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 مقواي كارتی 
این نوع مقوا در رنگ‌های متفاوت تولید می‌شود. مقوای کارتی بافت نسبتاً یک دست و بدون برجستگی و 
فرورفتگی دارد. از اين نوع مقوا براي جدا‌سازي بخش‌هاي مطالب در زونكن و از نوع مرغوب و ضخیم‌تر آن نيز 
براي چاپ كارت ويزيت استفاده مي‌شود. لازم به ذکر است، در صورت انتخاب این نوع مقوا برای چاپ کارت 

ویزیت، امکان استفاده از پوشش سلفون و یا لمینت وجود ندارد.
 

 کاغذ کاربن‌لس 
کاغذی با پوشش شیمیایی که شبیه به کاربن عمل میک‌ند و یک 
کپی از نوشته‌های دست‌نویس را روی صفحه بعدی انتقال می‌دهد. 
پایین است که  با گرماژ  الوان  و  تحریر سفید  واقع همان کاغذ  در 
پس از تولید با ماده شیمیایی تریکب شده تا قابلیت کپی کردن را 

باشد. داشته 
از کاغذهای الوان در چاپ فاکتورها و فرم‌های سه نسخه‌ای استفاده 

می‌شود.

 

21ـ9ـ استاندارد طراحی بروشور

تولیدک‌نندگان، فروشندگان و یا ارائه‌دهندگان خدمات در جستجوی راهی مؤثر و مقرون به صرفه برای معرفی 
کالا، محصولات و یا خدمات خود هستند و چاپ بروشور را به این منظور انتخاب میک‌نند. در این صورت 
دانستن اصول اولیه طراحی بروشور به شما کمک خواهد کرد تا بتوانید فایل بروشور خود را به بهترین شکل 

و به‌صورت استاندارد تهیه کرده و به چاپ برسانید.

شکل 19ـ9ـ نمونه بروشور

شکل ١٨ـ9ـ کاغذ کاربن لس
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در این بخش قصد داریم به معرفی اصول طراحی بروشور‌های تبلیغاتی بپردازیم زیرا دانستن این اصول به 
طراحان و صاحبان مشاغل کمک میک‌ند تا برای معرفی محصولات و خدمات خود استراتژی درستی به کار 
گیرند. در حقیقت، در طراحی بروشور، مباحثی همچون زیبایی‌شناسی، خلاقیت و برقرار کردن ارتباط مؤثر 

با مخاطب، اهمیت بسیاری دارد. 
در واقع لازم است ابتدا اصول طراحی بروشور و نحوه تهیه فایل مناسب برای چاپ را بدانیم تا با کمک این 
دانش فنی، بروشوری استاندارد طراحی کنیم. لازم به ذکر است، گرچه دانستن این اصول برای موفقیت در 
طراحی بروشور کافی نیست اما لازمه داشتن یک بروشور خوب و استاندارد به حساب می‌آید. بدین معنا که 
حتی در صورت داشتن یک طراحی جذاب و عالی، با رعایت نکردن این موارد فنی قطعاً محصول خروجی، 

انتظارات شما را برآورده نخواهد کرد. 
 

 ١ـ٢١ـ٩ـ اصول طراحی بروشور برای چاپ 
در طراحی بروشور موارد بسیاری وجود دارد که رعایت آن‌ها، یکفیت خروجی نهایی را تضمین میک‌ند. در 

ادامه به معرفی این موارد خواهیم پرداخت و ویژگی‌های فایل مناسب برای چاپ را عنوان خواهیم کرد.
 

 ابعاد بروشور چاپی 
 در تمام کارهای چاپی اعم از بروشور، تراکت، کاتالوگ، کارت ویزیت و ... پیش از شروع طراحی، حتماً ابعاد 
نهایی کار را در نظر گرفته و یک فایل طراحی به همان اندازه ایجاد کنید. زیرا تغییر اندازه کار پس از پایان 
طراحی می‌تواند موجب کاهش یکفیت کار، کاهش خوانایی نوشته‌ها و یا به هم ریختگی عناصر موجود در 

طراحی شود.
 به عنوان مثال فرض کنید هنگام طراحی ابعاد فایل خود را A5 در نظر گرفته‌اید. حالا تصمیم گرفته‌اید آن را 
بزرگ‌تر کرده و با اندازه A4 چاپ کنید. در این صورت با بزرگ کردن ابعاد کار، یکفیت تصاویر پایین می‌آید، 
چون در واقع تصاویر از دو طرف کشیده می‌شوند. همچنین در صورتی که فایل خود را بزرگ‌تر از ابعادی 
که قرار است چاپ شود طراحی کنید، امکان ناخوانا شدن نوشته‌ها و عناصر کوچک در ابعاد جدید به وجود 
می‌آید. به عنوان مثال اگر در ابعاد A4 اندازه فونت نوشته‌های شما 8 پوینت باشد با کوچک کردن کل فایل 

ممکن است اندازه جدید نوشته‌ها کاهش یافته و ناخوانا شود.
 جدا از این موارد مشکل دیگری که در تغییر ابعاد کار وجود دارد، دفرمه شدن یا تغییر نامتناسب ابعاد کار 
است. به‌طوری که تصاویر و عناصر موجود در طراحی با کشیده یا جمع شدن، شکل عادی خود را از دست 
می‌دهند و از زیبایی بروشور چاپ‌شده میک‌اهند. بنابراین بهتر است ابتدا تصمیم نهایی خود را برای اندازه 

چاپ بروشور اتخاذ کرده و سپس اقدام به طراحی کنید.
 

 نرم‌افزار مناسب برای طراحی بروشور 
انجام شود؟  نرم‌افزاری  با چه  است  بهتر  بروشور  که طراحی  می‌آید  پیش  این سؤال  افراد  از  بسیاری  برای 
برخی افراد نرم‌افزارهای نقش‌بیتی مانند Adobe Photoshop را برای این کار پیشنهاد میک‌نند و برخی 
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دیگر، استفاده از نرم‌افزارهای برداری مانند Adobe Illustrator و Corel Draw را برای این کار مناسب‌تر 
به  )نسبت  برای صفحه‌آرایی   InDesign نرم‌افزار  تخصصی  ویژگی‌های  و  امکانات  به  توجه  با  اما  می‌دانند. 
نرم‌افزارهای  یاد شده(، InDesign بهترین و مناسب‌ترین  است به‌ویژه اگر بروشور و کاتالوگ دارای صفحات 
و تصاویر زیادی باشد. بهتر است در نرم‌افزار InDesign،  از برگه Print که مختص کارهای چاپی است، ابعاد 
استاندارد مانند A4 را انتخاب کرده یا ابعاد دلخواه را ترجیحاً به میلی‌متر وارد کنید. اگر فایل بروشور را در 

نرم‌افزار Photoshop طراحی میک‌نید به این نکات باید بیشتر توجه کنید:
  رزولوشن فایل: چه کارت ویزیت طراحی کنید، چه کاتالوگ یا هر محصول چاپی دیگری، رزولوشن فایل 

طراحی از ابتدا باید 300dpi تعیین شود. در صورت پایین‌تر بودن رزولوشن، یکفیت چاپ مناسب نخواهد 
بود. گاهی اوقات افراد فایل خود را در مانیتور مشاهده میک‌نند و متوجه پایین بودن یکفیت تصاویر نمی‌شوند 
)رزولوشن نمایشگرها 72dpi است؛ بنابراین مقایسه تصویر چاپی با تصویر نشان داده شده در مانیتور به هیچ 
وجه درست نیست(. همچنین بالا بردن رزولوشن حین طراحی بروشور و یا پس از پایان آن، تأثیری در افزایش 

یکفیت کار، نخواهد داشت. بنابراین لازم است از ابتدا، رزولوشن فایل طراحی را 300dpi مشخص کنید.

Photoshop شکل 20ـ9ـ تعیین رزولوشن بروشور در نرم‌افزار

 
 

داشتن رزولوشن 300dpi علاوه بر فایل طراحی، برای تمام عناصر و تصاویر مورد استفاده در طراحی 
نیز الزامی است.

نکته
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  رنگ نوشته‌ها: نوشته‌ها از مهم‌ترین عناصر در طراحی بروشور هستند که وظیفه انتقال اطلاعات به مخاطب 

را به عهده دارند. اما به دلیل ظرافت و داشتن جزئیات، باید برای نحوه قرارگیری و نمایش آن‌ها به نکات ریزی 
توجه شود. یکی از این نکات، رنگ نوشته‌ها است. رنگ مشکی روی بسیاری از زمینه‌ها، به خوبی خودنمایی 
رنگ  استفاده هر  اما  استفاده می‌شود.  نوشته‌ها  برای  رنگ  این  از  اغلب  بروشور  در طراحی  بنابراین  میک‌ند. 
 Y=0 و M=0 و C=0( مشکی‌ای برای نوشته‌ها مناسب نیست. لازم است تریکب رنگ مشکی برای نوشته‌ها
و K=100( و blending option روی گزینه multiply باشد تا یکفیت و وضوح آن‌ها در چاپ مناسب باشد.

      لازم به ذکر است گرچه ممکن است این رنگ مشکی در مانیتور کم رنگ به نظر برسد اما بهترین انتخاب 
برای نوشته‌های کوچک و متوسط به شمار می‌رود.

  اندازه فونت نوشته‌ها: یکی از نکاتی که در طراحی بروشور و تهیه فایل چاپی آن بسیار مهم است، آن 

است که اندازه فونت نوشته‌ها کمتر از 6 پوینت نباشد. در حقیقت کوچک‌تر بودن اندازه فونت‌ها، از خوانایی 
مطالب میک‌اهد. البته این مقدار در فونت‌های مختلف و بین زبان فارسی و انگلیسی می‌تواند متفاوت باشد، 
اما عموماً رعایت این اندازه، خوانایی نوشته را تضمین میک‌ند. البته اندازه استاندارد فونت نوشته‌ها برای متون 
داخلی اغلب بین 8/5 تا 13/5 است. همچنین اندازه فونت برای نوشته‌های انگلیسی می‌تواند بین 0/5 تا یک 

پوینت کوچک‌تر از فونت فارسی تعیین شود.
  سیستم رنگی )Color Mode(: سیستم رنگی در مانیتورها، سه رنگ )RGB( است و ماهیت نمایش 

آن نوری است؛ بدان معنا که نور، عامل نمایش رنگ‌ها در نمایشگر است. در واقع هرچه نور بیشتر باشد )درجه 
RGB بالا برود( رنگ نهایی روشن‌تر می‌شود. اما در چاپ، سیستم رنگی، چهار رنگ )CMYK( است و این 
رنگ‌ها توسط مرکب یا جوهر چاپ ایجاد می‌شوند. هرچه مقدار این رنگ‌ها بیشتر شود، رنگ نهایی، تیره‌تر 
خواهد شد. به دلیل این که ماهیت این سیستم‌ها با یکدیگر متفاوت است، موارد استفاده از آن‌ها نیز متفاوت 
است. بنابراین باید برای نزدیک‌تر شدن رنگ‌ها به محصول خروجی، لازم است فایل طراحی در حالت رنگی 

CMYK ایجاد شود.

در صورت استاندارد بودن مانیتور و با رعایت سیستم رنگی ذکر شده در بالا، رنگ‌های دیده شده در 
نمایشگر به رنگ‌های چاپی نزدیک می‌شود، اما به دلیل تفاوت ماهیتی رنگ‌ها )در چاپ و نمایشگر( 
که در بالا ذکر شد، همچنان احتمال 15 درصد اختلاف رنگ میان فایل طراحی و محصول چاپی 

وجود دارد.

نکته

RGB در برابر CMYK شکل 21ـ9ـ حالت رنگ
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  اضافه رنگ: یکی دیگر از نکات کلیدی در طراحی بروشور، رعایت اضافه رنگ است. در تمام دستگاه‌های 

چاپ امکان جابه‌جایی چاپ پشت و روی فایل به اندازه چند میلی‌متر وجود دارد. بنابراین در سفارش‌هایی که 
زمینه آن‌ها رنگ یا طرح دارد، برای آن که اطراف کار پس از برش سفید نماند، لازم است رنگ و طرح زمینه 
را از هر طرف حدود سه میلی‌متر خارج از کادر اصلی، امتداد دهید. به عنوان مثال در صورتی که سفارش شما 
یک بروشور A4 باشد، بهتر است به جای 21×29/7 سانتیمتر، فایل خود را با ابعاد 21/6×30/3 سانتیمتر 
طراحی کنید. اما باید دقت کنید که در این فضای سه میلی‌متری، تنها می‌توانید رنگ و طرحی را قرار دهید 
که بریده شدن آن تأثیر منفی‌ای بر کار ندارد. به عبارتی قرار دادن لوگو و نوشته در این فضا توصیه نمی‌شود.

  حاشیه برش و فضای امن: همان‌گونه که در بند قبل ذکر شد، همیشه امکان جابه‌جایی طرح به اندازه 

چند میلی‌متر هنگام چاپ و برش وجود دارد و این خطا اجتناب‌ناپذیر است. بنابراین طراحان، حاشیه امنی را 
برای کار خود در نظر می‌گیرند تا نوشته‌ها و عناصر مهم در طراحی، به دلیل خطای برش، از بین نروند. این 
مقدار بین 7 تا 10 میلی‌متر از هر طرف کار است. البته در صورتی که فایل طراحی به اندازه A5 یا کوچک‌تر 

از آن باشد، رعایت 5 تا 7 میلی‌متر فاصله، کافی است.

  خطوط تا: بروشورها یک یا چند خط تا دارند و در نواحی »خط تا« نیز مشابه حاشیه‌های کار، امکان 

خطا و جابه‌جایی وجود دارد، بنابراین بهتر است عناصر و نوشته‌ها، حداقل 5 میلی‌متر از هر طرفِ خط تاها 
فاصله داشته باشند.

شکل 22ـ9ـ خط تا

به دلیل مسائل مربوط به زیبایی‌شناسی، در صورتی که فاصله نوشته‌ها با حاشیه بیشتر از مقدار مذکور 
باشد، زیبایی و خوانایی بروشور بیشتر می‌شود. 

نکته
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 نکات تکمیلی 
 هنگام طراحی بروشور شما می‌توانید هر لت را به‌طور جداگانه در یک صفحه طراحی کنید اما بهتر است تمام 
آن‌ها را به‌صورت یک تکه، طراحی کنید )یک صفحه روی کار و یک صفحه پشت کار باشد(. در این صورت 
لازم است به اندازه هر لت توجه کنید تا احتمال خطای طراحی کاهش یابد. این کار نه تنها به شما دید بهتری 
نسبت به نحوه قرارگیری عناصر در خروجی نهایی می‌دهد، بلکه احتمال بروز خطا در چیدمان صفحات موقع 
چاپ را نیز کاهش می‌دهد. همواره پیشنهاد می‌شود پیش از ثبت سفارش، یک پرینت سیاه و سفید از بروشور 
خود ـ ترجیحاً در ابعاد واقعی ـ تهیه کنید تا بتوانید با بررسی دقیق‌تر نوشته‌ها و خطوط تا و محل قرارگیری 

لت‌ها، خطا و اشتباه را تا حد ممکن کاهش دهید.
مسئله دیگری که بر بروشور نهایی شما تأثیرگذار است، انتخاب کاغذ است. شما باید با توجه به بودجه، نیاز و 
سلیقه خود، کاغذ مناسبی را جهت چاپ بروشور انتخاب کنید. به‌طور کلی، تفاوت کاغذها در جنس و ضخامت 
آن‌ها است و این امر تأثیر بسیاری در خروجی چاپی دارد. به عنوان مثال کاغذ تحریر، مات است و میزان جذب 
مرکب بالاتری نسبت به مقوای گلاسه دارد. با توجه به این که مقوای گلاسه اغلب براق است، رنگ‌ها روی 
آن با درخشندگی بیشتری نسبت به کاغذ تحریر، خودنمایی میک‌نند. این تفاوت ماهیتی در کاغذها، موجب 

تفاوت شدیدی در خروجی چاپی می‌شود.

22ـ9ـ استاندارد طراحی کاتالوگ

کاتالوگ‌ها در شکل، رنگ، جنس، طرح، اندازه و با اهداف مختلف طراحی و تولید می‌شوند. اگر قصد دارید 
برای محصولات شرکت خود یک کاتالوگ زیبا و مؤثر تولید کنید؛ تا انتهای این بخش همراه ما باشید. در ادامه 
درباره ویژگی‌های مختلف انواع کاتالوگ نکات مهمی را با شما در میان می‌گذاریم. نکاتی که کمک میک‌ند 

انتخاب‌های بهتری برای طراحی و تولید کاتالوگ داشته باشید.

 ١ـ٢٢ـ٩ـ اندازه انواع کاتالوگ 
کاتالوگ‌ها مانند سایر محصولات تبلیغات چاپی، دارای اندازه‌های استاندارد و مختص به خود هستند. این 
استانداردها بر اساس تجارب قبلی به وجود آمده و در درجه اول توصیه می‌شود کاتالوگ خود را در یک اندازه 

استاندارد و پرکاربرد طراحی کنید.
اندازه A4 و A5 و به سه صورت عمودی، افقی و مربعی طراحی و چاپ  به‌طور معمول کاتالوگ‌ها در دو 
می‌شوند. البته اندازه‌ها و اشکال دیگری از کاتالوگ نیز وجود دارد که معمولاً به دلیل اتلاف زیاد کاغذ هزینه 

بیشتری را موجب می‌شوند.
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شکل 23ـ9ـ کاتالوگ

 ٢ـ٢٢ـ٩ـ جنس و پوشش جلد کاتالوگ 
جنس جلد کاتالوگ‌ها به‌طور معمول از کاغذ گلاسه است؛ که بنابر سلیقه شخصی می‌توان از انواع کاغذ گلاسه 
با ضخامت‌های مختلف برای آن استفاده کرد. طبیعتاً کاغذهای گلاسه ضخیم‌تر، کاتالوگ شما را سنگین‌تر، 
مستحکم‌تر و البته با هزینه‌های بیشتر همراه میک‌ند. تجربه ثابت کرده است که استفاده از کاغذ گلاسه ضخیم 

برای جلد و کاغذهای گلاسه نازک‌تر برای صفحات داخلی، هارمونی خوبی در محصول نهایی ایجاد میک‌ند.
کاتالوگ‌ها ابزارهای تبلیغاتی با دوامی هستند. از این رو بسیار مهم است که مدت طولانی‌تری با همان یکفیت 
و زیبایی سابق حفظ شده و قابل استفاده باشند. از سویی دیگر یکی از ضعف‌های چاپ روی کاغذ گلاسه این 
است که در صورت استفاده متوالی و لمس جلد کاتالوگ با دست، کمک‌م از یکفیت تصویر چاپ شده روی آن 

کاسته می‌شود.
 

شکل 24ـ9ـ نمونه کاتالوگ
باشد.  مؤثر  بسیار  کاتالوگ  عمر  افزایش  در  محافظتک‌ننده می‌تواند  روکش  از یک  استفاده  این شرایط  در 
سلفون محبوب‌ترین پوشش مورد استفاده برای جلد کاتالوگ است. سلفون‌ها یک لایه پلاستیکی بسیار نازک 
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هستند که پس از چاپ، روی کاغذ جلد چسبانده می‌شوند. سلفون‌ها علاوه بر استحکام موجب افزایش زیبایی 
ظاهری کاتالوگ نیز می‌گردند. این پوشش در انواع براق، مات و مخملی )بافت‌دار( و بنابر سلیقه شما مورد 

استفاده قرار می‌گیرند.

 ٣ـ٢٢ـ٩ـ گرماژ کاتالوگ 
در قسمت اندازه درباره ضخامت کاغذ مورد استفاده در انواع کاتالوگ اشاره کوتاهی داشتیم. اما اینکه چطور 
ضخامت انواع کاغذ را تشخیص دهید نیازمند آشنایی با موضوع گرماژ کاغذ است. هر نوع کاغذی بر مبنای 
برگ ۱۰۰  یک  که  معناست  این  به  گرم  کاغذ گلاسه ۳۰۰  مثلًا  تعریف می‌شود.  مربع  متر  در  آن  گرماژ 

سانتی‌متر در ۱۰۰ سانتی‌متر از این کاغذ، ۳۰۰ گرم وزن دارد.
کاتالوگ،  از طراحی  از سلیقه شخصی و هدف  فارغ  کاتالوگ،  برای کاغذ  همچنین در مورد گرماژ مناسب 
معمولاً برای جلد کاتالوگ از کاغذ گلاسه ۲۵۰ یا ۳۰۰ گرم و برای صفحات داخلی آن از کاغذ با گرماژ  ۱۳۵، 

۱۵۰، ۱۷۰ و ۲۰۰ استفاده می‌گردد.

شکل 25ـ9ـ کاتالوگ‌هایی با گرماژهای مختلف

 ٤ـ٢٢ـ٩ـ جهت‌های باز کردن کاتالوگ 
جهت باز کردن کاتالوگ موضوعی به نسبت ساده است؛ اما اگر هنگام طراحی و چاپ به آن دقت نکنید به راحتی 
می‌تواند برای شما مشکل‌ساز شود. کاتالوگ‌ها را مانند کتاب‌ها می‌توان از چپ به راست یا برعکس باز کرد. 
کاتالوگ‌های راست به چپ برای محتوای فارسی و کاتالوگ چپ به راست برای محتوای انگلیسی مدنظر است.

شکل 26ـ9ـ نمونه‌ای از یک کاتالوگ انگلیسی



واحد كار نهم: وارد و صادر کردن محتوای سند

183

 ٥ ـ٢٢ـ٩ـ نوع صحافی کاتالوگ 
صحافی کاتالوگ براساس سه سبک مفتول تخت، مفتول لوپ و چسب گرم انجام می‌شود. به بیان ساده‌تر 
می‌توان گفت منظور از صحافی مفتول همان منگنه است. اگر این منگنه همان حالت ساده همیشگی را داشته 
باشد؛ به نام صحافی مفتول تخت شناخته می‌شود. اما اگر قسمت بیرون منگنه حالت نیم‌دایره داشته باشد؛ 
به آن صحافی مفتول لوپ می‌گویند. مزیت حالت لوپ در این است که قابلیت آویزان کردن کاتالوگ را از 

آویزهای مختلف فراهم میک‌ند.
 

شکل 27ـ9ـ انواع صحافی کاتالوگ

صحافی به شکل مفتول معمولاً برای کاتالوگ‌های با تعداد صفحات کم یا کاغذ نازک مناسب است. چرا که 
در صورت افزایش صفحات و حجم کاتالوگ، این سبک از صحافی قادر به حفظ ساختار برگه‌های کاتالوگ در 

کنار یک‌دیگر نخواهد بود.
صحافی چسب گرم روش معمول دیگری است که برای انواع کاتالوگ به وفور مورد استفاده قرار می‌گیرد. در 
این روش و به کمک دستگاه صحافی حرارتی، نوعی چسب را گرم کرده و عطف صفحات کاتالوگ را به کمک 
آن به هم پیوند می‌زنند. صحافی چسب گرم در صورت انجام درست فرایند، یکی از بهترین روش‌های صحافی 

برای کاتالوگ‌های با تعداد صفحات بالا است.

 ٦ ـ٢٢ـ٩ـ طراحی کاتالوگ متناسب با هر کسب‌وکار 
گاهی کسب‌وکارها درک  است.  متفاوت  دیگر  با کسب‌وکارهای  کاتالوگ،  از طراحی  هدف هر کسب‌وکاری 
با  تفاوتی  تبلیغات چاپی ندارند. به عنوان مثال نمی‌دانند کاتالوگ چه  ادوات مختلف  از تفاوت‌های  دقیقی 

بروشور دارد و در کجا به کار می‌رود.
کاتالوگ  یک  درست  انتخاب  پس  هستند.  شما  خدمات  یا  محصول  کاغذی  نمایشگاه  نوعی  به  کاتالوگ‌ها 
بیش از هرچیز به شناخت درست شما از محصول مدنظر مرتبط است. به عنوان مثال کاتالوگ یک خودرو با 
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کاتالوگ محصولات آرایشی و بهداشتی متفاوت است. این تفاوت علاوه بر طراحی، در جزئیات تولید فیزیکی و 
چاپ کاتالوگ نیز باید احساس شود. توجه به رنگ سازمانی، موضوع محصولات و خدمات، ویژگی‌ها، مخاطبان 

هدف، شکل توزیع و … از مهم‌ترین موارد در این زمینه است

 23ـ9ـ استاندارد طراحی کتاب و مجله

یکی از مهم‌ترین عواملی که در تفاوت قطع کتاب‌ها و نشریات اثرگذار هست میزان هدررفت کاغذ است که 
برای این منظور اندازه کتاب و نشریات به نحوی تعیین شده‌اند که بیشترین بازده و کمترین هدررفت کاغذ را 
داشته باشند. انواع قطع استاندارد کتاب و مجله با توجه به پرمصرف بودن ۳ نوع کاغذ ورقی یعنی ۷۰×۱۰۰، 
۹۰×۶۰ و ۴۵×۶۰ تعیین می‌شوند. به این ترتیب انتخاب بهترین قطع کار با توجه به میزان دورریز کاغذ 
می‌تواند در تصمیم‌گیری شما اثرگذار باشد و شما می‌توانید بر این مبنا قطع کار خود را انتخاب کنید. در چاپ 
کتاب و نشریات چند صفحه از کار در یک ابعاد کاغذ مورد نظر چیدمان یا در اصطلاح فرم‌بندی می‌شوند. در 

شکل 28ـ9 نمونه‌هایی از فرم‌بندی قطع‌های مختلف کتاب و مجله را مشاهده میک‌نید.

 
شکل 28ـ9ـ فرم‌بندی کتاب

 ١ـ٢٣ـ٩ـ قطع کتاب 
قطع و ابعاد کتاب‌ها معمولاً به‌صورت عمودی در نظر گرفته می‌شود، به این صورت که عطف کتاب در ضلع 
از  و عرض هر ضلع  به طول  بستگی  نام‌گذاری قطع‌های مختلف کتاب  دلیل  قرار می‌گیرد.  بزرگ‌تر کتاب 
کتاب‌ها دارد. چاپ کتاب در ابعاد متفاوت باعث استفاده آسان‌تر و همچنین امکان نگهداری بهتر می‌شود.

بیاضی، جانمازی،  بغلی،  بغدادی،  بازوبندی،  وزیری،  از: رقعی،  نشریات عبارت‌اند  و  قطع‌های مختلف کتاب 
. ... حمایلی، خشتی، رحلی، سلطانی، نیم ربعی، نیم ورقی، جیبی و 
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 ٢ـ٢٣ـ٩ـ قطع مجله 
قطع رحلی به دلیل ابعاد بزرگی که دارد فضای خوبی را برای قرار دادن انواع محتوا در اختیار پدیدآورندگان 
مجله قرار می‌دهد. متداول‌ترین قطع مجله، قطع رحلی کوچک است که معمولاً از این قطع برای طراحی و 
چاپ مجلات با موضوعات مختلف استفاده می‌شود. همچنین قطع رحلی کوچک به نسبت قطع‌های بزرگ‌تر، 
قطع مناسب‌تری برای جابه‌جایی و استفاده مخاطب از مجله است. از قطع رحلی بزرگ هم برای برخی مجلات 
و نشریات استفاده می‌شود که معمولاً موضوعات خاصی مانند مد و صنایع لوکس دارند و یا اهداف خاصی مانند 
نمایش تصاویر بزرگ را دارند )برای مشاهده ابعاد دقیق قطع رحلی کوچک و بزرگ به جدول 1ـ9 مراجعه کنید(.

 ٣ـ٢٣ـ٩ـ انواع قطع کتاب و مجله 
در جدول 1ـ9 رایج‌ترین و پرکاربردترین ابعاد و قطع کتاب و مجله را مشاهده میک‌نید )ابعاد ارائه شده در 
این جدول ابعادی هستند که به‌طور معمول در کشور برای چاپ کتاب و نشریات از آن‌ها استفاده می‌شود، 
البته ناشرانی هستند که از ابعادی با ۲ یا ۳ میلی‌متر بیشتر استفاده میک‌نند، ولی در مجموع ابعاد قطع‌های 

موجود در جدول زیر پر استفاده‌تر و کم ریسک‌تر هستند(.

جدول 1ـ9ـ انواع قطع کتاب

ابعاد حدودی قطع کتاب
استاندارد

ابعاد بعد از 
)cm( برش

ابعاد قبل از 
)cm( برش

تعداد صفحات در 
هر طرف فرم

کاغذ پیشنهادی 
شیت‌بندی

B516/5 × 23/5۱۷ × 24/5۸۷۰×۵۰وزیری

A5۱۴ × ۲۱14/5 × ۲۲۸۴۵×۶۰رقعی

A4۲۱ × 28/521/5 × 29/5۴۶۰×۴۵رحلی

۵۰×۳۴۴۷۰ × ۳۳24/5 × ۲۴—رحلی بزرگ

۱۰۰×۴۹۴۷۰ × ۴۸34/5 × ۳۴—سلطانی

۵۰×۲۳۶۷۰ × ۲۲۲۲ × 21/5—خشتی

۶۰×۲۰۶۴۵ × ۱۹19/5 × ۱۹—خشتی کوچک

۵۰×۲۳۱۲۷۰ × ۲۲۱۲ × 11/5—پالتویی

۶۰×19/5۱۲۴۵ × ۱۹۱۱ × ۱۰—پالتویی کوچک

۶۰×14/5۱۶۴۵ × ۱۴۱۱ × ۱۰—جیبی

B611/5 × ۱۶۱۲ × ۱۷۱۶۷۰×۵۰ربعی
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شکل 29ـ9ـ انواع قطع و ابعاد استاندارد کتاب و مجله

 قطع وزیری 
قطع وزیری، یکی از قطع‌های رایج است که به دلیل استفاده بیشتر این قطع در کتاب‌های مرتبط با آموزش و 
کتاب‌های دانشگاهی، بیشتر با آن برخورد داشته‌ایم. این قطع به دلیل کوچک‌تر بودن از قطع رحلی و بزرگ‌تر 
بودن از قطع رقعی، ویژگی‌های ساختاری مناسبی را برای کتاب‌های آموزشی و عمومی ایجاد میک‌ند، البته 
این موضوع همیشگی نیست و نسبت به محتوا، قطع تعیین می‌شود. کاغذ مناسب برای قطع وزیری، کاغذ 

۷۰×۵۰ است که با ۳ بار تا خوردن می‌توان به قطع وزیری رسید.
موارد مناسب برای قطع وزیری: کتاب‌های درسی، عمومی، آموزشی، دانشگاهی و کتاب‌های مصور.

 قطع رقعی 
یکی دیگر از رایج‌ترین قطع‌ها در میان کتاب‌ها قطع رقعی است. این قطع به دلیل ابعاد کوچک برای کتاب‌های 
این قطع برای مواردی مناسب است که معمولاً مدت طولانی  با حجم محتوای کم مناسب‌تر است. معمولاً 
همراه مخاطب است و جابه‌جایی زیادی دارد. ابعاد کاغذهای اولیه در سه اندازه مختلف در اختیار چاپخانه‌ها 

قرار می‌گیرد. یکی از این ابعاد ۴۵×۶۰ است. با سه بار تا کردن این کاغذ قطع رقعی به دست می‌آید.
موارد مناسب برای اندازه رقعی: کتاب‌های رمان، شعر و مذهبی.

 قطع خشتی 
قطع خشتی به کتاب‌ها و نشریاتی که به شکل مربع هستند گفته می‌شود که معمولاً از کاغذ در ابعاد ۴۵×۶۰ 
برای قطع خشتی استفاده می‌شود. با تا کردن کاغذ به‌صورتی که به ۶ قسمت ۲۰×۲۰ تقسیم شود یکی از 
ابعادی است که می‌توانید با کمترین هدررفت کاغذ به دست آورید. اگر از کاغذ با ابعاد ۷۰×۵۰ استفاده کنید 
کتاب در قطع خشتی با ابعاد ۲۳×۲۳ به دست می‌آید که اندازه استاندارد کتاب‌های خشتی بزرگ است. موارد 

مناسب برای قطع خشتی: کتاب‌های کودکان و داستان‌های مصور، کاتالوگ و بروشورهای تبلیغاتی.
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 قطع رحلی 
قطع رحلی یا A4 یکی از رایج‌ترین قطع‌های مورد استفاده برای کتاب و مجلات است. به سه دسته رحلی کوچک، 
رحلی متوسط، رحلی بزرگ تقسیم می‌شود که ابعاد رحلی 21×28/5 و ابعاد رحلی بزرگ 24×33 است. کاغذ 
مناسب قطع رحلی 45×60 و رحلی بزرگ 50×70 است. قطع رحلی از پرکاربردترین قطع‌های استاندارد است که 

در شاخه‌های مختلف چاپ و تبلیغات و مشاغل مختلف مورد استفاده قرار می‌گیرد.
دایره ..  المعارف‌ها،  و  دانشنامه‌ها  آموزشی، کتاب‌های مرجع،  برای قطع رحلی: کتاب‌های عمومی،  مناسب  موارد 

کتاب‌های مصور، برخی از کتاب‌های مذهبی مانند قرآن، مجلات و نشریات، کاتالوگ و بروشور.

 قطع سلطانی 
به دلیل ویژگی قطع سلطانی، می‌توان از این قطع برای نمایش جزئیات تصاویر و ایجاد حس شکوه و اهمیت 
کار بهره گرفت. قطع سلطانی معمولاً به دلیل بزرگی و فضای زیاد آن برای کتاب‌های خطی نفیس و مصور 
مانند قرآن‌ و کتاب‌های تاریخی و مصور و همچنین مجلات خاص مورد استفاده قرار می‌گیرد. کاغذ مورد 

استفاده برای این قطع ابعاد ۷۰×۱۰۰ است.
برای قطع سلطانی: کتاب‌های مرجع، قرآن و کتاب‌های خطی نفیس، شاهنامه و کتاب‌های  موارد مناسب 

.)... تاریخی و کتاب‌های مصور، مجلات خاص )مانند مجلات مد، ساختمان، لوکساری و 

 قطع جیبی 
قطع جیبی به دلیل ابعاد کوچکی که دارد امکان استفاده و حمل آسان را فراهم میک‌ند و می‌تواند برای تولیدات 
کم حجم و کوتاه مورد استفاده قرار گیرد. قطع جیبی خود به دو دسته جیبی بزرگ و جیبی کوچک تقسیم 

می‌شوند. اگر کاغذی در ابعاد ۷۰×۵۰ را چهار بار را تا کنید می‌توانید کتابی در ابعاد جیبی داشته باشید.
موارد مناسب برای اندازه جیبی: کتاب‌های مذهبی )ادعیه و زیارت‌نامه(، شعر و کتاب‌های کم حجم، پمفلت 

و اقلام تبلیغاتی با محتوای کم.

 قطع پالتویی 
همانطور که از نام این قطع مشخص است دلیل نامگذاری قطع پالتویی عرض کم و ارتفاع زیاد است که به 
راحتی داخل جیب قرار می‌گیرد. از قطع پالتویی برای کتاب دارای محتوای برخی اقلام تبلیغاتی و مواردی 
که نیاز است فرد به راحتی بتواند آن را با خود حمل و جابه‌جا کند مورد استفاده قرار می‌گیرد. کاغذ مورد 

استفاده در این قطع ۴۵×۶۰ و ۷۰×۵۰ است.
موارد مناسب برای قطع پالتویی: کتاب‌های مذهبی )ادعیه و زیارت‌نامه(، شعر و کتاب‌های کم حجم، کاتالوگ 

و بروشورهای تبلیغاتی و پمفلت.
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 قطع بیاضی 
بیاضی  قطع  در  که  است  سانتی‌متر  بیاضی کوچک ۲۹×۲۲  قطع  ابعاد  و  بزرگ ۲۴×۳۴  بیاضی  قطع  ابعاد 
برخلاف حالت معمول عطف کتاب در ضلع کوچک‌تر کتاب قرار می‌گیرد و ظاهر کتاب یا نشریه به‌صورت 
افقی است. البته معمولاً به قطع‌های دیگری که از ضلع کوچک صحافی می‌شوند و به‌صورت افقی هستند، در 

اصطلاح قطع بیاضی گفته می‌شود.
اگر  لذا  می‌شوند؛  شناخته  معمول  و  استاندارد  قطع‌های  عنوان  به  شده  ارائه  قطع‌های  باشید  داشته  توجه 
از  سفارش‌دهنده،  یا  طراح  نظر  و  پروژه  به  توجه  با  می‌توانید  باشید  داشته  خاصی  و  متمایز  کار  بخواهید 
قطع‌هایی خارج از موارد ذکر شده استفاده کنید. این موضوع یکی از راهکارهای ایجاد وجه تمایز محصول 

انتخاب شود! به دقت  و  اگر درست  البته  بود،  شما خواهد 

 اندازه حاشیه استاندارد 
اندازه حاشیه‌ها  معمولاً به عهده طراح است كه معمولاً بر مبنای موضوع و محتوای کتاب یا نشریه، همچنین 
سلیقه و ایده‌های بصری و گرافیکی طراح تعیین می‌شود. البته استانداردهایی برای حاشیه کتاب و نشریات 

وجود دارد که می‌توانید بر مبنای آن به حاشیه استاندارد برای کار خود دست یابید. 
توجه داشته باشید اگر صفحه‌آرايي را در نرم‌افزار InDesign انجام می‌دهید، این اندازه‌ها را در حین ایجاد 

فایل جدید باید در قسمت Margins وارد کنید.

 Document باید قطع InDesign اندازه پیش از برش ۵ میلی‌متر بیشتر از اندازه‌های جدول است. در نرم‌افزار
بالا  از   bleed برای ۵ میلی‌متر محدوده برش، در قسمت  و  تعیین کنید  اندازه‌های جدول  براساس  را 
)Top( پایین )bottom( و بیرون )Outside( پنج میلی‌متر و اندازه داخل )Inside( را صفر تعیین کنید.

نکته ١

ممکن است در منابع مختلف یا سفارش‌دهنده، ناشر و ... اندازه دقیق قطع‌ها تفاوت‌هایی )در حد چند 
میلی‌متر( با جدول داشته باشد. این تفاوت‌ها بیشتر اوقات دلیل فنی مشخصی ندارد و بهترین کار این 
اگر شما کارتان را با اندازه‌ای که در  است که قطع موردنظر را از ناشر یا چاپخانه سؤال کنید. طبیعتاً 
 Document جدول1ـ 9 گفته شد انجام دهید، تغییر چند میلی‌متری در حین خروجی، به سادگی و از

Setup در InDesign قابل انجام است.

نکته ٢
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هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  بروشور طراحی کند.

  پوستر طراحی کند.

  کاغذ کادو طراحی کند.

  کاتالوگ طراحی کند.

  سند تعاملی طراحی کند.

  صفحه‌آرایی مجله و کتاب را انجام دهد.

1ـ10ـ تهیه یک بروشور

 Print .بروید File>New>Document را باز کرده و به منوی InDesign برای تهیه یک بروشور نرم‌افزار
را از گزینه‌های Intent در پنجره فوقانی انتخاب کنید و در ادامه برای اندازه صفحه از گزینه Letter استفاده 
کنید. تعداد صفحات را به هشت افزایش دهید. البته در ادامه در پنل Pages می‌توانید تعداد صفحات را تغییر 
 6/35 )Bleed( در حالت تأیید قرار دارد. یک لبه Facing Pages دهید. همچنین مطمئن شوید که کادر
میلی‌متر برای همه جهت‌ها به جز جهت درونی تنظیم کنید. لبه درونی را می‌توانید روی 0 قرار دهید. در 

ادامه روی Create کلیک کنید.

شکل 1ـ10ـ کادر محاوره‌ای Document Setup برای تنظیم بروشور

زمان آموزش

عملینظری

565
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انتخاب کنید.  بازشوی پنل  از منوی  New Color Swatch را  انتخاب کرده و گزینه  Swatches را  پنل 
 CMYK کلیک کنید. نمونه رنگ Done و Add را تنظیم کنید و روی C=77 M=20 Y=0 K=0 مقادیر
دوم را به نیز صورت C=91 M=63 Y=49 K=52 قرار دهید. گزینه New Gradient Swatch را از منوی 

بازشوی پنل انتخاب کنید.
این نمونه رنگ را Gradient 1 نامگذاری کرده و نوع آن را Linear انتخاب کنید و Swatches را از منوی 

Spot Color انتخاب کنید.
 C=77 M=20 Gradient Ramp روی آن کلیک کنید و مقادیر  نقطه توقف چپ روی  انتخاب  برای 
 C=91 M=63 را از فهرست نمونه‌های رنگ فوق انتخاب کنید. رنگ آبی تیره را با مقادیر Y=0 K=0

Done کلیک کنید.  Add و  Y=49 K=52 در نمونه رنگ سمت راست انتخاب کنید. سپس روی 

شکل 2ـ10ـ نمونه‌ها و شیب رنگ

 1ـ1ـ10ـ ایجاد روی جلد برای قالب بروشور
هنگام کار روی لایه Color به ابزار Rectangle سوئیچ کنید و بکشید تا شکلی روی صفحه اول سند ایجاد 
کنید و لبه آن را به سمت بالا و تا لبه برش صفحه چپ بکشید. از پنل Swatches، مقدار Fill شکل را آبی 

تیره انتخاب کنید.
Mode را نیز روی  Object>Effects>Inner Glow بروید و  زمانی که دایره انتخاب می‌شود به مسیر 
Mode کلیک کنید تا پنجره  Normal تنظیم کنید. به این منظور روی مربع رنگی سمت راست منوی 

Effect Color انتخاب شود. نمونه رنگ آبی کمرنگ را انتخاب کرده و روی OK کلیک کنید.
 Softer را روی Technique را تا  25درصد کاهش دهید و Opacity بروید و میزان Inner Glow به پنجره
Source، را روی Center و Size را در حدود 202 میلی‌متر و Noise را روی 83 درصد تنظیم کنید. و 
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گزینه Choke را روی 40 درصد قرار داده و در نهایت روی OK کلیک کنید.
دو بار دایره را Edit>Copy و Edit>Paste کنید و اندازه هر یک را کوچک کنید و آن‌ها را مانند شکل زیر 

روی صفحه پراکنده کنید.
از ابزار Type برای ایجاد فریم متنی بزرگ در گوشه سمت چپ پایین استفاده کرده و عنوان اصلی بروشور را 

وارد کنید. فونت را به دلخواه انتخاب کرده و رنگ فونت را روی آبی کمرنگ بگذارید.
فریم متنی دوم را برای درج یک عنوان فرعی اضافه کنید که می‌تواند نام آن شرکت باشد و رنگ آن را سفید 

بگذارید و بالای صفحه هم می‌توانید لوگو یا آرم شرکت را درج کنید.

شکل 3ـ10ـ جلد روی بروشور

 2ـ1ـ10ـ ایجاد قالب برای صفحه درونی بروشور
حالا به دو صفحه جدا رفته و برای رنگ پس‌زمینه از رنگی که در پنل Gradient ایجاد کرده‌اید استفاده کنید و 

دو دایره بزرگ سمت چپ و راست بروشور ایجاد کنید )شکل 4ـ10( و رنگ آن را آبی کنید.

شکل 4ـ10ـ طراحی قالب بروشور
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یکی از دایره‌های ترسیم شده را انتخاب کنید، سپس به File>Place رفته و تصاویر منتخب را درون هر فریم 
تصویر قرار دهید. و Direct Selection Tool (A) را انتخاب کرده و عکس را داخل دایره کوچک یا بزرگ 

کنید تا به اندازه دلخواهتان در بیاید.

شکل 5ـ10ـ طراحی بروشور

حالا متن مورد نظری را که قرار است در بروشور استفاده کنید، در جاهای خالی پر کنید.

شکل 6ـ10ـ انداختن متن در بروشور

 3ـ1ـ1٠ـ صدور بروشور تجاری برای چاپ
به مسیر File>Export بروید و از منوی Format گزینه )Adobe PDF (Print را در انتهای پنجره انتخاب 
کنید. نامی برای فایل خود انتخاب کرده و روی Save کلیک کنید. در پنجره Export Adobe PDF که باز 

می‌شود گزینه Press Quality را از منوی Preset در ابتدای پنجره انتخاب کنید.
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شکل 7ـ10ـ صدور بروشور

 Use و All Printer’s Marks کلیک کرده و هر دو گزینه Marks and Bleeds در منوی سمت چپ روی
Document Bleed Settings را انتخاب کنید. در نهایت روی Export کلیک کنید تا PDF ایجاد شود. 

بدین ترتیب ما موفق شدیم فایل PDF آماده چاپ بروشور خود را تولید کنیم.

شکل 8ـ10ـ تنظیم PDF آماده چاپ بروشور
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قالب مدرن و شیک بروشور تجاری که در این راهنما ساختیم را می‌توان در سبک اصلی یا به عنوان یک قالب 
متنوع برای ایجاد طراحی بروشور منحصر به فرد دیگری مورد استفاده قرار داد.

شکل ٩ـ10ـ بروشور طراحی شده

2ـ10ـ تهیه یک پوستر

گام اول
InDesign را باز میک‌‌نیم و وارد مسیر File>New>Document می‌شویم. Web را از پنجره بالا انتخاب 
میک‌‌نیم. Width را روی ۸۷۰ پیکسل و Height را روی ۲۶۰۰ پیکسل قرار می‌دهیم. Margins را روی 

۴۴ پیکسل تنظیم کرده و روی Create کلیک میک‌نیم.

شکل 10ـ10ـ تنظیمات اولیه پوستر
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گام دوم
پنل Layers را باز میک‌‌نیم. روی لایه Layer 1 دابل کلیک کرده و اسم آن را Background می‌گذاریم. سه تا لایه 
دیگر به نام‌های Arrows،وBooks و Type درست میک‌‌نیم. تمام لایه‌ها را به غیر از لایه Background قفل میک‌‌نیم.

شکل 11ـ10ـ لایه‌های پوستر
گام سوم

 RGB Swatch را از منوی پنل انتخاب میک‌نیم. یک New Color Swatch می‌شویم و Swatches وارد پنل
با مقادیر رنگی R=209, G=207, B=194 درست کرده و روی Add و بعد هم Done کلیک میک‌‌نیم. پنج تا 

RGB Swatch دیگر با مقادیر رنگی زیر اضافه میک‌‌نیم.
R=51, G=56, B=97
R=82, G=48, B=112
R=237, G=164, B=192
R=255, G=54, B=102
R=90, G=88, B=91

ابزار Rectangle را انتخاب کنید و یک شکل به‌صورتی که می‌‌بینید روی لایه Background رسم میک‌‌نیم. وارد 
 R=90, G=88, B=91 را روی مقادیر رنگی Color و Tint را روی ۳٠ درصد Fill .می‌شویم Swatches پنل

تنظیم میک‌نیم.

شکل 12ـ10ـ تنظیمات رنگ پوستر
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 1ـ2ـ10ـ اضافه کردن تصویر کتاب
گام اول

چند آیکن کتاب تهیه کرده و آن‌ها را در Illustrator باز میک‌‌نیم.
کلیک راست کرده و Release Clipping Mask را انتخاب میک‌نیم.

شکل 13ـ10ـ آیکن‌های کتاب
گام دوم

کلیک راست کرده و دومین ردیف از آیکن‌ها را Ungroup میک‌نیم.
 

شکل 14ـ10ـ خارج کردن کتاب‌ها از حالت گروهی

وارد مسیر  و  انتخاب کرده  را که می‌‌بینید  Ungroup میک‌‌نیم. کتاب‌هایی  را هم  راست  کتاب‌های سمت 
می‌شویم.  Edit>Copy
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گام سوم
 Edit>Paste میک‌‌نیم. وارد مسیر Unlock را Books برمی‌‌گردیم. لایه Background  و لایه InDesign سراغ

می‌شویم. بعد هم اندازه و موقعیت کتاب‌ها را تنظیم کرده و آن‌ها را سمت راست پایین لایه قرار می‌دهیم.
 

شکل 15ـ10ـ تنظیم لایه‌ها

گام چهارم
حالا سراغ فایل Illustrator می‌رویم. آیکن سمت راست ردیف سوم را Ungroup میک‌‌نیم. بعد هم آن‌ها را 

Isolate کرده و وارد مسیر Edit>Copy می‌شویم. 

گام پنجم
مسیر  بار  این  و  کرده  راست  کلیک  می‌شویم.   Edit>Paste مسیر  وارد  می‌رویم.   InDesign سراغ  حالا 

می‌دهیم. قرار  می‌‌بینید،  که  محلی  در  را  آن‌ها  میک‌‌نیم.  دنبال  را   Transform>Flip Horizontal

شکل 16ـ10ـ تنظیم چیدمان کتاب‌ها
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گام ششم
همین کار را برای ردیف چهارم فایل Illustrator تکرار میک‌‌نیم. کتاب‌ها را به‌صورت زیگزاگ روی هم قرار 

داده و بین آن‌ها فاصله می‌گذاریم.
 

شکل 17ـ10ـ لایه‌بندی کتاب‌ها
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گام هفتم
تمام آیکن‌ها را انتخاب کرده و با هم گروه میک‌‌نیم. 

شکل 18ـ10ـ گروه‌بندی آیکن‌ها

گروه را انتخاب کرده و وارد مسیر Object>Effects>Drop Shadow می‌شویم. Opacity را روی ۵۰ درصد، 
Size را روی ۹ پیکسل، Spread را روی ۱۳ درصد، Noise را روی ۱۳ درصد قرار داده و روی مربع رنگی 
سمت راست منوی Mode کلیک میک‌‌نیم. Effect Color را هم روی صورتی کم رنگ قرار می‌دهیم. OK را 

زده و از پنجره خارج می‌شویم.
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شکل 19ـ10ـ تنظیمات رنگ و جلوه‌ها

 2ـ2ـ10ـ اضافه کردن متن

گام اول
لایه Books را با Lock و لایه Type را با Unlock تنظیم میک‌‌نیم. 

ابزار Type را برداشته و متن را اضافه میک‌‌نیم. وارد پنل Character یا Controls می‌شویم. Font را روی 
 R=82, قرار می‌دهیم. مقادیر رنگی Center را روی Align را روی ۶۳ و Size و Bw Modelica Black

G=48, B=112 را هم برای Color در نظر می‌‌گیریم. 
اگر بخواهید می‌‌توانید عنوان را هم با همین فونت اما با اندازه ۲۱ وارد کنید.

 



202

شکل 20ـ10ـ اضافه کردن متن

گام دوم
ابزار Line را بر می‌‌داریم و یک خط به دلخواه در کنار یکی از عناوین رسم میک‌‌نیم.

وارد پنل Stroke می‌شویم. Weight را روی ۱۴ قرار داده و Rounded Cap را روی آن اعمال میک‌‌نیم. 
وارد پنل Swatches می‌شویم و Stroke Color را روی Paper قرار می‌دهیم. خط را روی لبه‌های دیگر 

هم Copy و Paste میک‌‌نیم.  
تمام خطوط را انتخاب کرده و وارد مسیر Object>Effects>Transparency می‌شویم و Opacity را تا 

۶۰ درصد کاهش می‌دهیم.
 

گام سوم
متن بیشتری را اضافه میک‌‌نیم.

گام چهارم
اگر بخواهیم می‌‌توانیم کادر متن را جای دیگر Copy و Paste کرده و متن آن را تغییر بدهیم.

 
گام پنجم

لایه Type را Lock و لایه Arrows را Unlock میک‌‌نیم. ابزار Line را برداشته و یک خط باریک در محلی 
که می‌‌بینید رسم میک‌‌نیم. Stroke Color را روی R=255, G=54, B=102 قرار می‌دهیم. 
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Lock و Type شکل 21ـ10ـ انجام تنظیمات

وارد پنل Stroke می‌شویم و Weight را روی ۵ و End Style را روی CircleSolid قرار می‌دهیم. وارد 
مسیر Object>Effects>Drop Shadow می‌شویم. وارد مسیر Copy و Paste می‌شویم و آن را سمت 

دیگر هم Paste میک‌‌نیم.

 3ـ2ـ10ـ خروجی گرفتن

گام اول
وارد مسیر Edit>Spelling>Check Spelling و بعد هم File>Export می‌شویم.

نامی برای فایل انتخاب کرده و Format را روی PNG قرار می‌دهیم و روی Save کلیک میک‌‌نیم.
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PNG شکل 22ـ10ـ انتخاب فرمت

گام دوم
به این ترتیب، پنجره Export PNG باز می‌شود. Quality را روی Medium و Resolution را روی ۷۲ 

قرار می‌دهیم. Color Space باید روی RGB باشد. در نهایت، روی Export کلیک میک‌‌نیم.

PNG شکل 23ـ10ـ صدور به
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 4ـ2ـ10ـ نتیجه پوستر تحصیلی

شکل 24ـ10ـ پوستر نهایی
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3ـ10ـ تهیه یک کاغذ کادو

 1ـ3ـ10ـ کاغذ کادو چیست؟
کاغذ کادو به ورق نازکی گفته می‌شود که جهت بسته‌بندی کالا جهت هدیه دادن مورد استفاده  قرار می‌‌گیرد. 
تولید کاغذ کادو برحسب نیاز و علاقه‌مندی مشتری انواع مختلفی دارد. شرکت‌های معروف اغلب برای حفظ 
اعتبار خود از کاغذ کادوهای سفارشی و مخصوص با آرم و لوگوی اختصاصی​شان استفاده میک‌نند. زیرا ارسال 
هدیه شما همراه با یک بسته‌بندی و کاور خاص می‌تواند مکمل هدیه ویژه شما باشد و این امر تأثیر شگرفی 

در تثبیت برند شما خواهد داشت. 

 انواع کاغذ کادو 
  کاغذ کادوی فانتزی

  کاغذ کادوی کرافت

  کاغذ کادوی گلاسه

 2ـ3ـ10ـ خصوصیات کاغذ کادو
 کاغذ کادو به‌طور کلی و معمول برای بسته‌بندی و زیباتر کردن هدیه مورد استفاده قرار می‌گیرد تا آن را 
تأثیرگذارتر نمایش دهد. کاغذ کادو معمولاً در گرماژ 100 گرم، گلاسه یا کرافت 70 گرم استفاده می‌شود 
و اندازه استاندارد آن 50 در 70 یا 60 در 45 است. اندازه 50*70 اندازه‌ای است که بیشتر در بازار آماده 

و قابل دسترسی هستند. بهتر آن است که در طراحی شخصی از ابعاد معمول کاغذ در بازار استفاده شود.

 3ـ3ـ10ـ طراحی کاغذ کادو
امروزه کاغذ کادو به یکی از اصلی‌ترین اجزای هدیه در مناسبت‌ها تبدیل شده است. طراحی کاغذ کادوی 
شرکتی باید به نحوی باشد تا هنگام کادو پیچ کردن، خللی به هدیه وارد نکند. هدیه‌ای که با کاغذ کادوی 
رنگارنگ و متنوع کادویی و پیچیده شده است نشان می‌دهد طرف مقابلتان چقدر برایتان ارزش دارد و لبخند 
او شما را خوشحال میک‌ند. در طراحی کاغذ کادو باید این نکته را مدنظر قرار داد که کاغذ در جهت‌های قابل 

رؤیت است و نباید در پیچش کادو مفهوم خود را از دست دهد.

شکل 25ـ10ـ یک نمونه کاغذ کادو
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 4ـ3ـ10ـ نرم‌افزار طراحی کاغذ کادو
طراحی کاغذ کادو به‌وسیله برنامه CorelDraw و یا طرح کاغذ کادو با Photoshop یا InDesign انجام 
می‌شود. طرح گرافیکی کاغذ شامل طرح کاغذ کادوی کودکانه، طرح کاغذ کادوی سنتی، طرح کاغذ کادو 
با اشکال هندسی، طرح کاغذ کادوی مدرن، طرح کاغذ کادوی ولنتاین، طرح کاغذ کادوی تولد، طرح کاغذ 

کادوی بله​برون، طرح کاغذ کادوی عروسی و نامزدی و .... است.
با این شیوه تزئین هدیه حتی کاغذ کادوهای ساده نیز بسیار زیبا به نظر خواهند رسید. هنرهای کاغذی 

از ارزش آن‌ها کم نمیک‌ند. همیشه زیبا هستند، چنانک​ه دشواری و سادگی ساختنش 

شکل 26ـ10ـ نمونه‌هایی از کاغذ کادو

کاغذهای کادو فواید و مصارف زیادی دارند و با توجه به  سلیقه‌های مختلف طراحی می‌شوند. اگر طرح پشت 
و روی کاغذ متفاوت باشد، تنوع بیشتری را ایجاد میک‌ند. 

 5ـ3ـ10ـ طریقه طراحی کاغذ کادو
حالا می‌خواهیم از Adobe InDesign برای طرح‌بندی طرح‌های 
خود استفاده کنیم. حالا یک فایل جدید درست کنید و اندازه‌های 
آن را 500 در 700 میلی‌متر قرار دهید. طرح مورد نظرتان را که 
باشد،  مختلف  مناسبت‌های  برای  مختلف  اشکال  شامل  می‌تواند 
انتخاب کنید. فرض کنید می‌خواهید طرحی مناسب کودکان اجرا 

کنید. بنابراین شخصیت‌های کارتونی را انتخاب کنید.
مثلًا از تصاویر باب​اسفنجی استفاده كرده و برای اینکه پس‌زمینه، 
شبیه دریا باشد یک مستطيل ترسيم كنيد و رنگ آن را آبي كم 
رنگ در نظر بگيريد. همچنين براي اضافه كردن حباب مي‌توانيد 
آن را  طراحي كرده يا از Google جستجو و تهيه كنيد. در مرحله 
بيشتري  تا شفافيت  را كمتر كنيد  آن   Opacity است  بهتر  بعد 

شکل 27ـ10ـ ایجاد یک فایل جدیدپيدا كند.
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حالا عکس‌های انتخابی را فقط در یک ستون پر کنید و بعد همین عکس‌ها را در ستون‌های بعد کپی کرده 
و تکرار کنید تا تمام ستون‌ها از عکس باب اسفنجی پر شود. 

شکل 29ـ10ـ طرح باب اسفنجی

شکل 28ـ10ـ طرح سه​ستونی
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خاطر  به  میک‌نیم  تکرار  ستون‌ها  در  را  عکس‌ها 
از  کردید  استفاده  کاغذ  جای  هر  از  وقتی  آنکه 
همه کاراکترهایی که استفاده شده است روی کادو 
دیده شود البته در طرح‌های گل یا قلب می‌توانید 
کنید  بیشتر  را  آن‌ها  تکرار  و  باریک‌تر  را  ستون‌ها 
دارد. بستگی  خودتان  طراحی  و  سلیقه  به  این‌ها 

Export شکل 30ـ10ـ گرفتن خروجی با کادر محاوره‌ای

در پايان فايل را Save نموده و براي خروجي گرفتن، گزینه File>Export را انتخاب کرده و گزینه فرمت 
 300 ppi ظاهر ‌شود. در آن یکفیت عکس را روی Export JPEG قرار دهید تا کادر محاوره‌ای JPEG آن را

قرار دهید و تأیید کنید. کاغذ کادوی طراحی شده شما Save شده و آماده چاپ است.

شکل 31ـ10ـ صدور کاغذ کادو شکل 32ـ10ـ کاغذ کادوی چاپ شده
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 4ـ10ـ تهیه یک کاتالوگ

صفحه‌آرایی کاتالوگ، یکی از موارد با اهمیتی است که توجه به آن، می‌تواند طراحی کاتالوگ را منحصر به‌فرد 
کند. به‌طور کلی، صفحه‌آرایی، در چاپ و نشر مبحث با اهمیتی است که اهمیت آن بر کسی پوشیده نیست. 
هدف اصلی از صفحه‌آرایی را می‌توان انتقال بهتر و سریع‌تر مفاهیمی مانند متن و تصویر دانست. رعایت اصول 
صفحه‌آرایی کاتالوگ، می‌تواند چاپ کاتالوگ شما را حرفه‌ای‌تر کند. کاری که در زبان فارسی به آن صفحه‌آرایی 
می‌گوییم، در زبان انگلیسی لی‌آوت )Layout( و در زبان فرانسه میزانپاژ )MisenPage( نامیده می‌شود. اما 
مقصود از این کلمه چیست و چه کاربردهایی دارد و هدف از آن چیست؟ در ادامه به این موضوع خواهیم پرداخت.

 1ـ4ـ10ـ صفحه‌آرایی چیست؟
و  زیباسازی  و  چیدمان  برای  لازم  دانش  و  هنر  به 
یک  چاپ  کردن  آماده  از  قبل  فعالیت‌های  مجموعه 
به‌طور کلی  کاتالوگ صفحه‌آرایی می‌گویند.  و  نشریه 
تمامی فعالیت‌هایی نظیر: انتخاب فونت، اندازه کلمات، 
تنظیم فواصل بین خطوط را صفحه‌آرایی می‌گویند. در 
طراحی صفحه یا صفحه‌بندی مجموعه‌ای از اطلاعات 

اعم از:
  متن یا نوشته

  تصاویر و عکس‌های مختلف

  یا تریکبی از هر دو

در یک فضای از پیش تعیین شده و محدود جمع‌آوری 
و تنظیم می‌شود.

برای  صفحات  آماده‌سازی  چگونگی  دیگر  عبارت  به 
چاپ، صفحه‌آرایی نامیده می‌شود. بنابراین صفحه‌آرایی 
کاتالوگ، به معنی آراستن صفحات آن و آماده‌سازی 

که  گفت  می‌توان  واقع  در  شود.  مشتریان  بیشتر  توجه  جلب  موجب  که  به‌گونه‌ای  است،  چاپ  برای  آن 
هنر آراستن یک صفحه، سند یا کتاب به‌صورت تخصصی و علمی Layout یا طرح‌بندی خوانده می‌شود. 
صفحه‌آرایی، هنری است که مخاطبان را در مقابل خود متوقف میک‌ند و توجه آن​ها را به خود جلب میک‌ند. 
به‌این‌ترتیب آن​ها را ترغیب به مطالعه ادامه متن میک‌ند. اما این کار نیاز به دانش و توانایی‌های لازم دارد 
که تنها با شناخت مخاطبان، دانش روز صفحه‌آرایی و بهک‌ارگیری اصول علمی و روان​شناسی میسر می‌شود.

چنین تجربه، تلاش و تمرینی در این زمینه از مهم‌ترین ضروریات به شمار می‌رود. طراحی صفحه کاتالوگ، 
زیرمجموعه‌ای از هنر گرافیک به شمار می‌رود. این هنر تلاش میک‌ند تا یک رابطه موزون و مناسب از نظر 
بصری بین نوشته‌ها و تصاویر و فضای موردنظر به وجود آورد. طراحی صفحه کاربردهای زیادی دارد و برای 
طراحی مجله و کتاب و انواع نشریات، طراحی حرفه‌ای کاتالوگ، طراحی پوسترهای حرفه‌ای و دیگر موارد نیز 

به کار می‌رود. صفحه‌آرایی کاتالوگ یکی از مهم‌ترین مراحل در طراحی کاتالوگ است.

شکل ٣٣ـ١٠
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در این مرحله صفحه‌آرایی وارد مرحله جدیدی می‌شود که از تکنیک‌ها و امکانات فنی زیادی در آن استفاده 
می‌شود. زیبایی‌شناسی وارد کتاب‌آرایی و صفحه‌بندی می‌شود و متقارن بودن عناصر، تقسیم‌بندی متقارن 
سطوح، تنظیم هندسی نقوش، تریکب و تلفیق خطوط به‌صورت موزون و تریکب متعادل رنگ‌ها برای آرایش 
اجزای  بین  ایجاد یک هماهنگی بصری  از صفحه‌بندی  واقع هدف  قرار می‌گیرد. در  اهمیت  صفحات مورد 
مختلف صفحه است. امروزه برای تهیه کتاب از الگوی کشورهای پیشرفته صنعتی استفاده می‌شود که می‌تواند 

برای مطبوعات و کتاب ایران بسیار مفید باشد.

 2ـ٤ـ10ـ هدف از صفحه‌بندی کاتالوگ
مهم‌ترین اهداف صفحه‌بندی کاتالوگ را می‌توان در دو هدف اصلی زیر گنجاند:

  یک صفحه باید اطلاعات را به بهترین و ساده‌ترین شکل ممکن ارائه کند.

  توجه مخاطب را جلب کند و را مشتاق به مطالعه ادامه مطلب کند.

برای رسیدن به این اهداف از عکس، طرح، جداول و اشکال مختلف در کنار کلمات و حروف استفاده میک‌نید 
تا بتوانید منظور خود را به بهترین شکل ممکن برسانید. البته که همه آن‌ها را باید به زیبایی در کنار هم قرار 
دهید. افزایش سرعت و انتقال اطلاعات به ساده‌ترین شکل با چیدمان مناسب مطالب و صفحه‌آرایی میسر 

می‌شود که ارتباط تنگاتنگی میان مفاهیم و مخاطب به وجود می‌آورد.
با این تفاسیر مهم‌ترین اصل در صفحه‌آرایی کاتالوگ این است که اطلاعات درج شده در یک صفحه توسط 
طراح کاتالوگ باید بسیار روان‌تر و جذاب‌تر از زمانی باشد که یک فرد عادی همان اطلاعات را در صفحه درج 
کرده باشد. بنابراین یک صفحه با مجموعه‌ای از اطلاعات، نوشته‌ها و تصاویر در صورتی‌ که درک آن برای 

مخاطب مشکل باشد و یا رغبتی به خواندن آن در وی به وجود نیاورد صفحه‌آرایی نیست. همچنین:
  کاربردی بودن

  زیبایی‌آفرینی

  ارزش‌گذاری

از اهداف مهم و مورد توجه در طراحی صفحات به شمار می‌رود.

 3ـ4ـ10ـ نکات مهم در صفحه‌آرایی
در صفحه‌آرایی کاتالوگ انتخاب

  نوع فونت، اندازه کلمات

  فاصله از حاشیه، فواصل بین خطوط

  طراحی گرافیکی مناسب صفحات

  انتخاب مناسب رنگ‌ها

  و جایگذاری متناسب اطلاعات

اهمیت زیادی دارد. 
مواردی که در صفحه‌آرایی در چاپ باید به آن توجه کرد شامل:
  حروف‌چینی: یکی از مفاهیم صفحه‌آرایی، حروف‌چینی است.
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  نوع و اندازه حروف: صفحه‌آرا باید به نوع و اندازه حروف توجه کند.

  تک ستونه یا دو ستونه: رایج‌ترین شکل کتاب تک ستونه است اما برای طراحی بروشور و مجله می‌توان از 

دو ستونه استفاده کرد.
  سطربندی: ردیف کردن سطور محتوای کتاب

  حاشیه کتاب: تنظیم حاشیه با دقت کافی

  تورفتگی در اول پاراگراف: معمولاً اولین سطر پاراگراف‌ها با یک تورفتگی شروع می‌شود.

  پر کردن کتاب: برای بردن یک مطلب در بیش از یک صفحه یا افزایش حجم کتاب می‌توان فاصله سطور 

یا حروف را از یکدیگر افزایش داد.

 4ـ4ـ10ـ صفحه‌آرایی چگونه انجام می‌شود؟
امروزه برای طراحی صفحات از نرم‌افزارهای مختلف استفاده می‌شود در حالیک‌ه در گذشته این کار به‌صورت 
از بهترین نرم‌افزارهای کاربردی برای آماده‌سازی صفحات به‌صورت حرفه‌ای  دستی صورت می‌گرفت. یکی 
نرم‌افزار  به  می‌توان  نشر  و  چاپ  صفحه‌آرایی  نرم‌افزارهای  دیگر  از  است.   Adobe InDesign نرم‌افزار 
با  نرم‌افزار  این  می‌رود.  شمار  به  صفحه‌بندی  برای  حرفه‌ای  طراح  یک  که  کرد.  اشاره   QuarkXPress
پروژه‌های Photoshop سازگار است و امکان بارگذاری تصاویر با حجم و اندازه زیاد را نیز فراهم میک‌ند. 
Page Maker و نرم‌افزار Freehand از دیگر نرم‌افزارهای مورد کاربرد در صفحه‌بندی هستند. استفاده از

  Microsoft Word برای تایپ

  Adobe Photoshop برای ویرایش و آماده‌سازی تصاویر

  Adobe InDesign برای صفحه‌آرایی

  Adobe Illustrator برای ساخت و تبدیل فایل‎های InDesign به PDF که جهت چاپ کاربرد دارد.

نصب  فارسی‌سازی جهت  به  نیازی  نرم‌افزارها  این  می‌روند.  شمار  به  نرم‌افزارهای صفحه‌بندی  رایج‌ترین  از 
باشند. در کشور  انتشارات  و  پاسخگوی طراحان  و می‌توانند  ندارند  را  دلخواه شما  فارسی  فونت‌های 

شکل 34ـ١٠ـ نمونه​ای از صفحه​آرایی
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5ـ10ـ تهیه یک سند تعاملی

 InDesign تعاملی در PDF های تعاملی می‌توانند ابزاری عالی باشند. این بخش بر چگونگی ساخت‌PDF
 InDesign تعاملی  ‌PDFهای  از  کنید.  اضافه  به سند خود  را  ویژگی‌های خاصی  بتوانید  تا  است  متمرکز 
می‌توان برای کاربرگ، پروپوزال، چک لیست و کتاب الکترونیکی استفاده کرد. هنگامی که ‌PDFهای تعاملی 
را در InDesign ایجاد میک‌نید، می‌توانید از پیوندها، دکمه‌ها، لیست‌ها و کادرهای متنی استفاده کنید. مثال 

PDF تعاملی دیگر افزودن امضای الکترونیکی به پرونده شما است. 

PDFelement با InDesign تعاملی PDF 1ـ5ـ10ـ نحوه ویرایش 
همانطور که InDesign برای ایجاد ‌PDFهای تعاملی مفید است، بیشتر یک نرم‌افزار صفحه‌آرایی است که 
به‌طور خاص برای PDF طراحی نشده است. در اين زمينه اگر به نرم‌افزار حرفه‌ای‌تری علاقه‌مند هستید، 
 InDesign های تعاملی شما از‌PDF گزینه خوبی است که به‌طور ماهرانه‌ای برای ویرایش PDFelement

طراحی شده است.

PDFelement شکل 35ـ10ـ

حتی پس از استفاده از InDesign برای ایجاد صفحات تعاملی، باز هم ممکن است با خطاهایی روبه‌رو شوید 
 PDFelement باید ویرایش شوند. این خطاها را می‌توان با استفاده از PDF که پس از صادر کردن پرونده‌ها به

برطرف کرد تا سند شما شسته و رفته و حرفه‌ای به نظر برسد.
پیمایش این برنامه آسان است و دسترسی به ویژگی‌ها ساده است. برای جذابیت سند خود به عناصر اصلی 

مانند فونت‌های مختلف، رنگ و سبک دسترسی پیدا کنید.
  این یک نرم‌افزار قدرتمند برای ویرایش PDF با مهارت است.
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  همه ابزارهای ویرایش مورد نیاز برای انواع سند PDF را ارائه می‌دهد و به شما امکان می‌دهد تنظیمات 

خود را برای تجربه ویرایش سریع‌تر و آسان‌تر انجام دهید.
  گزینه حاشیه‌نویسی به شما امکان می‌دهد متن را برجسته کنید، یادداشت‌های مهم اضافه کنید و از ابزار 

طراحی در سند PDF خود استفاده کنید.
  این یک رابط کاربری آسان است که گزینه‌های اساسی موردنیاز در ویرایش سند شما را نشان می‌دهد.

  این نرم‌افزار PDF و سایر قالب‌ها را به Word،وExcel،وPowerPoint،وHTML و RTF تبدیل میک‌ند.

  ویژگی استخراج داده‌ها به‌طور خودکار فایل شما را در قالب دلخواه شما با دقت ذخیره میک‌ند.

  ویژگی ایجاد فرم به شما امکان می‌دهد عناصر را به راحتی کشیده و رها کنید.

  PDFelement به شما امکان می‌دهد اسناد PDF تعاملی را به‌صورت دستی یا خودکار ایجاد کنید. 

در زیر مرحله‌ای است که می‌توانید برای ایجاد یک فایل PDF تعاملی دنبال کنید:

InDesign های تعاملی ‌PDF مرحله 1: وارد کردن 
روی »Open Files« کلیک کرده و برای انتخاب فایل PDF موردنظر برای تغییر در یک سند تعاملی، به 

بروید. فهرست 

PDFelement شکل 36ـ10ـ باز کردن فایل با

PDF مرحله 2: افزودن لینک به 
به منوی Edit بروید و سپس Link را انتخاب کنید. یک پنجره بازشو جدید ظاهر می‌شود. شما می‌توانید 
Appearance و Action را در پنجره جدید تنظیم کنید. همچنین می‌توانید هر تعداد پیوندی را که لازم 

می‌دانید اضافه کنید.
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PDF شکل 37ـ10ـ افزودن لینک به

PDF مرحله 3: افزودن نشانک به 
 »View« افزودن نشانک به سند شما یکی دیگر از ویژگی‌هایی است که به راحتی در دسترس است. به منوی
بروید تا نماد »Bookmark« را مشاهده کنید. با کلیک روی این صفحه پنل نشانک باز می‌شود و می‌توانید 

نشانک‌ها را از آنجا اضافه، ویرایش و حذف کنید.

شکل 38ـ10ـ فهرست مطالب با نشانک

 مرحله 4: زمینه فرم تعاملی را به‌صورت خودکار یا دستی ایجاد کنید
ایجاد فرم‌های تعاملی به‌صورت خودکار ساده است و با یک کلیک کامل می‌شود که باعث کاهش بسیار زمان 

و بهبود کارایی می‌شود.
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  برای شناسایی برنامه، فاصله و جداول روی Form>Form Field Recognition کلیک کنید. با این کار 

زمینه‌های قابل پر کردن ظاهر می‌شوند.
  روی دکمه »بستن ویرایش فرم« کلیک کنید و نشانگر خود را در یک قسمت خاص قرار دهید تا پر کردن 

آن شروع شود.
برای ایجاد دستی یک سند تعاملی با InDesign، با این کار شروع ک‌نید:

  فایل PDF خود را باز کرده و سپس روی Form و بعد روی دکمه Add Field کلیک کنید.

  موقعیت مکانی را که می‌خواهید اضافه کنید انتخاب کنید تا کادر تأیید ظاهر ‌شود.

  روی دکمه »بستن ویرایش فرم« کلیک کنید و مکان‌نما را در قسمت متن قرار دهید تا مستقیم شروع به 

تایپ کنید.

شکل 39ـ10ـ اضافه کردن فیلدهای فرم
 

InDesign های تعاملی در ‌PDF 2ـ5ـ10ـ مراحل ایجاد 
امکان می‌دهد پیوندها، نشانک‌ها و دکمه‌ها را  InDesign نوعی سند است که به شما  PDF تعاملی در 
اضافه کنید. می‌توانید موارد را انتخاب کرده و سند خود را به‌صورت دیجیتالی امضا کنید تا از نظر قانونی 
لازم‌الاجرا باشد. فرم‌های اضافه شده به یک PDF تعاملی را می‌توان با اطلاعات خاصی که کاربر خواسته 

است پر کرد. ایجاد اسناد PDF تعاملی با انتقال صفحه، نشانک‌ها و دکمه‌ها شامل مراحل زیر است.
  مرحله InDesign :1 را باز کنید و گزینه تعاملی را از میان پنل‌های موجود در صفحه انتخاب کنید.
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  مرحله 2: با رفتن به پنل Links و کلیک روی دکمه Create Link پیوندها را اضافه کنید و سپس مقصد 

پیوند را انتخاب کنید.
  مرحله 3: پنل Bookmarks را باز کنید و با کلیک روی دکمه Create New Bookmark نشانک‌ها را 

به صفحات مورد نظر خود در سند خود اضافه کنید.
  مرحله 4: دکمه‌ها و صفحه فرم‌ها را باز کنید تا دکمه‌هایی در سند PDF خود ایجاد کنید. به نماد دکمه 

واقع در صفحه دکمه‌ها بروید و علامت + واقع در کنار صفحه اقدامات را انتخاب کنید تا دکمه فعال شود. شما 
می‌توانید PDF تعاملی خود را از InDesign مشاهده کنید.

6ـ10ـ آموزش صفحه‌آرایی مجله و کتاب

در این آموزش کوتاه و مفید به شما می‌آموزیم که چگونه صفحه آرایی کتاب را در InDesign انجام دهید. در 
این آموزش به‌صورت مرحله به مرحله به ایجاد سند، تنظیم Master Page، شیوه‌گذاری متون، وارد کردن 

محتوا،‌ صفحه‌آرایی کتاب و در نهایت خروجی گرفتن از سند ایجاد شده می‌پردازیم.

InDesign 1ـ6ـ10ـ ایجاد سند در 
 Document و گزینه New و زیرمجموعه گزینه File می‌توانید از منوی ،InDesign برای ایجاد سند جدید در
 New Document بر روی كیبورد خود استفاده کنید تا پنجره Ctrl+N را انتخاب کنید و یا از کلید تریکبی

نمایش داده شود.

شکل 40ـ10ـ باز کردن سند جدید

InDesign ایجاد سند جدید در 
در کادر محاوره‌ای شکل 41ـ10، باید تنظیمات کلی سند خود مثل ابعاد کار، تعداد صفحات،‌ فضای قرارگیری 
متن، تعداد ستون متن، جهت باز شدن و چند مورد دیگر را تعیین کنید. ما در این آموزش به​طور مثال 
به صفحه‌آرایی کتاب ۲۴ صفحه‌ای، با ابعاد وزیری می‌پردازیم و تنظیمات را طبق آن تعیین میک‌نیم، شما 

می‌توانید با توجه به کتاب خود مقدار هر یک از فیلدها را به‌طور دلخواه تعیین و تنظیم کنید.
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شکل 41ـ10ـ تنظیم مشخصات سند

(Number of Page=24) :1 تعداد صفحات
2 قطع صفحات: کتاب وزیری با محاسبه خط برش (Width=170 / Height=240) بر حسب میلی‌متر

)Gutter( و فاصله بین‌شان (Columns=1) :3 تعداد ستون‌ها
4 اندازه حاشیه‌ متن: فضای سفید اطراف متن از بالا، پایین، راست و چپ صفحه

(Top=35mm, Bottom=25mm , Inside=25mm ,Outside=25mm) این موارد با توجه به تشخیص 
شما و با توجه به محل قرار گرفتن سرصفحه و شماره صفحه می‌تواند متفاوت باشد. ما در اینجا بخش بالایی 

را برای قرارگیری سرصفحه و شماره صفحه بزرگ‌تر از جهت‌های دیگر در نظر گرفتیم.
5 پیش‌نمایش )Preview(: با فعال کردن این گزینه می‌توانید تنظیمات صفحه را به‌صورت زنده مشاهده کنید.

بعد از انجام تنظیمات روی دکمه OK کلید کنید تا سند جدید ایجاد شود.

InDesign در Master Page 2ـ6ـ10ـ ایجاد و تنظیم 
Master Page در InDesign، به صفحاتی گفته می‌شود که بخش‌های پایه‌ای و تکرارشونده در کتاب مانند 
مشبک‌بندی، سرصفحه‌ها، شماره صفحه، عناصر ثابت بصری و … را در آن تعیین و تنظیم میک‌نند. صفحات 
Master به‌طور پیش‌فرض به شکل دو صفحه مقابل هم تعریف شده‌اند که می‌توانند به‌صورت تکی هم به 

صفحات اعمال شوند.
شما بسته به نوع کارتان می‌توانید Master Page را به‌صورت تک صفحه‌ای استفاده کنید و یا از چندین 
Master Page با بخش‌های متغیر و ثابت و حتی با ظاهری متفاوت بهره ببرید و به صفحات و بخش‌های 
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مختلف ظاهر متفاوتی را اعمال کنید.
برای ایجاد و تنظیم Master Page، مسیر زیر را دنبال کنید و صفحاتتان را شخصی‌سازی کنید:

ابتدا از طریق پنجره Page در بخش کناری نرم‌افزار روی صفحات A- Master دابل کلیک کنید )اگر پنجره 
Page موجود نبود می‌توانید از طریق منوی Window و گزینه Page آن را فعال کنید و یا روی صفحهک‌لید 

دکمه F12 را فشار دهید(.

Master Page شکل 42ـ10ـ ایجاد و تنظیم

در بالای فضای متن با ابزار Type Tool یک کادر متنی ایجاد کنید و نام کتاب خود را درج کنید و نوع 
فونت و اندازه آن را تعیین کنید. می‌توانید از خطوط و طرح برای زیبایی کار در کنار عنوان خود بهره ببرید.
برای وارد کردن شماره صفحه ابتدا با ابزار Type Tool یک کادر متنی ایجاد کنید و داخل آن کلیک کنید و 
سپس به مسیر  Type>Insert Special Character>Markers>current Page Numberمراجعه کنید 
و یا با استفاده از کلیدهای تریکبی Ctrl+Alt+Shift+N شماره صفحه را درون کادر متنی قرار دهید. سپس 
نوع فونت و اندازه شماره صفحه را تعیین کنید )توجه داشته باشید شماره صفحه در Master Page نمایش 

داده می‌شود(.

شکل 43ـ10ـ تنظیم فونت و شماره صفحه
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بعد از تنظیم و جایگذاری عنوان و شماره صفحه می‌توانید از آن‌ها کپی بگیرید و آن‌ها را در صفحه مقابل نیز 
جایگذاری کنید. حال اگر به صفحات خود مراجعه کنید مشاهده میک‌نید سرصفحه و شماره صفحه به تمام 
صفحات شما اعمال شده است )برای مشاهده صفحات دیگر کافی است در پنجره Page روی صفحه مورد 

نظر خود دابل کلیک نمایید(.

اگر در سند خود بیشتر از یک Master Page داشتید و می‌خواستید به صفحه‌ای، Master Pageای را 
اعمال کنید کافی است صفحه یا صفحات مورد نظرتان را انتخاب کنید، سپس کلیک راست کرده و روی 
گزینه Apply Master to Pages کلیک کنید. پس از آن از منوی کشویی Master Page مورد نظر 

خود را انتخاب کرده و روی دکمه OK کلیک کنید. 

نکته

InDesign 3ـ6ـ10ـ ایجاد و تنظیم شیوه در 
اگر با نرم‌افزار Word کار کرده باشید حتماً می‌دانید که همه اجزای متن مانند عنوان‌ها، متن‌ها و پاراگراف‌ها 
دارای شیوه جداگانه‌ای هستند. در  بدنه متن  و  و عنوان‌ها  به خود هستند  یا سبک مختص  دارای شیوه 
InDesign هم همین شیوه‌ها وجود دارند البته به‌صورت کاملًا پیشرفته‌تر و با کارایی بالاتر. در صفحه‌آرایی 
کتاب با InDesign شیوه‌ها اهمیت ویژه و بسیار مهمی دارند؛ استفاده از آن‌ها کار شما را حرفه‌ای‌تر و سرعت 

انجام کار را بالاتر می‌برد.
شیوه‌ها در InDesign به دو صورت پاراگراف و کاراکتر وجود دارند که به ترتیب برای شیوه‌گذاری پاراگراف‌ها 
و کلمات و حتی تک حرف‌ها مورد استفاده قرار می‌گیرند و هرکدام دارای تنظیمات و ویژگی‌های مختص به 

خود هستند.

 شیوه پاراگراف متن 
برای ایجاد شیوه پاراگراف جدید در پنجره Paragraph Styles روی گزینه Create New Style کلیک 
کنید. برای تعیین مقادیر و تنظیمات شیوه پاراگراف روی آن کلیک راست کرده و گزینه Edit را انتخاب کنید 

و یا با دو بار کلیک کردن می‌توانید وارد تنظیمات شیوه پاراگراف )Options Paragraph Style( شوید.

شکل 44ـ10ـ تنظیم شیوه پاراگراف
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در بخش General نام شیوه خود را تعیین کنید. به‌عنوان مثال نام آن را Matn بنامید. برای تعیین نوع 
کلیک کنید. در بخش پیش رو   Basic Character Formats اندازه فونت در برگه کناری روی گزینه  و 

اعمال کنید. را  تنظیمات دلخواه خود 

Paragraph Style Options شکل 45ـ10ـ کادر محاوره‌ای
1 نوع فونت را انتخاب کنید.

2 نوع شیوه فونت را انتخاب کنید.
3 اندازه فونت را تعیین کنید.

4 فاصله بین خطوط را تعیین کنید.
5 فاصله بین کلمات را تعیین کنید.

 Indents and Spacing برای تنظیم جهت متن، کشیدگی، همچنین اعمال فرورفتگی و موارد دیگر از برگه کناری گزینه
را انتخاب کنید، در بخش پیش رو می‌توانید تنظیمات خود را با توجه به توضیحات زیر تعیین کنید:

1 جهت پاراگراف )راست به چپ یا چپ به راست(.
2 جهت تراز کردن متن ) با انتخاب گزینه Right justify می‌توانید خطوط متن خود را در ابتدا و انتها با 

هم تراز کنید(.
3 فرورفتگی شروع خط )این مورد تفاوتی در راست‌چین و چپ‌چین بودن متن ندارد(

4 فاصله قبل و بعد پاراگراف.

شکل 46ـ10ـ انجام تنظیمات شیوه پاراگراف
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بعد از تنظیم شیوه پاراگراف متن ممکن است شما در میان متن پاراگراف کتاب کلمات یا جملاتی داشته 
باشید که به‌عنوان مثال باید به‌صورت بولد باشند. در این حالت شما بهتر است برای تسریع در کار و یا نکات 

حرفه‌ای دیگر شیوه مختص به این نوع کلمات و جملات را تعریف کنید و مورد استفاده قرار دهید.
برای این کار به کادر محاوره‌ای Character Styles مراجعه کنید و روی گزینه Create New Style کلیک 
کنید. در اینجا نیز مانند شیوه پاراگراف در بخش Basic Character Formats می‌توانید نوع و اندازه فونت 
به شیوه‌های  تعداد گزینه‌های تنظیمات متن نسبت  به ساختار شیوه‌های کاراکتر  با توجه  تعیین کنید.  را 

پاراگراف کمتر است و مواردی مانند Indents and Spacing در کاراکتر وجود ندارد.

شما می‌توانید برای متن خود چندین شیوه پاراگراف و شیوه کاراکتر مشابه با اندک تغییرات ایجاد کنید 
و به تناسب کار خود از آن‌ها در جاهای مختلف صفحه‌آرایی کتاب بهره ببرید. به‌عنوان مثال می‌توانید دو 
شیوه پاراگراف متن با فونت و شیوه مشابه داشته باشید و فقط در بخش فرورفتگی یک شیوه پاراگراف با 

فرورفتگی و شیوه پاراگراف دیگر را بدون فرورفتگی ایجاد کنید. 

نکته

 تعیین شیوه تیترها 
است.  اهمیت  حائز  بسیار  موضوع  این  کنید،  استفاده  پاراگراف  از شیوه  نیز  متن  تیترهای  برای  است  بهتر 
به‌عنوان مثال برای تهیه فهرست مطالب حتماً باید از شیوه پاراگراف استفاده کنید، لذا تیترهای شما بر اساس 

پاراگراف استایل شناخته می‌شوند.
 Basic Character برای ایجاد شیوه پاراگراف تیتر نیز مانند شیوه پاراگراف متن عمل کنید و فقط در بخش
Formats اندازه فونت را بزرگ‌تر و نوع شیوه آن را بولد انتخاب کنید؛ همچنین می‌توانید از فونت متفاوتی 

برای تیترها استفاده کنید.

InDesign به Word 4ـ6ـ10ـ ترتیب قرارگیری صفحات و وارد کردن متن کتاب از 
قبل از وارد کردن متن کتاب به InDesign بهتر است با ترتیب صفحات کتاب آشنا شوید. رعایت این موارد 
نه​تنها بهتر است به آن عمل شود بلکه می‌تواند مواردی جذاب برای مخاطب رقم بزند. به‌طور معمول ترتیب 

اجزای کتاب‌ها به این شکل است.
3 فهرست مطالب	 		 2 صفحه شناسنامه 1 صفحه عنوان	

6 متن  			  5 مقدمه 		 4 پیشگفتار
 InDesign به Word بعد از آشنایی با ترتیب صفحات به وارد کردن متن کتاب می‌پردازیم. وارد کردن متن از

به دو روش انجام می‌شود که ما در اینجا به روشی که ساده‌تر و سریع‌تر است می‌پردازیم.

شیوه‌های  زیرا  کنید   InDesign وارد  شیوه  بدون  و  خام  به‌صورت  را  متن  است  بهتر  هستید  مبتدی  اگر 
 Edit از منوی ،InDesign به Word می‌تواند برای شما گیجک‌ننده باشند. برای وارد کردن متن خام Word
و از زیرمجموعه Preferences روی گزینه Clipboard Handling کلیک کنید و یا از روی صفحهک‌لید، 
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کلیدهای Ctrl+K را فشار دهید و از برگه کناری گزینه Clipboard Handling را انتخاب کنید. در پنجره 
 Text Only گزینه When Pasting Text and Tables from Other Applications پیش رو در قسمت

را انتخاب کنید و سپس روی دکمه OK کلیک کنید.

InDesign به Word شکل 47ـ10ـ وارد کردن متن از

بعد از انجام تنظیمات، برای کپی کردن متن کافی است به فایل Word خود مراجعه کنید و کلیه مطالب را 
انتخاب و کپی کنید، بعد از آن مجدداً وارد نرم‌افزار InDesign شوید و در صفحه شروع مطالب، با استفاده 
از ابزار Type Tool با کشیدن یک کادر متنی به اندازه فضای میانی حاشیه‌ها )فضای قرارگیری متن( ایجاد 

کنید. سپس متن خود را الصاق کنید.
بعد از جایگذاری متن در فریم متنی به دلیل بیشتر بودن متن از فضای در نظر گرفته شده، علامت مثبت 
قرمز رنگی در قسمت پایینی فریم متنی نمایان می‌شود که بیانگر این موضوع است. برای نمایش و جایگذاری 
تمام متن‌ها در صفحات کتاب، روی علامت مثبت قرمز رنگ کلیک کنید. در این حالت ظاهر نشانگر ماوس 
تغییر میک‌ند؛ سپس به صفحه بعد مراجعه کنید و با نگه داشتن دکمه Shift روی فضای متنی صفحه بعد 
 InDesign کلیک کنید. با این کار شاهد این خواهید بود که تمام متن شما به‌طور خودکار در تمامی صفحات

جایگذاری می‌شوند.
حالا می‌توانیم به شیوه‌گذاری اجزای مختلف متن و صفحه‌آرایی کتاب بپردازیم.

InDesign 5ـ6ـ10ـ ایجاد فهرست مطالب در 
قبل از ایجاد فهرست مطالب این نکته را مد نظر قرار دهید که همه بخش‌هایی که نیاز دارید در فهرست لیست 
شوند باید دارای شیوه پاراگراف مشخص باشند. به‌عنوان مثال تیترهای مهم شما باید دارای پاراگراف مختص 

به خود باشند تا بتوانید آن‌ها را در فهرست خودکار InDesign فراخوانی کنید.
همچنین قبل از تهیه فهرست مطالب می‌توانید یک شیوه مشخص برای لیست فهرست خود ایجاد کنید.

ابتدا به صفحه‌ای بروید که فهرست مطالب در آن قرار می‌گیرد. برای ایجاد فهرست از منوی Layout روی گزینه 
Table of Content کلیک کنید. در پنجره پیش رو تنظیمات خود را با توجه به توضیحات ارائه شده تعیین کنید.

  نام فهرست یا فهرست مطالب را در این فیلد وارد کنید. شیوه مقابل آن را روی شیوه تیتر خود قرار دهید 
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)شما می‌توانید این فیلد را خالی بگذارید و بعداً کلمه فهرست مطالب را به هر شکلی که می‌خواهید به صفحه 
اضافه کنید(.

  در بخش Styles in Table of Contents هر یک از شیوه‌هایی را که می‌خواهید لیست شوند، می‌توانید 

 Include Paragraph کلیک کنید تا به قسمت Add انتخاب کنید و روی دکمه Other Styles از قسمت
Styles انتقال پیدا کنند.

Include Paragraph Styles شیوه  ابتدا در کادر    برای تعیین نوع نمایش و تنظیمات شیوه فهرست، 

موردنظر خود را انتخاب کنید و سپس شیوه موردنظرتان )شیوه فهرست‌ها( را انتخاب کنید.

شکل 48ـ10ـ تهیه فهرست مطالب

1 عنوان فهرست مطالب
2 لیست کل شیوه‌های پاراگراف

3 کادر فهرست شیوه‌های وارد شده
4 شیوه فهرست

5 محل قرارگیری شماره صفحه
برای آشنایی و یادگیری تمام قسمت‌ها و نکات این بخش به فصل مربوط به تهیه خودکار فهرست مطالب 

اتوماتیک در InDesign مراجعه کنید.
بعد از اعمال تنظیمات روی گزینه OK کلیک کنید. اکنون مشاهده میک‌نید نشانگر ماوس شما تغییر کرد و فهرست 

شما آماده جایگذاری است. کافی است در فضای متن کلیک کنید یا در محدوده مدنظرتان کلیک کرده و بکشید.
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 6ـ6ـ10ـ خروجی گرفتن PDF برای چاپ
بعد از اتمام صفحه‌آرایی کتاب در InDesign، برای خروجی گرفتن کتاب کافی است از منوی File روی 

گزینه Export کلیک کنید و یا روی صفحهک‌لید دکمه‌های Ctrl+E را فشار دهید.
 Adobe گزینه Save as Type در پنجره باز شده محل ذخیره‌سازی و نام فایل را تعیین کنید و در قسمت

PDF (print) را انتخاب کنید و روی Save کلیک کنید.

PDF شکل 49ـ10ـ صدور به

در پنجره تنظیمات خروجی PDF در قسمت Adobe PDF Preset گزینه Press Quality را انتخاب کنید. 
سپس تنظیمات را مطابق شکل ​50 ـ10 قرار دهید و روی گزینه Export کلیک کنید.

Export Adobe PDF شکل 50 ـ10ـ کادر محاوره‌ای
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کلیات

پیچیدگی و مشکلات موجود در فرایند تولید کتاب، از دید هیچک‌س پوشیده نیست؛ و در این میان چگونگی 
آماده‌سازی فایل چاپی بیک‌م‌وکاست، از مسائلی است که همواره ناشران با آن دست‌وپنجه نرم‌ میک‌نند.

با اهمیتی که آراستگی هرچه بیشتر صفحات داخلی کتاب پیدا کرده است، هر ناشری به زعم خود سعی بر 
بهبود کتاب‌هایش در این راستا دارد و در این راه از تمام عناصر موجود بهره می‌برد؛ از بهک‌ارگیری قلم‌های 

برتر گرفته تا صفحه‌آرایی‌های مدرن، به‌روز و کارآمد.
بخش  در  )به‌ویژه  نشر  حوزه  در  شده  عرضه  نرم‌افزارهای  تنوع  و  ای  رایانه​ فناوری‌های  پیشرفت  با  امروزه، 
فایل کتابشان  برای تهیه  نامناسب  نرم‌افزارهای  از  ناشران،  از  با چاپ(، هنوز بسیاری  صفحه‌آرایی و مرتبط 

میک‌نند. استفاده 
یکی از نرم‌افزارهای متداول که به اشتباه، در این زمینه استفاده شده Word است. این برنامه علی‌رغم اینک‌ه 
ابزار بسیار قدرتمندی به حساب می‌آید، هرگز برای آماده‌سازی فایل کتابی که قرار است به شیوه افست چاپ 

شود، طراحی نشده است.
در عین حال، برنامه InDesign از نرم‌افزارهای مناسبی است که برای صفحه‌آرایی کتاب و مجلات عرضه 
شده است؛ و برخلاف تصور رایج، کار کردن با آن، بسیار ساده‌تر از Word است. امیدواریم با استفاده از آموزش 

گام به گام این مجموعه‌، بتوانید از امکانات بی‌نظیر این برنامه، بهره‌مند گردید.

هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي‌رود كه:
  مفهوم كسب‌وكار را درک کند.

  ساختار تهيه كسب‌وكار را بداند.

  نحوه انجام تعهدات و قراردادهاي حقوقي را بداند.

  مراحل انجام يك پروژه براي InDesign را بداند.

زمان آموزش

عملینظری

46
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1ـ11ـ مفهوم کسب‌وکار

نویسندگان مختلف، تعاریف متفاوتی از كسب‌وكار دارند. در واژه‌نامۀ آکسفورد كسب‌وكار به معنی خرید و 
فروش و تجارت آمده است. در واژه‌نامۀ لانگ‌من كسب‌وكار به فعالیت پول در آوردن و تجارتی که از آن پول 

حاصل شود، گفته می‌شود.
به زبان ساده، كسب‌وكار عبارت است از حالتی از مشغولیت و به‌طور عام، شامل فعالیت‌هایی است که تولید و 

خرید کالاها و خدمات با هدف فروش آن‌ها را به منظور کسب سود، در بر می‌گیرد.
  بر طبق نظر ارویک و هانت كسب‌وكار عبارت است از هر نوع کسب‌وکاری که در آن خدمات یا کارهایی 

که دیگر افراد جامعه به آن نیاز دارند و مایل به خرید آن هستند و توان پرداخت بهای آن را دارند، از جمله 
تولید، توزیع و عرضه.

  پترسن و پلومن بر این باورند که هر تبادلی که در آن خرید و فروش صورت گیرد، كسب‌وكار نیست، بلکه 

كسب‌وكار، هر نوع تبادل تکراری و تجدید‌شونده خرید و فروش است.
  پروفسور اون، كسب‌وكار را یک نوع کاسبی می‌داند که طی آن کالاها یا خدمات برای فروش در بازار تولید و 

توزیع می‌شوند.
بنابراین با توجه به تعاریف یاد شده می‌توان دریافت که كسب‌وكار با خرید و فروش کالاها، تولید کالاها یا 

عرضه خدمات، به منظور به دست آوردن سود، سر و کار دارد.

 1ـ1ـ11ـ ساختار تهیه کسب‌وکار
شروع یک تجارت جدید یک شبه اتفاق نمی‌افتد و نیاز به انجام بسیاری از اقدامات قبل از شروع کار تجاری 
است. مواردی مانند انتخاب یک محصول یا خدمت، تصمیم‌گیری در مورد یک ساختار قانونی برای تجارت 
خود، ایجاد نامی به یاد ماندنی برای شرکت شما و موارد دیگر. قبل از اینکه به همه این موارد بپردازید باید 

برنامه كسب‌وكار نوپای خود را بنویسید.

 2ـ1ـ11ـ چرا به یک برنامه كسب‌وكار نیاز دارید؟
برنامه‌های تجاری اغلب هنگام اخذ تسهیلات و تأمین منابع مالی پروژه از طریق بانک‌ها یا سرمایه‌گذاران مورد 
نیاز است. حتی اگر دنبال حمایت مالی خارج از کشور نیستید، یک برنامه تجاری برای موفقیت استارتاپ شما 
بسیار مهم است. بدون اینکه ابتدا یک طرح از یک معمار به‌دست آورید، ساخت‌وساز در خانه جدید را شروع 
نمیک‌نید! برنامه كسب‌وكار شما به عنوان یک طرح برای كسب‌وكار شما عمل میک‌ند و شما باید مطابق با 

آن جلو بروید.
برنامه كسب‌وكار به شما امکان می‌دهد با فکر کردن در مورد همه جوانب كسب‌وكار و اجرای آن، امکان‌سنجی 
ایده تجاری خود را آزمایش کنید. مشکلات و چالش‌های بالقوه را برجسته میک‌ند و به شما کمک میک‌ند 
تقریباً برای هر کاری آماده باشید. در اولویت‌بندی اهدافتان کمک میک‌ند. با نوشتن یک برنامه تجاری، خود 

را برای موفقیت آماده کنید. مطمئن نیستید که چگونه یکی را بنویسید؟ 
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 هفت مرحله تهیه برنامه كسب‌وكار
هنگام نوشتن برنامه كسب‌وكار نوپا، هفت مرحله وجود دارد. این هفت مرحله عبارت‌اند از:

1 خلاصه اجرایی
2 توضیحات شرکت

3 تحقیقات بازار
4 توضیحی درباره محصولات یا خدمات شما

5 توضیحی در مورد مدیریت و ساختار عملیاتی شما
6 بازاریابی و استراتژی فروش شما

7 اطلاعات مالی

۱ـ خلاصه اجرایی
این بخش به گونه‌ای طراحی شده است که اطلاعاتی را که در برنامه كسب‌وكار شما درج شده است، در اختیار 
خوانندگان قرار دهد. ایجاد این بخش معمولاً پس از اتمام مراحل دیگر آسان‌تر است و به شما امکان می‌دهد 
اطلاعات کلیدی هر قسمت از طرح را برجسته کنید. این بخش به‌طور معمول حدود یک صفحه است و شامل 

یک یا دو بند در مورد هر یک از عناصر دیگر است که در این سند بحث شده است.

۲ـ توضیحات شرکت
اطلاعات دقیق درباره شرکت خود را اینجا وارد کنید. درباره مشکلی که كسب‌وكار شما حل میک‌ند بحث 
کنید. از موارد خاصی مانند انواع افراد، سازمان‌ها یا مشاغل دیگری که قصد ارائه خدمات را دارید استفاده 
نکنید. در اینجاست که باید رسالت شرکت خود را بیان کنید. در مورد کدام ساختار تجاری مانند مالکان 
به  مربوط  اطلاعات  و حتماً  کنید.  بحث  مشارکت محدود  یا  مشارکت حرفه‌ای  عمومی،  مشارکت  شخصی، 

مکان)های( تجاری خود را نیز درج کنید.

۳ـ تحقیقات بازار
انجام یک تحلیل عمیق از شرایط بازار بسیار مهم است. این اطلاعات نشان می‌دهد که شغل شما چقدر موفق 

است. هرچه بازار هدف خود را بهتر درک کنید، احتمالاً شرکت شما رونق بیشتری خواهد یافت.

شکل ١ـ١١ـ هفت مرحله تهیه برنامه کسب و کار
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در این مرحله تحقیقات زیادی انجام دهید، از کارشناسان بخواهید اخبار صنعت، گزارش‌های مالی و منابع 
را بخوانند. شما می‌دانید که یک بازار مناسب برای محصول یا خدمتی که قصد ارائه آن را دارید وجود دارد. 

دریابید که مشتری بالقوه و ایده‌آل شما در یک منطقه جغرافیایی خاص زندگی میک‌ند یا خیر. 
در این مرحله شما همچنین می‌خواهید تحقیقات رقابتی را به پایان برسانید. رقبای شما چه کسانی خواهند 
بود؟ کدام یک موفق‌ترین هستند؟ آن‌ها چه میک‌نند و چرا کار میک‌ند؟ و چگونه می‌توانید این کار را بهتر انجام 
دهید؟ به‌علاوه، اطلاعات مربوط به پیشنهاد رقیب را جمع‌آوری کنید تا بتوانید تعیین کنید تفاوت شما با یکدیگر 

در چیست. پس از اتمام تحقیقات بازار، یافته‌های خود را در این بخش از برنامه تجاری خلاصه کنید.

۴ـ شرح محصولات یا خدمات
در اینجا باید جزئیات مربوط به آنچه را می‌فروشید به اشتراک بگذارید. اطلاعاتی از قبیل ویژگی‌ها و چگونگی 
بهره‌مندی مشتریان از هر یک از آن‌ها و همچنین مشکلاتی را که به آن‌ها کمک خواهید کرد حل کنید. در 
ادامه توضیح دهید که چگونه پیشنهاد شما به این نیاز پاسخ می‌دهد. با بحث در مورد چشم‌انداز رقابتی این 
کار را انجام دهید با این جمله که چگونه شرکت‌های دیگر در حال حل این مشکل هستند و چه چیزی راه‌حل 

شما را نسبت به دیگران متفاوت میک‌ند؟

۵ـ ساختار مدیریتی و عملیاتی
در این بخش نحوه عملکرد شغل شما و ترسیم تدارکات سازمان توضیح داده شده است. جزئیات مربوط به 
این موارد را درج کنید که بخش‌ها مسئولیت کدام یک و کدام سمت یا عنوان کدام یک از آن‌ها را بر عهده 
دارند. اگر قبلًا برخی یا همه افرادی را انتخاب کنید که در این موقعیت‌ها حضور داشته باشند، این مکان برای 
بحث در مورد این اطلاعات است. پیشینه آن‌ها و اینکه چرا آن‌ها برای انجام وظیفه شرکت خود و همچنین 
اندازه و ساختار  به  را مرور کنید. بسته  به موفقیت شرکت کمک میک‌ند  چگونه تجربه و تحصیلات آن‌ها 
كسب‌وكار مشخص شده شما، مناسب است که یک نمودار سازمانی را نیز در این بخش از برنامه كسب‌وكار 

خود قرار دهید.

۶ـ استراتژی‌های بازاریابی و فروش
توضیح  با  از جایی شروع کنید.  باید  اما  دارد،  فروش وجود  و  بازار  به  نزدیک شدن  برای  زیادی  روش‌های 
چگونگی برنامه‌ریزی برای جذب و حفظ مشتری شروع کنید. توضیحی از روند فروش مورد انتظار شما نیز 

باید در اینجا وارد شود. این بخش از برنامه كسب‌وكار شما باید یک تا دو صفحه باشد.

٧ـ اطلاعات مالی
زمانی که قرار است یک ایده به یک کسب​وک​ار تبدیل شود، همواره بحث مالی به میان می​آید. در نتیجه، 
هرقدر که ایده شما پتانسیل داشته باشد، بدون برخورداری از منابع مالی لازم قادر به رساندن آن به مرحله 
اجرا نخواهید بود. اینجاست که نقش سرمایه​گذاری به شکلی جدی مطرح می​شود. این سرمایه​گذاران با قبول 
ریسک سرمایه​گذاری، صاحب ایده را از منابع مالی لازم برخوردار میک​نند. اما چگونه باید این افراد را راضی 
کرد تا روی این ایده ریسک کنند؟ جواب این مسئله را می​توان در ادامۀ طرح مالی کسب​وک​ار جستجو کرد. از 
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آن​جایی که عموماً برای سرمایه​گذاران زمان بازگشت سرمایه و رسیدن به سود مناسب از همه چیز مهم​تر است، 
ارائه طرح مالی مستحکم و منطقی برای کسب​وک​ار تا حد زیادی اعتماد آنان را جلب خواهد کرد.

2ـ11ـ نحوه انجام تعهدات و قراردادهای حقوقی

برای صحت هر معامله این شرایط اساسی است: قصد طرفین و رضای آن‌ها، اهلیت طرفین، موضوع معین که مورد 
معامله باشد و مشروعیت جهت معامله. در این راستا کسی که معامله میک‌ند آن معامله برای خود آن شخص 

محسوب است مگر اینکه در موقع انجام عقد یا قرارداد خلاف آن را تصریح کند یا بعد خلاف آن ثابت شود.

 1ـ2ـ11ـ قرارداد چیست؟
را تشکیل می‌دهد و جزئی  ارکان اصلی زندگی اجتماعی روزانه  از  توافق و قرارداد یکی  امروزی  در دنیای 
جدانشدنی از آن به حساب می‌آید. انسان‌ها در هر جایگاهی که قرار بگیرند هم تعهداتی را قبول میک‌نند و 
هم تعهداتی را به هم می‌دهند. بنابراین قراردادهای حقوقی در واقع تعهداتی هستند که میان دو طرف قرارداد 
منعقد می‌شوند با این تفاوت که در قالب بخصوص و ویژه‌ای در می‌آیند و به این شکل آن​ها را از سایر توافقات 

روزمره متمایز میک‌نند.
ما در این بخش برآنیم که ابتدا در باب تعریف قرارداد حقوقی و مشخصات آن و سپس در مورد قراردادهای 

حقوقی متعارف در عرصه كسب‌وكار صحبت کنیم.
به‌طور کلی قرارداد نوعی از توافق بین دو یا چند نفر برای برقراری رابطه تجاری یا غیر تجاری است. در یک 
طرف قرارداد فردی قرار دارد که قصد به وجود آوردن قرارداد را دارد که به عمل او ایجاب می‌گویند و در 

طرف دیگر قرارداد شخصی است که ایجاب طرف مقابل را قبول میک‌ند.
در این راستا ماده 183 قانون مدنی بیان میک‌ند:

»عقد عبارت از این است که یک یا چند فرد در مقابل یک یا چند فرد دیگر تعهد بر 
امری کنند و مورد قبول آن‌ها باشد.«

نکته مورد توجه این است که شخص به تنهایی نمی‌تواند قرارداد منعقد کند و قانون تحقق توافق یا قرارداد 
را از دو فرد به بالا مقدور دانسته است.

بنابراین برای انجام قرارداد شرایط اصلی وجود دارد که در ماده 190 قانون مدنی نیز به آن اشاره شده است.
این‌ها از شرایط اساسی صحت یک قرارداد محسوب می‌شوند. به این معنی که در صورت عدم تحقق این 

از: اعتبار قانونی خواهد بود. این شرایط عبارتند  شرایط توافق فاقد 

قصد طرفین و رضایت آن‌ها
زمانی که دو طرف با اراده بر موضوعی توافق کنند ملزم به رعایت آن می‌شوند. رضایت یک عمل درونی و 
منظور از آن اشتیاق برای انجام عملی است و قصد صورت بیرونی این تمایل محسوب می‌شود که به واسطه 

عملی خارجی خود را نشان می‌دهد.
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صلاحیت طرفین
صلاحیت به معنای قدرت و توانایی اعمال حق است به این معنا که فرد بالغ، عاقل و رشید باشد و همچنین 

در مورد شخص حقوقی لازم است بررسی شود که آیا در حوزه مورد نظر قدرت عمل لازم را دارد یا خیر؟

معلوم و مشخص بودن مورد معامله )موضوع معامله(
موضوع قرارداد عبارت است از مال یا عملی که طرفین متعهد به انجام آن هستند که باید معلوم و مشخص 

باشد.

 2ـ2ـ11ـ مشروعیت جهت معامله
 منظور از جهت معامله همان هدف معامله است. البته باید گفت که معمولاً در قراردادهای حقوقی جهت 
معامله ذکر نمی‌شود ولی اگر ذکر شد نباید خلاف شرع باشد. علاوه بر این شروط که از شرایط کلی و اساسی 
صحت قراردادها هستند ممکن است برخی شروط دیگر هم در قراردادها بیاید که لازمه آن قرارداد باشد. به 
عنوان مثال در برخی از قراردادها مدت قرارداد جزء اصلی ارکان تشکیل‌دهنده آن قرارداد محسوب می‌شود. 
مثلًا در قراردادهایی که موضوع آن‌ها انجام کار یا ارائه خدمات است و یا در قرارداد اجاره که شرط اساسی 

صحت آن درج مدت زمان است و یا مواردی نظیر مبلغ قرارداد و محل تنظیم قرارداد.
بعد از آشنایی مختصری با قرارداد حقوقی لازم است به انواع قراردادهای حقوقی رایج در عرصه كسب‌وكار 

اشاره کنیم:

انواع قرارداد حقوقی
در این عرصه قراردادهای زیادی به چشم می‌خورد که گاهی ممکن است از دید بنیان‌گذاران، سرمایه‌گذاران، 
سهام‌داران و سایر اشخاص حاضر در صحنه كسب‌وكار به جهت عدم توجه به مسائل حقوقی پنهان بماند. 
ما تصمیم داریم با معرفی کامل آن‌ها این آشنایی را مقدور سازیم. به‌طور کلی ما 6 دسته قرارداد در عرصه 

كسب‌وكار داریم البته این تقسیم‌بندی بیشتر صوری بوده و مهم خود این قراردادها هستند.

InDesign 3ـ11ـ مراحل انجام یک پروژه برای

مراحل انجام پروژه‌های InDesign عبارت‌اند از:
  آماده‌سازی

  پیاده‌سازی 

   نهایی‌سازی

در مرحله آماده‌سازی، ابتدا نیاز به برنامه‌ریزی است؛ یعنی ایجاد برنامه ساده‌ای از الگوی مسئله و قرار دادن 
موارد موردنظر روی این الگو یا طرح اولیه. در برنامه‌ریزی هم‌چنین باید یک برنامه زمانی برای انجام و تحویل 
پروژه در نظر گرفته شود. در این مرحله کارهای تایپ اولیه و تهیه تصاویر نیز انجام می‌شود. البته قبل از هر 

چیزی نیاز به عقد قرارداد با کارفرما برای انجام کار است که در بخش‌های قبل توضیح داده شد.
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پس از عقد قرارداد لازم است در مورد ابعاد سند نهایی چاپ، الزامات رنگ و چاپخانه چاپک‌ننده آن از کارفرما 
سؤال کنید.

در مرحله پیاده‌سازی، باید کار را در InDesign به‌صورت عملیاتی انجام دهید؛ یعنی مواردی را که در این 
کتاب فراگرفتید از جمله وارد کردن متن از Word، قرار دادن تصاویر، طراحی جداول و ...، انجام دهید. 

در مرحله نهایی‌سازی باید مواردی همچون گرفتن خروجی از طریق گزینه‌های صدور را انجام دهید و از کل 
پروژه پکیج بگیرید. در نهایت یک نمونه از کار را چاپ کرده و ببینید با اهداف شما مطابقت دارد. در صورت 
تأييد سفارش دهنده پروژه شما به عنوان طراح، به شمارگان مورد نياز مي​تواند چاپ شود يا در فضاي مجازي 

استفاده گردد.
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سازمان پژوهش و برنامه ريزي آموزشي جهت ايفاي نقش خطير خود در اجراي سند تحول بنيادين در آموزش 
و پرورش و برنامه درسي ملي جمهوري اسلامي ايران، مشاركت هنرآموزان را به​عنوان يك سياست اجرايي 
مهم دنبال مي كند. به منظور تحقق اين امر مهم، اعتبارسنجي كتاب​هاي درسي را در دستور كار خود قرار 
داده است تا با دريافت نظرات هنرآموزان درباره كتاب​هاي نو نگاشت، كتاب​هاي درسي را در اولين سال چاپ، 
‌با كمترين اشكال به​هنرجويان و هنرآموزان ارجمند تقديم نمايد. در اجراي مطلوب اين فرايند، همكاران گروه 
تحليل محتواي آموزشي و پرورشي استان​ها و ‌گروه​هاي آموزشي نقش سازنده اي را برعهده داشتند. ضمن 
ارج نهادن به​تلاش تمامي اين همكاران، ‌اسامي هنرآموزاني كه تلاش مضاعفي را در اين زمينه داشته و با ارائه 

نظرات خود سازمان را در بهبود محتواي اين كتاب ياري كرده اند به​شرح زير اعلام مي شود.
اسامي دبيران و هنرآموزان شركتك ننده در اعتبارسنجي كتاب کاربر گرافیک رایانه‌ای

 با InDesign  ـ کد 312259
  

استان محل خدمت نام و نام خانوادگي رديف 

تهران سحر اسماعيلي 1

شهرستان هاي تهرانزهرا كردي2

تهرانليلا سعيد  3

تهرانمريم شفيعي 4

خراسان رضويليلا داودي ثاني5

شهرستان هاي تهرانبيتا رهنماي زربيجاري6

تهرانمیترا امیدوار7

تهراننگار نصر8

تهرانبهاره محمدی9

آذربایجان  غربیحسین ابازری برگشادی10

تهرانعباس احسان جو11

تهرانهادی صادقی خوانساری12

تهرانعباسعلي رضايي13

تهرانمحمد نقوي 14




